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Typographic Conventions

American English is the standard used in this handbook.

The following typographic conventions are also used.

This information is displayed in the instructor’s presentation

Demonstration

Procedure

Warning or Caution

Hint

Related or Additional Information

Facilitated Discussion

User interface control Example text

Window title Example text
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VLC About This Handbook

About This Handbook

This handbook provides you with basic information for attending your virtual live classroom session.

Adobe Connect Support Information

Web and audio support is available by:

● Pressing *0 from within the audio-conferencing

● Calling the support hotline numbers listed below

● Emailing the PGi support hotline below

Global PGi Support Hotline for SAP Education (24/7)

Tel: +1 800-368-1945

Tel: +1 719-234-7915

Note: After dialing in, press option 2 for technical support. You will then be presented with two options – 
press 1 for Audio support, or press 2 for Web support.

Email: sapedsupport@premiereglobal.com

This Instructor handbook provides a master reference document to help both the Instructor and 
the Producer (if available) to prepare for, and deliver this course. Have this handbook printed and 
in front of you for all deliveries.

Setting up your Learning Environment

Ideally you want to be in a private room when participating in a synchronous (live) event. In reality, you may 
not be able to arrange that. Here are some tips for maximizing your learning environment: 

● Create an inspirational office/studio to work in

● Use a comfortable chair

● Use well designed and functional computer peripherals

● Keep a log or journal of notes and ideas you can use for future sessions 

Before your online class:
● Tell co-workers you will be in class (send e-mail)

● Post a sign indicating when you will be free again (when class is over)

● Use a headset instead of your computer speakers to minimize disruption of others

● Ignore people who try to get your attention

● Turn off the ringers / alerts on telephone, pager, and cell phone

● Turn off e-mail and instant message alerts
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● Remove other distractions lying on your desktop

● Keep a glass of water at your desk

Teleconferencing ground rules:
● Use the mute button or press *6

● Do not place call on hold

● Use the "Raise hand" icon in the Attendee List: My Status to indicate you want to ask a question

● Identify yourself before speaking, when not called on

● Charge the batteries for your cordless handset

● If possible use a land line instead of your cell phone

This Instructor Handbook is a comprehensive resource that contains facilitation materials for 
this course, including:

● References to necessary materials and resources (slides, web page addresses, etc.)

● Presentation scripts and key points presented in Facilitator/Producer tables

● Time management guidelines for using the course interactive elements

● Technical guidelines for the Instructor (or Producer, if available)

The sessions are designed to keep participants interested and active with the technology, the 
Instructor, and one another. Chat and verbal feedback should be encouraged. In preparation for 
each class, read the handbook and the accompanying Participant Handbook, and enhance or 
adjust based on audience needs. 

What you will NOT find in the guide:

This handbook assumes that the Instructor and Producer are familiar with the synchronous 
delivery platform: Adobe Connect. Guidelines for using the online training tools are included 
under the Producer column of the Facilitator/Producer tables. This handbook does not include 
complete technical directions for the technology.

The Instructor and Producer need to become comfortable using the technology prior to 
delivering this course. Detailed information regarding using Adobe Connect can be found in the 
VLC Instructor Guide on the SAP Portal. Additionally a comprehensive User Guide can be found 
at the Adobe site: www.adobe.com

How this Handbook is Laid Out
The Instructor Handbook page format is arranged to assist you in facilitating the VLC class and 
includes several unique features.

Facilitator/Producer tables are found in the VLC Instructor Handbook only and provide prompts 
for presenting the content in the associated section that they precede. Although tasks are 
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divided into Facilitator and Producer roles, most often, the Instructor will perform all of these 
tasks.

Note:
The suggestions in the Producer column serve as a guideline for a Producer, if 
available. The Producer should feel free to adjust the suggestions (such as use of 
a particular tool) in order to maintain attention or emphasize the Instructor’s 
points. If there is no Producer, it is recommended that the Instructor perform 
these activities

Pre-Course Checklist

● In advance of the class, your Meeting Room will have been created and the session scheduled 
by your local operations team. Prior to the class, a welcome email will be sent to participants 
informing them of course prerequisites and asking participants to respond if they will not be 
finished with all prerequisites prior to the class. The Participant Handbook will be available via 
download from the Student File Share Pod, three days prior to the start of class.

Minimum Hardware Requirements

● PC with 1.4 GHz processor or higher (Windows) or 1.83 GHz process or higher (Mac OS). Minimum 
processor required for screen sharing. You may be asked to share your screen during hands-on exercise 
portions of the class.

● 17 inch or larger monitor is recommended, set at 1024 X 768. Larger monitor and 1024 X 768 setting will 
make presentation and system screens easier to read.

● Phone with Headset/Microphone or Speakerphone feature – to maximize student listening and comfort 
during presentation and demonstration portions of the course.

Software Requirement

A complete list of supported Operating Systems, browsers and additional requirements for Adobe® 
Acrobat® Connect™ can be found at: www.adobe.com/products/acrobatconnectpro/systemreqs

Sample Email to Notify Others You Are in a Virtual Class

This is a sample of an email you can send to your colleagues and manager when you are taking an online 
course.    

Dear colleagues,  

Today I will be participating in an online class from my desk. I will be online from approximately 9:30 a.m. to 
5:30 a.m. EST. I would appreciate it if you would not disturb me during this time. If you have an immediate 
question, please contact Joe Smith at extension 123. If it can wait until after 11:00 a.m., please send me an 
email and I will follow up with you before the end of the business day. I appreciate your consideration.  

Best regards,
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Getting the Most Out of Your Session

Session Guidelines

● Turn off email, phones, instant messaging tools, and clear other distractions away from your training 
area.

● Participate and prepare to be called on by name.

● Use the “Raise Hand” icon if you have an immediate question or comment.

● Be patient waiting for a response to your chat messages.

● If you leave the program, please use the “Step Away” status icon in the Attendee List pod to let your 
instructor know when you leave and remember to clear it when you return.

Session Preparation Checklist

These activities may be carried about by either the Instructor or Producer (if available). 

● Ensure you have the most current set of materials. Make necessary adjustments to course 
activities based on course enrolment (i.e. breakout group activities may need to be changed 
to individual activities or group collaboration activities if there are not enough participants to 
warrant breakout groups)

● Test all URLs at least one-day prior to delivery so that you have time to plan an alternate 
activity if necessary.

- Have a second browser open and to view the participant window

- Create breakout rooms if necessary

- Have the most current version of Instructor Guide printed and available and also have 
open on your desktop (to access hyperlinks)

- Print the class roster for use during the session

- Ensure Timer.swf has been uploaded into Share Pod to be used for breakout sessions

- Ensure the Participant Guide has been uploaded into the File Share Pod

- If you have session pre-requisites, verify from the Web Assessment report that all 
prerequisite web assessments have been passed

- Prepare your post class evaluation survey

- Create any polling questions needed for your session

Remember to always give technical direction when interacting with students; i.e. "please give me 
a green check mark when done" or, " use the Chat area to answer", etc.
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Breakout Preparations

TYPE OF BREAKOUT STEPS

Audio Breakout
● Review the activity task first. When going 

over activity directions, send breakout as-
signments in Chat. List name of each 
group (e.g., Group A), phone connection 
number and assigned members.

● If desired, email breakout room group as-
signments out an hour prior to the start of 
class so that participants can prepare.

● When it is time to reconvene the group, 
send a message via Chat.

Chat Pod (more than two participants per 
group)

● Create Chat pods prior to the start of the 
lesson.

● Rename Chad pods: Group A, Group B, 
Group C, etc.

● When going over activity directions, send 
breakout assignments in Chat.

● Let participants know you will be placing 
Chat pods on the screen for each group to 
access their assigned pod.

● Remind participants to use send “To: Ev-
eryone” when entering messages in Chat.

● Hide Chat pods during debrief to focus on 
one group's response at a time. To display 
a minimized Chat pod, go to Pods-Chat 
and click on the name of the Chat pod you 
want to share. Open one group Chat pod 
at a time during debrief.

● After session has ended determine if 
group Chat pods need to be deleted.
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Course Overview

TARGET AUDIENCE
This course is intended for the following audiences:

● System Administrator

● Systems Architect

© Copyright . All rights reserved. xv



xvi © Copyright . All rights reserved.



UNIT 1 SAP BusinessObjects Business 
Intelligence Platform

Lesson 1

Describing the SAP BusinessObjects Business Intelligence Platform 2

Lesson 2

Describing the SAP BusinessObjects Business Intelligence Platform Architecture 9
Exercise 1: Log on to the SAP BusinessObjects Business Intelligence Platform 4.1 29

UNIT OBJECTIVES

● Prepare for a virtual session

● Describe the SAP Business Intelligence platform

● Explain the architecture of the SAP BusinessObjects Business Intelligence platform
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Unit 1
Lesson 1

2
Describing the SAP BusinessObjects Business 
Intelligence Platform

LESSON OVERVIEW
Business Intelligence is a business improvement process that includes accessing and exploring 
information, analyzing the information, and developing insights and understanding that lead to 
informed decision making. SAP BusinessObjects Business Intelligence platform is a specialized 
tool for providing business intelligence. The platform is a flexible and scalable business solution 
that delivers powerful, interactive reports and operates as an integrated suite for reporting, 
analysis, and information delivery. Business Intelligence and SAP BusinessObjects Business 
Intelligence platform increases end-user productivity and reduces administrative efforts to 
increase overall business performance.

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● Prepare for a virtual session

● Describe the SAP Business Intelligence platform

Introductions

Introduce yourself (and other instructors, if applicable) to the course participants. Once you 
have introduced yourself, ask the class participants to introduce themselves.

Student Introduction

● Your name and company name

● The part of business and project you represent

● The SAP release currently implemented or implementing

● Project status

● What products or services your company provides

● Expectations for this class

Session Best Practices

Explain the best practices for participating in a virtual live classroom course.

Courtesy
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● Mute your phone except when talking to the instructor to eliminate background noise for other 
participants

● Access email and web sites only during breaks and after completion of exercises

Managing Questions

● Use the Q and A pod to ask questions electronically

● Review the Ask a Question icon in My Status

● Ask for verbal questions at different points in lecture and demonstrations

● Some questions will be parked until later

Discussions on the Phone

● Instructor will act as a moderator

● Speak clearly and loud enough so everyone can hear

● Only one conversation at a time

More Session Best Practices

More Session Best Practices

● Be prompt returning from breaks and lunch

- Restart times will be posted in meeting room

● Be considerate of and respect your fellow students

- Remember that every person learns at a different speed

- Remember that each student in class has a different SAP experience level

Additional Information
Documentation Website:

http://help.sap.com 

PGi Support Contact Information:

Press *0 from within the audio conference

Mail to: sapedusupport@premiereglobal.com

PGi Support hotline numbers: 1-800-368-1945 OR 1-800-234-7915

Note: Press option 2 for technical support and then press 1 for audio support or 2 for web support

Business Intelligence
A survey by BusinessWeek found that a majority of the business users today have either too little 
information or too much. If they have too much, which may be the best of the two situations, they 
still have to spend time to go through all that info and figure out what is relevant and what is not 
for their decision making. In any case, it is likely that the manager with too much information will 

Lesson: Describing the SAP BusinessObjects Business Intelligence Platform

© Copyright . All rights reserved. 3

http://help.sap.com


have to delay their decision for some time and possibly lose momentum. If executives end up with 
too little information, they could either delay their decision and possibly lose some momentum, or 
worse, rely on "instinct” and “gut feel” and move ahead with their decision with the associated 
risks of not having fact-based insight to back it up.

So, if the results of inadequate access information include lost productivity and flawed decision 
making, it is interesting to observe the reverse effect for companies providing access to analytic 
information and capabilities. Thomas Davenport is the author of “Competing on Analytics.” His 
research discovered that those companies that are truly high performing are more likely to use 
analytic information strategically. In fact, Davenport found that among the "high performers," 
77% of these companies have a depth of analytic support across their entire organization, and 
these top performers value the insights they gain from their analytics. In other words, when 
companies provide access to information and to analytics, they are far more likely to be high 
performing companies. And availability of analytics across the enterprise, and the USE of those 
analytics can drive competitive differentiation.

Gartner, Inc., a research and advisory firm that helps clients to leverage technology, coined the 
term “Business Intelligence” in the late 1980s.

Business Intelligence (BI), as defined by Gartner, is an iterative user-centered process that 
includes accessing and exploring information, analyzing this information, and developing insights 
and understanding that lead to improved and informed decision making. BI usage crosses the 
spectrum of users, both internally and externally throughout any enterprise, and includes rank-
and-file workers, executives, analysts, and knowledge workers.

Business Intelligence can help organization perform tasks such as:

● Generating a class list for a training session.

● Creating an employee performance review.

● Scheduling in a healthcare setting.

Business Intelligence can help organizations perform tasks like:

Benefits of Business Intelligence

● Identify and track key performance metric against their direct competitors and the overall 
market.

● Improve customer service and target high yield accounts.

● Streamline operations and improve supplier and warehouse operations.

● Identify successful marketing campaigns.

● Improve response time to market trends and customer requests.

● Decrease query and reporting time.

● Reduce cost and anxiety over compliance.

● Deliver true cost of Days Sales Outstanding and services.

● Reduce strain on IT departments.

Unit 1: SAP BusinessObjects Business Intelligence Platform
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SAP BusinessObjects Business Intelligence Platform

SAP BusinessObjects Business Intelligence platform is a flexible, scalable, and reliable 
solution for delivering powerful, interactive reports to end users via any Web application —
intranet, extranet, Internet, or corporate portal. Whether it is used for distributing weekly 
sales reports, providing customers with personalized service offerings, or integrating critical 
information into corporate portals, SAP BusinessObjects Business Intelligence platform 
delivers tangible benefits that extend across and beyond the organization. As an integrated 
suite for reporting, analysis, and information delivery, SAP BusinessObjects Business 
Intelligence platform provides a solution for increasing end-user productivity and reducing 
administrative efforts.

Figure 1: Introducing SAP BusinessObjects Business Intelligence Platform

BI Suite

The Business Intelligence suite components work together to provide solutions for various user 
needs. The suite provides:

● Access to and transformation of corporate data into highly formatted reports that provide 
greater insight.

● Visualization of data, which enables better decision making.

● Answers to specific questions and information interaction.

● Determination of trends from historical data and better forecasting.

● Immediate answers to business questions.

Lesson: Describing the SAP BusinessObjects Business Intelligence Platform
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Figure 2: SAP BusinessObjects BI Suite

Unit 1: SAP BusinessObjects Business Intelligence Platform
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Facilitator Producer

Say:

We'll be starting a group chat activity. I will be 
pasting a series of questions into the Chat 
pod and ask that you enter your responses af-
ter each question that is posted.

After you've entered your response to each 
question, review the responses of your class-
mates.

I will select some responses to discuss as a 
group.

Do:

Display the first question on the slide provid-
ed in the Instructor Presentation deck. Dis-
play questions one at a time.

Explain to participants that you will be posting 
a series of questions (every 30 seconds or so) 
in the chat area.

Ask participants to answer the questions 
based on their independent study, and then 
review their classmates' answers.

Select a response from one participant and 
copy and paste it to the whiteboard.

As a large group, (using audio) discuss the re-
sponses. Remind students to participate ac-
tively in class discussion, noting information 
of interest in their Participant Handbook.

Do:

Assist by pasting the prewritten questions in-
to the Chat pod.

If desired, archive the Chat pod and white-
board overlay for later reference or distribu-
tion.

Lesson: Describing the SAP BusinessObjects Business Intelligence Platform
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INTERACTIVE ELEMENT: Chat

1. Discuss how Business Intelligence can be useful to your company.

.

.

.

.

.

.

.

.

.

.

2. Which aspect of Business Intelligence interests you most as a system administrator?

.

.

.

.

.

.

.

.

.

.

LESSON SUMMARY
You should now be able to:

● Prepare for a virtual session

● Describe the SAP Business Intelligence platform

Unit 1: SAP BusinessObjects Business Intelligence Platform
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Unit 1
Lesson 2

8
Describing the SAP BusinessObjects Business 
Intelligence Platform Architecture

LESSON OVERVIEW
SAP BusinessObjects Business Intelligence platform has a flexible architecture that is designed 
for growth and modification. The platform can be easily understood as a series of conceptual tiers 
that contain servers and services that work together to provide flawless reporting.

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● Explain the architecture of the SAP BusinessObjects Business Intelligence platform

SAP BusinessObjects Business Intelligence Platform Architecture
The architecture of SAP BusinessObjects Business Intelligence platform is designed to meet the 
needs of any BI deployment, and is flexible enough to grow from several users with a single tool, 
to tens of thousands of users with multiple tools and interfaces.

Developers can integrate SAP BusinessObjects BI into your organization's other technology 
systems by using web services, Java, or .NET application programming interfaces (APIs).

Figure 3: SAP BusinessObjects BI Platform: Basic Architecture
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SAP BusinessObjects Business Intelligence Platform Tiers
SAP BusinessObjects Business Intelligence platform can be thought of a series of conceptual 
tiers:

Conceptual Tiers

● Client platform

● Web platform

● Management platform

● Storage platform

● Processing platform

● Data platform

SAP BusinessObjects Business Intelligence Client Tier

Figure 4: SAP BusinessObjects Business Intelligence Platform: Client Tier

Unit 1: SAP BusinessObjects Business Intelligence Platform
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Table 1: Tools in the Client Tier

Group Tool

BI Client Analysis, edition for MS Office (Excel and PPT Plug-In)
SAP BusinessObjects Analysis, edition for Microsoft Office, is a Plug-In that 
integrates into Microsoft Excel and Microsoft PowerPoint to be used as an 
online analytical processing (OLAP) tool. It provides access to a range of 
OLAP data sources, and also allows users to combine information from dif-
ferent systems within a single workspace.

Analysis, edition for OLAP (web client)
SAP BusinessObjects Analysis, edition for OLAP (formerly Voyager) is an 
online analytical processing (OLAP) tool for working with multi-dimensional 
data. It provides access to a range of OLAP data sources, and can also com-
bine information from different OLAP data sources within a single work-
space.

BI Launch Pad (web client)
BI launch pad (formerly InfoView) is the main web interface for business 
users to view, schedule, and track of published business intelligence docu-
ments. BI launch pad can access, interact with, and export, any type of busi-
ness intelligence including reports, analytics, dashboards, scorecards, and 
strategy maps. It simplifies information delivery and delivers secure access 
to BI content and tools, such as BI workspaces, SAP BusinessObjects Web 
Intelligence, SAP BusinessObjects Explorer, and SAP BusinessObjects Anal-
ysis, edition for OLAP.

BI workspaces (web client)
BI workspaces (formerly Dashboard Builder) helps you track your business 
activities and performance using modules (templates for data) and Busi-
ness Intelligence (BI) workspaces (for viewing data in one or more mod-
ules). Modules and BI workspaces provide information needed to adjust 
business rules as conditions change. It helps you track and analyze key busi-
ness data. It also supports group decision-making and analysis via integrat-
ed collaboration and workflow capabilities. BI workspaces enables you to or-
ganize content in pages, create mash-ups of Business Intelligence content, 
and present the information in a way that is tailored to the role of the user, 
either for personal use or for sharing with others.

Business View Manager
Business View Manager allows users to build semantic layer objects that 
simplify underlying database complexity. Business View Manager can create 
data connections, dynamic data connections, data foundations, business el-
ements, business views, and relational views. It also allows detailed column 
and row-level security to be set for the objects in a report. Designers can 
build connections to multiple data sources, join tables, alias field names, 
create calculated fields, and then use the simplified structure as a Business 
View. Report designers and users can then use the business view as the ba-

Lesson: Describing the SAP BusinessObjects Business Intelligence Platform Architecture
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Group Tool

sis for their Crystal reports, rather than building their own queries from the 
data directly.

Crystal Reports 2011
SAP Crystal Reports 2011 is a Windows-based report design tool that cre-
ates powerful reports that can be published in the SAP BusinessObjects 
Business Intelligence platform.

Crystal Reports for BI platform
SAP Crystal Reports for Enterprise is a Java-based report design tool that 
creates and integrates powerful reports in the SAP BusinessObjects Busi-
ness Intelligence platform.

Crystal Reports Viewer 2011
SAP Crystal Reports Viewer 2011 is a Java-based tool to view Crystal re-
ports.

Dashboards
SAP BusinessObjects Dashboards (formerly Xcelsius) is a tool for data visu-
alization and the creation of dynamic, interactive dashboards. Data can be 
updated dynamically from the SAP BusinessObjects Business Intelligence 
platform, and exported to many different formats that can be viewed by da-
ta consumers in standard formats, such as PowerPoint, PDF, or Flash.

Explorer
SAP BusinessObjects Explorer is an information-discovery tool that empow-
ers everyone in an organization with fast, easy access to information, so 
they can explore data, spark new ideas, and find new insights.

Information Design Tool
The Information Design Tool is an SAP BusinessObjects metadata design 
environment that enables a designer to extract, define, and manipulate met-
adata from relational and OLAP sources to create and deploy UNX univers-
es.

Live Office
SAP BusinessObjects Live Office integrates with the Microsoft Office envi-
ronment, allowing dynamically updated data to be embedded within Micro-
soft PowerPoint, Excel, and Word documents. In addition, you can share 
your documents with others over the Web for collaborative decision-making.

Web Service Query Tool
The Web Service Query Tool (formerly Query as a Web Service) allows Busi-
ness Intelligence queries to be used in custom web applications. Business 
users create their own queries from an universe connection and publish 
them as web services so they can be incorporated into client applications.

Universe Design Tool
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Group Tool

The Universe Design Tool (formerly Universe Designer) allows data design-
ers to combine data from multiple sources in a semantic layer (UNV uni-
verse) that hides database complexity from end users. It abstracts the com-
plexity of data by using business rather than technical language to access, 
manipulate, and organize data.

Universe Design Tool provides a graphical interface to select and view tables 
in a database. The database tables are represented as table symbols in a 
schema diagram. Designers can use this interface to manipulate tables, cre-
ate joins between tables, create alias tables, create contexts, and solve 
loops in a schema. You can also create universes from metadata sources. 
Universe Design Tool is used for the universe generation at the end of the 
creation process.

Web Intelligence Desktop
SAP BusinessObjects Web Intelligence Desktop is an ad hoc analysis and re-
porting tool for business users with or without access to the SAP Busines-
sObjects Business Intelligence platform. It allows business users to access 
and combine data from relational, online analytical processing (OLAP), 
spreadsheet, or text file sources, using familiar business terms in a drag-
and-drop interface. Workflows allow broad or narrow questions to be ana-
lyzed, and for further questions to be asked at any point in the analysis 
workflow. Web Intelligence Desktop users can continue working with Web 
Intelligence document files (.wid) even when unable to connect to a Central 
Management Server (CMS).

Web Intelligence (web client)
SAP BusinessObjects Web Intelligence is an ad hoc analysis and reporting 
tool for business users with access to the SAP BusinessObjects Business In-
telligence platform. It allows business users to access and combine data 
from relational, online analytical processing (OLAP), spreadsheet, or text file 
sources, using familiar business terms in a drag-and-drop interface. Work-
flows allow broad or narrow questions to be analyzed, and for further ques-
tions to be asked at any point in the analysis workflow.

Widgets
SAP Widgets (formerly BI Widgets) are mini-applications that allow easy 
and fast access to frequently used functions and provide visual information 
from your desktop. SAP Widgets allow your organization to provide access 
to existing BI content on the SAP BusinessObjects Business Intelligence 
platform. Or you can add Web Dynpro applications that are registered as Ex-
tensible Business Client Markup Language (XBCML) widgets on the SAP 
NetWeaver Application Servers, as desktop widgets.

Lesson: Describing the SAP BusinessObjects Business Intelligence Platform Architecture
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Group Tool

Admin Client Central Configuration Manager
The Central Configuration Manager (CCM) is a server troubleshooting and 
node management tool provided in two forms. In a Microsoft Windows envi-
ronment, the CCM allows you to manage local and remote servers through 
its Graphical User Interface (GUI) or from a command line. In a Unix environ-
ment, the CCM shell script (ccm.sh) allows you to manage servers from the 
command-line. The CCM allows you to create and configure Server Intelli-
gence Agent (SIA) nodes and start or stop your web application server. On 
Windows, it also allows you to configure network parameters, such as Se-
cure Socket Layer (SSL) encryption. These parameters apply to all servers 
within a node. Note: Most server management tasks are now handled 
through the Central Management Console (CMC), not through the CCM. 
The CCM is now used for troubleshooting and node configuration.

Central Management Console (web client).
The Central Management Console (CMC) is the main web interface to per-
form administrative tasks in the SAP BusinessObjects Business Intelligence 
platform, including user, content, and server management. It also allows you 
to publish and organize content, and configure security settings.

Data Federation Administration Tool
The Data Federation Administration Tool (formerly Data Federator) is a rich 
client application that offers easy-to-use features to manage your data fed-
eration service. Tightly integrated in the SAP BusinessObjects Business In-
telligence platform, the data federation service enables multi-source uni-
verses by distributing queries across disparate data sources, and lets you 
federate data through a single data foundation. The Data Federation Admin-
istration Tool lets you optimize data federation queries and fine-tune the da-
ta federation query engine for the best possible performance.

Lifecycle Management Console (web client)
The Lifecycle Management Console provides a centralized view to monitor 
the progress of the entire lifecycle process. It is used to promote content 
from one SAP BusinessObjects Business Intelligence platform to another of 
the same version.

Report Conversion Tool
The Report Conversion Tool converts Desktop Intelligence reports to Web 
Intelligence format, and publishes them to a Central Management Server 
(CMS).The Report Conversion Tool also lets you audit your converted re-
ports. This helps identify reports that cannot be fully converted, and ex-
plains why.

Repository Diagnostic Tool
The Repository Diagnostic Tool scans, diagnoses, and repairs inconsisten-
cies that may occur between the Central Management Server (CMS) system 
database and the File Repository Servers (FRS) filestore. It can also report 
the repair status and completed actions.
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Group Tool

Translation Management Tool
The Translation Management Tool defines multilingual universes and man-
ages translation of universes and their Web Intelligence documents and 
prompts.

Upgrade Management Tool
The Upgrade Management Tool (formerly Import Wizard) guides adminis-
trators through the process of importing users, groups, and folders from 
previous versions of the SAP BusinessObjects Business Intelligence plat-
form (formerly know as SAP BusinessObjects Enterprise). It also allows you 
to import and upgrade objects, events, server groups, repository objects, 
and calendars.

WDeploy
WDeploy is a tool that assists in deploying SAP BusinessObjects Business 
Intelligence platform web applications, such as BI Launch pad and the Cen-
tral Management Console, to target application servers.

Note:
Key administrative tools for administrators are Central Management Console (CMC), 
Central Configuration Manager (CCM), Repository Diagnostic Tool, and Upgrade 
Management Tool.

Lesson: Describing the SAP BusinessObjects Business Intelligence Platform Architecture
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SAP BusinessObjects Business Intelligence Web Tier

Figure 5: SAP BusinessObjects Business Intelligence Platform: Web Tier

Web Tier Components

Web Server
The Web server receives HTTP requests sent from the web client. The Web server holds and 
manages static content such as .html and .js files that may be part of an SAP 
BusinessObjects Business Intelligence suite web application.

Web Application Server
A web application server acts as the translation layer between a web browser or rich 
application, and the SAP BusinessObjects Business Intelligence platform. The Web 
application server hosts web applications, Web services, and Software Development Kits 
(SDK). Various Web application servers running on Windows, Unix, and Linux are supported. 
Note: If you do not have a web application server in place for use with the SAP 
BusinessObjects Business Intelligence platform, the installation program can install and 
configure a Tomcat 6 web application server for you.

Web Application Container Server
The Web Application Container Server (WACS) is an SAP BusinessObjects Business 
Intelligence platform server that allows the platform web services and web applications, such 
as the Central Management Console (CMC) and BI launch pad, to run without the need for a 
previously installed Java Web application server.

Web Applications
Web applications run in the web application server to process requests from the web client. 
SAP BusinessObjects Business Intelligence suite web applications include:
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● Central Management Console

● Lifecycle Management Console

● BI Launchpad

● BI Workspaces

● SAP BusinessObjects Web Intelligence

● SAP BusinessObjects Analysis, edition for OLAP

● SAP BusinessObjects Explorer

Web Services
Web services run in the web application server to process requests from client applications. 
Web services can be called remotely using the Simple Object Access Protocol (SOAP) for 
exchanging information that is not dependent on a specific platform, object model, or 
programming language.

SAP BusinessObjects web services include logic to understand and direct requests to the 
appropriate SAP BusinessObjects Business Intelligence platform server. SAP 
BusinessObjects web services can be accessed by rich clients such as Live Office and Crystal 
Reports, and also by custom-built web service consumer applications.

SAP BusinessObjects Business Intelligence platform web services include:

● Session

● BIPlatform

● ReportEngine

● QueryService

● SaveService

● BICatalog

● Publish

● LiveOffice

● Managequeryasaservice

● Federator

● XcelsiusWebServices

● BicsRemote

● Gopher

Lesson: Describing the SAP BusinessObjects Business Intelligence Platform Architecture
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SAP BusinessObjects Business Intelligence Platform Management Tier

Figure 6: SAP BusinessObjects Business Intelligence Platform: Management Tier

Management Tier Components

Central Management Server
The Central Management Server (CMS) maintains a database of information about your SAP 
BusinessObjects Business Intelligence platform (in the CMS system database) and audited 
user actions (in the Auditing Data Store). All platform services are managed by the CMS. The 
CMS also controls access to the system files where documents are stored, and information 
on users, user groups, security levels (including authentication and authorization), and 
content.

Event Server
The Event Server monitors the system for events, which can act as a trigger for running a 
report. When you set up an event trigger, the Event Server monitors the condition and 
notifies the CMS that an event has occurred. The CMS can then start any jobs that are set to 
run upon the event.

Explorer Master Server
Explorer Master Server manages all of the Explorer processing servers, including: Explorer 
Exploration Server, Explorer Indexing Server, and Explorer Search Server.

Server Intelligence Agent
A Server Intelligence Agent (SIA) manages and monitors all of the servers on a node, to 
ensure that they operate properly. Note: A node is a group of SAP BusinessObjects Business 
Intelligence platform servers that run on the same host. All of the servers on a node run 
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under the same user account. One machine can contain many nodes, so you can run 
processes under different user accounts.

SAP BusinessObjects Business Intelligence Platform Storage Tier

Figure 7: SAP BusinessObjects Business Intelligence Platform: Storage Tier

Storage Tier
Crystal Reports Cache Server

The Crystal Reports Cache server intercepts report viewing requests sent from clients to the 
Crystal Reports Processing server. If the Cache server cannot fulfill the request with a 
cached report page, it passes the request on to the Crystal Reports Processing server, which 
runs the report and returns the results. The Cache server then caches the report page for 
potential future use.

Dashboard Design Cache Server
The Dashboard Design Cache server determines whether a previously served dashboard 
viewing request would satisfy the current dashboard viewing request. If the request cannot 
be fulfilled by the Dashboard Design Cache server, it forwards the request to the Dashboard 
Design Processing server. The Dashboard Design Cache server will try to share previous data 
results as much as possible.

Input File Repository Server
The Input File Repository Server stores all of the documents and program objects that have 
been published to the SAP BusinessObjects Business Intelligence platform. It can store a 
large variety of file types.

Output File Repository Server

Lesson: Describing the SAP BusinessObjects Business Intelligence Platform Architecture
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The Output File Repository Server stores all of the instances generated by scheduled jobs for 
all object types including Crystal Reports, Web Intelligence, and programs. It can store a 
large variety of file types.

SAP BusinessObjects Business Intelligence Platform Processing Tier

Figure 8: SAP BusinessObjects Business Intelligence Platform: Processing Tier

Processing Tier

Adaptive Job Server
The Adaptive Job server is a generic server that processes scheduled jobs for many object 
types. Services that can be hosted on this server include: Authentication Update Scheduling 
Service, Crystal Reports 2011 Scheduling Service, Crystal Reports Scheduling Service, 
Destination Delivery Scheduling Service, Lifecycle Management Scheduling Service, 
Platform Search Scheduling Service, Probe Scheduling Service, Program Scheduling 
Service, Publication Scheduling Service, Replication Service, Security Query Scheduling 
Service, Visual Difference Scheduling Service, and Web Intelligence Scheduling Service.

Adaptive Processing Server
The Adaptive Processing server is a generic server that hosts services responsible for 
processing requests from many sources. Services that can be hosted on this server include: 
Adaptive Connectivity Service, BEx Web Application Service, Client Auditing Proxy Service, 
Custom Data Access Service, Data Federation Service, Document Recovery Service, DSL 
Bridge Service, Excel Data Access Service, Lifecycle Management ClearCase Service, 
Lifecycle Management Console Service, Monitoring Service, Multi Dimensional Analysis 
Service, Platform Search Service, Publishing Post Processing Service, Publishing Service, 
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Rebean Service, Security Token Service, Translation Service, Visual Difference Service, 
Visualization Service, and Web Intelligence Monitoring Service.

Connection Server
The Connection server provides database access to source data. It supports relational 
databases, as well as OLAP and other formats. The Connection server is responsible for 
handling connection and interaction with the various data sources and providing a common 
feature set to clients.

Connection Server 32
The Connection Server 32 is responsible for 32-bit database connectivity to access data.

Crystal Reports 2013 Processing Server
The Crystal Reports 2011 Processing server responds to Crystal Reports page requests by 
processing reports and generating encapsulated page format (EPF) files. The key benefit of 
EPF is that it supports page-on-demand access, so only the requested page is returned, not 
the entire report. This improves system performance and reduces unnecessary network 
traffic for large reports. The Crystal Reports 2011 Processing server retrieves data for the 
report from the latest instance or directly from the data source. After it generates the report, 
it converts the requested data to one or more EPF files. These EPF files are then sent to the 
Crystal Reports Cache server.

Crystal Reports 2013 Report Application Server
The Crystal Reports 2011 Report Application server (RAS) provides ad hoc reporting 
capabilities that allow users to create and modify Crystal reports via the SAP Crystal Reports 
server Embedded Software Development Kit (SDK).

Crystal Reports Processing Server
The Crystal Reports Processing server responds to Crystal Reports for Enterprise page 
requests by processing reports and generating encapsulated page format (EPF) files. The 
key benefit of EPF is that it supports page-on-demand access, so only the requested page is 
returned, not the entire report. This feature improves system performance and reduces 
unnecessary network traffic for large reports. The Crystal Reports Processing server 
retrieves data for the report from the latest instance or directly from the data source. After it 
generates the report, it converts the requested data to one or more EPF files. These EPF files 
are then sent to the Crystal Reports Cache server.

Dashboards Cache Server
Intercepts report requests sent from clients to the Dashboard server. If the cache server 
cannot fulfill the request with a cached report page, it passes the request on to the 
Dashboard server, which runs the report and returns the results. The cache server then 
caches the report page for potential future use.

Explorer Exploration Server
Explorer Exploration server provides and manages the Information Space exploration and 
analysis capabilities including search on data, filtering, and aggregation.

Explorer Indexing Server
Explorer Indexing server provides and manages the indexing of Information Space data and 
metadata.

Explorer Search Server
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Explorer Search server processes search queries and returns search results.

Web Intelligence Processing Server
The Web Intelligence Processing server is responsible for generating Web Intelligence 
documents. The Web Intelligence Processing server obtains document creation requests 
from the Web Application server and then communicates with the Input File Repository 
server to obtain a copy of the Web Intelligence document (WID) file and the universe 
definition. When viewing an existing instance of a WID, the Web Intelligence Processing 
server communicates with the Output File Repository server to obtain an existing historical 
instance of a WID.

SAP BusinessObjects Business Intelligence Platform Data Tier

Figure 9: SAP BusinessObjects Business Intelligence Platform: Data Tier

CMS system database
The CMS system database is used to store SAP BusinessObjects Business Intelligence 
platform information, such as user, server, folder, document, configuration, authorization, 
and authentication details. It is maintained by the Central Management Server (CMS), and is 
sometimes referred to as the system repository.

Auditing Data Store
The Auditing Data Store (ADS) is used to store information on trackable events that occur in 
SAP BusinessObjects BI platform. This information can be used to monitor the usage of 
system components, user activity, or other aspects of day-to-day operation.

Lifecycle Management database
The Lifecycle Management database tracks configuration and version information related to 
an SAP BusinessObjects Business Intelligence platform installation, as well as updates.
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Monitoring database
The Monitoring database is an embedded Java Derby database that stores system 
configuration and component information for SAP supportability in the SAP BusinessObjects 
Business Intelligence platform.

Universes (UNV)
UNV Universes are identified by the .unv file extension. They are the legacy type of universe 
based on the semantic layer in previous versions of the SAP BusinessObjects Business 
Intelligence platform. They are built using the legacy Universe Design Tool. An universe is an 
organized collection of metadata objects that enables business users to analyze and report 
on corporate data in non-technical language. These objects include dimensions, measures, 
hierarchies, attributes, predefined calculations, functions, and queries. The metadata object 
layer is built on a relational database schema or an OLAP cube, so the objects map directly to 
the database structures. A universe includes connections to the data sources so that users 
of query and analysis tools can connect to an universe and run queries and create reports 
using the objects in an universe without needing to know about the underlying data 
structures in the database.

Universes (UNX)
UNX Universes are identified by the .unx file extension. They are the new type of universe 
based on the new semantic layer in the SAP BusinessObjects Business Intelligence 4.0 
platform. They are built using the new Information Design Tool. An universe is an organized 
collection of metadata objects that enables business users to analyze and report on 
corporate data in non-technical language. These objects include dimensions, measures, 
hierarchies, attributes, predefined calculations, functions, and queries. The metadata object 
layer is built on a relational database schema or an OLAP cube, so the objects map directly to 
the database structures. A universe includes connections to the data sources so that users 
of query and analysis tools can connect to an universe and run queries and create reports 
using the objects in an universe without needing to know about the underlying data 
structures in the database.

Business Views
Business Views simplify report creation and interaction by abstracting the complexity of data 
for report developers. Business Views help separate the data connections, data access, 
business elements, and access control. Business Views can only be used by Crystal Reports 
and are designed to simplify the data access and view-time security required for Crystal 
report creation. Business Views support the combination of multiple data sources in a single 
view.

Flat files
Flat files include .txt, .csv, and .xls files.

Relational databases
Relational databases store data in two-dimensional tables.

OLAP data sources
OLAP data sources store data in multi-dimensional cubes.

SAP Business Warehouse
SAP NetWeaver Business Warehouse (BW) is the OLAP data source from SAP.

SAP Business Explorer Queries
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SAP Business Explorer (BEx) queries are used to analyze data in SAP NetWeaver Business 
Warehouse. BEx queries are built in the BEx query designer.

Services and Servers
SAP BusinessObjects BI platform uses the terms server and service to refer to the two types of 
software running on an SAP BusinessObjects BI platform machine.

BI Platform Terminology

Service
A service is a server subsystem that performs a specific function. The service runs within the 
memory space of its server under the process ID of the parent container (server). For 
example, the SAP BusinessObjects Web Intelligence Scheduling and Publishing Service is a 
subsystem that runs within the Adaptive Job server.

Server
The term server is used to describe an operating system level process hosting one or more 
services. For example, the Central Management server (CMS) and Adaptive Processing 
server are servers. A server runs under a specific operating system account and has its own 
PID.

Node
A node is a collection of SAP BusinessObjects BI platform servers running on the same host. 
One or more nodes can be hosted in a single host.

Server Intelligence Agent (SIA)
Server Intelligence Agent is a component of the Central Management Console (CMC) to 
manage a collection or server processes, collectively known as a node. Changes to server 
processes applied in the CMC are propagated to affected servers by the Server Intelligence 
Agent. The SIA is also used for the automatic restart or shutdown of a server when it 
encounters an unexpected condition, and is used by the Central Management Server (CMC) 
to manage nodes.

The Agent (SIA) server archives server information in the CMS system database so you can 
easily restore default server settings, or create redundant instances of server processes with 
the same settings.

Host
This term is used for the physical machine (PC tower, server blade) that is hosting nodes and 
SIAs. Each single host machine will host at least one node and one SIA, but it can host many 
more when being created by the administrator for scalability reasons.

SAP BusinessObjects BI platform consists of collections of servers running on one or more hosts. 
Small installations (such as test or development systems) can use a single host for a web 
application server, database server, and all SAP BusinessObjects BI platform servers.

Medium and large installations can have servers running on multiple hosts. For example, a web 
application server host can be used in combination with an SAP BusinessObjects BI platform 
server host. This combination frees up resources on the SAP BusinessObjects BI platform server 
host, allowing it to process more information than if it also hosted the web application server.

Large installations can have several SAP BusinessObjects BI platform server hosts working 
together in a cluster. For example, if an organization has many SAP Crystal Reports users, Crystal 
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Reports processing servers can be created on multiple SAP BusinessObjects BI platform server 
hosts to ensure that there are plenty of resources available to process requests from clients.

Production BI System

Figure 10: Production Business Intelligence System: Services and Servers

Note:
The nodes, servers, and services shown are for illustrative purposes only. The number 
of hosts, nodes, servers and services, as well as the type of servers and services, will 
vary in real world installation queries.

In this figure two hosts form the cluster named ProductionBISystem, with two hosts:

● The host named HostAlpha has two nodes:

- NodeMercury: contains an Adaptive Job server (NodeMercury.AJS) with services to 
schedule and publish reports, an Input File Repository server (NodeMercury.IFRS) with a 
service to store input reports, and an Output File Repository server (NodeMercury.OFRS) 
with a service to store report output.

- NodeVenus: contains an Adaptive Processing server (NodeVenus.APS) with services to 
provide publishing, monitoring, and translation features, an Adaptive Processing server 
(NodeVenus.APS2) with a service to provide client auditing, and a Central Management 
server (NodeVenus.CMS) with a service to provide the CMS services.

● The host named HostBeta has three nodes:
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- NodeMars: contains a Central Management server (NodeMars.CMS) with a service to 
provide the CMS services.

- NodeJupiter: contains a Web Intelligence Processing server (NodeJupiter.WebIntelligence) 
with a service to provide Web Intelligence documents, and an Event Server 
(NodeJupiter.EventServer) to provide report monitoring of files.

- NodeSaturn: contains an Adaptive Processing server (NodeSaturn.APS) with a service to 
provide client auditing.

Facilitator Producer

Say:

We will be starting a group chat activity. I will 
be pasting a series of questions into the Chat 
pod and ask that you enter your response af-
ter each question is posted. After you have 
entered your response to each question, re-
view your classmates responses. I will select 
some responses to discuss as a group.

Do:

Display the first question on the slide provid-
ed in the Instructor Presentation deck.

Display questions one at a time.

Explain to participants that you will be posting 
a series of questions (every 30 seconds or so) 
in the Chat area.

Ask participants to answer the questions 
based on their independent study and then to 
review their classmates answers.

Select the response from one participant and 
copy/paste it to the whiteboard. As a large 
group (using audio), discuss the response.

Remind students to participate actively in the 
class discussion, noting information of inter-
est in the Participant Handbook.

Do:

Assist by pasting the pre-written question in-
to the Chat pod.

If desired, archive the Chat pod and white-
board overlay for later reference and distribu-
tion.
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INTERACTIVE ELEMENT: Leading Questions Chat

1. Describe the interaction of the six different Business Intelligence platform tiers.

.

.

.

.

.

.

.

.

.

.

2. Which platform tier contains the key administrative tools for Administrators?

.

.

.

.

.

.

.

.

.

.

3. Name one of the platform storage tier servers and explain how it interacts with the rest of 
the platform.

.

.

.

.

.

.

.

.
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Unit 1
Exercise 1

29
Log on to the SAP BusinessObjects Business 
Intelligence Platform 4.1

Business Example:

As the system administrator, first you need to access the Administration Web application of the 
SAP BusinessObjects Business Intelligence platform. Second, you must change and customize 
the default BI launch pad Home page for a specific group in the platform.

Connect to the Training Cloud Environment

1. Launch the Remote Training Environment (Citrix connection).

2. Connect to the Remote Training Environment (Citrix connection).

Note:
We recommend using WTS in full screen mode. You can change this window size 
by clicking the Preferences tab, then selecting the Display option and the new 
window size.

Hint:
Press the Control + F12 keys on your keyboard to toggle between full screen view 
and your own desktop screen.

3. Connect to your Training Cloud environment:

Note:
If your training course is located outside the SAP Network (WAN) perform the 
following to optimize the quality of the display:

a) Click the Option button.

b) Select the Experience tab.

c) Choose the Modem (56 kbps) or LAN option in the listbox.

Note:
Write down your personal Training System Alias information in the following table.

© Copyright . All rights reserved. 29



Training System Alias User Name Password

__________________ train-_________ initial

Connect to the SAP BusinessObjects Business Intelligence Platform 4.1

1. Connect to the CMC Web Application for Administrators.

SAP BusinessObjects 
Business Intelligence 
Platform 4.1 System

User Name Password Authentication

WDFLBMT5072 Administrator admin41 Enterprise

WDFLBMT5073 Administrator admin41 Enterprise

Note:
Remember the name of the the BI platform 4.1 system that was assigned to you by 
your instructor.

2. Connect to the BI launch pad Web Application for Users.

3. Log off of the BI launch pad application.

Change the BI Launch Pad Preferences on the SAP BusinessObjects Business Intelligence 
Platform 4.1

1. In the CMC application, change the default BI launch pad preferences for all users who belong 
to the Administrators group to display the Public folders in the Documents tab instead of the 
Home tab as currently defaulted.

2. Check the changes in the BI Launchpad Web Application.

3. Set the user preferences in the BI launch pad to override those defined by the administrator.

4. Log off, and then log back on to the BI launch pad as "Administrator".
You are now connected to the User default Home page of the BI launch pad defined by the 
user.
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Unit 1
Solution 1

31
Log on to the SAP BusinessObjects Business 
Intelligence Platform 4.1

Business Example:

As the system administrator, first you need to access the Administration Web application of the 
SAP BusinessObjects Business Intelligence platform. Second, you must change and customize 
the default BI launch pad Home page for a specific group in the platform.

Connect to the Training Cloud Environment

1. Launch the Remote Training Environment (Citrix connection).
a) Launch the following URL address from your local web browser:

Training Course Environment URL Address

Training course is located inside the SAP 
Network (LAN)

http://wts.wdf.sap.corp/portal/

Training course is located outside the SAP 
Network (WAN)

a) http://mywts.sap.com

b) Click your nearest region (AMERICAS / 
EMEA / APJ).

c) Enter your logon and password creden-
tials (provided by your instructor).

2. Connect to the Remote Training Environment (Citrix connection).

Note:
We recommend using WTS in full screen mode. You can change this window size 
by clicking the Preferences tab, then selecting the Display option and the new 
window size.

Hint:
Press the Control + F12 keys on your keyboard to toggle between full screen view 
and your own desktop screen.

a) Once you are connected to the WTS@SAP portal, click the tab with the name of your 
region (example: "Region -- EMEA").
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b) Click the Training Zone submenu.

c) Click the Applications tab and then the Common Training link. After a couple of seconds, 
the remote Common Training desktop will appear in a new window.

d) Maximize this new window.

3. Connect to your Training Cloud environment:

Note:
If your training course is located outside the SAP Network (WAN) perform the 
following to optimize the quality of the display:

a) Click the Option button.

b) Select the Experience tab.

c) Choose the Modem (56 kbps) or LAN option in the listbox.

Note:
Write down your personal Training System Alias information in the following table.

Training System Alias User Name Password

__________________ train-_________ initial

a) Run the Remote Connection program from the Start > Programs menu.

b) Once the Remote Desktop Connection dialog box is displayed, go to the General tab and 
then enter the Training System Alias information that is provided by your instructor.

c) Click the Connect button to connect to your Training Cloud environment. After a couple of 
second the Log On screen appears.

d) Click the Other User option and then enter your persona credentials (see the previous 
table).

e) Click the Enter button. After a couple of seconds the desktop of your Training Cloud 
Environment is displayed in full screen.
You are now logged into your Training Cloud Environment.

Connect to the SAP BusinessObjects Business Intelligence Platform 4.1

1. Connect to the CMC Web Application for Administrators.

SAP BusinessObjects 
Business Intelligence 
Platform 4.1 System

User Name Password Authentication

WDFLBMT5072 Administrator admin41 Enterprise
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SAP BusinessObjects 
Business Intelligence 
Platform 4.1 System

User Name Password Authentication

WDFLBMT5073 Administrator admin41 Enterprise

Note:
Remember the name of the the BI platform 4.1 system that was assigned to you by 
your instructor.

a) From the Start menu in your Training Cloud Environment, select the _SAP Business 
Intelligence menu.

b) Click the custom link to Central Management Console (CMC) Home page option.

c) Enter the name of your personal BI 4.1 system that was assigned to you by your instructor 
in the dialog box.

d) Click the OK button. The CMC home page displays.

e) Enter your personal credential as Administrator (see previous table), and click the Log 
On button. After a couple of seconds the System Configuration Wizard window displays.

f) Click the Close button.
You are now connected to the Central Management Console Home page.

2. Connect to the BI launch pad Web Application for Users.
a) From the Start menu in your Training Cloud Environment, select the _SAP Business 

Intelligence menu.

b) Click the custom link to BI Launchpad Home page option.

c) Enter the name of your personal BI 4.1 system assigned to you by your instructor (see 
previous table).

d) Click the OK button. The BI launch pad Home page is displayed.

e) Enter your personal credential as Administrator and click the Log On button.
You are now connected to the default Home page of the BI launch pad

3. Log off of the BI launch pad application.
a) Click the Log Off button.

Change the BI Launch Pad Preferences on the SAP BusinessObjects Business Intelligence 
Platform 4.1

1. In the CMC application, change the default BI launch pad preferences for all users who belong 
to the Administrators group to display the Public folders in the Documents tab instead of the 
Home tab as currently defaulted.
a) Click the Users and Groups option in the CMC.

Lesson: Describing the SAP BusinessObjects Business Intelligence Platform Architecture

© Copyright . All rights reserved. 33



b) Select the Administrators group and right-click it. A context menu appears.

c) Select the BI Launchpad Preferences option. The BI Launchpad Preferences window 
displays.

d) Uncheck the No Preferences Defined option.

e) Select the Documents tab radio button.

f) Select the Folders radio button.

g) Click the Save and Close button to validate the changes.

2. Check the changes in the BI Launchpad Web Application.
a) From the Start menu in your Training Cloud Environment, select the _SAP Business 

Intelligence menu and then click the custom link to BI Launchpad Home page option.

b) Enter the name of your personal BI 4.1 system that was assigned to you by your instructor 
in the dialog box.

c) Click the OK button. The BI Launchpad Home page displays.

d) Enter your personal credential as Administrator and then click the Log On button.
You are now connected to the ADMIN default Home page of the BI launch pad defined by 
the BI 4.1 administrator.

3. Set the user preferences in the BI launch pad to override those defined by the administrator.
a) In the new BI launch pad home page, select the User Preferences option.

b) In the General page, uncheck the Use Default Settings (Administrator defined) option.

c) Select the Home tab radio button.

d) Click the Save and Close button to validate the changes.

4. Log off, and then log back on to the BI launch pad as "Administrator".
You are now connected to the User default Home page of the BI launch pad defined by the 
user.

Unit 1: SAP BusinessObjects Business Intelligence Platform
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LESSON SUMMARY
You should now be able to:

● Explain the architecture of the SAP BusinessObjects Business Intelligence platform

Lesson: Describing the SAP BusinessObjects Business Intelligence Platform Architecture
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Unit 1

37
Learning Assessment

1. Which of the following are examples of the application of Business Intelligence?

Choose the correct answers.

X A Identification of successful marketing campaigns

X B Generation of contact lists

X C Recording of consumer feedback

X D Decrease query and reporting time

2. How will your company benefit from Business Intelligence?

3. When a server starts, it registers with the Central Management Server (CMS).

Determine whether this statement is true or false.

X True

X False
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4. Match the Business Intelligence platform management tier component with the correct 
functions.

Match the item in the first column to the corresponding item in the second column.

Central Management Server 
(CMS)

Event server

Explorer Master server

Server Intelligence Agent

Manages and monitors all of 
the servers on a node, to en-
sure that they operate proper-
ly.

Monitors the system for 
events, which can act as a trig-
ger for running a report. When 
you set up an event trigger, 
this component monitors the 
condition and notifies the CMS 
that an event has occurred. 
The CMS can then start any 
jobs that are set to run upon 
the event.

Manages all of the Explorer 
processing servers, including: 
Explorer Exploration Server, 
Explorer Indexing Server, and 
Explorer Search Server.

Maintains a database of infor-
mation about your BI platform 
and audits user actions. All 
platform services are man-
aged by this component. It al-
so controls access to the sys-
tem files where documents are 
stored, and information on 
users, user groups, security 
levels (including authentica-
tion and authorization), and 
content.

Unit 1: Learning Assessment
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39
Learning Assessment - Answers

1. Which of the following are examples of the application of Business Intelligence?

Choose the correct answers.

X A Identification of successful marketing campaigns

X B Generation of contact lists

X C Recording of consumer feedback

X D Decrease query and reporting time

2. How will your company benefit from Business Intelligence?

3. When a server starts, it registers with the Central Management Server (CMS).

Determine whether this statement is true or false.

X True

X False
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4. Match the Business Intelligence platform management tier component with the correct 
functions.

Match the item in the first column to the corresponding item in the second column.

Central Management Server 
(CMS)

Event server

Explorer Master server

Server Intelligence Agent

Maintains a database of infor-
mation about your BI platform 
and audits user actions. All 
platform services are man-
aged by this component. It al-
so controls access to the sys-
tem files where documents are 
stored, and information on 
users, user groups, security 
levels (including authentica-
tion and authorization), and 
content.

Monitors the system for 
events, which can act as a trig-
ger for running a report. When 
you set up an event trigger, 
this component monitors the 
condition and notifies the CMS 
that an event has occurred. 
The CMS can then start any 
jobs that are set to run upon 
the event.

Manages all of the Explorer 
processing servers, including: 
Explorer Exploration Server, 
Explorer Indexing Server, and 
Explorer Search Server.

Manages and monitors all of 
the servers on a node, to en-
sure that they operate proper-
ly.
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UNIT 2 Installation of SAP 
BusinessObjects Business 
Intelligence Platform

Lesson 1

Installing SAP BusinessObjects Business Intelligence Platform: Server-Side Installation 42

Lesson 2

Installing SAP BusinessObjects Business Intelligence Platform: Client-Side Installation 48

UNIT OBJECTIVES

● Install SAP BusinessObjects Business Intelligence platform

● Install SAP BusinessObjects Business Intelligence platform client tools
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Unit 2
Lesson 1

42
Installing SAP BusinessObjects Business 
Intelligence Platform: Server-Side Installation

LESSON OVERVIEW
Server-side installation of the SAP BusinessObjects Business Intelligence platform may be 
performed as an interactive or as a silent installation. Before installing, make sure the technical 
prerequisites are satisfied and that preparation for the installation is finished. The provided 
installation checklist will help ensure that you are ready for the installation process.

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● Install SAP BusinessObjects Business Intelligence platform

Technical Prerequisites
Before you start the actual installation of SAP BusinessObjects BI platform, ensure that the 
following requirements are met:

● Validate the exact details of the supported platforms and ensure that this matches your 
environment. You can review the list of supported platforms at http://service.sap.com/
bosap-support .

● Check that your account for the operating system has administrative privileges.

● If you are planning to deploy on a distributed system, you need access to all machines via 
TCP/IP.

● You must have administrative access to the Web application server.

● You must have access to the database system to install the system database for SAP 
BusinessObjects BI platform.

Note:
The default installation of SAP BusinessObjects BI platform includes the Java 
application server, Tomcat, and Sybase SQL Anywhere for your system database.

Installation Preparation
The following sections detail how to prepare for the installation of SAP BusinessObjects BI 
platform.

Process Flow
This section explains the process flow for the installation of SAP BusinessObjects BI platform.
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1. Ensure that sufficient disk space is available. Allow for both the operating system and the 
software to grow over time as patches or new components become available.

2. Gather the installation media or download the latest release and any patches or service packs 
from the support portal at http://service.sap.com/bosap-support .

3. Decide which options you will change, and select the installation process. In most cases, you 
can accept the default values. More advanced installations require that you plan the 
installation process. The installation program prompts for the following information:

● License information (the name of the user and company associated with your SAP 
BusinessObjects BI platform license).

● Web application server configuration, including type, connection, and authentication 
details.

● Database server configuration, including type, connection, and authentication details.

● CMS system and Auditing Data Store configuration information, including type, 
connection, and authentication details.

● Folder where SAP BusinessObjects BI platform will be installed.

● Central Management Console (CMC) administrator account password and cluster key.

● CMS port number to receive incoming connections.

● Server Intelligence Agent (SIA) name.

● Server Intelligence Agent (SIA) port number for incoming connections.

● SAP Solution Manager Diagnostics (SMD) configuration.

● CA Wily Introscope Enterprise Manager configuration.

● Subversion or ClearCase version control system configuration to store configuration files.

● Lifecycle management (LCM) configuration.

● Installation type and components ("Full", "Custom / Expand", "Web Tier").

Installation Checklist
Before installing SAP BusinessObjects BI platform, review the following checklist.

Table 2: Checklist

Item Detail

Choose the installation destination folder.
● The use of Unicode characters in the desti-

nation folder is not supported.

● Ensure that the installation destination fold-
er is not the same folder in which the instal-
lation program has been extracted. (Do not 
install to the current working directory 
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Item Detail

when running the installation program from 
the current working directory.)

Verify that there is appropriate network con-
nectivity between all machines that will be part 
of your deployment.

Yes / No

Are you using your own database server?
● Have you created a database, tablespace (if 

required), and accounts for the CMS sys-
tem and Auditing Data Store databases?

● Have you made sure you can log on to the 
database from the SAP BusinessObjects BI 
platform host?

● If you are using DB2 or Sybase, have you 
verified that your database was created 
with the correct settings?

● Has the database client software been 
properly configured?

Are you using your own Web application serv-
er?

● Have you decided on which Web application 
server to use?

● Has the server been installed and config-
ured?

● Have you ensured that your existing Web 
application server has the required JDK in-
stalled?

Caution:
Installation on Microsoft Windows requires a minimum screen solution of 1024 × 
768.

Note:
The SAP BusinessObjects BI platform setup program no longer installs Client Tools. 
Client Tools can only be installed with the dedicated Client Tools installation program.

Methods of Installation
There are two different methods of running the installation program for SAP BusinessObjects BI 
platform:

Unit 2: Installation of SAP BusinessObjects Business Intelligence Platform
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● Interactive installation

An interactive wizard prompts for all information related to the installation. Use this option to 
select individual installation options from a series of screens. Interactive is the default 
installation method.

● Silent installation

Installation options are given on the command-line, which override the installation program's 
default values. The command-line can be used to give some or all installation options. When an 
installation option is not given on the command-line, the installation program uses a default 
value.

Installation options can be given in a response file rather than directly on the command-line. 
This type of silent installation uses the -r command-line parameter to read installation options 
from the response file. Use this option if you want to install multiple machines with the same 
configuration. Installation options stored in a response file can be overridden by giving them 
on the command-line.

When the -q (quiet mode) switch is used, the installation program does not prompt for any 
user input during the installation.

Interactive Installation Method

1. Log in at the console with a minimum screen resolution of 1024 × 768.

2. Locate the installation program setup.exe .

3. Double-click the setup.exe to run the program in Windows Explorer.

4. Choose a language for the setup program to use during the installation process. The language 
setting is used by the installation program to display information to you in the language of 
your choice. If you select a non-English language, the corresponding language pack is 
automatically installed on the server.

5. The installation program checks for required components. Review the results and decide 
whether to continue with the installation, or abort and correct any unmet requirements.

6. Review the recommendations made by the installation program welcome screen.

7. Review the agreement and select the I accept the License Agreement option.

8. Enter the name, company, and the product keycode you purchased. Keep the keycode safe in 
case you need to re-install the product.

9. Select an install type:

● Full

Installs all required server components onto a single machine. Use this option to create a 
single-host deployment, such as a pre-production development or test environment.

● Custom / Expand Install

Allows experienced users to select individual components. Use this option to create either 
a single host or a cluster deployment, such as a production environment.

Lesson: Installing SAP BusinessObjects Business Intelligence Platform: Server-Side Installation
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● Web Tier

The Web tier hosts Web applications and serves content to users over the Web. Use the 
Web Tier installation option to install Java Web applications onto a dedicated Java Web 
application server.

If you do not have a Web application server in place for use with SAP BusinessObjects BI 
platform, the installation program can install and configure a Tomcat Web application 
server for you. We recommend that you evaluate your requirements against information 
from your Web application server vendor to determine which supported Web application 
server would best suit your organization's needs.

If you already have a supported Web application server installed, you can deselect the 
option to install Tomcat, and only install the Java Web applications

Silent Installation Method
Every option in the installation wizard can be given from the command-line. This type of 
installation is known as a silent install. Installation options can be given directly on the command-
line as a parameter, or can be stored in a response file.

1. Giving installation options on the command-line:

Installation options can be passed directly to the setup program from the command-line as a 
parameter.

In the following example of giving the CMSPort parameter on the command-line, ellipses ([...]) 
are shown to indicate where other installation options would normally be present: 
setup.exe [...] CMSPort=6401 [...]

2. Giving installation options in a response file:

Installation options can be stored in a response file, which is a text file containing installation 
option parameters in key-value format. When using a response file to give installation options, 
the installation program is run from the command-line with the -r <RESPONSE_FILE> 
parameter, where <RESPONSE_FILE> is the name of the response file.

To create a response file, run the installation program with the -w <RESPONSE_FILE> 
parameter and select the desired installation options with the installation wizard. When the 
wizard completes installation, the program exits and the response file is created. The 
response file can then be used for future installations.

To use a response file, run the installation program with the -r <FILENAME> parameter. The 
installation program reads all installation options from the response file, and no further input 
is required.

The following table lists the switch parameters that can be given to the installation program on 
the command-line to perform a silent installation.

Table 3: Silent Installation Switch Parameters

Switch parameter Description Example

-w <FILENAME> Writes a response file to <FILE-
NAME> , containing the options se-
lected from the installation wizard.

setup.exe -w "C:\re-
sponse.ini"

Unit 2: Installation of SAP BusinessObjects Business Intelligence Platform
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Switch parameter Description Example

-r <FILENAME> Reads installation options from a 
response file named <FILENAME> .

setup.exe -r "C:\re-
sponse.ini"

-q When performing a silent installa-
tion, this switch causes the installa-
tion program to install with no con-
sole output or prompting. If a prob-
lem is encountered, the installation 
program will write a message to the 
installation log file and exit. This 
switch must always be used in 
combination with the -r <FILE-
NAME> switch parameter.

setup.exe -q -r "C:\re-
sponse.ini"

How to Create a Silent Installation File for an Installation of a BusinessObjects Business 
Intelligence Platform 4.x Server

In order to complete this demonstration, you have to use the new Training Course BOE320 
content that is in the Initialize Course folder in the Training Cloud Environment.

1. Uncompress the Training Course BOE 320 content file.

a) In the Training Cloud Environment, select the Initialize BOE320 program file from the 
Start > Initialize Course > BusinessObjects BI 4 folder.

b) In Windows Explorer , view the contents of the My Documents folder and find the Videos 
sub folder that is located within the BOE320 Training Course folder (sub folder
\BOE320\Videos ).

2. Play the DEMO1 BI 4 Silent Installation video and explain the following steps:

● Create a Silent Installation File for the BI 4 platform.

● Display the Content of the Silent Installation file.

● Complete the content of the Silent Installation file.

● Run the Silent Installation file for the BI 4 platform.

LESSON SUMMARY
You should now be able to:

● Install SAP BusinessObjects Business Intelligence platform

Lesson: Installing SAP BusinessObjects Business Intelligence Platform: Server-Side Installation
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Unit 2
Lesson 2

48
Installing SAP BusinessObjects Business 
Intelligence Platform: Client-Side Installation

LESSON OVERVIEW
Installation of the SAP BusinessObjects Business Intelligence Client Tools is performed after the 
server-side installation. The Client Tools can be installed all together with the suite, or by 
individual application depending upon the needs of the business. The Client Tools can be installed 
using an interactive or a silent installation.

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● Install SAP BusinessObjects Business Intelligence platform client tools

SAP BusinessObjects Business Intelligence Platform Client Tools Installation

● Some of the client applications that make up the Client Tools suite are also available with their 
own standalone installation program. This approach allows you to install the client application 
by itself, without having to install the Client Tools suite's Custom installation option.

● Client Tools can coexist on a system that also runs SAP BusinessObjects BI platform server 
software. When you are installing both SAP BusinessObjects BI platform servers and Client 
Tools on the same system, we recommend that you install the SAP BusinessObjects BI 
platform server components (including add-ons and language packs) before Client Tools. This 
installation order allows the Client Tools to use the same components as the server.

● No keycode is required to install Client Tools, but administrative privileges for the account 
being used are required to run the installation program.

● If a file is in use during the installation, the installation program recommends a system reboot 
when the install is complete. Although the reboot can be postponed, and you can continue to 
use the system after the installation, the system may be in an unsupported state until it is 
rebooted. We recommend that you restart the system promptly at the end of an installation 
when a reboot is recommended.

● The installation program requires a minimum screen resolution of 1,024 × 768 pixels. Using 
Microsoft Remote Desktop Connection to run the installation program is fully supported, as 
long as a minimum screen resolution of 1,024 × 768 pixels is used.
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Note:
Although the Client Tools are supported on 64-bit operating systems, the Client Tools 
themselves are only available as 32-bit applications.

When installing a database driver for Client Tools on 64-bit operating systems, ensure 
that you install the 32-bit version. A 32-bit application cannot use a 64-bit driver.

SAP BusinessObjects BI Platform Client Tools
The following desktop client applications are installed by the SAP BusinessObjects BI platform 
Client Tools installation program:

● Web Intelligence Desktop

● Business View Manager

● Report Conversion Tool

● Universe Design Tool

● Query as a Web Service Design Tool

● Information Design Tool

● Translation Management Tool

● Data Federation Administration Tool

● Widgets for SAP BusinessObjects BI platform

● Developer Components to integrate SAP BusinessObjects functionality into interactive web 
applications. These components include: SAP BusinessObjects BI platform Java SDK, Web 
Services SDK, and .NET SDK.

● Data Access and Security

Figure 11: Desktop Applications Installed by BI Platform Client Tools Installation Program

Interactive Installation Method for Client Tools

1. Log in at the console with a minimum screen resolution of 1024 × 768.

2. Locate the installation program setup.exe .

Lesson: Installing SAP BusinessObjects Business Intelligence Platform: Client-Side Installation
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3. Double-click the setup.exe to run the program in Windows Explorer.

A log file containing information on the installation process is saved to 
<CLIENT_INSTALL_DIR>\InstallData\logs\<DATE>\InstallDU<COMPONENT>.log .

4. Choose a language for the setup program to use during the installation process. The language 
setting is used by the installation program to display information to you in the language of 
your choice. If you select a non-English language, the corresponding language pack is 
automatically installed on the server.

5. The installation program checks for required components. Review the results and decide 
whether to continue with the installation, or abort and correct any unmet requirements.

6. Review the recommendations made by the installation program Welcome screen.

7. Review the agreement and select the I accept the License Agreement option.

8. Select any language for which you want language support to be installed. A language pack 
allows SAP BusinessObjects BI platform Client Tools to interact with users in a specific 
language.

9. Review and confirm the destination folder setting.

If you have already installed SAP BusinessObjects products, the Destination Folder field is not 
editable, and the path to the existing folder is displayed.

10. Review the list of features to install. Only features with a selected checkbox are installed.

11. Review the confirmation screen and start the installation when ready.

The Start Installation screen appears. Click Next to install.

Silent Installation Method for Client Tools
Every option in the installation wizard can be given from the command-line. This type of 
installation is known as a silent install. Installation options can be given directly on the command-
line as a parameter, or can be stored in a response file.

1. Giving installation options on the command-line:

Installation options can be passed directly to the setup program from the command-line as a 
parameter.

In the following example of giving the CMSPort parameter on the command-line, ellipses ([...]) 
are shown to indicate where other installation options would usually be present: setup.exe 
[...] CMSPort=6401 [...]

2. Giving installation options in a response file:

Installation options can be stored in a response file, which is a text file containing installation 
option parameters in key-value format. When using a response file to give installation options, 
the installation program is run from the command-line with the -r <RESPONSE_FILE> 
parameter, where <RESPONSE_FILE> is the name of the response file.

To create a response file, run the installation program with the -w <RESPONSE_FILE> 
parameter and select the desired installation options with the installation wizard. When the 
wizard completes, the installation program exits and the response file is created. The 
response file can then be used for future installations.

Unit 2: Installation of SAP BusinessObjects Business Intelligence Platform
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To use a response file, run the installation program with the -r <FILENAME> parameter. The 
installation program reads all installation options from the response file, and no further input 
is required.

Facilitator Producer

Say:

We will be starting a group chat activity. I will 
be pasting a series of questions into the Chat 
pod, and ask that you enter your response af-
ter each question is posted.

After you have entered your response to each 
question, review your classmates' responses.

I will select some responses to discuss as a 
group.

Do:

Display the first question on the slide provid-
ed n the Instructor Presentation deck. Display 
questions one at a time.

Explain to participant that you will be posting 
a series of questions (every 30 seconds or so) 
in the chat area.

As students to answer their questions based 
on their independent study and then to review 
their classmates answers.

Do:

Assist by pasting the pre-written questions in-
to the Chat pod.

If desired, archive the Chat pod and white-
board overlay for later reference and distribu-
tion.

Lesson: Installing SAP BusinessObjects Business Intelligence Platform: Client-Side Installation
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INTERACTIVE ELEMENT: Chat

1. Explain the difference between an interactive installation and a silent installation.

.

.

.

.

.

.

.

.

.

.

2. Which type of installation (interactive or silent) would you choose to perform for your 
company and why?

.

.

.

.

.

.

.

.

.

.

LESSON SUMMARY
You should now be able to:

● Install SAP BusinessObjects Business Intelligence platform client tools

Unit 2: Installation of SAP BusinessObjects Business Intelligence Platform
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Unit 2

53
Learning Assessment

1. Sort these steps into the correct order of the installation process flow.

Arrange these steps into the correct sequence.

0 Gather the installation media or download the latest release and any patches or service 
packs from the support portal.

0 Decide which options you will change, and select the installation process.

0 Ensure that sufficient disk space is available. Allow for both the operating system and the 
software to grow over time as patches or new components become available.

2. What is the difference between an interactive and a silent installation of the Business 
Intelligence platform?

3. Select the applications that are installed as part of the Business Intelligence Client Tools

Choose the correct answers.

X A Content Management Service

X B Universe Design Tool

X C Business Intelligence Connections

X D Data Federation Administrative Tools

X E Web Intelligence Desktop

4. When installing both SAP BusinessObjects BI platform servers and Client Tools on the same 
system, it is recommended that the SAP BusinessObjects BI platform server components 
(including add-ons and language packs) are installed after Client Tools.

Determine whether this statement is true or false.

X True

X False
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54
Learning Assessment - Answers

1. Sort these steps into the correct order of the installation process flow.

Arrange these steps into the correct sequence.

2 Gather the installation media or download the latest release and any patches or service 
packs from the support portal.

3 Decide which options you will change, and select the installation process.

1 Ensure that sufficient disk space is available. Allow for both the operating system and the 
software to grow over time as patches or new components become available.

2. What is the difference between an interactive and a silent installation of the Business 
Intelligence platform?

In an Interactive Installation an interactive wizard prompts for all information related to the 
installation. Use this option to select individual installation options from a series of screens. 
Interactive is the default installation method. In a Silent Installation, options are given on the 
command-line, which override the installation program's default values. The command-line 
can be used to give some or all installation options. When an installation option is not given on 
the command-line, the installation program uses a default value. This option is useful if you 
want to install multiple machines with the same configuration.

3. Select the applications that are installed as part of the Business Intelligence Client Tools

Choose the correct answers.

X A Content Management Service

X B Universe Design Tool

X C Business Intelligence Connections

X D Data Federation Administrative Tools

X E Web Intelligence Desktop

54 © Copyright . All rights reserved.



4. When installing both SAP BusinessObjects BI platform servers and Client Tools on the same 
system, it is recommended that the SAP BusinessObjects BI platform server components 
(including add-ons and language packs) are installed after Client Tools.

Determine whether this statement is true or false.

X True

X False

Unit 2: Learning Assessment - Answers
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UNIT 3 Server Administration and 
Management

Lesson 1

Using the Central Management Console (CMC) 58

Lesson 2

Using the Central Configuration Manager (CCM) 66
Exercise 2: Manage Nodes, Servers, and Configuration Templates 69
Exercise 3: Secure the BusinessObjects Business Intelligence Platform 4.1 79

UNIT OBJECTIVES

● Configure the Central Management Console (CMC)

● Operate the Central Configuration Manager (CCM)
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Unit 3
Lesson 1

58
Using the Central Management Console (CMC)

LESSON OVERVIEW
The Central Management Console (CMC) is a web-based tool to perform administrative tasks on 
the platform. Administrators use the CMC to manage users, content, and servers. Server 
management with the CMC includes server enablement and disablement, server cloning, server 
configuration, and node management.

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● Configure the Central Management Console (CMC)

CMC Servers Management Area

Central Management Console (CMC)
The Central Management Console (CMC) is a web-based tool to perform administrative 
tasks, including user, content, and server management. It also allows you to publish, 
organize, and configure security settings. Because the CMC is a web-based application, you 
can perform all of these administrative tasks through a web browser on any machine that 
can connect to the server.

All users can log on to the CMC to change their user preference settings. Only members of 
the Administrators group can change management settings, unless explicitly granted the 
rights to do so. Roles can also be assigned to the CMC to grant some users privileges to 
perform minor administrative tasks.

The Servers Management area of the CMC is your primary tool for server management tasks. It 
provides a list of all of the servers in your deployment. For most management and configuration 
tasks, you need to select a server in the list and choose a command from the Manage or Action 
menu.

The Navigation Tree

The navigation tree on the left side of the Servers Management area provides a number of ways to 
view the Servers list. Select items in the navigation tree to change the information displayed in 
the Details pane.

Table 4: CMC Navigation Tree

Navigation Tree Item Description

Servers List Displays a complete list of all servers in the Servers List deployment.
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Navigation Tree Item Description

Server Groups List Displays a flat list of all available server groups in the Details pane. Se-
lect this option if you want to configure a server group's settings or se-
curity.

Server Groups Lists the server groups and the servers within each server group. 
When you select a server group, its servers and server groups are dis-
played in the Details pane in a hierarchical view.

Nodes Displays a list of the nodes in your deployment. Nodes are configured 
in the CCM. You can select a node by clicking it to view or manage the 
servers on the node.

Service Categories Provides a list of the types of services that may be in your deployment. 
Service categories include:

● Connectivity Services

● Core Services

● Crystal Reports Services

● Data Federation Services

● Promotion Management Services

● Analysis Services

● Web Intelligence Services

● Dashboards Services

Server Status Displays the servers according to their current status. This is a valua-
ble tool for checking to see which of your servers are running or stop-
ped. Possible server states include the following:

● Stopped

● Starting

● Initializing

● Running

● Stopping

● Started with Errors

● Failed

● Waiting for resources
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CMC Details Pane

Depending on which options you have selected in the navigation tree, the Details pane on the right 
side of the Servers management area shows a list of servers, server groups, states, categories, or 
nodes. The following table describes the information listed for servers in the Details pane.

Table 5: CMC Details Pane

Details Pane Item Description

Server Name or Name Displays the name of the server.

State Displays the current status of the server. You can sort by server 
state using the Server Status list in the navigation tree. Possible 
server states include the following:

● Stopped

● Starting

● Initializing

● Running

● Stopping

● Started with Errors

● Failed

● Waiting for resources

Enabled Displays whether the server is enabled or disabled.

Stale If the server is marked as Stale, then it requires a restart. For exam-
ple, if you change certain server settings in the server's Properties 
screen, you may need to restart the server before the changes will 
take effect.

Kind Displays the type of server.

Host Name Displays the Host Name for the server.

Health Indicates the general health of the server.

PID Displays the unique Process ID number for the PID server.

Description Displays a description of the server. You can change this description 
in the server's Properties page.

Date Modified Displays the date that the server was last modified, or when the 
server's state was changed. This column is very useful if you want to 
check the status of recently changed servers.
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Server Enablement and Disablement

Enabling and disabling servers allows for the graceful addition and removal of a server from an 
environment. If you need to bring down a Job Server for maintenance, stopping it would halt the 
service and generate processing errors. Disabling the service would allow it to complete the 
processing of the current job and not taking any new job. At this point it can be stopped without 
impacting the environment. For example, if there is only one Web Intelligence Processing Server 
in the system, and you are in the middle of a Web Intelligence document creation when the 
server is stopped, you will get errors when you attempt to perform further action (such as 
refresh). However, if the server is disabled instead of stopped, you can continue working on your 
current document; only when you attempt to create another new document you will receive an 
error.

Enabling a server is also a security feature. Without this feature, anyone with connectivity to the 
system can run as a server that claims to be a particular server type (e.g. Processing Server or 
File Repository Server), and then incoming request can be routed to this server. The person 
running this server can then obtain a copy of the file or perform undesired actions to the system.

When you disable an SAP BusinessObjects BI platform server, you prevent it from receiving and 
responding to new SAP BusinessObjects BI platform requests, but you do not actually stop the 
server process. Disabling the server is useful when you want to allow the server to finish 
processing all of its current requests before you stop it completely. For example, you may want to 
stop a Job Server before rebooting the machine it is running on. However, you want to allow the 
server to fulfill any outstanding report requests that are in its queue. First, you disable the Job 
Server so it cannot accept any additional requests. Next, go to the Central Management Console 
to monitor when the server completes the jobs it has in progress. (From the Servers management 
area, right-click the server and select Metrics.) Then, once it has finished processing current 
requests, you can safely stop the server.

Note:

● The CMS must be running in order for you to enable or disable other servers.

● A CMS cannot be disabled by an administrator. You should never see a disabled 
status fo the CMS server on any environment. If the CMS is disabled, it will corrupt 
the health and the behavior of all servers running on the platform (production and 
system data are not affected).

Server Cloning
If you want to add a new server instance to your deployment, you can clone an existing server. 
The cloned server retains the configuration settings of the original server. Cloning a server can be 
particularly useful if you are expanding your deployment and want to create new server instances 
that use almost all of the same server configuration settings as an existing server.

Cloning also simplifies the process of copying servers between nodes. If you want to copy an 
existing CMS to another node, you can clone it to the new node. The cloned CMS appears on the 
new node and retains all of the configuration settings of the original CMS.
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Hint:
There are some considerations to keep in mind when cloning servers. You may not 
want all settings to be cloned, so it's good practice to check the cloned server to 
make sure that it meets your needs. For example, if you clone a CMS to the same 
machine, make sure that you change the port number settings that were copied 
from the original CMS to the cloned CMS.

Note:

● Before you clone servers, make sure that all machines in your deployment have the 
same version of SAP BusinessObjects BI platform (and any updates, if applicable).

● You can clone servers from any machine. However, you can only clone servers to 
machines where the required binaries for the server are installed.

● When you clone a server, it does not necessarily mean that the new server will use 
the same OS credentials. The user account is controlled by the Server Intelligence 
Agent that the server is running under.

Node Management

Explain that SIA is a locally run service managed by the operating system. The task of Server 
Intelligence Agent (SIA) is to start, stop, and monitor locally run SAP BusinessObjects Enteprise 
servers. When one of the managed servers goes down unexpectedly, the SIA will restart the 
server immediately. When you issue a command in the CMC to stop a server, the SIA will receive 
the request from the CMC, and the SIA will stop the server.

When you create a SIA, you create a new node. A node is a collection of SAP BusinessObjects BI 
platform servers which run on the same host and are managed by a single SIA . You can add 
servers to the node and you can have more than one node on the same machine.

The SIA continuously monitors server status information, which is stored in the CMS databases. 
When you change a server's settings or add a new server in the CMC, the CMS notifies the SIA 
and the SIA performs the jobs accordingly.

Nodes are initially created by installation setup programs during installation, but you can also 
add additional nodes. Instruct learners that they can either perform a custom installation with 
the installation setup program, or they can create a new node from the CCM.

A node is a group of SAP BusinessObjects BI platform servers that run on the same host. All of 
the servers on a node run under the same user account. One machine can contain many nodes, 
so you can run processes under different user accounts.

One Server Intelligence Agent (SIA) manages and monitors all of the servers on a node, ensuring 
they operate properly.

The following steps explain the interaction of platform components when the SIA is started.
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Figure 12: Start the Server Intelligence Agent

1. The user starts the SIA manually in the Central Configuration Manger (CCM).

Note:
An SIA can be configured to start automatically with the operating system, or it 
can be started manually with the CCM.

2. The SIA looks in its cache to locate a Central Management Server (CMS). If the SIA is 
configured to start a local CMS, and the CMS is not running, the SIA starts the CMS and 
connects. If the SIA is configured to use a running CMS (local or remote), it attempts to 
connect to the first CMS in its cache. If the CMS is not currently available, it attempts to 
connect to the next CMS in its cache. If no cached CMS is available, the SIA waits for one to 
become available. The CMS then confirms the SIA's identity to ensure that it is valid.

3. Once the SIA has successfully connected to a CMS, it requests a list of servers to manage. 
Note: A SIA does not store information about the servers it manages. The configuration 
information that dictates which server is managed by a SIA is stored in the CMS system 
database and is retrieved from the CMS by the SIA when it starts.

4. The CMS queries the CMS system database for a list of servers managed by the SIA. The 
configuration for each server is also retrieved.

5. The CMS returns the list of servers to manage, and their configuration, to the SIA.

6. For each server configured to start automatically, the SIA starts it with the appropriate 
configuration and monitors its state. Each server started by the SIA is configured to use the 
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same CMS used by the SIA. Servers that are not configured to start automatically with the SIA 
will not start.

Server Settings Configuration
You can change server settings though the Central Management Console (CMC) in two ways.

● On the Properties screen for the server.

● On the Edit Common Services screen for the server.

Note:
Not all changes occur immediately. If a setting cannot change immediately, the 
Properties and Edit Common Services screens display both the current setting (in red 
text) and the desired setting. When you return to the Servers management area, the 
server will be marked as Stale. When you restart the server, it will use the desired 
settings and the Stale flag is removed from the server.

Facilitator Producer

Say:

We have just been talking about the Central 
Management Console. Let me pop up a poll 
question for you to see what we might need to 
cover further in this lesson.

Do:

Using your Instructor Handbook, enter the 
pre-written poll questions into the Adobe 
Connect environment before class.

Display the poll question for the class and in-
vite participation.

When the voting is completed, display the re-
sults for the class and comment on them. 
Provide further detail on the lesson content 
that students would like to hear more about.

When done, minimize the Poll pod so that the 
results can be popped up again later in the 
class, if desired.

Do:

Assist the instructor by monitoring the ques-
tions n the Chat pod.
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INTERACTIVE ELEMENT: POLL

Question Answers

Which part of this lesson on the Central Man-
agement Console would you like to learn more 
about?

a. Server Cloning

b. Node Management

c. Server Configuration

d. Other -- Please specify in the Chat pod.

How to Configure the BusinessObjects Business Intelligence Platform 4.1

In order to perfrom this demonstration, you must use the Training Course BOE320 content 
that is in the Initialize Course folder in the Training Cloud Environment.

1. Go to the Videos subfolder in the Training Cloud Environment.

2. Play the DEMO2 System Configuration Wizard video file, and explain the following 
steps:

a) Stop and disable the WACS server.

b) Configure the JAVA Heap Max Memory Size for the JAVA Application server.

c) Configure the BI4 platform with the System Configuration Wizard (post-installation steps).

LESSON SUMMARY
You should now be able to:

● Configure the Central Management Console (CMC)
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Unit 3
Lesson 2

65
Using the Central Configuration Manager (CCM)

LESSON OVERVIEW
The Central Configuration Manager (CCM) is a platform tool that troubleshoots servers and 
manages nodes. The CCM allows administrators to create and configure Server Intelligence 
Agent (SIA) nodes, and to start and stop Windows servers. The CCM also makes managing and 
rebuilding bootstrap files simple and easy.

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● Operate the Central Configuration Manager (CCM)

Central Configuration Manager (CCM)

Central Configuration Manager (CCM)
The Central Configuration Manager (CCM) is a server troubleshooting and node 
management tool provided in two forms:

● In a Microsoft Windows environment, the CCM allows you to manage local and remote 
servers through its graphical user interface (GUI) or from a command line.

● In a Unix environment, the CCM shell script (ccm.sh) allows you to manage servers from 
the command-line.

The CCM allows you to create and configure Server Intelligence Agent (SIA) nodes and start 
or stop your web application server. On Windows, it also allows you to configure network 
parameters, such as Secure Socket Layer (SSL) encryption. These parameters apply to all 
servers within a node.

Note:
Most server management tasks are handled through the CMC, not through the CCM. 
The CCM is used for troubleshooting and node configuration.
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Figure 13: Central Configuration Manager Window

How to Start, Stop, and Restart a Windows Server with CCM

1. In the CCM, click the Manage Servers button on the toolbar.

2. When prompted, log on to your CMS with an administrative account.

3. In the Manage Servers dialog box, select the server that you want to start, stop, or restart. The 
CMS server should not be stopped.

4. Click Start , Stop , Restart , or Force Terminate .

5. Click Close to return to the CCM.

How to Manage Bootstrap Files During the SIA Startup

1. In the CCM, create a new SIA.

2. Observe the creation of the new bootstrap files in D:\Program Files (x86)\SAP 
BusinessObjects\SAP BusinessObjects Enterprise XI 4.0\win64_x64

3. In the CCM, select the newly created SIA and start the SIA.

4. Click the Properties button and click the Startup tab.

5. Stop the newly created SIA.

6. Move .bootstrap and .original files from their original location to a temporary folder.

7. Start the SIA and observe if it can be started successfully.
Bootstrap.backup file is used here during the SIA startup.

8. Navigate to D:\Program Files (x86)\SAP BusinessObjects\SAP 
BusinessObjects Enterprise XI 4.0\win64_x64 and investigate if the bootstrap files 
are being created.
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9. Stop the running SIA.

10. Go to D:\Program Files (x86)\SAP BusinessObjects\SAP BusinessObjects 
Enterprise XI 4.0\win64_x64 and move all the corresponding bootstrap files to the 
temporary directory.

11. Start the SIA and observe if it can be started successfully.
System can create brand new .bootstrap and .backup files. However, these files do not have 
the right information to communicate with the proper CMS. Thus, the SIA is unusable and will 
go down after about a minute.

12. Copy corresponding bootstrap files back from the temporary directory to D:\Program 
Files (x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 
4.0\win32_x86 .

13. Start the SIA.
The SIA needs a bootstrap file to connect to the CMS and to initialize itself properly at startup.

How to Rebuild Bootstrap Files When They Are Lost
The CCM can rebuild necessary bootstrap files for a given SIA even if the bootstrap files are lost.

1. Create a temporary directory in the file system to store the backup bootstrap files.

2. In the CCM, stop the running SIA.

3. Copy all the corresponding bootstrap files to the temporary directory. Remove all the 
bootstrap files from their original location.

4. Start the SIA.

5. Go to the CCM and click the Add Node button.

● Provide the same name to this SIA as the name of the SIA in step 2.

● Enter the SIA Port number.

● Select the option Add node with no servers .

● Select the option Use existing running CMS and

● Specify the CMS System Database Data Source Name (for example, BOE4x).

● If prompted, enter the cluster key. Refer to the Instructor Guide to find the value.

6. Click Next and Finish .

7. Navigate to the directory to see the bootstrap files.

8. Start the SIA.
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Unit 3
Exercise 2

67
Manage Nodes, Servers, and Configuration 
Templates

Business Example

As the system administrator, you are required to create a new node and change the user 
credentials for this node. In addition, you are asked to clone a server to this node and work with a 
configuration template.

Create a Node
Create a new SIA (node) on your SAP BusinessObjects Business Intelligence Platform.

Note:
This task is performed on the server side where administrative access to the Central 
Configuration Manager (CCM) is required. Remote desktop to the server to perform 
this task.

This part of the exercise needs to be performed on the server side where administrative access 
to the Central Configuration Manager (CCM) is required. Provide instructions to leaners on how 
to remote access the server.

1. Launch the Central Configuration Manager (CCM).

2. Add a new node.

3. Enter the new node name and Server Intelligence Agent port using the following information:

Field Name Value

Node Name Train##Node

SIA Port <assigned port number>

4. Select a CMS.

5. Specify the CMS system database configuration.

6. Enter the CMS logon information.

Field Name Value

System <assigned hostname>
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Field Name Value

User Name administrator

Password <assigned password>

Authentication Enterprise

The CCM creates a node. You can now use the CCM to manage this new node.

Changing the User Credentials for a Node
Change the user account under which the newly created SIA runs. For example, change the use 
account from the system account to administrator account.

1. Select the newly created node (Server Intelligence Agent).

2. Open the Properties page of this Server Intelligence Agent.

3. Change the user account from the system account to OS administrator account.

Field Name Value

User Name boadmin

Password BOTraining

4. Start the Server Intelligence Agent.

The SIA and the server processes log on to the local machine with the new user account.

Clone a Server
Clone the event server from an existing node to the newly created node.

1. Launch the CMC and log on with the following details:

Field Name Value

System <hostname>:6400

User name Administrator

Password admin41

2. Navigate to the Servers management area of the CMC

3. Select the Event server and clone this server to the new node.

4. Check the cloned server on the new node.

The new server appears in the Servers management area of the CMC.

Work with a Configuration Template
Change some settings on one event server in the first node and set it as the configuration 
template. Apply this configuration template to the event server on the second node. Verify that 
the settings of both event servers match.
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1. Select the event server on the origin node that hosts services whose configuration template 
you want to set.

2. Configure the service settings that you want to use in the template.

3. Set the settings as the configuration template.

4. Set the Event Server on the newly created node to use the configuration template.

5. Verify that the new settings are in effect.

The configuration settings on both event servers are consistent.
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Unit 3
Solution 2

70
Manage Nodes, Servers, and Configuration 
Templates

Business Example

As the system administrator, you are required to create a new node and change the user 
credentials for this node. In addition, you are asked to clone a server to this node and work with a 
configuration template.

Create a Node
Create a new SIA (node) on your SAP BusinessObjects Business Intelligence Platform.

Note:
This task is performed on the server side where administrative access to the Central 
Configuration Manager (CCM) is required. Remote desktop to the server to perform 
this task.

This part of the exercise needs to be performed on the server side where administrative access 
to the Central Configuration Manager (CCM) is required. Provide instructions to leaners on how 
to remote access the server.

1. Launch the Central Configuration Manager (CCM).
a) Click Start → Programs → SAP Business Intelligence → SAP BusinessObjects BI platform 

4 → SAP BusinessObjects BI platform → Central Configuration Manager .

2. Add a new node.
a) In the Central Configuration Manager (CCM), on the toolbar, click Add Node .

The Add Node Wizard page appears.

b) Click the Next button.

3. Enter the new node name and Server Intelligence Agent port using the following information:

Field Name Value

Node Name Train##Node

SIA Port <assigned port number>

a) Enter the Node Name and SIA Port number for the new Server Intelligence Agent (SIA).
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b) Select the Add node with no servers option.

c) Click the Next button.

4. Select a CMS.
a) Select the Use existing running CMS option.

b) Click the Next button.

5. Specify the CMS system database configuration.
a) Click the Specify... . button.

b) Select the SQL Anywhere (ODBC) option.

c) Click the OK button.
A window appears that asks you to select the data source.

d) Click the Machine Data Source tab.

e) Select the BI4_CMS_DSN Data Source.

f) Connect to to SQL Anywhere using the UserID: dba and the password Admin41 .

g) Click the OK button.

Note:
If you are prompted to enter the cluster key, enter CMSKey .

h) Click the OK button.

i) Click the Next button.

6. Enter the CMS logon information.

Field Name Value

System <assigned hostname>

User Name administrator

Password <assigned password>

Authentication Enterprise

a) Enter the logon information and click the Next button.
A confirmation box appears.

b) Review the confirmation page, and click theFinish button.

Hint:
If any errors occur, review the log file.

The CCM creates a node. You can now use the CCM to manage this new node.
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Changing the User Credentials for a Node
Change the user account under which the newly created SIA runs. For example, change the use 
account from the system account to administrator account.

1. Select the newly created node (Server Intelligence Agent).
a) In the CCM, navigate to the newly created Server Intelligence Agent (Train##Node) .

2. Open the Properties page of this Server Intelligence Agent.
a) Right-click Server Intelligence Agent (Train##Node) and select the Properties option.

3. Change the user account from the system account to OS administrator account.

Field Name Value

User Name boadmin

Password BOTraining

a) In the Log On As area, deselect the System Account check box.

b) Enter the user name and password information.

Note:
All servers managed by a Server Intelligence Agent run under the same 
account.

c) Click the OK button.

4. Start the Server Intelligence Agent.
a) Right-click Server Intelligence Agent (Train##Node) and select the Start menu option.

The SIA and the server processes log on to the local machine with the new user account.

Clone a Server
Clone the event server from an existing node to the newly created node.

1. Launch the CMC and log on with the following details:

Field Name Value

System <hostname>:6400

User name Administrator

Password admin41

a) Click Start → Programs → SAP BusinessObjects BI platform 4 → SAP BusinessObjects BI 
platform → Central Management Console .

b) Log on with your username and password.

2. Navigate to the Servers management area of the CMC
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a) In the CMC Home page, click the Servers option.

b) Click the + sign in front of Nodes .
You will see you newly created node is listed there, but it has no server.

3. Select the Event server and clone this server to the new node.
a) In the Servers page, click the Servers List option.

b) Right-click wdflbmt5072.EventServer and select theClone Server menu option.
The Clone Server dialog box appears.

c) On the Clone to Node list, choose the Train##Node option.

Note:
This is where you want to add the cloned server.

d) Click the OK button.

4. Check the cloned server on the new node.
a) In the Servers page, click the + sign in front of Nodes .

b) Select the Train##Node node option.

Note:
The new server appears in the Servers management area of the CMC.

Port number settings are also cloned. In many cases, such as cloning a CMS, 
you will want to change the port number to avoid port conflicts between the 
original server and its clone.

The new server appears in the Servers management area of the CMC.

Work with a Configuration Template
Change some settings on one event server in the first node and set it as the configuration 
template. Apply this configuration template to the event server on the second node. Verify that 
the settings of both event servers match.

1. Select the event server on the origin node that hosts services whose configuration template 
you want to set.
a) In the Servers page, click the Nodes option.

b) Navigate to the event server that is on the origin node wdflbmt5072.

c) Right-click wdflbmt5072.EventServer and select theProperties menu option.
The Properties dialog box appears.

2. Configure the service settings that you want to use in the template.
a) Under the Event Service area, change the Event Poll Interval (seconds) to 5 .

b) Under the Event Service area, change the Cleanup Interval (minutes) to 30 .
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3. Set the settings as the configuration template.
a) Under the Event Service area, select the Set Configuration Template checkbox.

Note:
The configuration template for the service type that you selected is defined 
according to the settings of the current server. Other servers of the same type 
hosting the same services will be automatically and immediately reconfigured 
to match the configuration template if they have the Use Configuration 
Template option enabled in their properties. If you do not explicitly define the 
settings for the configuration template, the service's default settings are used.

b) Click the Save & Close button.

Note:
If the server requires you to restart it in order for the new settings to take 
effect, it will show up as Stale in the servers list.

c) Right-click the Event Server and click the Restart Server menu option.

4. Set the Event Server on the newly created node to use the configuration template.
a) In the Servers page, click the Nodes option.

b) Navigate to the event server that is on your newly created node Train##Node .

c) Right-click wdflbmt5072.EventServer and select the Properties menu option.
The Properties dialog box appears.

d) Under the Event Service area, select the Use Configuration Template checkbox.

Note:
If you do not explicitly define the settings for the configuration template, the 
service's default settings are used.

e) Click the Save & Close button.

Note:
If the server requires you to restart it in order for the new settings to take 
effect, it will show up as Stale in the servers list.

f) Right-click the Event Server and click the Restart Server menu option.

5. Verify that the new settings are in effect.
a) Double-click the Event Server in your new node and check the new settings.
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b) The value in Event Poll Interval (seconds) should be 5.

c) The value in Cleanup Interval (minutes) should be 30.

The configuration settings on both event servers are consistent.
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Unit 3
Exercise 3

75
Secure the BusinessObjects Business 
Intelligence Platform 4.1

Business Example

As the system administrator, you must secure the BusinessObjects Business Intelligence 
Platform 4.1 (also known as "platform") to have 100% quality of service. You will identify all major 
Single Point of Failure to secure the application server platform.

Back up the BusinessObjects Business Intelligence 4.1 Platform Configuration

1. Connect to the Operating System (OS) desktop on your server using the credentials in the 
table.

BusinessObjects Business In-
telligence Platform 4.1 SP2 
System

Windows User Account Password

WDFLBMT5072 boadmin BOTraining

WDFLBMT5073 boadmin BOTraining

You are now connected to the Operating desktop of your Business Intelligence 4.1 Platform.

2. Back up the platform server configuration in the My Documents folder with the following 
name: ServerConfiguration.BIAR.

3. Check that the backup file was created.
You have backed up the platform configuration. This backup can also be restored at any time 
on this host machine for recovery.

Backup Bootstrap Files

1. Back up the platform Bootstrap files in the My Documents folder.

Securing the Platform

1. In Windows Task Manager , select the SIA.exe process. Note the PID in the table here, and 
then click the End Process button. What happened to the process and why?

SIA PID

'

2. In the Windows Task Manager , select the Central Management Server process. Note the PID 
in the table here, and click the End Process button. What happened to this process and why?
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CMS PID

'

3. Manage the bootstrap files on your platform:
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Unit 3
Solution 3

77
Secure the BusinessObjects Business 
Intelligence Platform 4.1

Business Example

As the system administrator, you must secure the BusinessObjects Business Intelligence 
Platform 4.1 (also known as "platform") to have 100% quality of service. You will identify all major 
Single Point of Failure to secure the application server platform.

Back up the BusinessObjects Business Intelligence 4.1 Platform Configuration

1. Connect to the Operating System (OS) desktop on your server using the credentials in the 
table.
a) Run the Remote Desktop Connection program from the Start > Programs menu on your 

Training Cloud Environment.

b) Enter the following credentials:

BusinessObjects Business In-
telligence Platform 4.1 SP2 
System

Windows User Account Password

WDFLBMT5072 boadmin BOTraining

WDFLBMT5073 boadmin BOTraining

You are now connected to the Operating desktop of your Business Intelligence 4.1 Platform.

2. Back up the platform server configuration in the My Documents folder with the following 
name: ServerConfiguration.BIAR.
a) Run the Central Configuration Management (CCM) program from the Start > Programs 

menu of your Operating System desktop.

b) Once the CCM is displayed, click the Backup Server Configuration button. The Server 
Configuration Backup Wizard starts.

c) Click the Next button to go to the next step.

d) Select the Use existing running CMS option. Then click the Next button.

e) Enter the credentials found in the table. Then click the Next button.
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BusinessObjects 
Business Intelli-
gence Platform 4.1 
SP2 System

User Name Password Authentication

WDFLBMT5072 Administrator admin41 Enterprise

WDFLBMT5073 Administrator admin41 Enterprise

f) Select the My Documents folder to store the BIAR file and enter the name of the BIAR file: 
ServerConfiguration.BIAR . Click the Next buton. The Confirmation screen displays.

g) Click the Finish button to confirm the server configuration backup.

3. Check that the backup file was created.
You have backed up the platform configuration. This backup can also be restored at any time 
on this host machine for recovery.

Backup Bootstrap Files

1. Back up the platform Bootstrap files in the My Documents folder.
a) In Windows Explorer, go to the D:\Program Files (x86)\SAP BusinessObjects

\SAP BusinessObjects Enterprise XI 4.0\win64_x64 folder.

b) Select all of the bootstrap files with the prefix "_boe".

c) Copy these bootstrap files to your My Documents folder.
You have now backed up the platform bootstrap files.

Securing the Platform

1. In Windows Task Manager , select the SIA.exe process. Note the PID in the table here, and 
then click the End Process button. What happened to the process and why?

SIA PID

'

a) In Windows Task Manager , select the Server Intelligent Agent (SIA) process 
and click the End Process button.
You will notice that the Process ID of the SIA changes instantly when you end the process. 
The quality of service of this process is guaranteed by default on this operating system.

b) From the Start menu, run Windows Services .

c) Run the services.msc panel.

d) In the list of Windows services, select the Server Intelligence Agent (WDFLBMTxxxx) and 
then double-click it.
The SIA process runs as a Windows service, so it is protected by the Windows operating 
system, and it will be automatically recycled on any process failure. Quality of service is 
guaranteed.
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2. In the Windows Task Manager , select the Central Management Server process. Note the PID 
in the table here, and click the End Process button. What happened to this process and why?

CMS PID

'

a) In Windows Task Manager , select the Central Management Server process, and click the 
End Process button.
You will notice that the CMS process is automatically restarted after a couple of seconds. 
This process is not a Windows service, but it is monitored by the SIA process. On any 
process failure for a Business Intelligence 4.1 platform server, a new process will be 
automatically restarted. Quality of service is guaranteed.

3. Manage the bootstrap files on your platform:
a) Stop the SIA agent with the Central Configuration Manager.

b) When the SIA agent is stopped, remove all of the bootstrap files from D:\Program Files 
(x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 
4.0\win64_x64 folder.

c) Start the SIA agent with the Central Configuration Manager. What happened when you did 
this?
The SIA process tries to re-create some empty files, so the platform application servers 
cannot be started. The next step is to restore these files in this folder so that the platform 
will restart correctly.

d) Restore all bootstrap files from the My Documents folder to D:\Program Files 
(x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 
4.0\win64_x64 folder.

If prompted, select the Copy and Replace option.

e) Restart the SIA agent with the Central Configuration Manager. What happened when you 
did this?
The platform application servers are starting correctly.

f) Log off from the Operating System desktop.

Lesson: Using the Central Configuration Manager (CCM)
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LESSON SUMMARY
You should now be able to:

● Operate the Central Configuration Manager (CCM)

Unit 3: Server Administration and Management
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81
Learning Assessment

1. Match the CMC navigation tree options with their correct descriptions.

Match the item in the first column to the corresponding item in the second column.

Servers List

Server Groups List

Server Groups

Nodes

Service Categories

Server Status

Displays a flat list of all availa-
ble server groups in the Details 
pane.

Lists the server groups and the 
servers within each server 
group.

Displays the servers according 
to their current status.

Provides a list of the types of 
services that may be in your 
deployment.

Displays a complete list of all 
servers in the Servers List de-
ployment.

Displays a list of the nodes in 
your deployment.

2. Which is an easy way to add a new server instance to your deployment?

Choose the correct answer.

X A Add New button

X B Manually

X C Cloning

X D Mirroring

3. Which server management component is Windows based?
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4. Why would you disable a server?
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Unit 3

83
Learning Assessment - Answers

1. Match the CMC navigation tree options with their correct descriptions.

Match the item in the first column to the corresponding item in the second column.

Servers List

Server Groups List

Server Groups

Nodes

Service Categories

Server Status

Displays a complete list of all 
servers in the Servers List de-
ployment.

Displays a flat list of all availa-
ble server groups in the Details 
pane.

Lists the server groups and the 
servers within each server 
group.

Displays a list of the nodes in 
your deployment.

Provides a list of the types of 
services that may be in your 
deployment.

Displays the servers according 
to their current status.

2. Which is an easy way to add a new server instance to your deployment?

Choose the correct answer.

X A Add New button

X B Manually

X C Cloning

X D Mirroring

3. Which server management component is Windows based?

The Windows-based server management component is the CCM.
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4. Why would you disable a server?

You would disable a server when want to prevent it from receiving and responding to new 
requests, but you do not want to stop the server process. This is useful when you want to 
allow a server to finish processing all of its current requests before you stop it completely.
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86
Configuring Web Application Servers

LESSON OVERVIEW
A Web Application Container Server (WACS) provides the platform for hosting SAP 
BusinessObjects Business Intelligence Web applications. A WACS simplifies system 
administration, is easy to install, maintain, and configure, and all hosted applications are 
predeployed, so no additional installation steps are necessary. The WACS administrative 
interface is consistent with other SAP BusinessObjects BI platform servers, so it effortlessly 
navigable for system administrators.

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● Configure Web Application Container servers

Web Application Container Server (WACS)

Web application server
A Web application server acts as the translation layer between a Web browser or rich 
application, and SAP BusinessObjects BI platform. The following Web application servers are 
supported:

● JBoss

● Oracle Application Server

● Sun Java System Application Server (Unix only)

● SAP NetWeaver AS Java

● Tomcat

● WebLogic

● WebSphere

Note:
SAP BusinessObjects BI platform requires a Java Web application server to 
process the server-side scripts that make up Web applications. If you do not 
have a Web application server in place for use with SAP BusinessObjects BI 
platform, the installation program can install and configure a Tomcat Web 
application server (version 6 or 7) for you.
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Web Application Container Server (WACS)
Web Application Container Servers (WACS) provide a platform for hosting SAP 
BusinessObjects BI platform Web applications. For example, a Central Management Console 
(CMC) can be hosted on a WACS.

WACS simplifies system administration by removing several workflows that were previously 
required for configuring application servers and deploying Web applications, and by 
providing a simplified, consistent administrative interface.

Using WACS to host the CMC provides a number of advantages:

● WACS requires a minimum effort to install, maintain, and configure.

● All hosted applications are predeployed on WACS, so that no additional manual steps are 
required.

● WACS is supported by SAP.

● WACS removes the need for Java application server administration and maintenance 
skills.

● WACS provides an administrative interface that is consistent with other SAP 
BusinessObjects BI platform servers.

Hint:
Do you need WACS?

Install the WACS when installing the platform if:

● You are an advanced Java Web application server administrator with 
advanced administration needs.

● You use a supported Java Web application server to host SAP 
BusinessObjects BI platform Web applications.

● You are using a supported Windows operating system to host SAP 
BusinessObjects BI platform, and prefer a simple Web application server 
installation process.

● You do not have the resources to administer a Java Web application server, 
you can install the WACS when installing the platform.
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Note:
There are some limitations to using WACS instead of a dedicated Java Web 
applications server:

● WACS is only available on supported Windows operating systems.

● You need a single web application server for test or preparation 
environments, but not for a production system.

● Custom Web applications cannot be deployed to WACS, as it only supports 
the Web applications installed with SAP BusinessObjects BI platform.

● WACS cannot be used with an Apache load balancer.

Additional Web Application Configuration Components
Web Application servers

It is possible to use a dedicated Web application server in addition to WACS. This 
configuration allows your dedicated Web application server to host custom Web 
applications, while the CMC and other SAP BusinessObjects BI platform Web applications 
are hosted by WACS.

Web servers
You can use a dedicated Web server to host static Web content, such as images, HTML, or 
multimedia files. This is known as a split deployment. Split deployments increase the 
performance of the Web application server as it no longer needs to serve static content, and 
returns dynamic content only when required.

wDeploy tool
The wDeploy tool is able to separate static dynamic content for deployment to separate Web 
and Web application servers. For some Web application servers, the SAP BusinessObjects BI 
platform installation program will not deploy Web applications for them. These Web 
application servers must have Web applications deployed manually through the Web 
application server administrative console, or on the command-line with the wDeploy tool 
included with BusinessObjects BI platform.

There are two different ways to deploy Web applications using the wDeploy tool:

1. Standalone mode

All Web application resources are deployed together on a Web application server that 
serves both dynamic and static content.

2. Split mode

The application's dynamic and static resources are separated. Static content is deployed 
to a Web server, and dynamic content is deployed to a Web application server.

The Web and Web application servers can run on the same machine, or on separate 
machines across a network.
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WACS Metrics
The following table describes the server metrics that appear on the Metrics screen for Web 
Application Container Servers.

Table 6: WACS Metrics

Metric Description

List of Running WACS Connectors A list of all running connectors on the server. If 
you do not see all of the connectors (HTTP, 
HTTPS and HTTP through proxy), it indicates 
that the connector is not enabled, or that it 
failed during startup.

WACS Connector(s) Failed at Startup Shows if there are any failed connectors. If 
true, at least one connector failed to start. If 
false, all connectors are running. Do not run a 
server when one or more connectors has failed 
to start. Troubleshoot the server to ensure that 
all connectors start properly.

WACS Properties

Table 7: WACS General Server Properties

Property Description Default Value

Service Startup Timeout 
(seconds)

How long the WACS will wait for its 
hosted services to start before it 
times out. If the timeout passes, the 
WACS will not provide services that 
have not started yet. On a slower 
machine, you can consider specify-
ing a larger value. If you specify a 
value that is too small, and the 
WACS does not start before timing 
out, restore the default settings of 
the WACS through the Central Con-
figuration Manager (CCM).

The default value is 600 
seconds.
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Property Description Default Value

Authentication Type The authentication type that is used 
to authenticate users logging on to 
SAP BusinessObjects BI Launchpad. 
Accepted values are:

● AD Kerberos

● AD Kerberos SSO

● Enterprise

● LDAP

The default value is Enter-
prise.

Default AD Domain The default Active Directory domain 
is used so that users do not have to 
supply a domain when they log in. 
For example, if the default domain is 
set to “mydomain” and a user logs 
on with the username “user”, the Ac-
tive Directory logon authority tries to 
authenticate “user@mydomain. 
com”.

By default, this value is 
empty.

Service Principal Name A service principal name (SPN) is 
used by clients to uniquely identify 
an instance of a service. The Ker-
beros authentication service uses an 
SPN to authenticate a service.

By default, this value is 
empty.

Keytab File The full path to a keytab file. A key-
tab file allows Kerberos Filters to be 
configured without exposing the 
password of the user account on the 
Web application machine.

By default, this value is 
empty.

Other WACS Properties

Table 8: WACS Properties: Other Configuration Properties

HTTP Configuration 
Property

Description Default Value

Bind to All IP Addresses Whether to bind to all network interfaces or 
not. If your server has more than one NIC, and 
you want to bind to a specific network inter-
face, uncheck this property.

The default value is 
TRUE.

Bind to Hostname or IP 
Address

Specifies the network interface (IP address or 
host name) on which HTTP service is provid-
ed. You can only specify a value if you un-
check Bind to All IP Addresses.

The default value is lo-
calhost.
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HTTP Configuration 
Property

Description Default Value

HTTP Port The port on which HTTP service is provided. The default value is 
6405. The range of al-
lowed values is 1 to 
65535.

Maximum HTTP Header 
Size

The maximum allowed size, in bytes, of the 
request and response HTTP header.

The default value is 
32768.

HTTP through Proxy 
Property

Description Default Value

Enable HTTP through 
Proxy

Whether to enable the HTTP through Proxy 
connector on the WACS. This option is typi-
cally checked in deployments with a reverse 
proxy.

The default value is 
FALSE.

Bind to All IP Addresses Whether to bind the HTTP through proxy port 
to all network interfaces or not.

The default value is 
TRUE.

Bind to Hostname or IP 
Address

Specifies the network interface (IP address or 
host name) on which HTTP through Proxy 
service is provided. You can only specify a 
value if you uncheck Bind to All IP Addresses.

The default value is lo-
calhost.

HTTP Port The port on which HTTP service in a reverse 
proxy deployment is provided. You can only 
specify a value if you check Enable HTTP 
through Proxy.

The default value is 
6406. The range of al-
lowed values is 1 to 
65535.

Proxy Hostname The IPv4 address, IPv6 address, hostname, or 
fully qualified domain name of your proxy 
server. You can only specify a value if you 
check Enable HTTP through Proxy.

By default, this value 
is empty.

Proxy Port The port of your forward or reverse proxy 
server. You can only specify a value if you 
check Enable HTTP through Proxy.

By default, this value 
is 0. The range of al-
lowed values is 1 to 
65535.

Maximum HTTP Header 
Size

The maximum allowed size, in bytes, of the 
request and response HTTP header.

The default value is 
32768.

HTTPS Configuration 
Property

Description Default Value

Enable HTTPS Whether HTTPS/SSL communication is ena-
bled or not.

The default value is 
FALSE.
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HTTPS Configuration 
Property

Description Default Value

Bind to Hostname or IP 
Address

Specifies the network interface (IP address or 
host name) on which HTTPS service is pro-
vided. You can only specify a value if you 
check Enable HTTPS.

The default value is lo-
calhost.

HTTPS Port The port on which HTTPS service is provided. 
You can only specify a value if you check Ena-
ble HTTPS.

The default value is 
443. The range of al-
lowed values is 1 to 
65535.

Proxy Hostname The IPv4 address, IPv6 address, hostname, or 
fully qualified domain name of your proxy 
server. You can only specify a value if you 
check Enable HTTPS.

By default, this value 
is empty.

Proxy Port The port of your forward or reverse proxy 
server. You can only specify a value if you 
check Enable HTTPS.

By default, this value 
is 0. The allowed 
range of values is 1 to 
65535.

Protocol The encryption protocol to use. You can only 
specify a value if you check Enable HTTPS.

The default value is 
TLS. Allowed values 
are TLS or SSL.

Certificate Store Type The type of certificate store that contains 
your certificates and private keys. In most 
cases, this type will be PCKS12. You can only 
specify a value if you check Enable HTTPS.

The default value is 
PKCS12. Allowed val-
ues are PKCS12 or 
JKS.

Certificate Store File Lo-
cation

The full path to the certificate file. You can on-
ly specify a value if you check Enable HTTPS.

By default, this value 
is empty.

Private Key Access 
Password

PKCS12 certificate stores and JKS keystores 
have private keys that are password protect-
ed, to prevent unauthorized access or theft. 
Enter the password that you specified when 
you generated the certificate store here, so 
that WACS can access private keys from the 
certificate store. You can only specify a value 
if you check Enable HTTPS.

By default, this value 
is empty.

Certificate Alias The alias of the certificate inside the certifi-
cate store. If this alias is not specified, and a 
certificate store that contains more than one 
certificate is used, the first certificate in the 
store is used. In most cases, you do not need 
to specify a value. You can only specify a val-
ue if you check Enable HTTPS.

By default, this value 
is empty.
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HTTPS Configuration 
Property

Description Default Value

Enable Client Authenti-
cation

If client authentication is enabled, only clients 
that have keys stored in the Certificate Trust 
List file can acquire WACS services. Other cli-
ents are rejected. You can only enable client 
authentication if you check Enable HTTPS.

The default value is 
FALSE.

Certificate Trust List 
File Location

The full path to the certificate trust list file. 
You can only specify a value if you check Ena-
ble HTTPS and Enable Client Authentication.

By default, this value 
is empty.

Certificate Trust List 
Private Key Access 
Password

The password that protects access to the pri-
vate keys in the Certificate Trust List file. You 
can only specify a value if you check Enable 
HTTPS and Enable Client Authentication.

By default, this value 
is empty.

Maximum HTTP Header 
Size

The maximum allowed size, in bytes, of the 
request and response HTTP header.

The default value is 
32768.

Facilitator Producer

Say:

We have just been discussing Web Applica-
tion Container Servers or WACS. Let me pop 
up a poll question for you.

Do:

Using your Instructor Handbook, enter the 
prewritten poll questions into the Adobe Con-
nect environment before class.

Display the poll question for the class and in-
vite participation.

When the voting is complete, display the re-
sults for the class and comment on them.

When done, minimize the Poll pod so that the 
results can be popped up again later in the 
class, if desired.

Do:

Assist the instructor by monitoring questions 
in the Chat pod
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INTERACTIVE ELEMENT: POLL

Question Answers

Do you need a WACS? a. Yes

b. No

c. Not sure

How to Add a WACS
We recommend that you run a single Web Application Container Server (WACS) on the same 
machine at the same time due to high resource utilization. However, you can deploy more than 
one WACS on the same machine, and only run one of them, to help you recover in the event of a 
misconfigured WACS.

1. Go to the Servers management area of the CMC.

2. Select Manage  → New → New Server.

3. From the Service Category list, select Core Services.

4. From the Select Service list, select the services that you want the WACS to host, and click the 
Next button.

5. Select one of the following options, based on your desired outcome:

● If you want the WACS to host Web applications such as the CMC, BI Launchpad or 
OpenDocument, select the BOE Web Application Service option.

● If you want the WACS to host web services such as Live Office or Query as a Web Service 
(QaaWS), select the Web Services SDK and QaaWS Service options.

● If you want the WACS to host Business Process BI Web Services, select the Business 
Process BI Web Service option.

6. On the next Create New Server screen, select any additional services that you want the WACS 
to host, and click the Next button.

7. On the next Create New Server screen, click the Next button.

8. On the next Create New Server screen, select a node to which to add the server, type a server 
name and description for the server, and click the Create button.

9. On the Servers screen, double-click the newly created WACS.

10. If you do not want the WACS to start automatically when the system restarts, in the Common 
Settings pane, ensure that the Automatically start this server when the Server Intelligence 
Agent starts checkbox is unchecked.
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11. Click the Save & Close button.

SAP BusinessObjects Business Intelligence Platform WAR Files

Explain to leaners that the functionality that makes up SAP BusinessObjects Business 
Intelligence platform is divided between several Web applications to make it easy to deploy only 
the components required by your organization. In SAP BusinessObjects Business Intelligence 
platform 4.x, many of the core Web applications included with previous releases have been 
bundled into a single OSGi archive. This saves Web application server memory and the reduces 
the number of Web sessions needed for Web applications that previously had multiple archives.

For example, SAP BusinessObjects Business Intelligence platform XI 3.x included the Central 
Management Console (CMC) and InfoView (now BI Launchpad) Web applications archived as 
CMC.war and InfoView.war. SAP BusinessObjects Business Intelligence platform 4.1 has 
consolidated the CMC and InfoView (now BI Launchpad) Web applications, along with others, 
into a single archive named BOE.war or BOE.ear.

The functionality that makes up SAP BusinessObjects Business Intelligence platform is divided 
between several Web applications to make it easy to deploy only the components required by 
your organization. In SAP BusinessObjects Business Intelligence platform, many of the core Web 
applications are in a single archive named BOE.war or BOE.ear.

Web application archive (may be WAR or EAR) Description

BOE OSGi archive of core Web applications, includ-
ing:

● Analytical Reporting

● CMC

● SAP Crystal Reports

● BI Launchpad

● Eclipse IDE support

● Lifecycle Manager

● Monitoring

● OpenDocument

● BI workspace

● Platform search

● Platform services

● Visual difference

● Dashboards
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You can modify settings for SAP BusinessObjects BI platform Web applications by overwriting 
default properties for the BOE.war file. This file is deployed on the machine hosting the Web 
application server.

The properties contained in the BOE.war file control specifications for default logon behavior, 
default authentication methods, and settings for single sign-on. The two types of properties you 
can specify:

● Global properties - these properties affect all the Web applications contained in the BOE.war 
file.

● Application-specific properties - property settings that affect only a specific Web application.

To modify any of the default properties, use the custom configuration directory to save new 
settings for either global or application-specific properties. By default, the directory is located at

<DRIVE>:\Program Files (x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 
4.0\warfiles\webapps\BOE\WEB-INF\config\custom.

Caution:
Do not modify the properties in the config\default directory.

Note:
On some web application servers such as the Tomcat version bundled with SAP 
BusinessObjects BI platform you can access the BOE.war directly. In this scenario, 
you can set custom settings directly without undeploying the WAR file. When you 
cannot directly access the deployed Web applications, undeploy, customize, and then 
redeploy the file.

Global BOE.war Properties
The following table lists the settings included in the default global.properties file for BOE.war. To 
overwrite any of the settings, create a new file in <DRIVE → :\Program Files (x86)\SAP 
BusinessObjects\SAP BusinessObjects Enterprise XI 4.0\warfiles\webapps\BOE\WEB-INF
\config\custom.

Setting Description

persistentcookies.enabled Enables or disables persistent cookies on the Web application 
logon page.

siteminder.authentication Specifies what authentication method to use with SiteMinder. 
The two options are secLDAP and secwinAD.

siteminder.enabled Enables and disables authentication with SiteMinder.

sso.enabled Enables and disables single sign-on (SSO) to SAP BusinessOb-
jects BI platform.

sso.sap.primary Set to true if you want to use SAP SSO as the application's pri-
mary single signon mechanism. Only applies to cases where 
both SAP and SiteMinder SSO are used.
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Setting Description

tree.pagesize Specifies the maximum number of entries that can be displayed 
in the Web application navigation pane.

trusted.auth.shared.secret Specifies the session variable name used to retrieve the secret 
for Trusted Authentication. Only applies if using the Web session 
to pass the shared secret.

trusted.auth.user.param Specifies the variable used to retrieve the username for Trusted 
Authentication. Can be set to one of the following:

● Header

● URL Parameter

● Cookie

● Session

trusted.auth.user.retrieval Specifies the method used to retrieve the username for Trusted 
Authentication. Can be set to one of the following:

● REMOTE_USER

● HTTP_HEADER

● COOKIE

● QUERY_STRING

● QUERY_STRING

● WEB_SESSION

● USER_PRINCIPAL

Set to empty to disable Trusted Authentication.

trusted.auth.user.namespa-
ceenabled

Enables and disables dynamic binding of aliases to existing user 
accounts. If property is set to true, Trusted Authentication uses 
alias binding to authenticate users to SAP BusinessObjects BI 
platform. With alias binding, your application server can work as 
a SAML service provider therefore enabling Trusted Authentica-
tion to provide SAML SSO to the system. If set to false, Trusted 
Authentication uses name matching to authenticate users.

vintela.enabled Used to enable or disable Vintela settings for Windows AD au-
thentication.

pinger.showWarningDia-
log.cmc

Specifies whether or not to display the warning dialog with the 
message that indicates the current session will expire soon in 
the CMC.

pinger.showWarningDia-
log.bilaunchpad

Specifies whether or not to display the warning dialog with the 
message that indicates the current session will expire soon in BI 
Launchpad.
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Setting Description

pinger.warning Period.pingIn-
crementsInSeconds

Specifies how often a Web server request should be sent while 
the session expiry warning message is displayed. This is impor-
tant for synchronizing the warning dialog across applications.

pinger.warning Peri-
od.lengthInMinutes

Specifies how long before session expiry the warning should be 
displayed.

logoff.on.web session.expiry Specifies if all application sessions log off when the Web session 
expires.

pinger.enabled Enables or disables the session expiry warning messaging mech-
anism.

system.com.sap.bip.jcoman-
ager.destinations.max size

Specifies the maximum number of cached Java connections.

BusinessObjects Business Intelligence Platform Launch Pad Properties
The following table lists the settings included in the default bilaunchpad.properties file for 
BOE.war. To overwrite any of the settings, create a new file in <DRIVE → :\Program Files 
(x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 4.0\warfiles\webapps\BOE
\WEB-INF\config\custom.

Setting Description

app.name Specifies the display name of the application. The name appears 
on the Web application title page and logon screen. Default: 
app.name=BI launch pad

app.name.greeting Default: app.name.greeting=BusinessObjects

app.name.short Specifies the display name of the application. The name appears 
on the Web application title page and logon screen. Default: 
app.name.short=BI launch pad

app.url.name Specifies the URL name of the application, preceded by the “/”" 
character. Default: app.url.name=/BI
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Setting Description

authentication.default Specifies the default authentication method used to authenti-
cate users into the application. You can use any of the following 
for this setting:

Enterprise
secEnterprise

LDAP
secLDAP

Windows AD
secWinAD

SAP
secSAPR3

PeopleSoft
secpsenterprise

JD Edwards
secPSE1

Siebel
secSiebel7

Oracles EBS
secOraApps

Default: authentication.default=secEnterprise

authentication.visible Specifies if users logging into BI Launchpad can view and change 
the authentication method. Default: authentication.visible=false

cms.default Specifies the default CMS name. Default: cms.default=[name of 
host machine]

cms.visible Specifies if users logging into BI Launchpad can view and change 
the CMS name. Default: cms.visible=true

dialogue.prompt.enabled Specifies if users should be prompted when navigating away 
from an input page in a dialog box. Default: dialogue.prompt.ena-
bled=false

logontoken.enabled Specifies whether or not to enable token creation for the session 
after a user logs into BI Launchpad. Token will be stored in a 
cookie. Default: lo gontoken.enabled=false

SMTPFrom Enables or disables the "From" field when scheduling an object 
to a destination. Default: SMTPFrom=true

url.exit Specifies which URL to redirect users after terminating their BI 
launch pad session. This setting applies only to users who have 
logged into the application through an external verification proc-
ess.
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Setting Description

disable.locale.preference Enables or disables the user from viewing and thus modifying the 
viewing local preferences for BI Launchpad. Default: disable.lo-
cale.preference=false

extlogon.allow.logoff Enables or disables automatically logging off user sessions once 
they have closed their BI Launchpad session. Set to false if you 
do not want user sessions not to terminate automatically when 
users log off BI Launchpad. Default: extlogon.allow.logoff=true
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Facilitator Producer

Say:

We will be starting a group chat activity. I will 
be pasting a series of questions into the Chat 
pod, and I ask that you enter your response 
after each question is posted.

After you have entered your response to each 
question, review your classmates responses.

I will select some responses to discuss as a 
group.

Do:

Display the first question on the slide provid-
ed in the Instructor Presentation deck. Dis-
play questions one at a time.

Explain to participants that you will be posting 
a series of questions (every 30 seconds or so) 
in the chat area

Ask students to answer their questions based 
on their independent study and then to review 
their classmates' answers.

Select the response from one participant and 
copy and paste it to the whiteboard.

As a large group (using audio), discuss the re-
sponse.

Remind students to participate actively in the 
class discussion, noting information of inter-
est in their Participant Handbook.

Do:

Assist by pasting the prewritten questions in-
to the Chat pod.

If desired, archive the Chat pod and white-
board overlay for later reference and distribu-
tion.
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INTERACTIVE ELEMENT: Chat

1. What is the archive file for the platform web applications?

.

.

.

.

.

.

.

.

.

.

2. How would you use the web application archive file to modify the web applications' 
properties?

.

.

.

.

.

.

.

.

.

.
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Unit 4
Exercise 4

101
Modify Web Application Properties

Business Example

As system administrator, you need to change the BI Launchpad default logon page to allow users 
to switch the authentication mode. Additionally, you want to activate and configure the automatic 
configuration of the platform for the SAP BI Mobile app.

Modify the BI Launchpad Properties

1. Connect to the Operating System (OS) desktop on your server with the credentials displayed 
in the table.

SAP BusinessObjects Busi-
ness Intelligence Platform 4.1 
SP2 System

Windows User Accounts Password

WDFLBMT5072 boadmin BOTraining

WDFLBMT0573 boadmin BOTraining

You are now connected to the Operating Desktop of your BI 4.1 platform.

2. Configure the properties of the BI Launchpad Web application in order to:

● Change the default display name "BI launch pad" in the logon page with the following text: 
SAP BOE320 -- Training Course Environment.

● Display the Authentication field with the value Enterprise as the default authentication.

3. Restart the modified Web application.

4. Test the modified Web application.

Modify SAP BI Mobile Properties

Note:
The Training Environment cannot be accessed from a mobile device, so this exercise 
is just for your information.

1. Configure the Properties of the Mobile Server Web Application to activate the automatic 
configuration properties for the SAP Mobile app on your BI 4 platform.

2. Restart the application.
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Solution 4

102
Modify Web Application Properties

Business Example

As system administrator, you need to change the BI Launchpad default logon page to allow users 
to switch the authentication mode. Additionally, you want to activate and configure the automatic 
configuration of the platform for the SAP BI Mobile app.

Modify the BI Launchpad Properties

1. Connect to the Operating System (OS) desktop on your server with the credentials displayed 
in the table.

SAP BusinessObjects Busi-
ness Intelligence Platform 4.1 
SP2 System

Windows User Accounts Password

WDFLBMT5072 boadmin BOTraining

WDFLBMT0573 boadmin BOTraining

a) Run the Remote Desktop Connection program from the Start > Programs menu of your 
Training Cloud Environment.

b) Enter the following credentials:

You are now connected to the Operating Desktop of your BI 4.1 platform.

2. Configure the properties of the BI Launchpad Web application in order to:

● Change the default display name "BI launch pad" in the logon page with the following text: 
SAP BOE320 -- Training Course Environment.

● Display the Authentication field with the value Enterprise as the default authentication.

a) In Windows Explorer, display the content of the following folder: D:\Program Files 
(x86)\SAP BusinessObjects\tomcat\webapps\BOE\WEB-INF\config\default

b) Copy the BIlaunchpad.properties folder to the following destination folder: D:
\Program Files (x86)\SAP BusinessObjects\tomcat\webapps\BOE\WEB-INF
\config\custom.
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c) Edit the copied file D:\Program Files (x86)\SAP BusinessObjects\tomcat
\webapps\BOE\WEB-INF\config\custom\ BIlaunchpad.properties and modify 
the lines to match the following:

app.name= Training Course Environment
app.name.short=SAP BOE320 - Training Course Environment
authentication.visible=true 

 

3. Restart the modified Web application.
a) Save the file.

b) Run the Central Configuration Manager (CCM).

c) Select the Apache Tomcat for BI 4 option from the list.

d) Click the Restart button in the toolbar of the CCM.

e) Wait for one minute before continuing.

4. Test the modified Web application.
a) Launch the BI Launchpad. What happened?

When the logon page is displayed, the displayed name of the Web application has 
changed. The Authentication field is displayed and can be changed at any time by the user. 
When logged into the BI Launchpad, the name of the Web application displayed in the 
window title has changed.

Modify SAP BI Mobile Properties

Note:
The Training Environment cannot be accessed from a mobile device, so this exercise 
is just for your information.

1. Configure the Properties of the Mobile Server Web Application to activate the automatic 
configuration properties for the SAP Mobile app on your BI 4 platform.
a) In Windows Explorer, display the content of the following folder: D:\Program Files 

(x86)\SAP BusinessObjects\tomcat\webapps\MOBIServer\WEB-INF\config
\default.

b) Copy the server.properties file to the following destination folder: D:\Program Files 
(x86)\SAP BusinessObjects\tomcat\webapps\MOBIServer\WEB-INF\config
\custom.

c) Edit the server.properties file by modifying the lines to match the following:
mobi.connections=MySAPBIMobileConnection
#
MySAPBIMobileConnection.DisplayName=Mobile Training Environment
MySAPBIMobileConnection.BOBJ_MOBILE_USER_NAME=Administrator
MySAPBIMobileConnection.BOBJ_MOBILE_URL=http://WDFLBMT5072.WDF.SAP.CORP:
8080
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MySAPBIMobileConnection.BOBJ_MOBILE_CMS= WDFLBMT5072.WDF.SAP.CORP
MySAPBIMobileConnection.BOBJ_MOBILE_AUTH_METHOD=secEnterprise
2. Restart the application.

a) Save the file.

b) Run the Central Configuration Manager (CCM).

c) Select the Apache Tomcat for BI 4 option from the list.

d) Click the Restart button in the toolbar of the CCM.
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LESSON SUMMARY
You should now be able to:

● Configure Web Application Container servers
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107
Learning Assessment

1. What are the two different ways to deploy Web applications using the wDeploy tool?

2. Which of the following choices are advantages of using a WACS to host the CMC?

Choose the correct answers.

X A WACS updates the CMC every 10 seconds.

X B WACS removes the need for Java application server administration and maintenance 
skills.

X C All hosted applications are predeployed on WACS, so that no additional manual steps 
are required.

X D WACS provides additional security to the CMC.
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Unit 4

108
Learning Assessment - Answers

1. What are the two different ways to deploy Web applications using the wDeploy tool?

The two methods are Standalone mode and Split mode. In Standalone mode all Web 
application resources are deployed together on a Web application server that serves both 
dynamic and static content. In Split mode the application's dynamic and static resources are 
separated. Static content is deployed to a Web server, and dynamic content is deployed to a 
Web application server.

2. Which of the following choices are advantages of using a WACS to host the CMC?

Choose the correct answers.

X A WACS updates the CMC every 10 seconds.

X B WACS removes the need for Java application server administration and maintenance 
skills.

X C All hosted applications are predeployed on WACS, so that no additional manual steps 
are required.

X D WACS provides additional security to the CMC.
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Lesson 1

110
Managing the Central Management Server 
(CMS) and System Database

LESSON OVERVIEW
The Central Management Server (CMS) manages the platform services and maintains a database 
of information about the platform and audited user actions. The CMS system database is 
maintained by the CMS, and stores various platform information. Together, the CMS and CMS 
system database perform user validation and authentication, user management, system auditing 
and monitoring, and program object scheduling. Management of CMS metrics and properties is 
simple and affects the user experience of the entire platform through authentication, auditing, 
and data storage.

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● Manage CMS database

Central Management Server (CMS)

Central Management Server (CMS)
The CMS maintains a database of information about your SAP BusinessObjects Business 
Intelligence platform and audited user actions (in the Auditing Data Store). All platform 
services are managed by the CMS. The CMS also controls access to the system files where 
documents are stored, and information on users, user groups, security levels (including 
authentication and authorization), and content.

CMS system database
The CMS system database is used to store SAP BusinessObjects BI platform information, 
such as user, server, folder, document, configuration, authorization, and authentication 
details. It is maintained by the Central Management Server (CMS), and is sometimes 
referred to as the system repository.

CMS User Validation
The CMS implements a simple tracking algorithm. When a user logs on, the user is granted a CMS 
session, which the CMS preserves until the user logs off, or until the Web application server 
session variable is released.

The Web application server session is designed to notify the CMS on a recurring basis that it is 
still active, so the CMS session is retained so long as the Web application server session exists. If 
the Web application server session fails to communicate with the CMS for a ten-minute period, 
the CMS destroys the CMS session. This handles scenarios where client-side components shut 
down irregularly.
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CMS User Validation Process

The following steps describe how the CMS validates users and creates a session.

1. The user sends the logon request from the BI launch pad web client through the Web server to 
the Web application server, where the BI launch pad Web application is running.

Note:
This logon process also applies to other Web clients, such as the Central 
Management Console (CMC).

2. The Web application server determines that the request is a logon request. The Web 
application server sends the username, password, and authentication type to the Central 
Management Server (CMS) for authentication.

3. The CMS validates the username and password against the appropriate database. In this 
case, Enterprise authentication is used, so user credentials are authenticated against the 
CMS system database.

4. Upon successful validation, the CMS creates a session for the user in memory.

5. The CMS sends a response to the Web application server to let it know that the validation was 
successful.

6. The Web application server generates a logon token for the user session in memory. For the 
rest of this session, the Web application server uses the logon token to validate the user 
against the CMS. The Web application server also generates the next Web page to send to the 
Web client.

7. The Web application server sends the next Web page to the Web server.

8. The Web server sends the Web page to the Web client.

Lesson: Managing the Central Management Server (CMS) and System Database
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Figure 14: Log on to SAP BusinessObjects Business Intelligence Platform

CMS Process For Scheduling a Program Object
The following steps explain how the CMS functions when you set a schedule for a program object.

1. The user sends the schedule request from the Central Management Console (CMC) Web 
client through the Web server to the Web application server, where the CMC Web application 
is running.

2. The Web application server interprets the request and determines that the request is a 
schedule request. The Web application server sends the schedule time and other required 
information to the specified Central Management server.

3. The Central Management Server (CMS) checks the CMS system database to ensure that the 
user has rights to schedule the object. If the user has sufficient rights, the CMS adds a new 
record to the CMS system database. The CMS also adds the instance to its list of pending 
schedules.

4. The CMS sends a response to the Web application server to let it know that the schedule 
operation was successful.

5. The Web application server generates the next Web page and sends it through the Web server 
to the Web client.

Unit 5: Central Management Server (CMS) Database

118 © Copyright . All rights reserved.



Figure 15: Schedule a Program Object

CMS Properties
When you modify any of these server properties, restart the server for the changes to take effect.

Table 9: CMS Properties

CMS Properties Description Default Value

Name Server Port Specifies the port on which the 
CMS listens to initial name service 
requests.

The default value is 
6400.

System Database Connections Re-
quested

Specifies the number of CMS sys-
tem database connections that the 
CMS attempts to establish. If the 
server cannot establish all of the 
requested database connection, 
the CMS continues to function but 
at a reduced performance, since 
fewer concurrent requests can be 
served simultaneously. The CMS 
will attempt to establish additional 
connections, until the requested 
number of connection is establish-
ed. The CMS's Established System 
Database Connections metric 
shows the current number of es-
tablished connections.

The default value is 
14.
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CMS Properties Description Default Value

Auto Reconnect to System Data-
base

Specifies whether the CMS auto-
matically attempts to reestablish a 
connection to the CMS database in 
the event of a service disruption. If 
this value is set to FALSE, you can 
check the integrity of the CMS da-
tabase before resuming opera-
tions. Restart the CMS to reestab-
lish the database connection.

The default value is 
TRUE.

CMS Metrics
The CMS metrics are listed in the following table:

Table 10: CMS Metrics

CMS Metrics Description

Connection to Auditing 
Database is Established

Indicates whether the CMS has a healthy connection to the auditing 
database. A value of “1” indicates that there is a connection. A value 
of “0” indicates that there is no connection to the auditing database. 
If the CMS is an auditor, this value should be “1”. If it is “0”, investi-
gate why a connection to the Auditing database cannot be establish-
ed.

CMS Auditor Indicates if the Central Manager Server (CMS) is acting as an auditor. 
A value of “1” indicates that the CMS is acting as an auditor. A value of 
“0” indicates that the CMS is not acting as an auditor.

Auditing Database Con-
nection Name

The name of the auditing database connection. This is not necessarily 
the name of the auditing database itself. If this metric is empty, it indi-
cates that a connection to the auditing database cannot be establish-
ed.

Auditing Database User 
Name

The name of the user account used to connect to the auditing data-
base.

Auditing Database Last 
Updated On

The most recent date and time that the CMS successfully started to 
retrieve events from an auditee. If the CMS is an auditor, this metric 
must show a time that is close to the time that the Metrics page is 
loaded. If this value is more than two hours prior to the time that the 
page is loaded, it may indicate that auditing is not working properly.
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CMS Metrics Description

Auditing Thread Last 
Polling Cycle Duration 
(seconds)

The duration of the last polling cycle in seconds. This indicates the 
maximum delay for event data to reach the auditing database during 
the previous polling cycle.

● A value of less than 20 minutes indicates a healthy system.

● A value between 20 minutes and 2 hours indicates a busy system.

● A value of greater than 2 hours indicates a very busy system. If 
this state persists and you consider the delay too long, we recom-
mend that you either update your deployment to all the auditing 
database to receive data at a higher rate or decrease the number 
of auditing events that your system tracks.

Auditing Thread Utiliza-
tion

The percentage of the polling cycle the auditor CMS spends collecting 
data from auditees. The remainder is time spent resting between 
polls.If this value reaches 100%, the auditor is still collecting data 
from the auditees when the next poll is due to begin. This may cause 
delays in the events reaching the auditing database. If the Thread Uti-
lization frequently reaches 100%, and remains at this rate for several 
days, it is recommended that you either update your deployment to 
allow the auditing database to receive data at a higher rate, or de-
crease the number of auditing events that your system tracks.

Clustered CMS Servers A semicolon-separated list of the host names and port numbers of 
the running Central Management Servers in the cluster.

Number of Sessions Es-
tablished by Concurrent 
Users

The total number of sessions for users with concurrent licensing.

Number of Sessions Es-
tablished by Named 
Users

The total number of sessions for users with named licensing.

Peak Number of User 
Sessions Since Startup

The peak number of concurrent user sessions that the CMS has han-
dled since it was started.

Number of Sessions Es-
tablished by Servers

The number of concurrent sessions that SAP BusinessObjects BI 
platform servers have created with the CMS. If this number is greater 
than 250, create an additional CMS.

Number of Sessions Es-
tablished by All Users

The number of concurrent user sessions that are being handled by 
the CMS at the time that the Metrics screen loads. The larger this 
number is, the larger the number of users that are using the system. 
If this number is greater than 250, create an additional CMS.

Failed Jobs The total number of failed jobs on the CMS since the Failed Jobs serv-
er started.

Pending Jobs The current number of pending jobs.
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CMS Metrics Description

Running Jobs The current number of running jobs. This includes jobs that are 
scheduled but not ready to run because their scheduled time has not 
arrived.

Completed Jobs The total number of completed jobs on the CMS since the server 
started.

Waiting Jobs The current number of waiting jobs on the CMS. This includes jobs 
that are scheduled and waiting for free resources.

Concurrent User Licens-
es

The number of Concurrent User licenses as indicated by the key 
code.

Named User Licenses The number of Named User licenses as indicated by the key code.

Build Date The build date of the CMS.

System Database Con-
nection Name

The name of the CMS system database connection. This is not neces-
sarily the name of the CMS system database itself.

System Database Serv-
er Name

The name of the server where the CMS system database is running. 
This is not necessarily the name of the CMS system database itself.

System Database User 
Name

The name of the user account used to connect to the CMS system 
database.

Data Source Name The name of the CMS system database connection.

Build Number The build number of the CMS. This number can be used to identify 
the version of SAP BusinessObjects BI platform that you have instal-
led.

Product Version The product version of the CMS.

Resource Version The resource version of the CMS.

Average Commit Re-
sponse Time Since 
Startup (msec)

The average length of time in milliseconds that it took the CMS to per-
form commit operations since the server was started. A response 
time greater than 1000 milliseconds may indicate a need to tune the 
CMS or the CMS system database.

Average Query Re-
sponse Time Since 
Startup (msec)

The average length of time in milliseconds that it took the CMS to per-
form query operations since the server was started. A response time 
greater than 1000 milliseconds may indicate a need to tune the CMS 
or the CMS system database.

Longest Commit Re-
sponse Time Since 
Startup (msec)

The longest length of time in milliseconds that it took the CMS to per-
form commit operations since the server was started. A response 
time greater than 10000 milliseconds may indicate a need to tune the 
CMS or the CMS system database.

Longest Query Re-
sponse Time Since 
Startup (msec)

The longest length of time in milliseconds that it took the CMS to per-
form query operations since the server was started. A response time 
greater than 10000 milliseconds may indicate a need to tune the 
CMS or the CMS system database.
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CMS Metrics Description

Number of Commits 
Since Startup

The number of commits to the CMS system database since the serv-
er was started.

Number of Queries 
Since Startup

The total number of database queries since the server was started. A 
large number may indicate a more active or heavily loaded system.

Number of User Logons 
Since Startup

The number of user logons since the server was started. A large num-
ber may indicate a more active or heavily loaded system.

Established System Da-
tabase Connections

The number of connections to the CMS system database that the 
CMS was able to establish. If a database connection is lost, the CMS 
attempts to restore the connection. If the number of established da-
tabase connections is consistently lower than the number of system 
database connections that are specified by the System Database 
Connections Requested property, it may indicate that the CMS can-
not acquire additional connections, and that the system is not func-
tioning well. A potential solution is to configure the database server to 
allow more database connections for the CMS.

Currently Used System 
Database Connections

The number of connections to the CMS system database that the 
CMS is currently using. The number of connections that are being 
currently used may be smaller than or equal to the number of estab-
lished system database connections. If the number of established 
connections and the number of used connections are identical for 
some time, this may indicate a bottleneck. Increasing the value for 
the System Database Connections Requested property may improve 
the performance of the CMS.

Pending System Data-
base Requests

The number of requests for the CMS system database that are wait-
ing for an available connection. If this number is high, consider in-
creasing the value for the System Database Connections Requested 
property. Tuning the CMS system database may also improve per-
formance.

Number of Objects in 
CMS System Cache

The total number of objects that are currently in the CMS system 
cache.

Number of Objects in 
CMS System DB

The total number of objects that are currently in the CMS system da-
tabase.

Existing Concurrent 
User Accounts

The total number of existing users with concurrent licensing in the 
cluster.

Existing Named User 
Accounts

The total number of existing users with named licensing in the clus-
ter.
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How to Manage SAP Authentication in BusinessObjects Business Intelligence Platform 4.1

In order to perform this demonstration, you must use the Training Course BOE320 content 
in the Initialize Course folder in the Training Cloud Environment.

1. Go to theVideos subfolder in the Training Cloud Environment.

2. Play the DEMO3 Manage SAP Authentication in BI 4 video file, and explain the 
following steps:

a) Create an SAP user and SAP Role for the BI 4 platform in an SAP BW system.

b) Set up the SAP Authentication in the BI 4 platform.

c) Assign BI 4 security to SAP user accounts.

d) Log on to the BI launch pad with an SAP user account.

e) Check the BI 4 user license.

f) Synchronize the security on platforms when an SAP user is locked on the SAP BW system.

g) Synchronize the security on platforms when an SAP user is deleted on the SAP BW 
system.

LESSON SUMMARY
You should now be able to:

● Manage CMS database

Unit 5: Central Management Server (CMS) Database
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118
Configuring Auditing

LESSON OVERVIEW
The CMS audits platform servers and applications. It regularly requests auditing records from the 
other platform components, and writes data from these records to the Auditing Data Store 
(ADS). The CMC Auditing page provides administrators with a status summary, and the ability to 
set events and event details, and configure the CMS for auditing. Auditing workflows to record 
events vary according to the type of platform component being audited, but all audits write 
events to the Auditing Data Store (ADS) and delete the events from the auditee temporary files.

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● Configure CMS for auditing

● Manage auditing

Auditing
The Central Management Server (CMS) acts as the system auditor, while each SAP 
BusinessObjects BI platform server or application that triggers an auditable event acts as an 
auditee. When an audited event is triggered, the auditee will generate a record and store it in a 
local temporary file. At regular intervals, the CMS communicates with the auditees to request 
these records and writes the data to the Auditing Data Store (ADS).

The CMS also controls the synchronization of auditing events that occur on different machines. 
Each auditee provides a time stamp for the auditing events that it records. To ensure that the 
timestamps of events on different servers are consistent, the CMS periodically broadcasts its 
system time to the auditees. The auditees then compare this time to their internal clocks. If 
differences exist, the auditees correct the time recorded for subsequent auditing events.

CMS Auditing Page and Metrics
The Auditing page in the CMS has the following areas:

● Auditing Status Summary

● Set Events

● Set Event Details

● Configuration

The Status Summary shows a set of metrics that help you optimize your auditing configuration 
and alerts you to any issues that might affect the integrity of your auditing data. The following 
table explains the metrics for auditing.
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Table 11: Auditing Metrics

Metric Auditing Metrics

ADS Last Updated on The date and time the auditor CMS last started polling the auditees for 
their auditing events.

Auditing Thread Uti-
lization

The percentage of the polling cycle the auditor CMS spends collecting 
data from auditees, the remainder is time spent resting between polls. 
If this reaches 100% the figure will be displayed in yellow, and means 
the auditor is still collecting data from the auditees when the next poll is 
due to begin. This may cause delays in the events reaching the ADS. If 
this is happening frequently or persistently, it is recommend you either 
update your deployment to allow the ADS database to receive data at a 
higher rate (faster network connections or more powerful database 
hardware for example), or decrease the number of auditing events your 
system tracks.

Last Polling Cycle Du-
ration

Duration of the last polling cycle in seconds. This indicates the maxi-
mum delay for event data to reach the ADS during the previous polling 
cycle.

● If under 20 minutes (1200 seconds), the figure will appear on a 
green background.

● If between 20 minutes and 2 hours (7200 seconds), it will appear on 
a yellow background.

● If over 2 hours, it will appear on a red background.

If this state persists and you consider the delay too long, we recom-
mend that you either update your deployment to allow the ADS data-
base to receive data at a higher rate (faster network connections or 
more powerful database hardware for example), or decrease the num-
ber of auditing events your system tracks.

CMS Auditor The name of the CMS currently acting as auditor.

ADS Database Con-
nection Name

The name of the database connection currently used by the auditor 
CMS to connect to the Auditing Data Store (ADS). For SQL servers this 
will be the name of the ODBC connection. For other database types it 
will be the database name, followed by the server name and connection 
port.

ADS Database User 
Name

The user name the auditor CMS is using to log in to the ADS database.

Clients that Support Auditing
The following clients support auditing:

● CORBA clients; for example, WEBI rich client

● HTTP and HTTPS clients; for example, BI launch pad and the CMC
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Auditing Workflows
Depending on the type of auditee, the system uses one of the following five workflows to record 
events.

Server Auditing

Figure 16: Server auditing

1. An auditable event is performed by the server.

2. The auditee writes events in a temporary file.

3. The auditor polls the auditee and requests a batch of auditing events.

4. The auditee retrieves the events from the temporary files.

5. The auditee transmits the events to the auditor.

6. The auditor writes events to the Auditing Data Store (ADS) and signals the auditee to delete 
the events from the temporary files.

Client Logon Auditing for Clients Connecting Through CORBA

This auditing process applies to clients that connect through CORBA, including applications like 
Web Intelligence.

Lesson: Configuring Auditing

© Copyright . All rights reserved. 127



Figure 17: Client logon auditing for clients connecting through CORBA

1. The client connects to the CMS, which will act as the auditee. The client provides its IP 
address and machine name, which the auditee then verifies.

Note:
A port must be open in the firewall between the client and CMS.

2. The auditee writes events in a temporary file.

3. The auditor polls the auditee and requests a batch of auditing events.

4. The auditee retrieves the events from the temporary files.

5. The auditee transmits the events to the auditor.

6. The auditor writes events to the Auditing Data Store (ADS) and signals the auditee to delete 
the events from the temporary files.

Client Logon Auditing for Clients Connecting Through HTTP
This auditing process applies to clients that connect through HTTP, and includes online 
applications, such as BI Launchpad, Central Management Console (CMC), and Web Intelligence.
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Figure 18: Client logon auditing for clients connecting through HTTP

1. The browser connects to the Web application server, and logon data is submitted to the Web 
application server.

2. SAP BusinessObjects BI platform SDK submits the logon request to the auditee (CMS), along 
with the IP address and name of the browser machine.

3. The auditee writes events in a temporary file.

4. The auditor polls the auditee and requests a batch of auditing events.

5. The auditee retrieves the events from the temporary files.

6. The auditee sends events to the auditor.

7. The auditor writes events to the Auditing Data Store (ADS) and signals the auditee to delete 
the events from the temporary files.

Non-Logon Auditing for Clients Connecting Through CORBA

This workflow applies to auditing Web Intelligence events when connecting through CORBA.
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1. The user performs an operation that may be audited.

2. The client contacts the CMS to check if the operation is configured to be audited.

3. If the action is set to be audited, the CMS communicates this information to the client.

4. The client sends the event information to the Client Auditing Proxy Service (CAPS), hosted in 
an Adaptive Processing Server.

5. The CAPS writes events in a temporary file.

6. The Auditor polls the CAPS and requests a batch of auditing events.

7. The CAPS retrieves the events from the temporary files.

8. The CAPS sends the event information to the auditor.

9. The auditor writes events to the Auditing Data Store (ADS) and signals the CAPS to delete the 
events from the temporary files.

Non-Logon Auditing for Clients Connecting Through HTTP
This workflow applies to auditing Web Intelligence events (except for logon events) when 
connecting through HTTP.
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Figure 19: Non-logon auditing for clients connecting through HTTP

1. The user initiates a potentially auditable event. The client application contacts the Web 
application server.

2. The Web application checks to see if the event is configured to be audited.

3. The CMS returns the audit configuration information to the Web application server, which 
passes this information back to the client application.

4. If the event is configured to be audited, the client sends the event information to the Web 
application server, which passes it to the Client Auditing Proxy Service (CAPS), hosted in an 
Adaptive Processing Server (APS).

5. The CAPS writes events in a temporary file.

6. The auditor polls the CAPS and requests a batch of auditing events.

7. The CAPS retrieves the events from the temporary files.

8. The CAPS sends the event information to the auditor.

9. The auditor writes events to the Auditing Data Store (ADS) and signals the CAPS to delete the 
events from the temporary files.

How to Manage Auditing in BusinessObjects Business Intelligence Platform 4.1

In order to perform this demonstration, you must use the Training Course BOE320 content 
in the Initialize Course folder in the Training Cloud Environment.

Lesson: Configuring Auditing
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The Development environment that is provided uses Sybase SQL Anywhere databases instead 
of Microsoft SQL Server. Many students do not have any experience with this database, so the 
accompanying video demonstration shows the BI 4.1 platform on a MS SQL Server 2008 
environment.

1. Go to the Videos subfolder in the Training Cloud Environment.

2. Play the DEMO4 Manage Auditing in BI 4 video file, and explain the following steps:

a) Explain the technical prerequisites for installing Auditing on a BI4 environment.

b) Design and publish an Auditing Universe on the platform with the Information Design Tool.

c) Reporting on the Auditing database with the BI Launchpad.

d) Monitor the size of the temporary files in the BI 4 Auditing folder.

e) Monitor the Auditing Dashboard in the CMC.

LESSON SUMMARY
You should now be able to:

● Configure CMS for auditing

● Manage auditing
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Unit 5

125
Learning Assessment

1. All platform services are managed by the Central Management Server (CMS)

Determine whether this statement is true or false.

X True

X False

2. Arrange these process steps in the correct order for scheduling a program object.

Arrange these steps into the correct sequence.

0 The Central Management Server (CMS) checks the CMS system database to ensure that 
the user has rights to schedule the object. If the user has sufficient rights, the CMS adds a 
new record to the CMS system database. The CMS also adds the instance to its list of 
pending schedules.

0 The user sends the schedule request from the Central Management Console (CMC) Web 
client through the Web server to the Web application server, where the CMC Web 
application is running.

0 The Web application server generates the next Web page and sends it through the Web 
server to the Web client.

0 The Web application server interprets the request and determines that the request is a 
schedule request. The Web application server sends the schedule time and other required 
information to the specified CMS.

0 The CMS sends a response to the Web application server to let it know that the schedule 
operation was successful.

3. What does a CMS act as?

Choose the correct answer.

X A Application database

X B Report repository

X C System auditor

X D Security application
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4. Select which of the following are aspects of the CMS Auditing page.

Choose the correct answers.

X A Configuration

X B Set Events

X C Alert Properties

X D Auditing Status Summary

5. How many different workflows can auditing use to record events?

6. Which part of the Auditing page of the CMS shows metrics to optimize your auditing 
configuration and alert you to any issues that might affect the integrity of your auditing data.

Choose the correct answer.

X A Set Event Details

X B Configuration

X C Auditing Status Summary

X D Set Events

Unit 5: Learning Assessment
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Unit 5

127
Learning Assessment - Answers

1. All platform services are managed by the Central Management Server (CMS)

Determine whether this statement is true or false.

X True

X False

2. Arrange these process steps in the correct order for scheduling a program object.

Arrange these steps into the correct sequence.

3 The Central Management Server (CMS) checks the CMS system database to ensure that 
the user has rights to schedule the object. If the user has sufficient rights, the CMS adds a 
new record to the CMS system database. The CMS also adds the instance to its list of 
pending schedules.

1 The user sends the schedule request from the Central Management Console (CMC) Web 
client through the Web server to the Web application server, where the CMC Web 
application is running.

5 The Web application server generates the next Web page and sends it through the Web 
server to the Web client.

2 The Web application server interprets the request and determines that the request is a 
schedule request. The Web application server sends the schedule time and other required 
information to the specified CMS.

4 The CMS sends a response to the Web application server to let it know that the schedule 
operation was successful.
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3. What does a CMS act as?

Choose the correct answer.

X A Application database

X B Report repository

X C System auditor

X D Security application

4. Select which of the following are aspects of the CMS Auditing page.

Choose the correct answers.

X A Configuration

X B Set Events

X C Alert Properties

X D Auditing Status Summary

5. How many different workflows can auditing use to record events?

There are five workflows available to accommodate different auditee types.

6. Which part of the Auditing page of the CMS shows metrics to optimize your auditing 
configuration and alert you to any issues that might affect the integrity of your auditing data.

Choose the correct answer.

X A Set Event Details

X B Configuration

X C Auditing Status Summary

X D Set Events
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UNIT 6 File Repository Server 
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UNIT OBJECTIVES

● Manage File Repository server

● Use the Repository Diagnostic tool
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Unit 6
Lesson 1

130
Managing the File Repository Server

LESSON OVERVIEW
A File Repository Server (FRS) creates file system objects. An FRS may be an Input FRS that 
stores report and program objects that have been published to the system by administrators or 
end users. An FRS may also be an Output FRS that stores all of the report instances that are 
generated by the Job server. Management of the File Repository Servers is simple to perform 
through the BI launch pad and FRS properties.

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● Manage File Repository server

File Repository Servers

File Repository Server
File Repository Server (FRS) is responsible for the creation of file system objects, such as 
exported reports, and imported files in non-native formats. An Input FRS stores report and 
program objects that have been published to the system by administrators or end users. An 
Output FRS stores all of the report instances generated by the Job Server.

Input File Repository Server
The Input File Repository server manages files that contain information to be used in reports. 
Input File Repository Server file types 
include: .rpt, .car, .exe, .bat, .js, .xls, .doc, .ppt, .rtf, .txt, .pdf, .wid, .rep, and .unv.

Output File Repository Server
The Output File Repository Server manages reports created by the system. Output File 
Repository Server file types include: .rpt, .csv, .xls, .doc, .rtf, .txt, .pdf, .wid, and .rep.

Table 12: Servers

Server Type Service Service category

Input File Repository Server Input Filestore Service Core Services

Output File Repository Server Output Filestore Service Core Services
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Input File Repository Server Properties

Table 13: Input File Repository Server Properties

Property Description Default Value

Maximum Retries for File Ac-
cess

Specifies the number of times 
the server tries to access a file.

The default value is 1.

Maximum Idle Time (minutes) Specifies the length of time 
that the server waits before it 
closes inactive connections. 
Setting a value that is too low 
can cause a user request to be 
closed prematurely. Setting a 
value that is too high can 
cause excessive consumption 
of system resources, such as 
processing time and disk 
space.

The default value is 10 mi-
nutes.

Temporary Directory Specifies the directory where 
temporary files are created 
when necessary.

%DefaultInputFRS Dir/temp%

File Store Directory Specifies the directory where 
file repository objects are stor-
ed.

%DefaultInputFRS Dir/%

Note:
You may encounter performance issues if this directory does not have adequate disk 
space. To ensure better performance, we recommend that the Temporary Directory 
is located on the same file system as the File Store Directory.

Output File Repository Server Properties

Table 14: Output File Repository Server Properties

Property Description Default Value

Maximum Retries for File Ac-
cess

Specifies the number of times 
the server tries to access a file.

The default value is 1.

Lesson: Managing the File Repository Server
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Property Description Default Value

Maximum Idle Time (minutes) Specifies the length of time 
that the server waits before it 
closes inactive connections. 
Setting a value that is too low 
can cause a user request to be 
closed prematurely. Setting a 
value that is too high can 
cause excessive consumption 
of system resources such as 
processing time and disk 
space.

The default value is 10 mi-
nutes.

Temporary Directory Specifies the directory where 
temporary files are created 
when necessary.

%DefaultOutputFRS Dir/temp
%

File Store Directory Specifies the directory where 
file repository objects are stor-
ed.

%DefaultOutputFRS Dir/%

Note:
You may encounter performance issues if this directory does not have adequate disk 
space. To ensure better performance, we recommend that the Temporary Directory 
is located on the same file system as the File Store Directory.

File Repository Server Metrics
The following table describes the server metrics that appear on the Metrics screen for Input and 
Output File Repository Servers.

Table 15: Metrics

Metric Description

Active Files The number of files in the File Repository Server that are cur-
rently being accessed.

Data Written (MB) The total number of megabytes written to files on the server.

Data Sent (MB) The total number of megabytes read from files on the server.

List of Active Files A table that displays the files in the File Repository Server that 
are currently being accessed.

Active Connections The total number of active connections from clients and to 
other servers.

Available Disk Space in Root Di-
rectory (GB)

The total amount of available space on the disk containing the 
server executable file, in gigabytes.
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Metric Description

Free Disk Space in Root Direc-
tory (GB)

The total amount of free space on the disk containing the serv-
er executable file, in gigabytes.

Total Disk Space in Root Direc-
tory (GB)

The total disk space, in gigabytes, on the disk containing the 
server executable file.

Available Disk Space in Root Di-
rectory (%)

The amount of available disk space, in percentage, on the disk 
containing the server executable file.

Lesson: Managing the File Repository Server
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135
Manage the Input File Repository Server

Business Example

As the system administrator, you need to identify where all the file repository objects (reports, 
instances, shortcuts) are located in the BI 4 platform (including the BI launch pad and Query 
Builder). You must also know where file repository objects inconsistencies come from in the 
platform.

Manage a BI 4 Report with the File Repository Server

1. Locate where the input file repository objects are stored on the BI 4 platform.

2. Write down the default value of the %DefaultInputFRSDir% entry in the table. Click the OK 
button.

Placeholder Value

%DefaultInputFRSDir%

%DefaultOutputFRSDir%

3. Check the file store directory of the Input File Repository Server.

4. Enter the value that specifies where the file repository objects are stored into the table.

Input Filestore Service Value

File Store Directory

%DefaultInputFRSDir%

5. Check the file store directory of the Output File Repository server.

6. Enter the value that specifies where the file repository objects are stored into the table below.

Output Filestore Service Value

File Store Directory

%DefaultOutputFRSDir%

7. From the BI launch pad, schedule the Crystal Reports "World Sales Report" with the default 
settings.

8. Go back to the Demonstration public folder in the launchpad. What happened?
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Note:
This instance is stored as a new file repository object in the platform.

9. From the BI launch pad, copy the Crystal Reports World Sales Report to your Favorites 
folder.

10. From the BI Launchpad, complete the following table with the store location of your two 
copies of the report, then delete the copied file in Windows Explorer on the server-side. What 
happened when you tried to display this copied report from the launchpad?

Name of the Private Report File Name Properties

Shortcut to World Sales Report

World Sales Report

11. Go to the operating system of the platform, then rename the file by adding the ".old" file 
extension for the World Sales Report specified in the previous table.

Hint:
This can be done without stopping any FRS servers.

12. Go to the launchpad. Notice that you can now see the entry of the report in the Private 
folder. An attempt to view the report, however, results in an error message. This is due to an 
inconsistency in the platform.

Use the Query Builder Tool

1. From the Web application Query Builder tool, locate all of the folders where the World 
Sales Report is published.

2. How many objects relative to the World Sales Report are stored in the platform? Why?
You will see four file repository objects:

● Two published Crystal Reports (in the FRS Input folder)

● One Crystal Reports Instance (in the FRS Output folder)

● One shortcut to published Crystal Reports (no file in the FRS folders)
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Manage the Input File Repository Server

Business Example

As the system administrator, you need to identify where all the file repository objects (reports, 
instances, shortcuts) are located in the BI 4 platform (including the BI launch pad and Query 
Builder). You must also know where file repository objects inconsistencies come from in the 
platform.

Manage a BI 4 Report with the File Repository Server

1. Locate where the input file repository objects are stored on the BI 4 platform.
a) Click the Servers option and then navigate to Service Categories --> Core 

Services .

b) Right-click the Input File Repository server and then click the Placeholders option.

c) Locate the %DefaultInputFRSDir% entry. Do not change any value.

2. Write down the default value of the %DefaultInputFRSDir% entry in the table. Click the OK 
button.

Placeholder Value

%DefaultInputFRSDir%

%DefaultOutputFRSDir%

3. Check the file store directory of the Input File Repository Server.
a) Right-click the Input File Repository Server and then click the Properties option 

from the resulting dialog menu.

b) In the Properties tab, navigate to the File Store Directory field. The value specifies the 
directory where file repository objects are stored.

4. Enter the value that specifies where the file repository objects are stored into the table.

Input Filestore Service Value

File Store Directory

%DefaultInputFRSDir%

5. Check the file store directory of the Output File Repository server.
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a) Right-click the Output File Repository server and then click the Properties option 
from the resulting dialog menu.

b) In the Properties tab, navigate to the File Store Directory field. The value specifies the 
directory where the file repository objects are stored.

6. Enter the value that specifies where the file repository objects are stored into the table below.

Output Filestore Service Value

File Store Directory

%DefaultOutputFRSDir%

7. From the BI launch pad, schedule the Crystal Reports "World Sales Report" with the default 
settings.
a) Select the Demonstration Public folder.

b) Select the World Sales Report option from the list of reports that is displayed on the right 
side of the screen.

c) Right-click the report and then click the Schedule option from the resulting dialog menu.

d) In the new window, click the Schedule button to accept all of the default values.

e) Wait for about a minute until the status of the job is "Success".

8. Go back to the Demonstration public folder in the launchpad. What happened?

a) A new instance has been created and stored in the platform. (Value "1" n from of the report 
in the "Instances" column.)

Note:
This instance is stored as a new file repository object in the platform.

9. From the BI launch pad, copy the Crystal Reports World Sales Report to your Favorites 
folder.
a) Go to the BI Launchpad and select the Demonstration Public folder.

b) Select the World Sales Report from the list of reports on the right side of the screen.

c) Select the Organize option and then the Create Shortcut in My Favorites option from the 
resulting menu.

Note:
This copy is stored as a new file repository object that links to the original 
report. You will notice that you see the instance number "1" of the original 
report.
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d) From the BI Launchpad, select the Demonstration Public folder.

e) Select the World Sales Report from the list of reports that is displayed on the right 
side of the screen.

f) Click the Organize option, and then select the Copy option from the dropdown menu.

g) Select your private My Favorites folder.

h) Click the Organize option in the launchpad, and then select the Paste option from the 
dropdown menu. You will see a copy of the World Sales Report .

Note:
This copy is stored as a new file repository object and is not a simple link to the 
original report.

10. From the BI Launchpad, complete the following table with the store location of your two 
copies of the report, then delete the copied file in Windows Explorer on the server-side. What 
happened when you tried to display this copied report from the launchpad?

Name of the Private Report File Name Properties

Shortcut to World Sales Report

World Sales Report

a) Go to the BI Launchpad and select the Private My Favorites folder.

b) Right-click each object in the My Favorites folder and select the Properties option from 
the resulting dialog menu.

c) Enter the file name properties in the following table for each object.

Note:
The Shortcut to World Sales Report object does not have any file 
name properties.

11. Go to the operating system of the platform, then rename the file by adding the ".old" file 
extension for the World Sales Report specified in the previous table.

Hint:
This can be done without stopping any FRS servers.

12. Go to the launchpad. Notice that you can now see the entry of the report in the Private 
folder. An attempt to view the report, however, results in an error message. This is due to an 
inconsistency in the platform.

Lesson: Managing the File Repository Server
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Use the Query Builder Tool

1. From the Web application Query Builder tool, locate all of the folders where the World 
Sales Report is published.

a) From the Web browser, go to the following URL: http://wdflbmt50xx:8080/AdminTools .

b) Enter your Enterprise credentials, then click the Log On button.

Note:
The Business Intelligence platform 4.1 security is applied to this tool. You will 
only see object for you have permissions.

c) Enter the following query in the text field: SELECT SI_ID, SI_NAME, SI_FILES FROM 
CI_INFOOBJECTS WHERE SI_NAME LIKE '%World%' .

d) Click the Submit Query button.

2. How many objects relative to the World Sales Report are stored in the platform? Why?
You will see four file repository objects:

● Two published Crystal Reports (in the FRS Input folder)

● One Crystal Reports Instance (in the FRS Output folder)

● One shortcut to published Crystal Reports (no file in the FRS folders)
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LESSON SUMMARY
You should now be able to:

● Manage File Repository server

Lesson: Managing the File Repository Server
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Using the Repository Diagnostic Tool

LESSON OVERVIEW
The Repository Diagnostic Tool (RDT) is a command line tool that finds and repairs 
inconsistencies between the Central Management Server (CMS) system database and the File 
Repository Server (FRS) filestore, or inconsistencies in the InfoObjects' metadata that is stored in 
the CMS system database. The RDT can be configured to either scan, diagnose, and repair 
inconsistencies, or scan, diagnose, and log the inconsistencies for later repair by administrators.

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● Use the Repository Diagnostic tool

Terminology

The Repository Diagnostic Tool (RDT)
The Repository Diagnostic Tool (RDT) is a command-line tool that scans, diagnoses, and 
repairs inconsistencies that may occur between your Central Management Server (CMS) 
system database and the File Repository Servers (FRS) filestore, or inconsistencies that can 
occur in the metadata of InfoObjects stored in the CMS database.

Inconsistencies
During normal operations, it is unusual for the CMS system database to have 
inconsistencies. However, inconsistencies may occur during unexpected events such as 
disaster recovery, back-up restoration, or network outages. During these events, the CMS 
system database may be interrupted while performing a task. This interuption can cause 
inconsistencies with objects in the CMS system database.

The RDT scans for two types of inconsistencies.

1. Object inconsistency

These inconsistencies can occur when an InfoObject in the CMS database does not have 
the corresponding files, which are missing in the File Repositories. For example, a file that 
is stored in the FRS may be missing a corresponding object in the CMS system database.

2. File Inconsistency

These inconsistencies can occur when a file that is located in the File Repository does not 
have the corresponding InfoObject in the CMS database. For example, an InfoObject may 
reference another InfoObject that does not exist in the CMS database.

The RDT preforms two functions, depending on the parameters that you provide when you run 
the tool:
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● It scans the CMS system database and FRS filestore, reports inconsistencies, and outputs a 
log file in XML format with suggested actions to repair the inconsistencies.

● It scans and repairs the inconsistencies identified in the CMS system database and FRS, and 
outputs the actions taken to a log file in XML format.

Note:

● Do not run the RDT against a live CMS database and FRS. Changes that your users 
make to the CMS or FRS while the RDT is running can create new inconsistencies 
in your deployment. Repair actions that the RDT takes while users are accessing 
your deployment can create further inconsistencies.

● We recommend that you back up your CMS database and FRS filestore, and run 
the RDT against the backed-up version while your SAP BusinessObjects BI 
platform services are down.

● The RDT does not require the CMS service to be running. The RDT runs directly 
against the CMS database.

To Use the Repository Diagnostic Tool

1. On a Windows computer, open a command window and run the following command.
<INSTALLDIR>\SAP BusinessObjects Enterprise XI 
4.0\win64_x64\reposcan.exe <arguments>where <arguments> is the list of 
parameters you want to specifiy.

The Repository Diagnostic Tool scans your repository for inconsistencies. Depending on the 
parameters that you specify, it either diagnoses and logs inconsistencies, or it repairs 
inconsistencies and logs the action that it takes.

Repo_Scan_yyyy_mm_dd_hh_mm_ss.xml lists the inconsistencies that the tool finds. If you 
had the tool repair the discrepancies that it finds, it also creates the file 
Repo_Repair_yyyy_mm_dd_hh_mm_ss.xml .

The path to the log files can be specified by the outputdir parameter. If this parameter is not 
specified, the default directory for the log files is <INSTALLDIR>\SAP BusinessObjects 
Enterprise XI 4.0\reposcan .

Note:
The application also provides a default XSL file that is used with the XML file to 
produce an HTML page. The XSL file is stored in <INSTALLDIR>\SAP 
BusinessObjects Enterprise XI 4.0\reposcan .

Lesson: Using the Repository Diagnostic Tool
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Table 16: Repository Diagnostic Tool

Mandatory Parameter Description

dbdriver The type of driver used to connect to the CMS 
database. Accepted values are:

● db2databasesubsystem

● maxdbdatabasesubsystem

● mysqldatabasesubsystem

● oracledatabasesubsystem

● sqlserverdatabasesubsystem

● sybasedatabasesubsystem

connect The connection details that are used to con-
nect to the CMS database.For example -con-
nect ”UID=root;PWD=<pass-
word>;DSN=<dsn>;HOSTNAME=<host-
name>;PORT=<portnumber>”

dbkey Enter the cluster key for your BI platform de-
ployment.

inputfrsdir The file path of the Input File Repository Serv-
er.

outputfrsdir The file path of the Output File Repository 
Server.

Note:
For more optional parameter, refer to http://help.sap.com/

How to Run Repository Diagnostic Tool
Demonstrate how Reposcan works on the server.

1. Go to the Command Prompt and change the directory to the location where the Repository 
Diagnostic Tool is located.

2. Run the reposcan.exe .
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Note:

● Remember to put double quotes around the directory path.

● Leave no spaces between -connect parameters.

● Dbdriver - the name of the database type of your CMS system database.

● The command runs the scan without repairing it.

● Be sure to add the dbkey field

● Use this example: D:\Program Files (x86)\SAP BusinessObjects\SAP 
BusinessObjects Enterprise XI 4.0 \win64_x64>\reposcan.exe" 
-dbdriver sqlserverdatabasesubsystem -connect 
"UID=boadmin;PWD=BOTraining;DSN=BOE4x" -dbkey cms123 -
inputfrsdir "D:\Program Files (x86)\SAP BusinessObjects\SAP 
BusinessObjects Enterprise XI 4.0\FileStore\Input" -
outputfrsdir "D:\Program Files (x86)\SAP BusinessObjects\SAP 
BusinessObjects Enterprise XI 4.0\FileStore\Output

3. Navigate to the .xml file location as indicated by the status of the command line to see the 
output of the Repository Diagnostic Tool.

4. Create a new Folder within the CMC.
You are now going to create an inconsistency between the CMS system database and the 
specific file in the Input FRS.

5. Copy the existing Crystal Reports to the new folder.

6. Rename the file on the Input FRS.

7. Run the Repository Diagnostic Tool again to look for inconsistencies.

8. Review the output to check for the inconsistency that has been created as a result of your 
action.

Inconsistencies Between CMS and FRS
The following table describes the inconsistencies that may between a Central Management 
Server (CMS) database and the File Repository Servers (FRS) that are recognized by the 
Repository Diagnostic Tool (RDT).

Table 17: Inconsistencies between the CMS and the FRS

Inconsistency Recommendation Action

The object exists in the CMS 
database, but there is no cor-
responding file in the FRS.

Allow the application to re-
move the missing files from 
the object's file list.

The RDT removes the object 
from the CMS database.
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Inconsistency Recommendation Action

The file exists in the FRS, but 
there is no corresponding file 
in the CMS database.

Republish the file. The applica-
tion will not publish this file for 
you.

When you republish the file, an 
object is created in the CMS 
database.

The size of the file does not 
match the InfoObject file size.

Allow the application to update 
the object with the correct file 
size.

The RDT updates the file size 
in the CMS database.

The FRS folder is empty. Allow the application to re-
move the directory.

The RDT removes the empty 
directory.

Inconsistencies in CMS Metadata
The following table describes the inconsistencies that can occur in the metadata of the objects 
that are in a Central Management Server (CMS) system database that are recognized by the 
Repository Diagnostic Tool (RDT).

Table 18: Inconsistencies in the CMS Metadata

Inconsistency Recommendation Action

The object has a missing or in-
valid Parent Object ID.

Allow RDT to move the object 
to the BO Repair folder.

The RDT moves the object and 
any child objects to a repair 
folder. Only the administrator 
has access to this folder.

The object has a missing or in-
valid Owner Object ID.

Allow the RDT to assign the 
object to the Administrator.

The RDT assigns the value of 
the Administrator's ID to the 
objects Owner ID.

The object has a missing or in-
valid Submitter Object ID.

The recommendation that the 
RDT displays depends on 
whether you have provided a 
value for the -submitterid pa-
rameter.

● If you provide this parame-
ter, then we recommend 
that you allow the applica-
tion to update the object 
with the provided submitter 
ID.

● If you do not provide this 
parameter, then we recom-
mend that you reschedule 
the object or submit a user 
ID to use to replace the in-
valid submitter ID.

If you provide a value from the 
-submitterid parameter, the 
RDT applies the value for the 
object's submitter ID. If you 
don't provide a value for this 
parameter, the RDT takes no 
action. When you reschedule 
the object, the CMS applies a 
new ID.
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Inconsistency Recommendation Action

The object's last successful in-
stance is missing or invalid.

Allow the application to recal-
culate the property.

When you reschedule the ob-
ject, the CMS automatically re-
calculates the ID.

The object references a calen-
dar that does not exist.

Reschedule the object with an 
existing calendar. No action 
can be taken by this applica-
tion.

When you reschedule the ob-
ject, the CMS applies a calen-
dar to the object.

The preferred server does not 
exist.

Reschedule the object and 
choose an existing server 
group. No action can be taken 
by this application.

When you reschedule the ob-
ject, the CMS applies a server 
group to the object.

The event or events that this 
object is waiting on does not 
exist.

Allow the application to re-
move the missing events from 
the object's list of events to 
wait for.

The RDT removes the missing 
events.

This object triggers an event 
that does not exist.

Allow the application to re-
move the missing events from 
the object's list of events to 
trigger.

The RDT removes the missing 
events.

Orphaned Access Control en-
try.

Allow the application to re-
move the missing principal 
from the object's Access Con-
trol List.

The RDT removes the missing 
principal.

The preferred server does not 
exist.

Allow the tool to remove the 
object's invalid entries from its 
Server Group list.

The RDT removes the objects 
missing entries from the ob-
ject's server group list.

A specific user account has 
multiple Favorites folders.

Allow the application to con-
solidate multiple Favorites 
folders into a single Favorites 
folder.

The RDT consolidates the us-
er's Favorites folders into a 
single folder.

Lesson: Using the Repository Diagnostic Tool

© Copyright . All rights reserved. 155



Facilitator Producer

Say:

We will be starting a group chat activity. I will 
be pasting a series of questions in the Chat 
pod, and I ask that you enter your response 
after each question is posted.

After you have entered your response to each 
question, review your classmates' responses.

I will select some responses to discuss as a 
group.

Do:

Display the first question on the slide provid-
ed in the Instructor Presentation Deck. Dis-
play the questions one at a time.

Explain to participants that you will be posting 
a series of questions (every 30 seconds or so) 
in the chat area.

Ask students to answer their questions based 
on their independent study and then to review 
their classmates' answers.

Select the response from one participant and 
copy and paste it to the whiteboard.

As a large group (using audio), discuss the re-
sponse.

Remind students to participate actively in the 
class discussion, noting information of inter-
est in their Participant Handbook.

Do:

Assist by pasting the prewritten questions in-
to the Chat pod.

If desired, archive the Chat pod and white-
board overlay for later reference and distribu-
tion.
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INTERACTIVE ELEMENT: Chat

1. Explain where Repository Diagnostic Tool log files can be found if the default directory is 
not changed.

.

.

.

.

.

.

.

.

.

.

2. Which files are logged by the Repository Diagnostic tool?

.

.

.

.

.

.

.

.

.

.

3. Name an inconsistency between the CMS and the FRS. Explain how to resolve this 
inconsistency.

.

.

.

.

.

.

.

.
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Unit 6
Exercise 6

149
Run the Repository Diagnostic Tool

Business Example

As the system administrator, you must periodically scan the report for some potential objects 
and file inconsistencies on your Business Intelligence 4 platform.

Scanning the Platform for Inconsistencies with the Repository Diagnostic Tool

1. Run the Repository Diagnostic Tool for scanning the File Repository objects on the BI 4 
platform.

2. Check the Diagnostic file created by the Repository Diagnostic Tool. In the previous 
exercise on the File Repository Servers, you renamed the file repository object with an .OLD 
extension. Did Reposcan discover this inconsistency? Is it an Inconsistent Object or and 
Inconsistent File?
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150
Run the Repository Diagnostic Tool

Business Example

As the system administrator, you must periodically scan the report for some potential objects 
and file inconsistencies on your Business Intelligence 4 platform.

Scanning the Platform for Inconsistencies with the Repository Diagnostic Tool

1. Run the Repository Diagnostic Tool for scanning the File Repository objects on the BI 4 
platform.
a) Double-click the CMD server icon on the desktop.

b) Change the current directory to the following: C:> CD “D:\Program Files 
(x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 
4.0\win64_x64 , then change the current directory to the following: C:> D :, then check 
that the following directory is correct in the prompt command windows : D:\Program 
Files (x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 
4.0\win64_x64>

c) In the command prompt window, enter the following command line:
reposcan.exe 
-dbdriver sqlanywheredatabasesubsystem 
-connect “UID=dba;PWD=admin41;DSN=BI4_CMS_DSN“
-dbkey CMSkey 
-inputfrsdir "d:\Program Files (x86)\SAP BusinessObjects\SAP 
BusinessObjects Enterprise XI 4.0\FileStore\Input" 
-outputfrsdir "d:\Program Files (x86)\SAP BusinessObjects\SAP 
BusinessObjects Enterprise XI 4.0\FileStore\Output”
2. Check the Diagnostic file created by the Repository Diagnostic Tool. In the previous 

exercise on the File Repository Servers, you renamed the file repository object with an .OLD 
extension. Did Reposcan discover this inconsistency? Is it an Inconsistent Object or and 
Inconsistent File?
a) Go to the folder that contains the Repository Scan Report by navigating in Windows 

Explorer to: D:\Program Files (x86)\SAP BusinessObjects\SAP 
BusinessObjects Enterprise XI 4.0\reposcan .

Hint:
The Repository Scan Report is an .XML file.

b) In Windows Explorer, double-click the Repository Scan Report file to open the report.
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c) Evaluate the scan summary and detailed inconsistencies in the report.
The Repository Diagnostic Tool found two inconsistencies with regard to the renamed file 
repository object:

● One inconsistent object -- The World Sales Report object references files that do not 
exist in the File Repository Server (FRS)

● One inconsistent file -- The .OLD file exists in the Input or Output FRS, but there is no 
corresponding InfoObject in the repository.
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LESSON SUMMARY
You should now be able to:

● Use the Repository Diagnostic tool
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Unit 6

153
Learning Assessment

1. Which type of server stores report and program objects that have been published to the 
system by administrators?

Choose the correct answer.

X A Central Management Server

X B Output File Repository Server

X C Audit File Repository

X D Input File Repository Server

2. An Output FRS stores all of the report instances generated by the Job Server.

Determine whether this statement is true or false.

X True

X False

3. Which two types of inconsistencies does the RDT scan for?

Choose the correct answers.

X A Object to file inconsistencies

X B Object to data server inconsistencies

X C InfoObject to CMS inconsistencies

X D InfoObject metadata inconsistencies
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4. Match the inconsistency between the CMS and the FRS with the appropriate action.

Match the item in the first column to the corresponding item in the second column.

The FRS folder is empty.

The file exists in the FRS, but 
there is no corresponding file 
in the CMS database.

The object exists in the CMS 
database, but there is no cor-
responding file in the FRS.

The size of the file does not 
match the InfoObject file size.

When you republish the file, an 
object is created in the CMS 
database.

The RDT removes the empty 
directory.

The RDT updates the file size 
in the CMS database.

The RDT removes the object 
from the CMS database.
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155
Learning Assessment - Answers

1. Which type of server stores report and program objects that have been published to the 
system by administrators?

Choose the correct answer.

X A Central Management Server

X B Output File Repository Server

X C Audit File Repository

X D Input File Repository Server

2. An Output FRS stores all of the report instances generated by the Job Server.

Determine whether this statement is true or false.

X True

X False

3. Which two types of inconsistencies does the RDT scan for?

Choose the correct answers.

X A Object to file inconsistencies

X B Object to data server inconsistencies

X C InfoObject to CMS inconsistencies

X D InfoObject metadata inconsistencies
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4. Match the inconsistency between the CMS and the FRS with the appropriate action.

Match the item in the first column to the corresponding item in the second column.

The FRS folder is empty.

The file exists in the FRS, but 
there is no corresponding file 
in the CMS database.

The object exists in the CMS 
database, but there is no cor-
responding file in the FRS.

The size of the file does not 
match the InfoObject file size.

The RDT removes the empty 
directory.

When you republish the file, an 
object is created in the CMS 
database.

The RDT removes the object 
from the CMS database.

The RDT updates the file size 
in the CMS database.
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UNIT 7 Adaptive Servers

Lesson 1

Managing the Adaptive Job Server 168
Exercise 7: Manage the Adaptive Job Server 173

Lesson 2

Managing the Adaptive Processing Server 179
Exercise 8: Manage the Adaptive Processing Server 183

UNIT OBJECTIVES

● Configure the Adaptive Job server

● Configure the Adaptive Processing server

● Manage Multi-Dimensional Analysis service
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Unit 7
Lesson 1

158
Managing the Adaptive Job Server

LESSON OVERVIEW
The Adaptive Job server processes scheduled jobs. Job servers can be configured to process 
reports, documents, programs, or publications, and send the results to selected destinations. The 
Adaptive Job server hosts various authentication and scheduling services, which support this 
processing.

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● Configure the Adaptive Job server

Adaptive Job Server Services
The Adaptive Job server is a general server that processes scheduled jobs. When you add a Job 
server to the SAP BusinessObjects Business Intelligence platform, you can configure the Job 
server to process reports, documents, programs, or publications and send the results to different 
destinations.

The following table describes each of the services in the Adaptive Job server.

Table 19: Adaptive Job Servers

Service Service Category Service Description

Authentication Update Sched-
uling Service

Core Services Provides synchronization of 
updates for third party securi-
ty plug-ins.

Crystal Reports 2011 Schedul-
ing Service

Crystal Reports Services Accepts and processes Crystal 
Reports 2011 reports. It can 
share data between reports to 
reduce the number of data-
base accesses.

Crystal Reports Scheduling 
Service

Crystal Reports Services Runs scheduled legacy Crystal 
Reports jobs and publishes the 
results to a given output loca-
tion.
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Service Service Category Service Description

Destination Delivery Schedul-
ing Service

Core Services Runs scheduled jobs and pub-
lishes the results to a given 
output location, such as the 
file system, FTP, e-mail, or a 
user inbox.

Lifecycle Management Sched-
uling Service

Lifecycle Management Serv-
ices

Runs scheduled Lifecycle Man-
agement jobs.

Platform Search Scheduling 
Service

Core Services Runs scheduled search to in-
dex all content in the Central 
Management Server (CMS) re-
pository.

Probe Scheduling Service Core Services Provides scheduled Probe jobs 
and publishes the results to a 
given output location.

Program Scheduling Service Core Services Runs programs that have been 
scheduled to run at a given 
time.

Publication Scheduling Service Core Services Runs scheduled publishing 
jobs and publishes the results 
to a given output location.

Replication Service Core Services Runs scheduled federation 
jobs to replicate content be-
tween federated sites.

Security Query Scheduling 
Service

Core Services Runs scheduled Security 
Query jobs.

Visual Difference Scheduling 
Service

Lifecycle Management Serv-
ices

Runs scheduled Visual Differ-
ence (Lifecycle Management) 
jobs and publishes the results 
to a given output location.

Web Intelligence Scheduling 
Service

Web Intelligence Service Enables support for scheduled 
Web Intelligence jobs.

Scheduled Program Running

The Program Scheduling Service now runs on the Adaptive Job server. In the previous version, it 
was a separate server called the Program Job server.

The following steps explain the interaction of platform components when a scheduled program 
object is run.
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1. The Central Management Server (CMS) checks the CMS system database to determine if 
there is any scheduled programs to be run at that time.

2. When the scheduled job time arrives, the CMS locates an available Program Scheduling 
Service running on an Adaptive Job server. The CMS sends the job information to the 
Program Scheduling Service.

3. The Program Scheduling Service communicates with the Input File Repository Server (FRS) 
to obtain the program object. Note: this step also requires communication (not shown in this 
diagram) with the Central Management Server (CMS) and the CMS system database to locate 
the required server and objects.

4. The Program Scheduling Service launches the program.

5. The Program Scheduling Service updates the CMS periodically with the job status. At this 
time, the status shows that it is processing.

6. The Program Scheduling Service sends a log file to the Output File Repository Server. The 
Output File Repository Server notifies the Program Scheduling Service that the object was 
scheduled successfully by sending an object log file. Note: this step also requires 
communication (not shown in this diagram) with the Central Management Server (CMS) and 
the CMS system database to locate the required server and objects.

7. The Program Scheduling Service updates the CMS with the job status. At this time, the status 
is reported as a success.

8. The Central Management Server (CMS) updates the job status in its memory, and then writes 
the object instance information to the CMS system database.

Figure 20: Run a scheduled program
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Adaptive Job Server Properties

Table 20: General Properties

Property Description Default Value

Temporary Directory Specifies the directory where 
temporary files are created on 
when necessary. You may en-
counter performance issues if 
this directory does not have 
adequate disk space. For bet-
ter performance, ensure that 
this directory is located on a 
local disk.

%DefaultDataDir%

Note:
You must restart the server for changes to take effect.

The Adaptive Job server can host a number of different services. Each service has the following 
properties:

Table 21: Service Properties

Property Description Default Value

Maximum Concurrent Jobs Specifies the number of con-
current independent process-
es (child processes) that the 
server allows. You can adjust 
the maximum number of jobs 
to suit your reporting environ-
ment.

The default setting is accepta-
ble for most reporting scenar-
ios. The ideal setting for your 
reporting environment de-
pends on your hardware con-
figuration, database software, 
and reporting requirements.

The default value is 5.

Maximum Child Requests Specifies the number of jobs 
the child will process before 
restarting.

The value is 100.

Lesson: Managing the Adaptive Job Server
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Manage the Adaptive Job Server

Business Example

As the system administrator, you need to set a default destination for all the scheduling jobs.

Configure the Adaptive Job Server
Configure the Adaptive Job Server to schedule documents to your file system.

Note:
This task needs to be performed on the server side where administrative access to 
the file system is required. Remote desktop to the server to perform this task.

1. Create a new folder at the root directory of your file system and name it Train## Folder .

2. Launch the Central Management Console (CMC) and log on with the following details:

Field Name Value

System <hostname>:6400

User name Administrator

Password <assigned password>

Authentication Enterprise

3. In the CMC, navigate to the Adaptive Job server and configure its destination property.

4. Set the destination directory to the new folder you created.

Schedule a Web Intelligence Document to Run Now

1. Log on to SAP BusinessObjects BI Launchpad with the following information.

Field Name Value

System <hostname>:6400

User name administrator

Password <Assigned password>

2. Schedule the Charting Samples document to run.

3. Set the format to PDF and specify the destination to use the Adaptive Job Server's default 
location.
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Schedule a Crystal Report to Run Now

1. Log on to SAP BusinessObjects BI Launchpad with the following information.

Field Name Value

System <hostname>:6400

User name administrator

Password <Assigned password>

2. Schedule the customer list report to run.

3. Set the format to PDF and specify the destination to use the default location of the Adaptive 
Job Server.

Check the Scheduled Jobs
Check in your directory to ensure that the two jobs are completed.

1. Wait a few minutes and then verify that the documents appear in the File System destination.

The Adaptive Job Server has completed the jobs and sent the files to your specified folder in the 
file system.
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165
Manage the Adaptive Job Server

Business Example

As the system administrator, you need to set a default destination for all the scheduling jobs.

Configure the Adaptive Job Server
Configure the Adaptive Job Server to schedule documents to your file system.

Note:
This task needs to be performed on the server side where administrative access to 
the file system is required. Remote desktop to the server to perform this task.

1. Create a new folder at the root directory of your file system and name it Train## Folder .

a) Navigate to the D: drive of the file system.

b) At the root level of D: drive, create a folder and name it Train## Folder .

2. Launch the Central Management Console (CMC) and log on with the following details:

Field Name Value

System <hostname>:6400

User name Administrator

Password <assigned password>

Authentication Enterprise

a) Click Start → Programs → SAP BusinessObjects BI platform 4 → SAP BusinessObjects BI 
platform → SAP BusinessObjects BI platform Central Management Console .

b) Log on with your username and password.

3. In the CMC, navigate to the Adaptive Job server and configure its destination property.
a) In the CMC Home page, click the Servers option.

b) Click the Servers List option.

c) Right-click the Adaptive Job Server and select the Destination menu option.

4. Set the destination directory to the new folder you created.
a) In the Destination selection box, select File System a nd click Add .
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b) In the Directory field, enter the path to the folder you created earlier, for example D:/
Train## Folder .

Hint:
Type the absolute path to the directory including the correct slashes before 
the UNC (example: \\servername\train02). The directory can be on a local 
drive on which the Adaptive Job server runs, or on a UNC path that points to 
any other locations.

c) Select the Use Specific Name option.

d) Use the Add placedholder selection box to add Title to your file name.

e) Select the Add File Extension option.

f) Click the Save & Close button.

Schedule a Web Intelligence Document to Run Now

1. Log on to SAP BusinessObjects BI Launchpad with the following information.

Field Name Value

System <hostname>:6400

User name administrator

Password <Assigned password>

a) Click Start → Programs → SAP BusinessObjects BI platform 4 → SAP BusinessObjects BI 
platform → SAP BusinessObjects BI platform Java BI Launch Pad .

b) Log on with your username and password.

2. Schedule the Charting Samples document to run.
a) Click the Documents tab.

b) Click the Folders option.

c) Navigate to All Folders → Web Intelligence Samples .

d) Right-click Charting Samples and select the Schedule menu option.

3. Set the format to PDF and specify the destination to use the Adaptive Job Server's default 
location.
a) Click the Formats tab, select Adobe Acrobat in Format Options for Selected Document .

b) Click the Destinations tab, select File System in the Destination selection box.

c) Ensure that the Use defaults settings checkbox is selected.

d) Click the Schedule button.
The History page appears. Refresh the page to check if the job ran successfully.
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Schedule a Crystal Report to Run Now

1. Log on to SAP BusinessObjects BI Launchpad with the following information.

Field Name Value

System <hostname>:6400

User name administrator

Password <Assigned password>

a) Click Start → Programs → SAP BusinessObjects BI platform 4 → SAP BusinessObjects BI 
platform → SAP BusinessObjects BI platform Java BI Launch Pad .

b) Log on with your username and password.

2. Schedule the customer list report to run.
a) Click the Documents tab.

b) Click the Folders option.

c) Navigate to All Folders → Report Samples → Demonstration .

d) Right-click customer list report and select theSchedule menu option.

3. Set the format to PDF and specify the destination to use the default location of the Adaptive 
Job Server.
a) Click the Formats tab, and select PDF in the Format Options for Selected Document menu.

b) Click the Destinations tab, and select File System in the Destination selection box.

c) Ensure that the Use defaults settings checkbox is selected.

d) Click the Schedule button.
The History page appears. Refresh the page to check if the job ran successfully.

Check the Scheduled Jobs
Check in your directory to ensure that the two jobs are completed.

1. Wait a few minutes and then verify that the documents appear in the File System destination.
a) Navigate to the folder you created earlier in the file system.

b) There should be two files in your folder, one for the Crystal Rreport and one for the Web 
Intelligence document. The formats should be PDF.

The Adaptive Job Server has completed the jobs and sent the files to your specified folder in the 
file system.

Lesson: Managing the Adaptive Job Server
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LESSON SUMMARY
You should now be able to:

● Configure the Adaptive Job server
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Managing the Adaptive Processing Server

LESSON OVERVIEW
The Adaptive Processing server hosts services that process requests from various sources. 
These services include, but are not limited to, core services, Web Intelligence services, 
connectivity services, and Lifecycle Management services. The server provides Administrators 
easy access to management and configuration option through the Metrics and Properties 
screens.

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● Configure the Adaptive Processing server

● Manage Multi-Dimensional Analysis service

Adaptive Processing Server Role
Adaptive Processing server is a generic server that hosts services responsible for processing 
requests from various sources.

The following table lists all the services that are hosted by the Adaptive Processing server.

Table 22: Adaptive Processing Server Services

Service Service category Service description

Adaptive Connectiv-
ity Service

Connectivity Services Provides connectivity services (replaces Con-
nection Server).

BEx Web Applica-
tion Service

Analysis Services Provides integration of SAP Business Ware-
house (BW) Business Explorer (BEx) Web appli-
cations with BI launch pad.

Client Auditing 
Proxy Service

Core Services Collects auditing events sent from clients and 
forwards them to the CMS server.

Custom Data Ac-
cess Service

Connectivity Services Provides dynamic connections to data sources 
that do not require a Connection server.

Data Federation 
Service

Data Federation Serv-
ices

Data Federation service.

Document Recovery 
Service

Web Intelligence Serv-
ices

Web Intelligence document auto-save and re-
covery.
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Service Service category Service description

DSL Bridge Service Web Intelligence Serv-
ices

Dual Semantic Layer (DSL) session support.

Excel Data Access 
Service

Connectivity Services Supports Excel files uploaded to SAP Busines-
sObjects BI platform as data sources.

Web Intelligence 
Monitoring Service

Web Intelligence Serv-
ices

Monitors Web Intelligence servers.

Lifecycle Manage-
ment ClearCase 
Service

LifecycleManagement 
Services

Provides ClearCase support for LCM.

Lifecycle Manage-
ment Service

LifecycleManagement 
Services

Lifecycle Management Core service.

Monitoring Service Core Services Provides monitoring functions.

Multi Dimensional 
Analysis Service

Analysis Services Provides access to multi-dimensional Online An-
alytical Processing (OLAP) data; converts the 
raw data into XML, which can be rendered into 
Excel, PDF, or Analysis (formerly Voyager) 
crosstabs and charts.

Platform Search 
Service

Core Services Provides searching functionality for the plat-
form.

Publishing Post 
Processing Service

Core Services Performs actions on reports after they have 
completed, such as sending a report to a specif-
ic output location.

Publishing Service Core Services Coordinates with the Publishing Post Processing 
Service and Destination Job Service to publish 
reports to a given output location, such as the 
file system, FTP, e-mail, or a user's inbox.

Rebean Service Web Intelligence Serv-
ices

SDK used by Web Intelligence and Explorer

Security Token 
Service

Core Services SAP Single Sign-On support

Translation Service Core Services Translates InfoObjects with input from the 
Translation Manager client.

Visual Difference 
Service

LifecycleManagement 
Services

Determines whether documents are visually 
identical for document promotion and Lifecycle 
Management.

Visualization Serv-
ice

Web Intelligence Serv-
ices

Common Visualization Object Model Service, 
used by Web Intelligence.
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Adaptive Processing Server Properties

Table 23: General Properties

Property Description Default Value

Service Startup 
Timeout (seconds)

Specifies the amount of time, in seconds, that the 
server will wait for services to start. If a service 
fails to start within the time specified, there are 
two possible reasons:

● The service failed, for example, because a re-
quired resource such as a database could not 
be found, or the service encountered a port 
conflict.

● The service could not start within the specified 
time, for example, because the system is too 
slow.

To find the reason, check the server log file. If the 
service could not start within the time specified, 
consider increasing this value.

The default value is 
1200 seconds.

Adaptive Processing Server Metrics
The following table describes the server metrics that appear on the Metrics screen for Adaptive 
Processing servers.

Table 24: Adaptive Processing Server Metrics

Metric Description

Threads in Transport 
Layer

The total number of threads in all thread pools of the transport layer.

Transport Layer 
Thread Pool Size

The total number of shared transport layer threads. These threads can 
be used by any of the hosted services on the Adaptive Processing serv-
er.

Available Processors The number of processors that are available to the Java Virtual Ma-
chine (JVM) on which the server is running.

Maximum Memory 
(MB)

The maximum amount of memory, in megabytes, that the Java virtual 
machine will attempt to use.

Free Memory (MB) The amount of memory, in megabytes, that is available to the JVM for 
allocating new objects.

Total Memory (MB) The total amount of memory, in megabytes, in the Java virtual machine. 
This value may vary over time, depending on the host environment.
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Metric Description

CPU Usage Percent-
age (last 5 minutes)

The percentage of total CPU time used by the server during the previ-
ous five minutes. For example, if a single thread fully utilizes one CPU of 
a four-CPU system, the utilization is 25%. All processors allocated to 
the JVM are considered. A value of greater than 80% may indicate a 
CPU bottleneck.

CPU Usage Percent-
age (last 15 minutes)

The percentage of total CPU time used by the server during the previ-
ous 15 minutes. For example, if a single thread fully utilizes one CPU of 
a four-CPU system, the utilization is 25%. All processors allocated to 
the JVM are considered. A value of greater than 70% may indicate a 
bottleneck.

Percentage of Stop-
ped System During GC 
(last 5 minutes)

Percentages of stopped system while Garbage Collections (GC) were 
running during the last five minutes. In this state all APS services are 
prevented from executing while the virtual machine performs a critical 
stage of garbage collection that requires exclusive access. Generally, a 
low, single-digit value should be the normal behavior, even under load. 
A double-digit value over time might indicate an issue of low throughput 
and should be investigated.
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Unit 7
Exercise 8

173
Manage the Adaptive Processing Server

Business Example

As the system administrator, you must properly configure client auditing by enabling and 
disabling the Client Auditing Proxy Service (CAPS) located inside the Adaptive Processing Server. 
In addition, for high availability and load balancing purposes, you want to have 2 Adaptive 
Processing Servers with CAPS services.

Use the Client Auditing Proxy Service
To enable client auditing (events sent by clients) you must have a least one Adaptive Processing 
Server with the Client Auditing Proxy Service (CAPS) running. Ensure this service in turned on in 
the CMC.

1. Launch the CMC and log on with the following details:

Field Name Value

System <hostname>:6400

User name Administrator

Password <assigned password>

Authentication Enterprise

2. Navigate to the Adaptive Processing Server.

3. Look up the Client Auditing Proxy Service Metrics.

4. Stop the Adaptive Processing Server.

5. Navigate to the auditing dashboard.

6. Start the Adaptive Processing Server.

7. Look up the Client Auditing Proxy Service Metrics.

Add Another Adaptive Processing Server with Client Auditing Proxy Service
Create another Adaptive Processing Server dedicated only to the Client Auditing Proxy Service. 
This will significantly improve performance and high availability.

1. In the CMC, navigate to the Servers Management page.

2. In the Servers List area, add a new server.

3. Specify the properties and service type for this new server.

4. Enable and start the new Adaptive Processing Server.
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A second Adaptive Processing Server is running for high availability.

Create a New Adaptive Processing Server to Manage Transient Universes
Create a new Adaptive Processing server that is dedicated to the management of transient 
universes for SAP BW Query.

1. In the CMC, navigate to the Server Management page.

2. In the Servers List area, add a new server.

3. Specify the properties and service type for this new server.

4. Configure the JAVA Max Memory Consumption parameter (Xmx) in the properties of this new 
server.

Create a New Adaptive Processing Server to Manage Multiple Sources
Create a new Adaptive Processing server that is dedicated to manage multiple sources with a BI 4 
platform relational universe.

1. In the Central Management Console (CMC), navigate to the Servers Management page.

2. In the Servers List area of the screen, add a new server.

3. Specify the properties and service type for this new server.

4. Configure the JAVA Max Memory Consumption parameter (Xmx) in the properties of this new 
server.

Create a New Adaptive Processing Server for OLAP Data Sources
Create a New Adaptive Processing server that is dedicated to the management of pure OLAP 
data sources, such as Microsoft Analysis Services.

1. In the Central Management Console (CMC), navigate to the Server Management page.

2. In the Servers List area, add a new server.

3. Specify the properties and service type for this new server.

4. Configure the JAVA Max Memory Consumption parameter (Xmx) in the properties of this new 
server.

Create a New Adaptive Processing Server to Manage BIAL Scripting
Create a new Adaptive Processing server that is dedicated to the management of BIAL Scripting 
for Design Studio Analysis Application and Workbook for Analysis Office (SAP BW only).

1. In the Central Management Console (CMC), click the Servers option.

2. In the Servers List area, create a new server.

3. Specify the properties and service type for this new server.

4. Configure the JAVA Max Memory Consumption parameter (Xmx) in the new server 
properties.
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Unit 7
Solution 8

175
Manage the Adaptive Processing Server

Business Example

As the system administrator, you must properly configure client auditing by enabling and 
disabling the Client Auditing Proxy Service (CAPS) located inside the Adaptive Processing Server. 
In addition, for high availability and load balancing purposes, you want to have 2 Adaptive 
Processing Servers with CAPS services.

Use the Client Auditing Proxy Service
To enable client auditing (events sent by clients) you must have a least one Adaptive Processing 
Server with the Client Auditing Proxy Service (CAPS) running. Ensure this service in turned on in 
the CMC.

1. Launch the CMC and log on with the following details:

Field Name Value

System <hostname>:6400

User name Administrator

Password <assigned password>

Authentication Enterprise

a) Click Start → Programs → SAP BusinessObjects BI platform 4 → SAP BusinessObjects BI 
platform → SAP BusinessObjects BI platform Central Management Console .

b) Log on with your username and password.

2. Navigate to the Adaptive Processing Server.
a) Click Servers .

b) Navigate to Service Category → Core Services .

Hint:
Alternately, you can find the Adaptive Processing Server from the Server List .

c) Right-click the Adaptive Processing Server and click Properties .

3. Look up the Client Auditing Proxy Service Metrics.
a) Right-click the Adaptive Processing Server and select Metrics .
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b) Navigate to the Client Auditing Proxy Service Metrics section.

Note:
There should be a metric labeled Number of Audit Events Received Since 
Server Startup . It shows how many client events were routed through this 
Client Auditing Proxy Service . On a busy system and on a long running server 
this number would not be 0.

c) Write down the value of the metric.

4. Stop the Adaptive Processing Server.
a) In the CMC Home page, click Servers .

b) Click Servers List .

c) Right-click the Adaptive Processing Server and select Stop Server .
Wait for a few seconds. A Stale flag appears.

Hint:
Refresh the window if needed using the Refresh button.

5. Navigate to the auditing dashboard.
a) In the CMC Home page, click Auditing .

A warning message appears indicating client auditing is unavailable.

Note:
Warning: Client auditing is unavailable. This indicates that events from client 
tools (for example, BI launch pad, CMC, Web Intelligence Rich Client, and 
Crystal Reports) cannot be received and will be lost.

6. Start the Adaptive Processing Server.
a) In the CMC Home page, click Servers .

b) Click Servers List .

c) Right-click the Adaptive Processing Server and select Start Server .
Wait for a few seconds. The Stale flag disappears and the state becomes running.

7. Look up the Client Auditing Proxy Service Metrics.
a) Right click the Adaptive Processing Server and select Metrics .

b) Navigate to the Client Auditing Proxy Service Metrics section.
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There is a new metric for Number of Audit Events Received Since Server Startup . This 
metric should be different from your previous value because you have just restarted this 
service.

Note:
In a typical environment, the new metric for Number of Audit Events Received 
Since Server Startup would be different from the previous value because you 
just restarted this service. However, in the training environment, the value is 
typically zero at the start of the exercise, so there is no change in value.

Add Another Adaptive Processing Server with Client Auditing Proxy Service
Create another Adaptive Processing Server dedicated only to the Client Auditing Proxy Service. 
This will significantly improve performance and high availability.

1. In the CMC, navigate to the Servers Management page.
a) In the CMC Home page, click Servers .

2. In the Servers List area, add a new server.
a) Click Server List .

b) Click Manage → New → New Server .

3. Specify the properties and service type for this new server.
a) In the Service Category selection box, choose the Core Services option.

b) In the Select Service selection box, choose theClient Auditing Proxy Service option.

c) Click Next .
A window appears to allow you to select additional services for this server.

d) Click Next .

e) Leave the Node field and Server Name field as default. Enter a brief description for this 
server.

f) Click Create .

4. Enable and start the new Adaptive Processing Server.
a) In the Servers page, right-click your new Adaptive Processing Server and select Enable 

Server .

b) Right-click your new Adaptive Processing Server and select Start Server .
Wait for a few seconds. The state becomes running and enabled.

A second Adaptive Processing Server is running for high availability.

Create a New Adaptive Processing Server to Manage Transient Universes
Create a new Adaptive Processing server that is dedicated to the management of transient 
universes for SAP BW Query.

1. In the CMC, navigate to the Server Management page.
a) In the CMC, click the Servers option.
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2. In the Servers List area, add a new server.
a) Click the Server List option.

b) Click the Manage --> New --> New Server options from the menus.

3. Specify the properties and service type for this new server.
a) In the Service Category selection box, choose the Web Intelligence Services option.

b) In the Select Service selection box, select the DSL Bridge Service option.

c) Click the Next button. A window appears that allows you to select additional services for 
this server.

d) Click the Next button.

e) Leave the Node field as the default.

f) Enter the following for the Server Name: 
WDFLBMT50xx.AdaptiveProcessingServerforSAPQueryBW

g) Click the Create button.

Note:
You will see the new Adaptive Processing server in the Web Intelligence 
services. It is recommended to create such a server when you have platform 
content (Web Intelligence documents, Crystal Reports Enterprise, 
Dashboards) that will have direct access to an SAP BW Query (BI 4 platform 
Transient Universes).

Caution:
Do not start the server.

4. Configure the JAVA Max Memory Consumption parameter (Xmx) in the properties of this new 
server.
a) In the Properties window of the new server, keep the Xmx parameter as the default value in 

the Parameters command line (-Xmx2g, by default).

Caution:
Do not start the server.

Create a New Adaptive Processing Server to Manage Multiple Sources
Create a new Adaptive Processing server that is dedicated to manage multiple sources with a BI 4 
platform relational universe.

1. In the Central Management Console (CMC), navigate to the Servers Management page.
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a) In the CMC Home page, click the Servers option. The Servers Management page screen 
appears.

2. In the Servers List area of the screen, add a new server.
a) Click the Server List option.

b) Click the Manage --> New --> New Server menu options.

3. Specify the properties and service type for this new server.
a) In the Service Category selection box, choose the Data Federation Services option.

b) In the Select Service selection box, choose the Data Federation Service option.

c) Click the Next button. A window appears that allows you to select additional services for 
this server.

d) Click the Next button.

e) Leave the Node field as the default. Enter the following in the Server Name field: 
WDFLBMT50xx.AdaptiveProcessingServerforMultiSourceUniverse

f) Click the Create button.

Note:
You will see the new Adaptive Processing server in the Data Federation 
services. It is recommended to create such a server when you have BI 4 
platform content (Web Intelligence documents, Crystal Reports Enterprise, 
Dashboards) that will have access to several data sources by using a platform 
relational multisource universe (.UNX).

Caution:
Do not start the server.

4. Configure the JAVA Max Memory Consumption parameter (Xmx) in the properties of this new 
server.
a) In the server properties window, change the Xmx parameter to 1Gb in the Parameters 

command line. (It is set to -Xmx2g by default.)

Caution:
Do not start the server.

Create a New Adaptive Processing Server for OLAP Data Sources
Create a New Adaptive Processing server that is dedicated to the management of pure OLAP 
data sources, such as Microsoft Analysis Services.

1. In the Central Management Console (CMC), navigate to the Server Management page.
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a) In the CMC Home page, click the Servers option.

2. In the Servers List area, add a new server.
a) Click the Servers List option.

b) Click the Manage --> New--> New Server option on the menus.

3. Specify the properties and service type for this new server.
a) In the Service Category selection box, choose the Analysis Services option.

b) In the Select Service selection box, choose the Multi Dimensional Analysis Service option.

c) Click the Next button. A window appears that allows you to select additional services for 
this server.

d) Click the Next button.

e) Leave the Node field as default. Enter the following name in the Server Name field: 
WDFLBMT50xx.AdaptiveProcessingServerforOLAP .

f) Click the Create button.

Note:
You will see this new Adaptive Processing server in the Analysis Services. It is 
recommended to create this kind of server when you have BI 4 platform 
content (such as Analysis OLAP) that will have access to a single OLAP data 
source.

Caution:
Do not start the server.

4. Configure the JAVA Max Memory Consumption parameter (Xmx) in the properties of this new 
server.
a) In the Properties window of this new server, change the Xmx parameter in the Parameters 

command line to 1 Gb. It is set to -Xmx2g by default.

Caution:
Do not start the server.

Create a New Adaptive Processing Server to Manage BIAL Scripting
Create a new Adaptive Processing server that is dedicated to the management of BIAL Scripting 
for Design Studio Analysis Application and Workbook for Analysis Office (SAP BW only).

1. In the Central Management Console (CMC), click the Servers option.
a) In the CMC Home page, click the Servers option.

2. In the Servers List area, create a new server.
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a) Click the Server List option.

b) Click the Manage --> New --> New Server menu options.

3. Specify the properties and service type for this new server.
a) In the Service Category selection box, choose the Analysis Services option.

b) In the Select Service selection box, choose the Analysis Application Service option.

c) Click the Next button. A window appears that allows you to select additional services for 
the server.

d) Click the Next button.

e) Keep the Node field as default. Enter the following in the Server Name field: 
WDFLBMT50xx.AdaptiveProcessingServerforSAPBWAnalysis .

f) Click the Create button.

Note:
You will see the new Adaptive Processing server in the Analysis Services. It is 
recommended to create such a server when you have BI 4 platform content 
(such as Analysis Office or Design Studio) that has direct access to the SAP 
BW Query.

Caution:
Do not start the server.

4. Configure the JAVA Max Memory Consumption parameter (Xmx) in the new server 
properties.
a) In the new server Properties window, change the Xmx parameter in the Parameters 

command line to 1 Gb. It is set to -Xmx2g by default.

Caution:
Do not start the server.

Lesson: Managing the Adaptive Processing Server

© Copyright . All rights reserved. 191



Analysis Viewing
The following steps explain the interaction of platform components when you view an Analysis.

1. The user accesses BusinessObjects Analysis edition for OLAP via the BI Launchpad. The 
Multi-Dimensional Analysis Service (MDAS) now runs on the Adaptive Processing Server. In 
the previous version, it ran as its own separate server (Multi-Dimensional Analysis Server).

2. The Web application server recognizes the request as a request to view an Analysis 
workspace. The Web application server checks the Central Management Server (CMS) to 
ensure that the user has sufficient rights to view the workspace.

3. The CMS checks the CMS system database to determine if the user has the appropriate rights 
to view the workspace.

4. The CMS sends a response to the Web application server to confirm that the user has 
sufficient rights to view the workspace. At the same time, the CMS also sends a list of one or 
more available Multi-Dimensional Analysis Services.

5. The Web application server picks a Multi-Dimensional Analysis Service (MDAS) from the list 
of available choices and sends a CORBA request to the MDAS to find the appropriate Online 
Analytical Processing (OLAP) servers to refresh an existing workspace.

Note:
The MDAS is a service that runs on an Adaptive Processing Server.

6. The Multi-Dimensional Analysis Service (MDAS) communicates with the Input File Repository 
Server (FRS) to retrieve the appropriate workspace document that has information about the 
underlying OLAP data source and an initial OLAP query saved with it. The Input FRS retrieves 
the appropriate Information Analyzer workspace (.amw) from the underlying directory and 
streams that workspace back to the MDAS.

Note:
This step also requires communication (not shown in this diagram) with the 
Central Management Server (CMS) and the CMS system database to locate the 
required server and objects.

7. The Multi-Dimensional Analysis Service (MDAS) opens the workspace, formulates a query, 
and sends it to the OLAP database server. The MDAS has to have an appropriate OLAP 
database client configured for the OLAP data source so that the Web client query is translated 
into the appropriate OLAP query. The OLAP database server sends the query result back to 
the MDAS.

8. The Multi-Dimensional Analysis Service (MDAS) pre-renders the result to enable the Web 
application server to finish the rendering more quickly. The MDAS sends XML packages of the 
rendered result back to the Web application server.
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9. The Web application server renders the workspace and sends the formatted page or portion 
of the page through the Web server to the Web client. The Web client displays the updated or 
newly requested page.

Figure 21: View an Analysis
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LESSON SUMMARY
You should now be able to:

● Configure the Adaptive Processing server

● Manage Multi-Dimensional Analysis service
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Unit 7

185
Learning Assessment

1. What is the function of the Adaptive Job server?

2. The Probe Scheduling service is on the Adaptive Job server.

Determine whether this statement is true or false.

X True

X False

3. Select the services that are hosted on the Adaptive Processing server.

Choose the correct answers.

X A Server Security Service

X B Platform Search Service

X C Excel Data Access Service

X D Business Intelligence Reporting Service

X E Visualization Service

4. What is the purpose (function) of the Adaptive Processing server?

5. What server hosts the Multi-Dimensional Analysis Service (MDAS)?
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Unit 7

186
Learning Assessment - Answers

1. What is the function of the Adaptive Job server?

The Adaptive Job server processes scheduled jobs (such as reports, documents, programs, 
or publications) and send the results to different destinations.

2. The Probe Scheduling service is on the Adaptive Job server.

Determine whether this statement is true or false.

X True

X False

3. Select the services that are hosted on the Adaptive Processing server.

Choose the correct answers.

X A Server Security Service

X B Platform Search Service

X C Excel Data Access Service

X D Business Intelligence Reporting Service

X E Visualization Service

4. What is the purpose (function) of the Adaptive Processing server?

The Adaptive Processing server is a generic server that hosts services responsible for 
processing requests from various sources.

5. What server hosts the Multi-Dimensional Analysis Service (MDAS)?

The Adaptive Processing server hosts the MDAS.
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Unit 8
Lesson 1

188
Demonstrating Information Flows in Crystal 
Reports

LESSON OVERVIEW
Crystal Reports servers host several services that run under a Server Intelligence Agent (SIA). 
The type of server a Crystal Reports server is, depends on which services are running within it. 
The services also dictate and coordinate the flow of information on Crystal Reports servers. The 
services coordination of information flow and information sharing helps the platform servers and 
databases to run efficiently.

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● Demonstrate how information flows in Crystal Reports

Crystal Reports Services
The following table describes each of the Crystal Reports services.

Table 25: Crystal Reports Services

Service Server type Service Description

Crystal Reports 2011 Process-
ing Service

Crystal Reports Processing 
Server

Accepts and processes Crystal 
Reports 2011 reports. It can 
share data between reports to 
reduce the number of data-
base accesses.

Crystal Reports 2011 Schedul-
ing Service

Adaptive Job Server Runs scheduled legacy Crystal 
Reports jobs and publishes the 
results to a given output loca-
tion.

Crystal Reports 2011 Viewing 
and Modification Service

Report Application Server Report Application Server

Crystal Reports Cache Service Crystal Reports Cache Server Limits the number of database 
accesses generated from 
Crystal reports and increases 
the speed of reporting by man-
aging a cache of reports.
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Service Server type Service Description

Crystal Reports Processing 
Service

Crystal Reports Processing 
Server

Accepts and processes Crystal 
reports. It can share data be-
tween reports to reduce the 
number of database accesses.

Crystal Reports Scheduling 
Service

Adaptive Job Server Runs scheduled new Crystal 
Reports jobs and publishes the 
results to a given output loca-
tion.

Crystal Reports Servers
Servers are collections of services running under a Server Intelligence Agent (SIA) on a host. The 
type of server is denoted by the services running within it. Servers can be created in the Central 
Management Console (CMC). The following table lists the different types of servers that can be 
created in the CMC.

Table 26: Servers

Server kind Service Description

Adaptive Job Server Crystal Reports 2011 Schedul-
ing Service

Crystal Reports Scheduling 
Service

General server that processes 
scheduled jobs. When you add 
a Job server to the SAP Busi-
nessObjects Business Intelli-
gence Platform, you can con-
figure the Job server to proc-
ess reports, documents, pro-
grams, or publications and 
send the results to different 
destinations.

Crystal Reports Cache Server Crystal Reports Cache Service Intercepts report requests 
sent from clients to the page 
server. If the cache server can-
not fulfill the request with a 
cached report page, it passes 
the request on to the Crystal 
Reports Processing server, 
which runs the report and re-
turns the results. The cache 
server then caches the report 
page for potential future use.
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Server kind Service Description

Crystal Reports Processing 
Server

Crystal Reports 2011 Process-
ing Service

Crystal Reports Processing 
Service

Responds to page requests by 
processing reports and gener-
ating encapsulated page for-
mat (EPF) pages. The key ben-
efit of EPF is that it supports 
page-on-demand access, so 
only the requested page is re-
turned, not the entire report. 
This improves system per-
formance and reduces unnec-
essary network traffic for large 
reports.

Report Application Server Crystal Reports 2011 Viewing 
and Modification Service

Provides ad-hoc reporting ca-
pabilities that allow users to 
create and modify Crystal re-
ports via the SAP Crystal Re-
ports Server Embedded Soft-
ware Development Kit (SDK).

Note:

An Encapsulated Page Format (.epf) file contains all the necessary formatting 
information to display a complete page of the report.

An Encapsulated Tree Format (.etf) file stores the group tree information for a 
report. A group tree appears on the left-side panel of the report viewer window when 
a report is viewed.

LESSON SUMMARY
You should now be able to:

● Demonstrate how information flows in Crystal Reports
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Unit 8
Lesson 2

191
Configuring Crystal Reports

LESSON OVERVIEW
The Crystal Reports servers are accessed through the Service Categories container on the CMC. 
Each server's right-click menu options provide administrators with entry to the server metric 
information and properties. Crystal Reports servers are easily configured through these 
individual Properties screens.

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● Configure Crystal Reports servers

Crystal Reports Services Properties

Note:
Any properties that apply to both Crystal Reports Cache servers and Crystal Reports 
Processing servers should be set to the same value. For example, if you set the Viewer 
Refresh Always Yields Current Data setting to TRUE on the Cache server, you should 
set the same property to TRUE on the Processing server.

The Crystal Reports service category includes the following servers:

● Crystal Reports Cache server

● Crystal Reports Processing server

● Crystal Reports 2013 Report Application server properties

● Crystal Reports 2013 Processing server

Table 27: Crystal Reports Cache Service Properties

Property Description

Viewer Refresh Always Yields Cur-
rent Data

Specifies whether or not all cached pages are ignored and 
new data is retrieved directly from the database when 
users explicitly refresh a report.

Share Report Data Between Clients Specifies whether report data is shared between different 
clients.
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Property Description

Idle Connection Timeout (minutes) Specifies the amount of time, in minutes, that the Crystal 
Reports Cache server waits for a request from an idle 
connection. There is generally no need to modify the de-
fault value.

Security Cache Timeout (minutes) Specifies the amount of time, in minutes, that the server 
uses cached logon credentials, report parameters, and 
database connection information to serve requests be-
fore querying the CMS.

Oldest On-Demand Data Given to 
Clients (seconds)

Specifies the amount of time, in seconds, that the server 
uses cached data to meet requests from ondemand re-
ports. If the server receives a request that can be met us-
ing data that was generated to meet a previous request, 
and the time elapsed since that data was generated is less 
than the value set here, then the server will reuse this da-
ta to meet the subsequent request. Reusing data in this 
way significantly improves system performance when 
multiple users need the same information. When setting 
this value consider how important it is that users receive 
up-to-date data. If it is important that all users receive 
fresh data (perhaps because important data changes fre-
quently) you may need to disallow this kind of data reuse 
by setting the value to 0.

Maximum Cache Size (KB) Specifies the amount of hard disk space (in KB) that is 
used to cache reports. A large cache size may be neces-
sary if the server handles large numbers of reports, or re-
ports that are especially complex.

Cache Files Directory Specifies the location of the cache file directory.

Java VM Arguments Specifies the command-line arguments that can be sup-
plied to the JVM.

DLL Name Specifies the name of the document type plugin that is 
currently loaded. The property is read only, rasprocRe-
port.
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Facilitator Producer

Say:

"We'll be starting a group chat activity. I will 
be pasting a series of questions into the Chat 
Pod and ask that you enter your response af-
ter each question is posted."

"I will select some responses to discuss as a 
group."

Do:

Display the first question on the slide provid-
ed in the Instructor Presentation deck. Dis-
play questions one at a time.

Ask them to answer their questions based on 
their independent study and then to review 
their classmates answers.

Select the response from one participant and 
copy and paste it to the whiteboard.

Do:

Assist by pasting the prewritten questions in-
to the Chat Pod.

If desired, archive the Chat Pod and white-
board overlay for later reference and distribu-
tion.

INTERACTIVE ELEMENT: Chat

1. Discuss how you can improve RAS performance when working in the Crystal Reports 2011 
Report Application Server Properties table.

.

.

.

.

.

.

.

.

.
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Crystal Reports 2013 Report Application Server Properties

Table 28: Crystal Reports 2013 Report Application Server Properties

Property Description Default Value

Allow Report Jobs to 
Stay Connected to the 
Database until the Re-
port Job is Closed

Specifies whether or not the report 
job will remain connected to the data-
base until the process has been exe-
cuted.

The default value is FALSE.

Browse Data Size (re-
cords)

Specifies the number of distinct re-
cords returned from the database 
when browsing through a particular 
field value. The data is retrieved first 
from the client's cache (if it is availa-
ble) and then from the server cache. If 
the data is not in either cache, it is re-
trieved from the database.

The default value is 100 re-
cords.

Idle Connection Time-
out (minutes)

Specifies the amount of time, in mi-
nutes, that the Report Application 
server (RAS) waits for requests from 
an idle client before timing out. Set-
ting a value too low can cause a user 
request to be closed prematurely. 
Setting a value that is too high can af-
fect the server scalability. (For in-
stance, if the ReportClient Docu-
ment object is not closed explicitly, 
the server will be waiting unnecessari-
ly for an idle job to close.)

The default value is 30 mi-
nutes

Batch Size (records) Specifies how many rows from the re-
sult set are returned by the database 
during each data transfer. For exam-
ple, if 500 records are requested, and 
the Batch Size property is set to 100 
records, the data will be returned in 5 
separate batches of 100 rows. To im-
prove the performance of your RAS, 
understand your network environ-
ment, database, and the type of re-
quests to set the appropriate batch 
size.

The default value is 100 re-
cords.

Unit 8: Crystal Reports Servers

204 © Copyright . All rights reserved.



Property Description Default Value

Number of database 
records to read when 
previewing or refresh-
ing a report (-1 for un-
limited)

Specifies the number of database re-
cords that will be read when viewing 
or refreshing a report. This setting 
limits the number of records that the 
server retrieves from the database 
when a user runs a query or report. 
This setting is useful when you want 
to prevent users from running on-de-
mand reports that return excessively 
large record sets. You may prefer to 
schedule such reports, both to make 
the reports available more quickly to 
users and to reduce the load on your 
database from these large queries.

The default value is 20000 re-
cords.

Maximum Concurrent 
Report Jobs (0 for un-
limited)

Specifies the maximum number of in-
dependent jobs allowed to run con-
currently on the RAS.

The default value is 75 jobs.

Oldest On-demand Da-
ta Given to a Client (mi-
nutes)

Specifies the amount of time, in mi-
nutes, an on-demand report will serve 
cached report data.

The default value is 75 jobs.

Temporary Directory Specifies the directory where tempo-
rary files are created when necessary.

Note:
You may encounter per-
formance issues if this 
directory does not have 
adequate disk space.

%DefaultDataDir%/Crys-
talReportsRasServer/
temp

Single Sign-On Expiry 
(seconds)

Specifies the time, in seconds, that an 
SSO connection is valid before expir-
ing.

The default value is 86400 
seconds.

Crystal Reports 2013 Processing Server Properties

Table 29: Crystal Reports 2013 Processing Server Properties

Property Description Default Value

Idle Job Timeout (mi-
nutes)

Specifies the length of time, in mi-
nutes, that the Crystal Reports Proc-
essing server waits between requests 
for a given job.

The default value is 20 mi-
nutes.
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Property Description Default Value

Maximum Lifetime 
Jobs Per Child

Specifies the maximum number of 
jobs that each child process can man-
age per lifetime.

The default value is 1000.

Viewer Refresh Always 
Yields Current Data

Specifies whether, when users explic-
itly refresh a report, all cached pages 
are ignored and new data is retrieved 
directly from the database. It speci-
fies if report data is shared between 
different clients.

Note:
This property can be set 
on a report object itself, 
and can vary from report 
to report. Values speci-
fied on the report object 
override the server set-
tings. To specify a value 
on the report object, se-
lect the report in the 
CMC, and click Default 
settings Viewing Server 
Group.

The default value is FALSE.

Share Report Data Be-
tween Clients

Specifies whether report data is 
shared between different clients. It 
specifies if report data is shared be-
tween different clients.

Note:
This property can be set 
on a report object itself, 
and can vary from report 
to report. Values speci-
fied on the report object 
override the server set-
tings.

The default value is TRUE.

Idle Connection Time-
out (minutes)

Specifies the amount of time, in mi-
nutes, that the Crystal Reports Proc-
essing server waits for a request from 
an idle connection. There is generally 
no need to modify the default value.

The default value is 30 mi-
nutes.
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Property Description Default Value

Maximum Concurrent 
Jobs (0 for automatic)

Specifies the maximum number of in-
dependent jobs allowed to run con-
currently on the Crystal Reports Proc-
essing server. If the value of this prop-
erty is set to “0”, the server applies a 
suitable value, based on the CPU and 
memory of the machine on which the 
server is running.

The default value is 0.

Oldest On-Demand Da-
ta Given to Clients (sec-
onds)

Specifies the amount of time, in sec-
onds, that the server uses cached da-
ta to meet requests from ondemand 
reports.

If the server receives a request that 
can be met using data that was gener-
ated to meet a previous request, and 
the time elapsed since that data was 
generated is less than the value set 
here, then the server will reuse this 
data to meet the subsequent request. 
Reusing data in this way significantly 
improves system performance when 
multiple users need the same infor-
mation.

When setting this value, consider how 
important it is that your users receive 
up-to-date data. If it is important that 
all users receive fresh data (perhaps 
important data changes frequently) 
you may need to disallow this kind of 
data reuse by setting the value to 0. 
This property can be set on a report 
object itself, and can vary from report 
to report. Values specified on the re-
port object override the server set-
tings.

Note:
This property can be set 
on a report object itself, 
and can vary from report 
to report. Values speci-
fied on the report object 
override the server set-
tings.

The default value is 0.
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Property Description Default Value

Maximum Number of 
Prestarted Children

Specifies the maximum number of 
prestarted child processes that are al-
lowed by the server. If this value is too 
low, the server creates child process-
es as soon as requests are made, and 
a user may experience latency. If this 
value is too high, system resources 
may be unnecessary wasted by idle 
child processes.

The default value is 1 child.

Temporary Directory Specifies the directory where tempo-
rary files are created when necessary.

Note:
You may encounter per-
formance issues if this 
directory does not have 
adequate disk space.

%Default DataDir%/Crys-
talReports2013Proces-
singServer/temp

Allow Report Jobs to 
Stay Connected to the 
Database until the Re-
port Job is Closed

Specifies whether the report job will 
remain connected to the database un-
til the job is closed.

The default value is FALSE.

Database Records 
Read When Previewing 
or Refreshing

Specifies the number of database re-
cords that will be read when viewing 
or refreshing a report. This setting 
limits the number of records that the 
server retrieves from the database 
when a user runs a query or report. 
This setting is useful when you want 
to prevent users from running onde-
mand reports that return excessively 
large record sets.

You may prefer to schedule such re-
ports, both to make the reports avail-
able more quickly to users and to re-
duce the load on your database from 
these large queries.

The default value is 20000.

Single Sign-On Expiry 
(seconds)

Specifies the time, in seconds, that an 
SSO connection is valid before expir-
ing.

The default value is 86400 
seconds.

Crystal Reports Services Metrics
The Crystal Reports server metrics are listed in the following table:
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Table 30: Crystal Reports Processing Server Metrics

Metric Description

Open Jobs The number of currently open jobs that the 
server and its child processes are currently 
processing.

Number of Requests Served The total number of requests that the server 
has served since it started.

Number of Open Jobs The number of currently open jobs that the 
server and its child processes are currently 
processing/

Object Type The type of InfoObject that the server primarily 
deals with. The value for this metric does not 
change.

Average Processing Time (milliseconds) The average time, in milliseconds, the server 
has spent processing on of the last 500 re-
quests that the server has received. If this 
number is consistently high and growing, con-
sider creating additional servers on other ma-
chines.

Maximum Processing Time (milliseconds) The maximum time, in milliseconds, that the 
server has spent processing one of the last 
500 requests. If this number is consistently 
high and growing, consider creating additional 
servers on other machines.

Minimum Processing Time (milliseconds) The minimum time, in milliseconds, that the 
server has spent processing one of the last 
500 requests. If this number is consistently 
high and growing, consider creating additional 
servers on other machines.

Number of Queued Requests The number of requests that are either waiting 
to be processed or are being processed. If this 
number is consistently high and growing, con-
sider creating additional servers on other ma-
chines.

Object DII Name The name of the processing plug-in for the 
server. The value of this metric does not 
change.

Number of Open Connections The number of connections that are currently 
open between the server and clients.

Request Failure Rate The number of requests that the server failed 
to process as a percentage of the last 500 re-
quests that the server has received.
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Metric Description

Data Transferred (KB) The total amount of data, in kilobytes, that 
have been transferred to clients since the serv-
er was started.

Number of Requests Failed The number of requests that the server was 
unable to complete since the server started.

Maximum Number of Child Processes The maximum number of concurrent child 
processes that are allowed on the server.

Crystal Reports Cache Server Metrics

The following table describes the server metrics that appear on the Metrics screen for Crystal 
Reports Cache servers.

Table 31: Crystal Reports Cache Server Metrics

Metric Description

Cache Hit Rate (%) The percentage of requests, over the last 500 
requests, that have been served with cached 
data.

Connected Processing Servers A table listing of the Crystal Reports Process-
ing servers in your deployment. The table lists 
the name of the server and the number of con-
nections that are currently open with the serv-
er.

Number of Requests Served The total number of requests that the server 
has served since it started.

Object Type The type of InfoObject that the server primarily 
deals with. The value for this metric does not 
change.

Average Processing Time (milliseconds) The average time, in milliseconds, the server 
has spent processing the last 500 requests 
that the server has received. If this number is 
consistently high and growing, consider creat-
ing additional servers on other machines.

Maximum Processing Time (milliseconds) The maximum time, in milliseconds, that the 
server has spent processing one of the last 
500 requests. If this number is consistently 
high and growing, consider creating additional 
servers on other machines.
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Metric Description

Minimum Processing Time (milliseconds) The minimum time, in milliseconds, that the 
server has spent processing one of the last 
500 requests. If this number is consistently 
high and growing, consider creating additional 
servers on other machines.

Number of Queued Requests The number of requests that are either waiting 
to be processed, or are being processed. If this 
number is consistently high and growing, con-
sider creating additional servers on other ma-
chines.

Object DII Name The name of the processing plugin for the serv-
er. The value of this metric does not change.

Cache Size (KB) The amount of data, in kilobytes, that is cur-
rently open between the server and clients.

Number of Open Connections The number of connections that are currently 
open between the server and clients.

Data Transferred (KB) The total amount of data, in kilobytes, that 
have been transferred to clients since the serv-
er was started.

Crystal Reports 2013 Report Application Server Metrics

The following table describes the server metrics that appear on the Metrics screen for Crystal 
Reports 2013 report Application servers.

Table 32: Crystal Reports 2013 Report Application Server Metrics

Metric Description

Metric_currentdoccount

Note:
This metric appears as "docu-
ment_s_" on the Monitoring page 
of the CMC.

The number of documents that are currently 
being processed by the server.

Metric_totaldoccount

Note:
This metric appears as "docu-
ment_s_" in the Monitoring page 
of the CMC

The number of documents that have been 
processed by the server since it started.

Lesson: Configuring Crystal Reports

© Copyright . All rights reserved. 211



Metric Description

Metric_currentagentthreadcount

Note:
This metric appears as "agent 
thread_s_" on the Monitoring page 
of the CMC

The number of threads that are currently being 
processed by the server.

Metric_totalagentthreadcount

Note:
This metric appears as "agent 
thread_s_" on the Monitoring page 
of the CMC

The number of threads that have been proc-
essed by the server since it started.

How to Access the Crystal Reports Server and Monitor the Metrics
Follow these steps to access the Crystal Reports servers in the CMC and monitor metrics.

1. Log on to the CMC as an administrator. Close out the System Configuration Wizard if it 
appears soon after you log on.

2. Navigate to the Servers area of the CMC and then expand the Service Categories container.

3. Observe the contents of the Service Categories.

4. In the Service Categories container, select the Crystal Report Services container.

5. Observe the different Crystal Reports servers in the following order:

a) Adaptive Job server

b) Crystal Reports 2013 Processing server

c) Crystal Reports 2013 Report Application server

d) Crystal Reports Cache server

e) Crystal Reports Processing server

6. View metric information for each of the servers.
a) In the Crystal Report Services container, right-click each server and select the Metrics 

menu option.

b) Observe the distinct server metric information. Notice that each server has a different set 
of metrics.
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7. In the Metrics window, click the Refresh button in the top right corner of the screen to view the 
latest metrics.

How to Configure the Crystal Reports Cache and Processing Servers
Follow these steps to configure the Crystal Reports Cache server.

1. Log on to the CMC as an administrator. Close out the System Configuration Wizard if it 
appears soon after you log on.

2. Navigate to the Servers area of the CMC and then expand the Service Categories container.

3. In the Service Categories container, select the Crystal Reports Services container.

4. In the Crystal Reports Services container, right-click the Crystal Reports Cache server and 
select the Properties menu option.

5. In the Properties window, scroll down to the Crystal Reports Cache Service area.

6. Refer students to the Crystal Reports Cache Service Properties portion of their handbooks, 
and change the appropriate configuration options.

Follow these steps to configure the Crystal Reports Processing server.

7. Return to the Crystal Reports Services container.

8. Right-click the Crystal Reports Processing server and select the Properties menu option.

9. In the Properties window, scroll down to the Crystal Reports Processing Service area.

10. Refer students to the Crystal Reports Processing Service Properties portion of their 
handbooks, and change the appropriate configuration options.

LESSON SUMMARY
You should now be able to:

● Configure Crystal Reports servers
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Unit 8
Lesson 3

203
Managing Crystal Reports Servers

LESSON OVERVIEW
Managing Crystal Reports servers entails setting a schedule for a report, running a scheduled 
report, viewing reports on demand, and viewing reports when they are in cache and when they 
are not. The Crystal Reports servers can be configured through each server's Properties screen, 
which in turn, is accessed through the CMC. The BI launch pad provides access to view the 
reports, and the ability to send a schedule request. The CMS locates an available Crystal Reports 
Scheduling service to receive job information and schedule the report.

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● Manage Crystal Reports servers

SAP Crystal Report Scheduling
The following steps explain the interaction of platform components when you set a schedule for a 
Crystal Reports 2011 report or a Crystal Reports for Enterprise report.

1. The user sends the schedule request in a URL from the BI launch pad Web client through the 
Web server to the Web Application server, where the BI launch pad Web Application is 
running.

2. The Web Application server interprets the URL request and determines that the request is a 
schedule request. The Web Application server sends the schedule time, database login values, 
parameter values, destination, and format to the specified Central Management server.

3. The Central Management Server (CMS) checks the CMS system database to ensure that the 
user has rights to schedule the object. If the user has sufficient rights, the CMS adds a new 
record to the CMS system database. The CMS also adds the instance to its list of pending 
schedules.

4. The CMS sends a response to the web application server to let it know that the schedule 
operation was successful.

5. The Web Application server generates the next HTML page and sends it through the Web 
server to the Web client.
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Figure 22: Schedule an SAP Crystal Report

Report Schedule Running

Run a Scheduled SAP Crystal Reports for Enterprise Report

The following steps explain the interaction of platform components when a scheduled Crystal 
Reports for Enterprise report is run to create a report instance.

1. The Central Management Server (CMS) checks the CMS system database to determine if 
there are any scheduled SAP Crystal Reports for Enterprise reports to be run at that time.

2. When the scheduled job time arrives, the CMS locates an available Crystal Reports 
Scheduling Service running on an Adaptive Job server. The CMS sends the job information to 
the Crystal Reports Scheduling Service. The job information includes report ID, format, 
destination, logon information, parameters, and selection formulas.

3. The Crystal Reports Scheduling Service communicates with the Input File Repository Server 
(FRS) to obtain a report template as per the requested report ID, as well as the universe 
(UNX) on which the report is based. Note: this step also requires communication (not shown 
in this diagram) with the Central Management Server (CMS) and the CMS system database to 
locate the required server and objects.

4. The Crystal Reports Scheduling Service launches the processes needed to generate the 
report and retrieve records from the data source (in this case a relational database) as 
indicated by the universe on which the report is based.

5. The Crystal Reports Scheduling Service updates the CMS periodically with the job status. At 
this time, the status shows that it is processing.

6. Once the report is compiled into the memory of the Crystal Reports Scheduling Service, it 
may be exported to a different format, such as Portable Document Format (PDF).
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7. The report with saved data is sent to be stored by the Output File Repository server. It may 
also be submitted to a scheduled location, such as email. Note: this step also requires 
communication (not shown in this diagram) with the Central Management Server (CMS) and 
the CMS system database to locate the required server and objects.

8. Once the process is finished, the Crystal Reports Scheduling Service updates the CMS with 
the job status. At this time, the status is reported as a success.

9. The CMS updates the job status in its memory, and then writes the instance information to 
the CMS system database.

Figure 23: Run a Scheduled SAP Crystal Reports for Enterprise Report

Run a Scheduled SAP Crystal Reports 2011 Report

The following steps explain the interaction of platform components when a scheduled Crystal 
Reports 2011 report is run to create a report instance.

1. The Central Management Server (CMS) checks the CMS system database to determine if 
there is any scheduled SAP Crystal report to be run at that time.

2. When the scheduled job time arrives, the CMS locates an available Crystal Reports 2011 
Scheduling Service running on an Adaptive Job server. The CMS sends the job information to 
the Crystal Reports 2011 Scheduling Service. The job information includes report ID, format, 
destination, logon information, parameters, and selection formulas.

3. The Crystal Reports 2011 Scheduling Service communicates with the Input File Repository 
Server (FRS) to obtain a report template as per the requested report ID. Note: this step also 
requires communication (not shown in this diagram) with the CMS and the CMS system 
database to locate the required server and objects.
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4. The Crystal Reports 2011 Scheduling Service launches the JobChildserver process. The 
JobChildserver process launches the ProcReport.dll upon receipt of the report template from 
the Input File Repository server. The ProcReport.dll contains all of the parameters that were 
passed from the CMS to the Crystal Reports 2011 Scheduling Service. The ProcReport.dll 
launches the crpe32.dll that processes the report according to all the parameters that were 
passed.

5. While crpe32.dll is still processing the report, records are retrieved from the data source (in 
this case a relational database) as defined within the report.

6. The Crystal Reports 2011 Scheduling Service updates the CMS periodically with the job 
status. At this time, the status shows that it is processing.

7. Once the report is compiled into the memory of the Crystal Reports 2011 Scheduling Service, 
it may be exported to a different format, such as Portable Document Format (PDF). When 
exporting to PDF, the crxfpdf.dll is used.

8. The report with saved data is sent to be stored by the Output File Repository server. It may 
also be submitted to a scheduled location, such as email. Note: this step also requires 
communication (not shown in this diagram) with the CMS and the CMS system database to 
locate the required server and objects.

9. Once the process is finished, the Crystal Reports 2011 Scheduling Service updates the CMS 
with the job status. At this time, the status is reported as a success.

10. The CMS updates the job status in its memory, and then writes the instance information to 
the CMS system database.

Figure 24: Run a Scheduled SAP Crystal Reports 2011 Report
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Crystal Report Instance Viewing

View a Report Instance When the Page is in Cache

The following steps explain the interaction of platform components when you view an existing 
Crystal Reports 2011 or Crystal Reports for Enterprise report instance when the required report 
page is already stored in the cache.

1. The user sends the view request from the BI launch pad Web client through the Web server to 
the Web Application server, where the BI launch pad Web Application is running.

2. The Web Application server recognizes the request as a request to view a report page. The 
Web Application server checks the Central Management Server (CMS) to ensure that the user 
has sufficient rights to view the report.

3. The CMS checks the CMS system database to determine if the user has the appropriate rights 
to view the report.

4. The CMS sends a response to the Web Application server to confirm the user has sufficient 
rights to view the report.

5. The Web Application server sends a request to the Crystal Reports Cache server for the 
requested report page (.EPF file).

6. The Crystal Reports Cache server determines if the requested .EPF file exists in the cache 
directory. The requested .EPF file is found in the cache directory.

7. The Crystal Reports Cache server sends the requested report page to the Web Application 
server.

8. The Web Application server forwards the report page to the Web server.

9. The Web server sends the requested report page to the report viewer in the Web client.
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Figure 25: View a Report Instance When the Page is in the Cache

View a Crystal Reports for Enterprise Report Instance When the Page is not in the Cache

The following steps explain the interaction of platform components when you view an existing 
Crystal Reports for Enterprise report instance when the required report page is not already 
stored in the cache.

1. The user sends the view request from the BI launch pad Web client through the Web server to 
the Web application server, where the BI launch pad Web Application is running.

2. The Web Application server recognizes the request as a request to view a report page. The 
Web Application server checks the Central Management Server (CMS) to ensure that the user 
has sufficient rights to view the report.

3. The CMS checks the CMS system database to determine if the user has the appropriate rights 
to view the report.

4. The CMS sends a response to the Web Application server to confirm the user has sufficient 
rights to view the report.

5. The Web Application server sends a request to the Crystal Reports Cache server for the 
requested report page (.EPF file).

6. The Crystal Reports Cache server determines if the requested .EPF file exists in the cache 
directory. The requested .EPF file is not found in the cache directory.

7. The Crystal Reports Cache server sends the request to the Crystal Reports Processing server.

8. The Crystal Reports Processing server contacts the Output File Repository Server (FRS) for 
the requested report instance. The Output FRS sends the requested report instance to the 
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Crystal Reports Processing server. Note: this step also requires communication (not shown in 
this diagram) with the CMS and the CMS system database to locate the required server and 
objects.

9. The Crystal Reports Processing server opens the report instance and checks the report to 
determine if it has data. The Crystal Reports Processing server determines that the report 
contains data and creates the .EPF file for the requested report page without having to 
connect to the production database.

10. The Crystal Reports Processing server sends the .EPF file to the Crystal Reports Cache 
server.

11. The Crystal Reports Cache server writes the .EPF file to the cache directory.

12. The Crystal Reports Cache server sends the requested report page to the Web Application 
server.

Figure 26: View an SAP Crystal Reports for Enterprise Report Instance When the Page is not in the Cache

View an SAP Crystal Reports 2011 Report Instance When the Page is not in the Cache

The following steps explain the interaction of platform components when you view an existing 
Crystal Reports 2011 report instance when the required report page is not already stored in the 
cache.

1. The user sends the view request from the BI launch pad Web Client through the Web server to 
the Web Application server, where the BI launch pad Web Application is running.

2. The Web Application server recognizes the request as a request to view a report page. The 
Web Application server checks the Central Management Server (CMS) to ensure that the user 
has sufficient rights to view the report.
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3. The CMS checks the CMS system database to determine if the user has the appropriate rights 
to view the report.

4. The CMS sends a response to the web application server to confirm the user has sufficient 
rights to view the report.

5. The Web Application server sends a request to the Crystal Reports Cache server for the 
requested report page (.EPF file).

6. The Crystal Reports Cache server determines if the requested .EPF file exists in the cache 
directory. The requested .EPF file is not found in the cache directory.

7. The Crystal Reports Cache server sends the request to the Crystal Reports 2011 Processing 
server.

8. The Crystal Reports 2011 Processing server contacts the Output File Repository Server (FRS) 
for the requested report instance. The Output FRS sends the requested report instance to the 
Crystal Reports 2011 Processing server. Note: this step also requires communication (not 
shown in this diagram) with the CMS and the CMS system database to locate the required 
server and objects.

9. The Crystal Reports 2011 Processing server opens the report instance and checks the report 
to determine if it has data. The Crystal Reports 2011 Processing server determines that the 
report contains data and creates the .EPF file for the requested report page without having to 
connect to the production database.

10. The Crystal Reports 2011 Processing server sends the .EPF file to the Crystal Reports Cache 
server.

11. The Crystal Reports Cache server writes the .EPF file to the cache directory.

12. The Crystal Reports Cache server sends the requested page to the Web Application server.

13. The Web Application server forwards the file to the Web server.

14. The Web server sends the requested page to the report viewer in the Web client.
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Figure 27: View an SAP Crystal Reports 2011 Report Instance When the Page is not in the Cache

View an SAP Crystal Reports for Enterprise Report on Demand

The following steps explain the interaction of platform components when you view a Crystal 
Reports for Enterprise report on demand to see the most current data available.

1. The user sends the view request from the BI launch pad Web client through the Web server to 
the Web application server, where the BI launch pad Web Application is running.

2. The Web Application server recognizes the request as a request to view a report page. The 
Web Application server checks the Central Management Server (CMS) to ensure that the user 
has sufficient rights to view the report.

3. The CMS checks the CMS system database to determine if the user has the appropriate rights 
to view the report.

4. The CMS sends a response to the Web Application server to confirm the user has sufficient 
rights to view the report.

5. The Web Application server sends a request to the Crystal Reports Cache server for the 
requested report page (.EPF file).

6. The Crystal Reports Cache server checks its cache to see if the report page already exists. 
Unless the report meets the requirements for On Demand report sharing (within a set time of 
another On Demand request, with appropriate parameter values and database logon 
credentials), the Crystal Reports Cache server sends a request for the Crystal Reports 
Processing server to generate the report page.

7. The Crystal Reports Processing server requests the report object, and the universe (UNX) 
that the report is based on, from the Input File Repository server. The Input File Repository 
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server sends a copy of the report object and the universe to the Crystal Reports Processing 
server. Note: this step also requires communication (not shown in this diagram) with the CMS 
and the CMS system database to locate the required server and objects.

8. The Crystal Reports Processing server opens the report in its memory and checks to see if the 
report contains data. In this case there is no data in the report object, so the Crystal Reports 
Processing server connects to the data source (according to the universe that the report is 
based on) to retrieve data and generate the report.

9. The Crystal Reports Processing server sends the report page (.EPF file) to the Crystal Reports 
Cache server. The Crystal Reports Cache server writes the .EPF file to its cache directory.

10. The Crystal Reports Cache server sends the requested report page to the Web Application 
server.

Figure 28: View an SAP Crystal Reports for Enterprise report on demand

View an SAP Crystal Reports 2011 Report on Demand

The following steps explain the interaction of platform components when you view a Crystal 
Reports 2011 report on demand to see the most current data available.

1. The user sends the view request from the BI launch pad Web client through the Web server to 
the Web application server, where the BI launch pad Web Application is running.

2. The Web Application server recognizes the request as a request to view a report page. The 
Web Application server checks the Central Management Server (CMS) to ensure that the user 
has sufficient rights to view the report.

3. The CMS checks the CMS system database to determine if the user has the appropriate rights 
to view the report.
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4. The CMS sends a response to the Web Application server to confirm the user has sufficient 
rights to view the report.

5. The Web Application server sends a request to the Crystal Reports Cache server for the 
requested report page (.EPF file).

6. The Crystal Reports Cache server checks its cache to see if the page already exists. Unless 
the report meets the requirements for On Demand report sharing (within a set time of another 
On Demand request, with appropriate parameter values and database logon credentials), the 
Crystal Reports Cache server sends a request for the Crystal Reports 2011 Processing server 
to generate the page.

7. The Crystal Reports 2011 Processing server requests the report object from the Input File 
Repository server. The Input File Repository server sends a copy of the report object to the 
Crystal Reports 2011 Processing server. Note: this step also requires communication (not 
shown in this diagram) with the CMS and the CMS system database to locate the required 
server and objects.

8. The Crystal Reports 2011 Processing server opens the report in its memory and checks to see 
if the report contains data. In this case there is no data in the report object, so the Crystal 
Reports 2011 Processing server connects to the data source to retrieve data and generate the 
report.

9. The Crystal Reports 2011 Processing server sends the report page (.EPF file) to the Crystal 
Reports Cache server. The Crystal Reports Cache server writes the .EPF file to its cache 
directory.

10. The Crystal Reports Cache server sends the requested page to the Web Application server.

11. The Web Application server forwards the report page to the Web server.

12. The Web server sends the requested page to be rendered in the report viewer in the Web 
client.
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Figure 29: View an SAP Crystal Reports 2011 Report on Demand
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Unit 8
Exercise 9

215
Manage and Monitor Crystal Reports Cache 
Server and Crystal Reports Processing Server

Business Example

As the system administrator, you need to improve system performance when multiple users need 
the same information. You want to enable servers to use cached data to meet request from on-
demand queries. Reusing data in this way significantly improves server performance.

Configure the Crystal Reports Cache Server
Change settings on the Crystal Reports Cache Server to allow sessions to be shared between 
users.

1. Launch the CMC and logon with the following details:

Field Name Value

System <hostname>:6400

User name Administrator

Password <assigned password>

Authentication Enterprise

2. Go to the Servers area in the Central Management Console and select the Crystal Reports 
Cache Server.

3. Change the setting Oldest On-Demand Data Given to Clients (seconds) from 0 (no sharing) to 
300.

4. Restart the Crystal Reports Cache Server.

Configure the Crystal Reports Processing Server
Change settings on the Crystal Reports Processing Server to allow sessions to be shared 
between users.

Note:
The settings on the Crystal reports Cache server and the Crystal Reports Processing 
Server work together and need to be modified in both places.

1. Go to the Servers area in the Central Management Console and select the Crystal Reports 
Processing Server.
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2. Change the setting Oldest On-Demand Data Given to Clients (seconds) from 0 (no sharing) to 
300.

Note:
The settings on the Crystal reports Cache server and the Crystal Reports 
Processing Server work together and need to be modified in both places.

3. Restart the Crystal Reports Processing Server.

View a Crystal report
Launch BI launch pad and log in as an end user to view the customer list report. Then launch 
another instance of BI launch pad and log in as another user and view the same report. Make sure 
that you log in within 300 seconds (5 minutes) from the first viewing of the report to ensure that 
the sessions are shared between the two users.

1. Log onto SAP BusinessObjects BI launch pad with the following information:

Field Name Value

System <hostname>:6400

User name Train-XX

Password Assigned password

2. Open the customer list report.

3. Log on to SAP BusinessObjects BI launch pad with the following information:

Field Name Value

System <hostname>:6400

User name Train-XX (different from the user above)

Password Assigned password

4. Open the customer list report.

Monitor the Cache Files
Monitor the cache files for viewing Crystal Reports files in the Business Intelligence (BI) launch 
pad.

1. Each time a user views a new page within Crystal Reports, new cache files are created and 
hosted by the BI 4 platform. Go to the Operating System of the BI 4 platform, and then find 
the folder that contains the cache files. Enter the location of this folder in the table below.

Note:
To find the location of the cache files, check the properties of the Crystal Reports 
server.

Unit 8: Crystal Reports Servers

228 © Copyright . All rights reserved.



Crystal Reports
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Unit 8
Solution 9

218
Manage and Monitor Crystal Reports Cache 
Server and Crystal Reports Processing Server

Business Example

As the system administrator, you need to improve system performance when multiple users need 
the same information. You want to enable servers to use cached data to meet request from on-
demand queries. Reusing data in this way significantly improves server performance.

Configure the Crystal Reports Cache Server
Change settings on the Crystal Reports Cache Server to allow sessions to be shared between 
users.

1. Launch the CMC and logon with the following details:

Field Name Value

System <hostname>:6400

User name Administrator

Password <assigned password>

Authentication Enterprise

a) Click Start → Programs → SAP BusinessObjects BI platform 4 → Custom Link to CMC 
home page.

b) Log on with your username and password.

2. Go to the Servers area in the Central Management Console and select the Crystal Reports 
Cache Server.
a) Click Servers.

b) Navigate to Service Category → Crystal Reports Services.

Hint:
Alternately, you can find the Crystal Reports Cache Server from the Server 
List.

c) Right-click the Crystal Reports Cache Server and click Properties.

3. Change the setting Oldest On-Demand Data Given to Clients (seconds) from 0 (no sharing) to 
300.
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a) Under the Crystal Reports Cache Service section, click inside the Oldest On-Demand Data 
Given to Clients (seconds) field.

Note:
This field is used to specify the amount of time, in seconds, that the server 
uses cached data to meet requests from on demand reports. If the server 
receives a request that can be met using data that was generated to meet a 
previous request, and the time elapsed since that data was generated is less 
than the value set here, then the server will reuse this data to meet the 
subsequent request. Reusing data in this way significantly improves system 
performance when multiple users need the same information. When setting 
this value consider how important it is that your users receive up-to-date data. 
If it is very important that all users receive fresh data (perhaps because 
important data changes very frequently) you may need to set the value to 0.

b) Enter 300.

c) Click Save & Close.
A flag appears next to the Crystal Reports Cache Server inside the Stale column.

4. Restart the Crystal Reports Cache Server.
a) Right-click the Crystal Reports Cache Server.

b) Click Restart Server.
Wait for a few seconds for the server to restart.

c) Click the Refresh button.
The stale flag disappears and the server state is changed to Running.

Configure the Crystal Reports Processing Server
Change settings on the Crystal Reports Processing Server to allow sessions to be shared 
between users.

Note:
The settings on the Crystal reports Cache server and the Crystal Reports Processing 
Server work together and need to be modified in both places.

1. Go to the Servers area in the Central Management Console and select the Crystal Reports 
Processing Server.
a) In the CMC home page, Click Servers.

b) Navigate to Service Category → Crystal Reports Services.
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Hint:
Alternately, you can find the Crystal Reports Processing Server from the 
Server List.

c) Right-click the Crystal Reports Processing Server and click Properties.

2. Change the setting Oldest On-Demand Data Given to Clients (seconds) from 0 (no sharing) to 
300.

Note:
The settings on the Crystal reports Cache server and the Crystal Reports 
Processing Server work together and need to be modified in both places.

a) Under the Crystal Reports Processing Service section, click inside the Oldest On-Demand 
Data Given to Clients (seconds) field.

Note:
This field is used to specify the amount of time, in seconds, that the server 
uses cached data to meet requests from ondemand reports. If the server 
receives a request that can be met using data that was generated to meet a 
previous request, and the time elapsed since that data was generated is less 
than the value set here, then the server will reuse this data to meet the 
subsequent request. Reusing data in this way significantly improves system 
performance when multiple users need the same information. When setting 
this value consider how important it is that your users receive up-to-date data. 
If it is very important that all users receive fresh data (perhaps because 
important data changes very frequently) you may need to set the value to 0.

b) Enter 300.

c) Click Save & Close.
A flag appears next to the Crystal Reports Processing Server inside the Stale column.

3. Restart the Crystal Reports Processing Server.
a) Right-click the Crystal Reports Processing Server.

b) Click Restart Server.
Wait for a few seconds for the server to restart.

c) Click the Refresh button.
The stale flag disappears and the server state is changed to Running.

View a Crystal report
Launch BI launch pad and log in as an end user to view the customer list report. Then launch 
another instance of BI launch pad and log in as another user and view the same report. Make sure 
that you log in within 300 seconds (5 minutes) from the first viewing of the report to ensure that 
the sessions are shared between the two users.
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1. Log onto SAP BusinessObjects BI launch pad with the following information:

Field Name Value

System <hostname>:6400

User name Train-XX

Password Assigned password

a) Click Start → Programs → SAP BusinessObjects BI platform 4 → Custom Link to BI launch 
pad.

b) Log on with your username and password.

2. Open the customer list report.
a) Navigate to All Folders → Report Samples → Demonstration.

b) Double-click customer list report.
The report opens with customer information inside. You should see there are 416 pages in 
total.

c) Navigate the pages using the Go to Next Page button.

Note:
Only individual viewable pages are being passed from the Processing Server to 
the Cache Server. If page has not been requested yet it is not delivered to the 
Cache Server. This mechanism is sometimes referred to as viewing on demand 
(only demanded pages get created and saved in anticipation for future 
requests).

3. Log on to SAP BusinessObjects BI launch pad with the following information:

Field Name Value

System <hostname>:6400

User name Train-XX (different from the user above)

Password Assigned password

a) Click Start → Programs → SAP BusinessObjects BI platform 4 → Custom Link to BI launch 
pad.

b) Log on with your username and password.

4. Open the customer list report.
a) Navigate to All Folders → Report Samples → Demonstration.

b) Double-click customer list report.
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Hint:
Make sure that you log in within 300 seconds (5 minutes) since the first 
viewing the report, so that the viewable sessions can be shared between the 
two users.

The report opens with customer information inside. You should see there are 416 pages in 
total.

c) Navigate the pages using the Go to Next Page button.

Note:
Only individual viewable pages are being passed from the Processing Server to 
the Cache Server. If page has not been requested yet it is not delivered to the 
Cache Server. This mechanism is sometimes referred to as viewing on demand 
(only demanded pages get created and saved in anticipation for future 
requests).

Monitor the Cache Files
Monitor the cache files for viewing Crystal Reports files in the Business Intelligence (BI) launch 
pad.

1. Each time a user views a new page within Crystal Reports, new cache files are created and 
hosted by the BI 4 platform. Go to the Operating System of the BI 4 platform, and then find 
the folder that contains the cache files. Enter the location of this folder in the table below.

Note:
To find the location of the cache files, check the properties of the Crystal Reports 
server.

a) In Windows Explorer, monitor the Crystal Reports cache files (.ETF and .EPF files) that are 
created automatically when pages are viewed in a Crystal Reports document.

Hint:
Encapsulated Page Files (.EPF) are the Crystal Reports cache files for data. 
Each of these files is mandatory for viewing a single page of data within the 
Crystal Reports report.

Hint:
Encapsulated Tree Files (.ETF) files are the Crystal Reports files for the 
navigation tree. Each of these files is mandatory for navigating in groups 
within the Crystal Reports report.
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LESSON SUMMARY
You should now be able to:

● Manage Crystal Reports servers
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Unit 8

225
Learning Assessment

1. Match the server with the Crystal Reports services it hosts.

Match the item in the first column to the corresponding item in the second column.

Crystal Reports Processing 
Server

Report Application Server

Crystal Reports Cache Server

Adaptive Job Server

Crystal Reports Cache Service

Crystal Reports 2011 Schedul-
ing Service and Crystal Re-
ports Scheduling Service

Crystal Reports 2011 Viewing 
and Modification Service

Crystal Reports 2011 Process-
ing Service and Crystal Re-
ports Processing Service

2. Crystal Reports 2011 Scheduling Service runs on demand Crystal Reports jobs and publishes 
the results to the Adaptive Job Processing server.

Determine whether this statement is true or false.

X True

X False

3. Any properties that apply to both Crystal Reports Cache servers and Crystal Reports 
Processing servers should be set to the same value.

Determine whether this statement is true or false.

X True

X False
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4. Identify the correct menu path to configure the Crystal Reports Processing server properties.

Choose the correct answer.

X A Go to CMC --> Services --> Servers -->Crystal Reports Server. Double click the Crystal 
Reports Processing server and then click the Properties button.

X B Go to CMS --> Services --> Servers --> Crystal Reports Services. Double click the 
Crystal Reports Processing service and then click the Properties button.

X C Go to CMC --> Servers --> Service Categories --> Crystal Reports Services. Right click 
Crystal Reports Processing server and select the Properties menu option.

X D Go to the CMS --> Service Categories --> Properties --> Crystal Reports Processing 
service.

5. The interaction of platform components is the same, regardless of whether you set a schedule 
for a Crystal Reports 2011 report or a Crystal Reports for Enterprise report.

Determine whether this statement is true or false.

X True

X False
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227
Learning Assessment - Answers

1. Match the server with the Crystal Reports services it hosts.

Match the item in the first column to the corresponding item in the second column.

Crystal Reports Processing 
Server

Report Application Server

Crystal Reports Cache Server

Adaptive Job Server

Crystal Reports 2011 Process-
ing Service and Crystal Re-
ports Processing Service

Crystal Reports 2011 Viewing 
and Modification Service

Crystal Reports Cache Service

Crystal Reports 2011 Schedul-
ing Service and Crystal Re-
ports Scheduling Service

2. Crystal Reports 2011 Scheduling Service runs on demand Crystal Reports jobs and publishes 
the results to the Adaptive Job Processing server.

Determine whether this statement is true or false.

X True

X False

3. Any properties that apply to both Crystal Reports Cache servers and Crystal Reports 
Processing servers should be set to the same value.

Determine whether this statement is true or false.

X True

X False

© Copyright . All rights reserved. 239



4. Identify the correct menu path to configure the Crystal Reports Processing server properties.

Choose the correct answer.

X A Go to CMC --> Services --> Servers -->Crystal Reports Server. Double click the Crystal 
Reports Processing server and then click the Properties button.

X B Go to CMS --> Services --> Servers --> Crystal Reports Services. Double click the 
Crystal Reports Processing service and then click the Properties button.

X C Go to CMC --> Servers --> Service Categories --> Crystal Reports Services. Right click 
Crystal Reports Processing server and select the Properties menu option.

X D Go to the CMS --> Service Categories --> Properties --> Crystal Reports Processing 
service.

5. The interaction of platform components is the same, regardless of whether you set a schedule 
for a Crystal Reports 2011 report or a Crystal Reports for Enterprise report.

Determine whether this statement is true or false.

X True

X False
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Unit 9
Lesson 1

230
Managing Web Intelligence Document Schedules

LESSON OVERVIEW
The Web Intelligence Processing server hosts four services that support Web Intelligence 
document processing. The Central Management Console (CMC) makes it easy for administrators 
to manage Web Intelligence document schedules. The CMC offers a Schedule option on the 
document right click menu. This function allows users to select the recurrence for the document 
schedule to run. Document schedule requests are flawlessly processed from the BI launch pad, 
through the Web Application Server, to the CMS, and back with a confirmation.

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● Manage Web Intelligence document schedules

Web Intelligence Processing Server
Web Intelligence Processing server is responsible for processing SAP BusinessObjects Web 
Intelligence documents.

The Web Intelligence Processing server properties are grouped into the following services:

Table 33: Web Intelligence Processing Server

Server Service Service Description

Web Intelligence Processing 
Server

Information Engine Service Service required for Web Intel-
ligence documents process-
ing.

Web Intelligence Common 
Service

Supports Web Intelligence 
documents processing.

Web Intelligence Core Service Supports Web Intelligence 
documents processing.

Web Intelligence Processing 
Service

Accepts and processes Web 
Intelligence documents.

Schedule Setting for a Web Intelligence Document
The following steps explain the interaction of platform components when you set a schedule for a 
Web Intelligence document.
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1. The user sends the schedule request from the BI launch pad Web client through the Web 
server to the Web application server, where the Launchpad Web Application is running.

2. The Web Application server interprets the request and determines that the request is a 
schedule request. The Web Application server sends the schedule information, including time 
and destination, to the specified Central Management Server (CMS).

3. The Central Management Server (CMS) checks the CMS system database to ensure that the 
user has rights to schedule the object. If the user has sufficient rights, the CMS adds a new 
record to the CMS system database. The CMS also adds the instance to its list of pending 
schedules.

4. The CMS sends a response to the Web Application server to let it know that the schedule 
operation was successful.

5. The Web Application server generates the next HTML page and sends it through the Web 
server to the Web client.

Figure 30: Schedule an SAP BusinessObjects Web Intelligence Document

Schedule Running for Web Intelligence Documents
The following steps explain the interaction of platform components when a scheduled Web 
Intelligence document is run to create a document instance.

1. The Central Management Server (CMS) checks the CMS system database to determine if 
there is any scheduled Web Intelligence document to be run at that time.

2. When the scheduled job time arrives, the CMS locates an available Web Intelligence 
Scheduling Service running on an Adaptive Job Server. The CMS sends the schedule request 
and all information about the request to the Web Intelligence Scheduling Service.
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3. The Web Intelligence Scheduling Service locates an available Web Intelligence Processing 
Server based on the Maximum Jobs Allowed value configured on each Web Intelligence 
Processing server.

4. The Web Intelligence Processing server determines the location of the Input File Repository 
Server (FRS) that houses the document and the universe metalayer file on which the 
document is based. The Web Intelligence Processing server then requests the document from 
the Input FRS. The Input FRS locates the Web Intelligence document as well as the universe 
file on which the document is based, and then streams them to the Web Intelligence 
Processing server.

Note:
This step also requires communication (not shown in this diagram) with the 
Central Management Server (CMS) and the CMS system database to locate the 
required server and objects.

5. The Web Intelligence document is placed in a temporary directory on the Web Intelligence 
Processing server. The Web Intelligence Processing server opens the document in memory. 
The QT.dll generates the SQL from the universe on which the document is based. The 
Connection server libraries included in the Web Intelligence Processing server are used to 
connect to the data source, which is a relational database in this example. The queried data 
passes through QT.dll back to the Report Engine in the Web Intelligence Processing server, 
where the document is processed. A new successful instance is created.

6. The Web Intelligence Processing server uploads the document instance to the Output File 
Repository server. Note: this step also requires communication (not shown in this diagram) 
with the Central Management Server (CMS) and the CMS system database to locate the 
required server and objects.

7. The Web Intelligence Processing server notifies the Web Intelligence Scheduling Service (on 
the Adaptive Job server) that document creation is completed. If the document is scheduled 
to go to a destination such as file system, FTP, SMTP, or Inbox, the Adaptive Job server 
retrieves the processed document from the Output File Repository server and delivers it to 
the specified destinations. That is not the case in this example.

8. The Web Intelligence Scheduling Service updates the CMS with the job status.

9. The CMS updates the job status in its memory, and then writes the instance information to 
the CMS system database.
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Figure 31: Run a Scheduled SAP BusinessObjects Web Intelligence Document

How to Set and Run a Schedule for a Web Intelligence Document
Demonstrate how to set and run a schedule for a Web Intelligence document from the CMC with 
the following steps.

1. Log on to the CMC as an administrator.

2. Navigate to the folder that contains the Web Intelligence document that you want to schedule.

3. Right-click the document and select Schedule from the menu options. The Schedule window 
opens.

4. In the Schedule window, select the Weekly option (or whichever option you prefer) from the 
Recurrence Run Object dropdown list.

5. Click the Schedule button at the bottom right of the screen. The scheduled document appears 
listed n the Documents > History window.

LESSON SUMMARY
You should now be able to:

● Manage Web Intelligence document schedules

Lesson: Managing Web Intelligence Document Schedules
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234
Viewing Web Intelligence Documents

LESSON OVERVIEW
Web Intelligence documents are easily viewed on demand with a request sent from the BI launch 
pad. The request is pushed through the Web Application server, to the Central Management 
Server (CMS) for verification, and then Web Intelligence Processing server requests the 
document from the Input File Repository Server (FRS). The requested document and its 
accompanying metalayer information is then sent back through the system to be viewed by the 
user on the BI launch pad. A similar process is enacted to export or refresh a Web Intelligence 
document.

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● View Web Intelligence documents

Web Intelligence Document Viewing on Demand
The following steps explain the interaction of platform components when you view a Web 
Intelligence document on demand to see the most current data available.

1. The user sends the view request from the BI launch pad web client through the Web server to 
the Web Application server, where the BI launch pad Web Application is running.

2. The Web Application server recognizes the request as a request to view a Web Intelligence 
document. The Web Application server checks the Central Management Server (CMS) to 
ensure that the user has sufficient rights to view the document.

3. The CMS checks the CMS system database to determine if the user has the appropriate rights 
to view the document.

4. The CMS sends a response to the web application server to confirm that the user has 
sufficient rights to view the document.

5. The Web Application server sends a request to the Web Intelligence Processing server, 
requesting the document.

6. The Web Intelligence Processing server requests the document, and the universe file on which 
the requested document is built, from the Input File Repository Server (FRS). The universe file 
contains metalayer information, including row-level and column-level security. The Input FRS 
sends a copy of the document and the universe to the Web Intelligence Processing server.
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Note:
This step also requires communication (not shown in this diagram) with the 
Central Management Server (CMS) and the CMS system database to locate the 
required server and objects.

7. The Web Intelligence Report Engine runs on the Web Intelligence Processing server. The 
Report Engine opens the document in memory and launches QT.dll and a Connection server 
in process. QT.dll generates, validates, and regenerates the SQL and connects to the 
database to run the query. The Connection server uses the SQL to obtain the data from the 
database to the Report Engine, where the document is processed.

8. The Web Intelligence Processing server sends the viewable document page that was 
requested to the Web Application server.

9. The Web Application server forwards the document page to the Web server.

10. The Web server sends the requested page to be rendered in the Web client.

Figure 32: View an SAP BusinessObjects Web Intelligence Document on Demand

Document Exportation
The following steps explain the interaction of platform components when you export a Web 
Intelligence document.

1. The user sends the export request from the Web Intelligence Web client through the web 
server to the Web Application server, where the Web Intelligence Web Application is running.
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Note:
The user previously logged on to the SAP BusinessObjects Business Intelligence 
platform through BI launch pad. Rights were checked and the document was 
opened in the Web Intelligence Web client.

2. The Web Application server sends a request to the Web Intelligence Processing server to 
export the currently open document.

3. The Web Intelligence Processing server processes the document into the requested export 
format (PDF or Excel).

4. The Web Intelligence Processing server sends the formatted document to the Web 
Application server.

5. The Web Application server sends the formatted document through the Web server to the 
Web client.

Figure 33: Export an SAP BusinessObjects Web Intelligence Document

Document Refresh

Document Refresh Based on a Multi-Source Universe

The following steps explain the interaction of platform components when you refresh a Web 
Intelligence document based on a multi-source universe.

1. The user sends the refresh request from the Web Intelligence Web client through the Web 
server to the Web Application server, where the Web Intelligence Web application is running.
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Note:
The user previously logged on to the SAP BusinessObjects Business Intelligence 
platform through BI launch pad. Rights were checked and the document was 
opened in the Web Intelligence Web client.

2. The Web Application server sends a request to the Web Intelligence Processing server to 
refresh the document with current data.

3. The Web Intelligence Report Engine runs on the Web Intelligence Processing server. It sends a 
request to the Data Federation Service (running on an Adaptive Processing server) to obtain 
the current data from the multiple data sources.

4. The Data Federation Service (running on the Adaptive Processing server) obtains the current 
data from the multiple data sources, which are different types of relational databases in this 
example.

5. The Data Federation Service (running on the Adaptive Processing server) sends the current 
data to the Web Intelligence Processing server, where the Web Intelligence Report Engine 
uses the data to build the refreshed document.

6. The Web Intelligence Processing server sends the refreshed document with the current data 
to the Web Application server.

7. The Web Application server sends the refreshed document through the Web server to be 
rendered in the Web client.

Figure 34: Refresh an SAP BusinessObjects Web Intelligence Document Based on a Multi-Source Universe
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Facilitator Producer

Say:

"We'll be starting a group chat activity. I will 
be pasting a series of questions into the Chat 
Pod and ask that you enter your response af-
ter each question is posted."

"I will select some responses to discuss as a 
group."

Do:

Display the first question on the slide provid-
ed in the Instructor Presentation deck. Dis-
play questions one at a time.

Ask them to answer their questions based on 
their independent study and then to review 
their classmates answers.

Select the response from one participant and 
copy/paste it to the whiteboard.

Do:

Assist by pasting the pre-written questions in-
to the Chat Pod.

If desired, archive the Chat Pod and white-
board overlay for later reference/distribution.
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INTERACTIVE ELEMENT: Chat

1. Explain the two functions the Data Federation Service provides when refreshing documents 
in a multi-source universe.

.

.

.

.

.

.

.

.

.

2. What is the role of the Web Intelligence Processing server when refreshing documents in a 
multi-source universe?

.

.

.

.

.

.

.

.

.

.

Refresh a Document Based on a Dimensional Universe

The following steps explain the interaction of platform components when you refresh a Web 
Intelligence document based on a dimensional universe.

1. The user sends the refresh request from the Web Intelligence Web client through the Web 
server to the Web Application server, where the Web Intelligence Web application is running. 
Note: The user previously logged on to the SAP BusinessObjects Business Intelligence 
platform through BI launch pad. Rights were checked and the document was opened in the 
Web Intelligence Web client.

2. The Web Application server sends a request to the Web Intelligence Processing server to 
refresh the document with current data.
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3. The Web Intelligence Report Engine runs on the Web Intelligence Processing server. It sends a 
request to the DSL Bridge Service (running on an Adaptive Processing server) to obtain the 
current data from the OLAP data source.

4. The DSL Bridge Service (running on the Adaptive Processing server) obtains the current data 
from the OLAP data source.

5. The DSL Bridge Service (running on the Adaptive Processing server) sends the current data 
to the Web Intelligence Processing server, where the Web Intelligence Report Engine uses the 
data to build the refreshed document.

6. The Web Intelligence Processing server sends the refreshed document with the current data 
to the Web Application server.

7. The Web Application server forwards the refreshed document through the Web server to be 
rendered in the Web client.

Figure 35: Refresh an SAP BusinessObjects Web Intelligence Document Based on a Dimensional Universe

Document Refresh in Web Intelligence Desktop in One-tier Mode
The following steps explain the interaction of platform components when you refresh a document 
in SAP BusinessObjects Web Intelligence Desktop in one-tier mode

1. The SAP BusinessObjects Web Intelligence Desktop client runs all processes necessary to 
obtain current data from the data source to refresh the Web Intelligence document with 
current data.
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Note:
All middleware required is installed locally on the same machine as the Web 
Intelligence Desktop client.

Figure 36: Refresh a Document in SAP BusinessObjects Web Intelligence Desktop in One-Tier Mode

LESSON SUMMARY
You should now be able to:

● View Web Intelligence documents

Lesson: Viewing Web Intelligence Documents
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Unit 9
Lesson 3

241
Configuring a Web Intelligence Processing 
Server

LESSON OVERVIEW
The Web Intelligence Processing server and service properties are easy to configure from the 
CMC. Simply navigate to the Web Intelligence Services container, right click it, and select the 
Properties option. All configuration for the server and its hosted services can be performed on 
this Properties screen.

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● Configure a Web Intelligence Processing server

Web Intelligence Processing Server Properties
The Web Intelligence Processing server properties are grouped into the following services:

● Information Engine Service Settings

● Web Intelligence Processing Server Properties

● Web Intelligence Processing Service Settings

● Web Intelligence Common Service Settings

Information Engine Service Settings
Property Description

Enable List of Values Cache Specifies whether caching is enabled for List of 
Values on the Web Intelligence Processing 
server.

List of Values Batch Size (entries) Specifies the maximum number of entries (or 
values) for each List of Values batch.

Maximum Custom Sort Size (entries) Specifies the maximum number of entries in 
the custom sort.

Universe Cache Maximum Size (Universes) Specifies the number of universes to be cach-
ed on the Web Intelligence Processing server.

Maximum List of Values Size (entries) Specifies the maximum number of entries (or 
values) for each List of Values.
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Web Intelligence Processing Server Properties

Property Description

Timeout Before Recycling (seconds) Specifies the time, in seconds, the server is idle 
before the Server Intelligence Agent (SIA) 
stops and restarts the server when the total 
number of documents processed is above the 
value specified with the Maximum Documents 
Before Recycling property.

Idle Document Timeout (seconds) Specifies the amount of time, in seconds, be-
fore the Web Intelligence Processing server 
session will be swapped. Therefore, when the 
client is not generating requests during this pe-
riod of time, the session will be swapped onto 
the hard disk, freeing up resources for an ac-
tive session.

Server Polling Interval (seconds) Specifies the interval, in seconds, that must 
pass before the server polls for new thread re-
quests. When the server is in the polling phase, 
it performs cleanup actions like swapping un-
used documents to keep the server memory 
under the upper memory threshold.

Maximum Documents per User Specifies the maximum number of active ses-
sions (Web Intelligence documents) that can 
be associated with a user at any given time. 
Therefore, if the default value is 5, the user can 
use up to 5 active sessions at once.

Maximum Documents Before Recycling Specifies the number of Web Intelligence docu-
ments that can be processed before the server 
will be considered for recycling. If the number 
of processed documents has been reached, 
and the server is idle, then the server is closed 
and the Server Intelligence Agent (SIA) starts a 
new instance of the server. However, there will 
be a time delay before a new instance of the 
server is started. The time delay is defined by 
the Timeout Before Recycling property.

Allow Document Map Maximum Size Errors Specifies whether the Maximum Connections 
property is restricted. If this property is ena-
bled, then the value set for the Maximum Con-
nections property is recognized by the server; 
otherwise the property is disregarded.
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Property Description

Idle Connection Timeout (minutes) Specifies the amount of time, in minutes, that 
the server waits for a request from an idle con-
nection. Setting a value that is too low can 
cause a request to close prematurely. Setting a 
value that is too high can cause requests to be 
queued while the server waits for idle requests 
to be closed.

Maximum Connections Specifies the maximum number of simultane-
ous sessions that can be opened at one time. 
This is an approximate number; this setting 
does not count the inactive sessions that are 
swapped, or the session that is created to ana-
lyze the number of sessions. If this limit is 
reached, and no other server is available to 
handle the request, the user will receive an er-
ror message.

Enable Memory Analysis Specifies whether memory analysis is enabled. 
If this property is enabled then the following 
properties will be active and recognized by the 
server:

● Memory Maximum Threshold

● Memory Upper Threshold

● Memory Lower Threshold

When the server process memory is above the 
Memory Upper Threshold , the only operation 
that is allowed is saving documents. When the 
process memory is above the Memory Maxi-
mum Threshold , all operations stop and fail.

Memory Maximum Threshold (MB) Specifies the maximum threshold for memory 
consumption.

Memory Upper Threshold (MB) Specifies the memory upper threshold. The de-
fault value is 1500MB for memory consump-
tion.

Memory Lower Threshold (MB) Specifies the lower threshold for memory con-
sumption.

Enable PJS Service Monitoring Enables monitoring of the server by the PJS 
service, hosted on the Adaptive processing 
server.

Retry Count on PJS Service Ping Failure Specifies the number of times the server will 
try to reach the PJS Service before deciding 
that it is unable to reach it.
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Property Description

PJS Service Monitoring Thread Period Specifies the period of delay between attempts 
to reach the PJS Service.

Web Intelligence Processing Service Settings
Property Description

Enable use of HTTP URL Specifies whether the server is able to access 
files that are stored remotely.

Proxy Value Specifies the address of your network proxy 
server. It is only necessary to specify a value if 
your network uses a proxy server and you at-
tempt to access files that are stored remotely.

Web Intelligence Common Service Settings
Property Description

Cache Timeout (minutes) Specifies the amount of time, in minutes, be-
fore the contents of the document cache will 
be cleared. The timeout depends on the most 
recent access date per document.

Document Cache Clean-up Interval (minutes) Specifies the time interval, in minutes, that the 
document cache is scanned and is checked 
against the Maximum Document Cache Size , 
Maximum Document Cache Reduction Space , 
and Maximum Document in Cache settings.

Disable Cache Sharing Specifies whether cache sharing is disabled. By 
default, cache sharing is enabled, which means 
that all Web Intelligence Processing server in-
stances will share the same cache. However, if 
you prefer to have one cache per instance of 
Web Intelligence Processing server then you 
must enable this property.

Enable Document Cache Specifies whether the document cache is ena-
bled. If the property is enabled, then the cache 
can be pre-loaded with scheduled Web Intelli-
gence documents.

Enable Real-Time Cache Specifies whether the real-time cache is ena-
bled. If the property is enabled, then the cache 
can be loaded dynamically. Therefore, the Web 
Intelligence Processing server caches Web In-
telligence documents when they are viewed. 
The server also caches the documents when 
they run as a scheduled job, if the pre-cache 
was enabled in the document.
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Property Description

Maximum Document Cache Size (KB) Specifies whether the real-time cache is ena-
bled. If the property is enabled, then the cache 
can be loaded dynamically. Therefore, the Web 
Intelligence Processing server caches Web In-
telligence documents when they are viewed. 
The server also caches the documents when 
they run as a scheduled job, if the pre-cache 
was enabled in the document.

Maximum Document Cache Reduction Space Specifies the percentage of cache that is emp-
tied to allow newer actions and results to be 
stored in the cache. Documents with the oldest 
“last access time” are purged.

Maximum Character Stream Size (MB) Specifies the maximum character stream size, 
in MB, sent to the Web Intelligence client.

Binary Stream Maximum Size (MB) Specifies the maximum size, in MB, of a binary 
stream sent to the Web Intelligence client.

Maximum Documents in Cache The maximum number of Web Intelligence 
documents that can be stored in the cache. 
There is never more than this many documents 
in the cache; the total size of the cache is never 
greater than the value specified with the Maxi-
mum Document Cache Reduction Space (MB) 
setting.

Images Directory Specifies the location of the image directory.

Output Cache Directory Specifies the location of the cache.

Web Intelligence Processing Server Metrics

Table 34: Server Metrics

Metric Description

Cache size (KB) The current amount, in kilobytes, of data that is 
stored in the cache.

Number of Out-of-Date Documents in Cache The number of documents deleted from the 
cache, because they were too old, since the 
server was started.

Cache High Mark Count The number of times that the cache has 
reached the maximum size allowed on the 
server since it was started.

CPU Usage (%) The percentage of total CPU time spent by the 
server since the server was started.
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Metric Description

Total CPU Time (seconds) The total CPU time, in seconds, spent by the 
server since it was started.

Memory High Threshold Count The number of times that the high memory 
threshold has been reached on the server since 
it was started.

Memory Max Threshold Count The number of times that the maximum mem-
ory threshold has been reached on the server 
since it was started.

Virtual Memory Size (MB) The total amount of memory, in megabytes, 
that are assigned to the server.

Current Number of Client Calls The current number of CORBA calls that the 
server is processing.

Current Number of Tasks The current number of tasks that are being 
executed on the server.

Total Number of Client Calls The total number of CORBA calls that the serv-
er has received since it was started.

Total Number of Tasks The total number of tasks that have been exe-
cuted on the server since it was started.

Idle Time (seconds) The amount of time, in seconds, that have 
elapsed since the last request that the server 
has received from a client.

Current Number of Active Sessions The current number of sessions that are able 
to accept requests from clients.

Number of Documents The number of documents that are currently 
open on the server.

Current Number of Sessions The current number of sessions that have been 
created on the server.

Number of Document Swap The number of documents for which a cleanup 
thread has scheduled swap requests.

Number of Swapped Documents The number of documents that have been 
swapped by swap requests.

Number of Sessions Timeout The number of sessions that have timed out 
since the server was started.

Total Number of Sessions The number of sessions that have been creat-
ed on the server since the server was started.

Number of Users The total number of users that are connected 
to the server.
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How to Configure the Web Intelligence Processing Server

Refer students to the Web Intelligence Processing Server Properties portion of their handbook to 
follow along with this demonstration.

Follow these instructions to configure the Web Intelligence Processing server properties.

1. Log on to the CMC as an administrator. Close the System Configuration Wizards if it appears 
after you log on.

2. Navigate to the Servers > Service Categories container and expand it.

3. Select the Web Intelligence Services container.

4. In the Web Intelligence Services container, right-click the node.WebIntelligenceProcessing 
server and select the Properties menu option.

5. In the Properties window, scroll down and locate the Information Engine Service portion of the 
window.

6. Make the appropriate changes to the Information Engine Service properties.

7. Scroll down the Properties window and locate the Web Intelligence Core Service portion.

8. Make the appropriate changes to the Web Intelligence Core Service properties.

9. Continue to scroll down the Properties window until you reach the Web Intelligence Processing 
Service portion.

10. Make your choice of changes to the Web Intelligence Processing Service properties.

11. Continue to scroll down the Properties window until you reach the Web Intelligence Common 
Service portion.

12. Make the appropriate changes to the Web Intelligence Common Service properties.
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Unit 9
Exercise 10

247
Manage and Monitor the Web Intelligence 
Processing Server

Business Example

As the system administrator, you must configure the Web Intelligence Processing Server to close 
idle connections after a certain amount of time and observe the impact of changing this number 
on the viewing of Web Intelligence reports.

Caution:
To do this exercise, use the new Training Course BOE320 content in the Initialize 
Course procedure.

Modifying Time Out for the Web Intelligence Processing Server
Configure the Web Intelligence Processing Server to close idle connections after two minutes.

1. Launch the CMC and logon with the following details:

Field Name Value

System <hostname>:6400

User name Administrator

Password <assigned password>

Authentication Enterprise

2. Go to the Servers area in the Central Management Console (CMC) and select the Web 
Intelligence Processing Server Properties .

3. Set the Idle Connection Timeout of the Web Intelligence Processing Server to 2 minutes.

4. Restart the chosen Web Intelligence Processing Server.

Publish an Excel File in the Platform
Publish an Excel file in the Business Intelligence 4.x platform.

1. Open your My Documents folder with Windows Explorer in your Training Cloud Environment. 
Make sure that you have uncompressed your Course Environment as requested by your 
instructor at the beginning of the training course.

2. As an administrator, publish the local EuropeTargets.xls file to your Personal folder in 
the BI 4.x platform.
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Create a Web Intelligence Document with a Published Excel File as a Datasource

1. From the BI 4.x launchpad, launch the Web Intelligence Web Application.

2. Create a New Web Intelligence Document with a published Excel file as the datasource.

3. In the Web Intelligence document, format the data in the Year column.

Note:
The data in the Year column is not date data.

4. Create a section for the year data.

5. Create a break for the country data.

6. Add a total to the performance measure at the section level.

7. Add a subtotal on all other measures at the break level.

8. Complete the Web Intelligence document by adding and applying a new conditional format 
rule for totals and subtotals on the Performance measure.

Conditions Color

Performance >0 Background: Green

Text: Black

Performance < = 0 Background: Red

Text: White

9. Save the Web Intelligence document with the name WEBI-Europe Targets to your 
Personal folder in the BI 4.x platform.

10. Close the Web Intelligence document.

Auto-Disconnect Web Intelligence Document Users

1. From the BI launch pad, open the WEBI-Europe Targets Web Intelligence document and 
refresh it.

2. Keep the document open for three minutes. Do not touch the Web browser. After two minutes 
of idle time, the Web Intelligence document automatically closes and all Web Intelligence 
users are automatically disconnected from the BI launch pad.

Note:
This automatic log-off of the Web Intelligence application and BI launch pad is the 
result of the Timeout parameter that was set to "2 minutes" in the Properties of 
the Web Intelligence Processing Server.
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Unit 9
Solution 10

249
Manage and Monitor the Web Intelligence 
Processing Server

Business Example

As the system administrator, you must configure the Web Intelligence Processing Server to close 
idle connections after a certain amount of time and observe the impact of changing this number 
on the viewing of Web Intelligence reports.

Caution:
To do this exercise, use the new Training Course BOE320 content in the Initialize 
Course procedure.

Modifying Time Out for the Web Intelligence Processing Server
Configure the Web Intelligence Processing Server to close idle connections after two minutes.

1. Launch the CMC and logon with the following details:

Field Name Value

System <hostname>:6400

User name Administrator

Password <assigned password>

Authentication Enterprise

a) Click Start → Programs → SAP BusinessObjects BI platform 4 → Custom Link to CMC 
homage page .

b) Log on with your username and password.

2. Go to the Servers area in the Central Management Console (CMC) and select the Web 
Intelligence Processing Server Properties .
a) Click Servers .

b) Navigate to Service Category  → Web Intelligence Services .

Hint:
Alternately, you can find the Web Intelligence Processing Server from the 
Server List .
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c) Right-click the Web Intelligence Processing Server and click Properties .

3. Set the Idle Connection Timeout of the Web Intelligence Processing Server to 2 minutes.
a) Under the Web Intelligence Core Service section, set the Idle Connection Timeout 

(minutes): to 2 .

b) Click Save & Close .
A flag appears next to the Web Intelligence Processing Server inside the Stale column.

4. Restart the chosen Web Intelligence Processing Server.
a) Right-click the Web Intelligence Processing Server.

b) Click Restart Server .
Wait for a few seconds for the server to restart.

c) Click the Refresh button.
The stale flag disappears and the server state is changed to Running .

Publish an Excel File in the Platform
Publish an Excel file in the Business Intelligence 4.x platform.

1. Open your My Documents folder with Windows Explorer in your Training Cloud Environment. 
Make sure that you have uncompressed your Course Environment as requested by your 
instructor at the beginning of the training course.

2. As an administrator, publish the local EuropeTargets.xls file to your Personal folder in 
the BI 4.x platform.
a) Log on to the Central Management Console (CMC) and select Personal Folders .

b) Select the Administrator folder.

c) Click the Manage Add-Local Document menu options.

d) Browse to your local folder and select the local EuropeTargets.xls file.

e) Click the Add button to publish the Excel file to your BI 4.x personal folder.
The local Excel file is now published to the BI 4.x platform.

Create a Web Intelligence Document with a Published Excel File as a Datasource

1. From the BI 4.x launchpad, launch the Web Intelligence Web Application.
a) Log on to the launchpad as the Administrator.

b) Click the Web Intelligence icon to launch it. Wait a couple of seconds for the application to 
load.

2. Create a New Web Intelligence Document with a published Excel file as the datasource.
a) Click the New icon to create a new Web Intelligence document.

b) Select the Excel option and then click the OK button.
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Note:
This is a new feature of the BI Launchpad in the BI 4.x.1 SP2 platform.

c) In your Personal folder, select the EuropeTargets.xls file and click the Open button.

d) Accept all of the default values in the dialog box and then click the OK button.

e) In the Query Panel dialog box, modify the following properties of the "Year" object in the 
Query:

a) Select the Year object in the Query panel.

b) In the Object Properties portion of the window, change the entry in the Qualification 
field to Dimension .

c) In the Object Properties portion of the window, change the entry in the Type field to 
Date.

f) Click the Run Query button to generate the Web Intelligence document.
The Web Intelligence document is now generated.

3. In the Web Intelligence document, format the data in the Year column.

Note:
The data in the Year column is not date data.

a) Select all of the data in the Year column of the Web Intelligence document.

b) Right-click on the selected data. On the resulting menu, click the Format Numbers option.

c) Select the Number option from the list.

d) In the list of values, select the 1235;-1235 option.

e) Click the OK button.
The year data is now formatted correctly in the Web Intelligence document.

4. Create a section for the year data.
a) In the Web Intelligence document, select all of the data in the "Year" column.

b) Right-click on the selected data. On the resulting menu, select the Set as Section option.

c) Resize the width of the cell for the section according to your own preferences.
The Web Intelligence document is now grouped by year.

5. Create a break for the country data.
a) In the Web Intelligence document, select all of the data in the "Country" column.

b) Right-click on the selected data. On the resulting menu, select the Break > Add Break 
options.

Lesson: Configuring a Web Intelligence Processing Server

© Copyright . All rights reserved. 265



c) Resize the width of the cell for the break according to your own preferences.
The Web Intelligence document is now grouped by year and contains breaks by country.

6. Add a total to the performance measure at the section level.
a) In the Web Intelligence document, drag the Performance object on the left-side of the 

window to the right-side of the Year section (just above the Performance column header).
The Web Intelligence document is now grouped by year, contains breaks by country, and 
shows the performance measure which is automatically aggregated at the section level.

7. Add a subtotal on all other measures at the break level.
a) In the Web Intelligence document, drag the Sold object from the left-side of the window, to 

the inside of the break cells of the Sold column.

b) Drag the Target object from the left-side of the window, to the inside of the break cell of 
the Target column.

c) Drag the Performance object frp, the left-side of the window, to the inside of the break cell 
of the Performance column.
The Web Intelligence document is now grouped by year, contains breaks by country, and 
shows totals and subtotals at the section and break level.

8. Complete the Web Intelligence document by adding and applying a new conditional format 
rule for totals and subtotals on the Performance measure.

Conditions Color

Performance >0 Background: Green

Text: Black

Performance < = 0 Background: Red

Text: White

a) Select the Analysis Condition options in the application toolbar.

b) Click the New Rule button.

c) Create the first condition as shown in the previous table.

d) Create the second condition as shown in the previous table.

e) Click the OK button.

f) In the Web Intelligence document, select the Total Value of Performance at the Section 
level. Then select the Formatting Rules -- Conditional Format option in the toolbar.
The new rule is evaluated and the conditional format is applied to Totals in the Web 
Intelligence document.

g) In the Web Intelligence document, select the subtotal value of Performance at the Break 
level. Then select Formatting Rules -- Conditional Format option in the toolbar.
The new rule is evaluated and the conditional format is applied to subtotals in the Web 
Intelligence document.
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h) In the Web Intelligence document, select all the other data in the Performance column. 
Then select the Formatting Rules -- Conditional Format option in the toolbar.
The new rule is evaluated and the conditional format is now applied to all of the 
Performance data in the Web Intelligence document.

9. Save the Web Intelligence document with the name WEBI-Europe Targets to your 
Personal folder in the BI 4.x platform.

10. Close the Web Intelligence document.

Auto-Disconnect Web Intelligence Document Users

1. From the BI launch pad, open the WEBI-Europe Targets Web Intelligence document and 
refresh it.

2. Keep the document open for three minutes. Do not touch the Web browser. After two minutes 
of idle time, the Web Intelligence document automatically closes and all Web Intelligence 
users are automatically disconnected from the BI launch pad.

Note:
This automatic log-off of the Web Intelligence application and BI launch pad is the 
result of the Timeout parameter that was set to "2 minutes" in the Properties of 
the Web Intelligence Processing Server.
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LESSON SUMMARY
You should now be able to:

● Configure a Web Intelligence Processing server
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Unit 9
Lesson 4

255
Configuring a Connection Server

LESSON OVERVIEW
A Connection server provides database access to source data. The Connection server manages 
connection and interaction with various data sources and provides a common feature set to 
clients. It is an integral step in the process to refresh a document in either two tier or three tier 
mode. The Connection server hosts two services: Native Connectivity service and Native 
Connectivity service (32-bit). The Connection server's few properties are easily configured from 
the CMC.

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● Configure a Connection server

Connection Server Role
Connection server provides database access to source data. It supports relational databases, as 
well as OLAP and other formats. The Connection server is responsible for handling connection 
and interaction with the various data sources and providing a common feature set to clients.

The following table lists all the services that are hosted by the Connection server.

Table 35: Services

Service Service category Service description

Native Connectivity 
Service

Connectivity Serv-
ices

Provides Native Connectivity services for 64-bit 
architectures.

Native Connectivity 
Service (32-bit)

Connectivity Serv-
ices

Provides Native Connectivity services for 32-bit 
architectures.

Document Refresh in Web Intelligence Desktop in Two-Tier Mode
The following steps explain the interaction of platform components when you refresh a document 
in SAP BusinessObjects Web Intelligence Desktop in two-tier mode

1. The SAP BusinessObjects Web Intelligence Desktop client sends a CORBA request to the 
Central Management Server (CMS) to locate an available Connection server.
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Note:
The user previously logged on to the SAP BusinessObjects Business Intelligence 
platform. Rights were checked and the document was opened in the Web 
Intelligence Desktop client. The CMS checks the CMS system database to locate 
an available Connection server, and then sends this information to the Web 
Intelligence Desktop client.

2. The Web Intelligence Desktop client sends a CORBA request to the Connection server to 
obtain current data for the Web Intelligence document.

3. The Connection server launches the required processes and obtains the current data from the 
data source, a relational database in this case.

4. The Connection server sends the current data to the Web Intelligence Desktop client, where 
the current data is displayed to refresh the Web Intelligence document.

Figure 37: Refresh a Document in SAP BusinessObjects Web Intelligence Desktop in Two-Tier

Document Refresh in Web Intelligence Desktop in Three-Tier Mode
The following steps explain the interaction of platform components when you refresh a document 
in SAP BusinessObjects Web Intelligence Desktop in three-tier mode.

1. The user sends the HTTP request (to refresh the Web Intelligence document) from the SAP 
BusinessObjects Web Intelligence Desktop client through the Web server to the Web 
Application server.
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Note:
The user previously logged on to the SAP BusinessObjects Business Intelligence 
platform. Rights were checked and the document was opened in the Web 
Intelligence Desktop client.

2. The Web Application server recognizes the request as a request to refresh a Web Intelligence 
document. The web application server requests an available Connection server from the 
Central Management Server (CMS). The CMS checks the CMS system database to locate an 
available Connection server, and then sends this information to the Web Application server.

3. The Web Application server sends a request to the Connection server to obtain current data 
for the Web Intelligence document.

4. The Connection server launches the required processes and obtains the current data from the 
data source, a relational database in this case.

5. The Connection server sends the current data to the Web Application server.

6. The Web Application server forwards the current data through the web server to the SAP 
BusinessObjects Web Intelligence Desktop client, where the current data is displayed to 
refresh the document.

Figure 38: Refresh a Document in SAP BusinessObjects Web Intelligence Desktop in Three-Tier Mode

Connection Server Metrics

The Connection Server and Connection Server 32 metrics are listed in the following table:
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Table 36: Connection Server Metrics

Server Metrics

Connection Server Busy Server Threads

CPUs

Disk Size

PID

RAM

Server Enabled State

Server Running State

Used Disk Space

Table 37: Connectivity Service Metrics

Metric Description

Data Sources Displays the following information for each network layer and database 
pair:

● Status : current status of the driver

● Available Connections : number of pool connections that can be used

● Jobs (CORBA) : number of jobs that are being processed (2-tier de-
ployment)

● Jobs (HTTP) : number of jobs that are being processed processing 
(web tier deployment)

LESSON SUMMARY
You should now be able to:

● Configure a Connection server
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Unit 9

259
Learning Assessment

1. Match the Web Intelligence Processing Server Service with the appropriate description.

Match the item in the first column to the corresponding item in the second column.

Information Engine Service

Web Intelligence Core Service

Web Intelligence Processing 
Service

Web Intelligence Common 
Service

Service required for Web Intel-
ligence documents process-
ing.

Accepts and processes Web 
Intelligence documents.

Supports Web Intelligence 
documents processing.

Supports Web Intelligence 
documents processing.

2. Arrange the steps to set and run a schedule for a Web Intelligence Document into the proper 
order.

Arrange these steps into the correct sequence.

0 Log on to the CMC as an administrator.

0 Click the Schedule button at the bottom right of the screen. The scheduled document 
appears listed n the Documents > History window.

0 In the Schedule window, select the Weekly option (or whichever option you prefer) from 
the Recurrence Run Object dropdown list.

0 Navigate to the folder that contains the Web Intelligence document that you want to 
schedule.

0 Right-click the document and select Schedule from the menu options. The Schedule 
window opens.
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3. Arrange these steps to match the sequence of the interaction of platform components when 
you export a Web Intelligence document.

Arrange these steps into the correct sequence.

0 The Web Application server sends a request to the Web Intelligence Processing server to 
export the currently open document.

0 The Web Application server sends the formatted document through the Web server to the 
Web client.

0 The user sends the export request from the Web Intelligence Web client through the web 
server to the Web Application server, where the Web Intelligence Web Application is 
running.

0 The Web Intelligence Processing server sends the formatted document to the Web 
Application server.

0 The Web Intelligence Processing server processes the document into the requested export 
format (PDF or Excel).

4. How many platform interactions are involved in the process to refresh a document in Web 
Intelligence Desktop in one-tier mode?

Choose the correct answer.

X A 1

X B 2

X C 3

X D 4

5. Select the correct menu path for accessing the Web Intelligence Processing server properties.

Choose the correct answer.

X A Go to CMC > Services > Web Intelligence Services > Service Properties .

X B Go to CMC > Servers > Web Intelligence Servers > Web Intelligence Processing server > 
Properties .

X C Go to the CMC > Servers>Service Categorie s> Web Intelligence Services . Right click 
Web Intelligence Processing serve r and select the Properties option from the resulting 
options menu.

X D  Go to CMS > Services > Web Intelligence Services . Right click Web Intelligence 
Processing server and select the Properties menu option.

Unit 9: Learning Assessment
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Unit 9

261
Learning Assessment - Answers

1. Match the Web Intelligence Processing Server Service with the appropriate description.

Match the item in the first column to the corresponding item in the second column.

Information Engine Service

Web Intelligence Core Service

Web Intelligence Processing 
Service

Web Intelligence Common 
Service

Service required for Web Intel-
ligence documents process-
ing.

Supports Web Intelligence 
documents processing.

Accepts and processes Web 
Intelligence documents.

Supports Web Intelligence 
documents processing.

2. Arrange the steps to set and run a schedule for a Web Intelligence Document into the proper 
order.

Arrange these steps into the correct sequence.

1 Log on to the CMC as an administrator.

5 Click the Schedule button at the bottom right of the screen. The scheduled document 
appears listed n the Documents > History window.

4 In the Schedule window, select the Weekly option (or whichever option you prefer) from 
the Recurrence Run Object dropdown list.

2 Navigate to the folder that contains the Web Intelligence document that you want to 
schedule.

3 Right-click the document and select Schedule from the menu options. The Schedule 
window opens.
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3. Arrange these steps to match the sequence of the interaction of platform components when 
you export a Web Intelligence document.

Arrange these steps into the correct sequence.

2 The Web Application server sends a request to the Web Intelligence Processing server to 
export the currently open document.

5 The Web Application server sends the formatted document through the Web server to the 
Web client.

1 The user sends the export request from the Web Intelligence Web client through the web 
server to the Web Application server, where the Web Intelligence Web Application is 
running.

4 The Web Intelligence Processing server sends the formatted document to the Web 
Application server.

3 The Web Intelligence Processing server processes the document into the requested export 
format (PDF or Excel).

4. How many platform interactions are involved in the process to refresh a document in Web 
Intelligence Desktop in one-tier mode?

Choose the correct answer.

X A 1

X B 2

X C 3

X D 4

5. Select the correct menu path for accessing the Web Intelligence Processing server properties.

Choose the correct answer.

X A Go to CMC > Services > Web Intelligence Services > Service Properties .

X B Go to CMC > Servers > Web Intelligence Servers > Web Intelligence Processing server > 
Properties .

X C Go to the CMC > Servers>Service Categorie s> Web Intelligence Services . Right click 
Web Intelligence Processing serve r and select the Properties option from the resulting 
options menu.

X D  Go to CMS > Services > Web Intelligence Services . Right click Web Intelligence 
Processing server and select the Properties menu option.
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UNIT 10 Dashboard Servers

Lesson 1

Configuring Dashboard Servers 278

Lesson 2

Managing Dashboard Design Servers 288
Exercise 11: Create and Manage Dashboards 295

UNIT OBJECTIVES

● Configure Dashboards servers

● Manage Dashboards Design servers
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Unit 10
Lesson 1

264
Configuring Dashboard Servers

LESSON OVERVIEW
Dashboard Design is a tool that provides data visualization with an embedded Excel spreadsheet 
on a Flash interface. This powerful tool updates data dynamically from the platform and exports it 
to the user's preferred format. The Dashboard Design Cache server and the Dashboard 
Processing server are the Dashboard Design servers. These servers can be configured by 
accessing their properties through the CMC.

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● Configure Dashboards servers

SAP Business Objects Dashboards Design Servers

SAP BusinessObjects Dashboards Design
SAP BusinessObjects Dashboards Design (formerly Xcelsius) is a tool for data visualization 
and the creation of dynamic, interactive Dashboards. Data and formulae are imported or 
directly entered into an embedded Excel spreadsheet. A Flash interface provides a canvas 
that can display a variety of analytics and Dashboards. Data can be updated dynamically 
from SAP BusinessObjects BI platform, and exported to a variety of different formats that 
can be viewed by data consumers in standard formats, such as PowerPoint, PDF, or Flash.

Table 38: Dashboards Design Servers

Server kind Description

Dashboards Cache Server Intercepts report requests sent from clients to the Dash-
boards Processing Server. If the cache server cannot ful-
fill the request with a cached report page, it passes the re-
quest on to the Dashboards Processing server, which 
runs the report and returns the results. The cache server 
then caches the report page for potential future use.

Dashboards Processing Server Responds to Dashboards Design requests and shares da-
ta between reports to reduce the number of database ac-
cesses.
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INTERACTIVE ELEMENT: Chat

1. Discuss the two Dashboards design servers. How do they work in unison?

.

.

.

.

.

.

.

.

.

Dashboards Processing Server Properties

Table 39: Dashboards Processing Server Properties

Property Description Default Value

Maximum Concurrent Jobs Specifies the maximum num-
ber of independent jobs al-
lowed to run concurrently on 
the server. If the value of this 
property is set to "0", the serv-
er applies a suitable value that 
is based on the CPU and mem-
ory of the machine that the 
server is running on.

The default value is 0.

Maximum Lifetime Jobs Per 
Child

Specifies the maximum num-
ber of jobs that each child 
process can manage per life-
time.

The default value is 10000.

Maximum Number of Prestart-
ed Children

Specifies the maximum num-
ber of prestarted child proc-
esses that are allowed by the 
server. If this value is too low, 
the server creates child proc-
esses as soon as requests are 
made. A user may experience 
latency. If this value is too 
high, system resources may 
be unnecessarily wasted by 
idle child processes.

The default value is 1.

Lesson: Configuring Dashboard Servers
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Property Description Default Value

Idle Connection Timeout (mi-
nutes)

Specifies the amount of time, 
in minutes, that the server 
waits for a request from an idle 
connection. There is generally 
no need to modify the default 
value.

The default value is 15 mi-
nutes.

Idle Job Timeout (minutes) Specifies the length of time (in 
minutes) that the server waits 
between requests for a given 
job.

the default value is 15 minutes.

Java Child VM Arguments Species the command line ar-
guments that are supplied to 
child processes that are creat-
ed by the server.

Xmx858M,Dswfinjec 
tion.lang.directo ry=%Com-
monJavaL ibDir%,Dbusines-
sob jects.connectivity.di recto-
ry=%CONNEC TIONSERV-
ER_DIR%

Unit 10: Dashboard Servers
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Facilitator Producer

Say:

"We'll be starting a group chat activity. I will 
be pasting a series of questions into the Chat 
Pod and ask that you enter your response af-
ter each question is posted."

"I will select some responses to discuss as a 
group."

Do:

Display the first question on the slide provid-
ed in the Instructor Presentation deck. Dis-
play questions one at a time.

Ask them to answer their questions based on 
their independent study and then to review 
their classmates answers.

Select the response from one participant and 
copy and paste it to the whiteboard.

Do:

Assist by pasting the prewritten questions in-
to the Chat Pod.

If desired, archive the Chat Pod and white-
board overlay for later reference and distribu-
tion.

Dashboards Cache Server Properties

Table 40: Dashboards Cache Server Properties

Property Description Default Value

Maximum Cache Size (KB) Specifies the amount of hard 
disk space, in kilobytes, that is 
used to cache queries. A large 
cache size may be necessary if 
the server needs to handle 
large numbers of queries or 
highly complex queries.

The default value is 256000 
KB.

Lesson: Configuring Dashboard Servers
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Property Description Default Value

Idle Connection Timeout (mi-
nutes)

Specifies the amount of time, 
in minutes, that the Dash-
boards Cache Server waits for 
a request from an idle connec-
tion. There is not normally a 
need to modify the default val-
ue.

The default value is 15 mi-
nutes.

Share Data Between Clients Specifies whether report data 
is shared between different cli-
ents.

The default value is TRUE.

Unit 10: Dashboard Servers
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Property Description Default Value

Oldest On Demand Data Given 
to Clients (seconds)

Specifies the amount of time, 
in seconds, that the server 
uses cached data to meet re-
quests from ondemand quer-
ies.

If the server receives a request 
that can be met using data 
that was generated to meet a 
previous request, and the time 
elapsed since that data was 
generated is less than the val-
ue set here, then the server 
will reuse this data to meet the 
subsequent request. Reusing 
data in this way significantly 
improves system performance 
when multiple users need the 
same information.

When setting this value, con-
sider how important it is that 
your users receive up-to-date 
data. If it is very important that 
all users receive fresh data 
(important changes happen 
frequently) you may need to 
disallow this kind of data reuse 
by setting the value to 0.

Note:
This property can 
be set in a report 
object itself. The 
values specified 
on the report ob-
ject override the 
server settings.

The default value is 0 seconds.

Security Cache Timeout (mi-
nutes)

Specifies the amount of time, 
in minutes, that the server 
uses cached logon credentials, 
query properties, and data-
base connection information 
to server requests before 
querying the CMS.

The default value is 20 mi-
nutes.

Lesson: Configuring Dashboard Servers
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Property Description Default Value

Java VM Arguments Specifies the command line ar-
guments that can be supplied 
to the JVM.

Xmx858M

Dashboards Server Metrics

Table 41: Dashboards Processing Server Metrics

Metric Description

Open Jobs A table listing of the jobs that are currently being run on the server. 
The table includes the ID and Name of the document, the name of 
the user running the job, the date that the document was last ac-
cessed, and the amount of time that the job has been running.

Number of Requests 
Served

The total number of requests that the server has served since it 
started.

Number of Open Jobs The number of currently jobs that the server and its child processes 
are currently processing.

ObjectType The type of InfoObject that the server primarily deals with. The value 
for this metric does not change.

Average Processing Time 
(msec)

The average time, in milliseconds, the server has spent processing 
the last 500 requests that the server has received. If this number is 
consistently high and growing, consider creating additional servers 
on other machines.

Maximum Processing 
Time (msec)

The maximum time, in milliseconds, that the server has spent proc-
essing one of the last 500 requests. If this number is consistently 
high and growing, consider creating additional servers on other ma-
chines.

Minimum Processing 
Time (msec)

The minimum time, in milliseconds, that the server has spent proc-
essing one of the last 500 requests. If this number is consistently 
high and growing, consider creating additional servers on other ma-
chines.

Number of Queued Re-
quests

The number of requests that are either waiting to be processed or 
are being processed. If this number is consistently high and growing, 
consider creating additional servers on other machines.

ObjectDllName The name of the processing plug-in for the server. The value of this 
metric does not change.

Number of Open Connec-
tions

The number of connections that are currently open between the 
server and clients.

Request Failure Rate The number of requests that the server failed to process as a per-
centage of the last 500 requests that the server has received.
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Metric Description

Data Transferred (KB) The total amount of data, in kilobytes, that have been transferred to 
clients since the server was started.

Number of Requests 
Failed

The number of requests that the server was unable to complete 
since the server started.

MaxChildProcesses The maximum number of concurrent child processes that are al-
lowed on the server.

Dashboards Cache Server Metrics

Table 42: Dashboards Cache Server Metrics

Metric Description

Cache Hit Rate (%) The percentage of requests, over the last 500 requests, that have 
been served with cached data.

Connected Processing 
Servers

A table listing of the Dashboards Design Processing servers in your 
deployment. The table lists the name of the server and the number 
of connections that are currently open with the server.

Number of Requests 
Served

The total number of requests that the server has served since it 
started.

ObjectType The type of InfoObject that the server primarily deals with. The value 
for this metric does not change.

Average Processing Time 
(msec)

The average time, in milliseconds, the server has spent processing 
the last 500 requests that the server has received. If this number is 
consistently high and growing, consider creating additional servers 
on other machines.

Maximum Processing 
Time (msec)

The maximum time, in milliseconds, that the server has spent proc-
essing one of the last 500 requests. If this number is consistently 
high and growing, consider creating additional servers on other ma-
chines.

Minimum Processing 
Time (msec)

The minimum time, in milliseconds, that the server has spent proc-
essing one of the last 500 requests. If this number is consistently 
high and growing, consider creating additional servers on other ma-
chines.

Number of Queued Re-
quests

The number of requests that are either waiting to be processed or 
are being processed. If this number is consistently high and growing, 
consider creating additional servers on other machines.

ObjectDllName The name of the processing plug-in for the server. The value of this 
metric does not change.

Cache Size (KB) The amount of data, in kilobytes, that is currently being cached by 
the server on the disk.
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Metric Description

Number of Open Connec-
tions

The number of connections to clients that are currently open.

Data Transferred (KB) The total amount of data, in kilobytes, that have been transferred to 
clients since the server was started.

Dashboards Cache Server

Figure 39: View an SAP BusinessObjects Dashboard Cache Dashboard based on a universe when the query result is 
in the cache

The following steps describe the interaction of components when a user views a Dashboard that 
is based on a universe.

1. The user sends the view request from the BI Launchpad web client through the Web server to 
the Web application server, where the Launchpad web application is running.

2. The Web Application server recognizes the request as a request to view the Dashboards of a 
Dashboards Design object. The Web Application server communicates with the Central 
Management Server (CMS) to obtain the Dashboards SWF file in the language corresponding 
to the user’s preferred viewing locale (PVL).

3. The CMS checks the CMS system database to locate the Dashboards SWF file.

4. The CMS obtains the Dashboards SWF file from the Input File Repository server.

5. The CMS provides the Dashboards SWF file to the Web Application server.

Unit 10: Dashboard Servers
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6. The Web Application server sends the Dashboards SWF file through the web server to the 
Web client, where the SWF is rendered.

7. The SWF sends a request through the Web server to XcelsiusWebServices (which is a web 
service running on the Web Application server) to retrieve the universe (UNX) query result 
set.

Note:
The Dashboards may require one or more query results, depending on the 
visualization components included on the Dashboards.

8. XcelsiusWebServices sends the request to the Dashboards Cache server, requesting the 
universe (UNX) query result set.

9. The Dashboards Cache server checks with the Central Management Server (CMS) to see if 
the user has rights to run a query off the universe. The CMS checks the CMS system database 
and returns confirmation that the user has rights to run the query.

10. The Dashboards Cache server checks to see if the query result set already exists in its cache. 
In this case, the result set does exist, so the Dashboards Cache server returns the result set to 
XcelsiusWebServices.

11. XcelsiusWebServices sends the query result set back through the web server to the SWF on 
the Web client, to load up the Dashboards with current data.

LESSON SUMMARY
You should now be able to:

● Configure Dashboards servers

Lesson: Configuring Dashboard Servers
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Unit 10
Lesson 2

272
Managing Dashboard Design Servers

LESSON OVERVIEW
The Dashboard Design servers enable Dashboard creation, Dashboard design, Dashboard 
previewing, and Dashboard viewing when the query result is not in the cache. A New Query wizard 
provides easy steps to create a new query based on a BI universe on dashboards. Dashboard 
design offers simple configuration options through the Dashboard Components Panel. 
Administrators can test and publish a Dashboard to the platform with just a few mouse clicks.

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● Manage Dashboards Design servers

Dashboards Previewing

Figure 40: Preview a new Dashboard based on a universe in SAP BusinessObjects Dashboards Design

1. SAP BusinessObjects Dashboards Design sends an HTTP request through the web server to 
XcelsiusWebServices (which is a Web service running on the Web Application server) to 
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retrieve the universe (UNX) query result set. Note: The Dashboards may require one or more 
query results, depending on the visualization components included on the Dashboards. Note: 
This process assumes the user previously logged on to the SAP BusinessObjects Business 
Intelligence platform from SAP BusinessObjects Dashboards Design to access the universe 
(UNX) on which to design the new Dashboards.

2. XcelsiusWebServices sends the request to the Dashboards Design Cache server, requesting 
the universe (UNX) query result set.

3. The Dashboards Design Cache server checks with the Central Management Server (CMS) to 
see if the user has rights to run a query off the universe. The CMS checks the CMS system 
database and returns confirmation that the user has rights to run the query.

4. The Dashboards Design Cache server checks to see if the query result set already exists in its 
cache. In this case the result does not exist, so the Dashboards Design Cache server sends 
the request to the Dashboards Design Processing server to retrieve the query result set.

5. The Dashboards Design Processing server launches the processes required to connect to the 
data source to obtain the query result set.

6. The Dashboards Design Processing server obtains the query result data from the data source, 
in this case a relational database.

7. The Dashboards Design Processing server returns the query result set to the Dashboards 
Design Cache server. The Dashboards Design Cache server saves the query result set in its 
cache directory.

8. The Dashboards Design Cache server returns the query result set to XcelsiusWebServices.

9. XcelsiusWebServices sends the query result set through the web server to SAP 
BusinessObjects Dashboards Design, to load current data into the Dashboards.

Lesson: Managing Dashboard Design Servers
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Dashboards Viewing When the Query Result is not in the Cache

Figure 41: View an SAP BusinessObjects Dashboards Design Dashboards on a Universe When the Query Result is not 
in the Cache

1. The user sends the view request from the BI launch pad Web client through the web server to 
the web application server, where the BI launch pad Web Application is running.

2. The Web Application server recognizes the request as a request to view the Dashboards of a 
Dashboards Design object. The Web Application server communicates with the Central 
Management Server (CMS) to obtain the Dashboards SWF file in the language corresponding 
to the user’s preferred viewing locale (PVL).

3. The CMS checks the CMS system database to locate the Dashboards SWF file.

4. The CMS obtains the Dashboards SWF file from the Input File Repository server.

5. The CMS provides the Dashboards SWF file to the Web Application server.

6. The Web Application server sends the Dashboards SWF file through the web server to the web 
client, where the SWF is rendered.

7. The SWF sends a request through the web server to XcelsiusWebServices (which is a Web 
service running on the Web Application server) to retrieve the universe (UNX) query result 
set.
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290 © Copyright . All rights reserved.



Note:
The Dashboards may require one or more query results, depending on the 
visualization components included on the Dashboards.

8. XcelsiusWebServices sends the request to the Dashboards Design Cache server, requesting 
the universe (UNX) query result set.

9. The Dashboards Design Cache server checks with the Central Management Server (CMS) to 
see if the user has rights to run a query off the universe. The CMS checks the CMS system 
database and returns confirmation that the user has rights to run the query.

10. The Dashboards Design Cache server checks to see if the query result set already exists in its 
cache. In this case the result does not exist, so the Dashboards Design Cache server sends 
the request to the Dashboards Design Processing server to retrieve the query result set.

11. The Dashboards Design Processing server launches the processes required to connect to the 
data source to obtain the query result set. These processes obtain any required objects, such 
as the universe (UNX), from the Input File Repository server. Note: this step also requires 
communication (not shown in this diagram) with the Central Management Server (CMS) and 
the CMS system database to locate the required server and objects.

12. The Dashboards Design Processing server obtains the query result data from the data source, 
in this case a relational database.

13. The Dashboards Design Processing server returns the query result set to the Dashboards 
Design Cache server. The Dashboards Design Cache server saves the query result set in its 
cache directory.

14. The Dashboards Design Cache server returns the query result set to XcelsiusWebServices.

15. XcelsiusWebServices sends the query result set back through the web server to the SWF on 
the web client, to load up the Dashboards with current data.

Lesson: Managing Dashboard Design Servers
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Dashboards Design Based on an Universe in SAP BusinessObjects Dashboards 
Design

Figure 42: Design a New Dashboard Based on a Universe in SAP BusinessObjects Dashboards Design

1. SAP BusinessObjects Dashboards Design sends a CORBA message to the Central 
Management Server (CMS) for the user to log on to the SAP BusinessObjects Business 
Intelligence platform. The CMS checks the CMS system database to authenticate the user 
and check rights. The CMS returns information about log on success and user rights to SAP 
BusinessObjects Dashboards Design.

2. SAP BusinessObjects Dashboards Design sends HTTP requests (to obtain information about 
universes (UNX) available to the user) through the web server to the web application server, 
where the XcelsiusWebServices Web service is running.

3. XcelsiusWebServices sends requests to the Central Management server to obtain information 
about the universes (UNX) available to the user.

4. The Central Management Server (CMS) checks the CMS system database to determine which 
universes (UNX) are available to the user and where the universe files are stored.

5. The CMS Management server obtains required resources, such as universe (UNX) files, from 
the Input File Repository server.

6. The CMS sends the information (about universes available to the user) to 
XcelsiusWebServices.

7. XcelsiusWebServices sends the information (about universes available to the user) through 
the web server to SAP BusinessObjects Dashboards Design.
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8. The user selects an universe (UNX) and builds a query based on that universe in the SAP 
BusinessObjects Dashboards Design query panel.

9. The user binds the query to a visualization.

Note:
A Dashboard can include multiple visualizations, and each can be bound to a 
different query.

Dashboards Saved to SAP Business Objects Business Intelligence Platform

Figure 43: Save a New Dashboard to the SAP BusinessObjects Business Intelligence Platform

1. SAP BusinessObjects Dashboards Design sends a CORBA message to the Central 
Management Server (CMS) to save the new Dashboards to the SAP BusinessObjects 
Business Intelligence platform. Note: This process assumes the user previously logged on to 
the SAP BusinessObjects Business Intelligence platform from SAP BusinessObjects 
Dashboards Design to design the new Dashboards based on an universe (UNX).

2. The Central Management Server (CMS) creates all required metadata about the new 
Dashboards and stores it as an InfoObject in the CMS system database.

3. The CMS communicates with the Input File Repository server to store the new Dashboards 
runtime SWF file and the new Dashboards definition XLF file.

4. The CMS returns information about save success to SAP BusinessObjects Dashboards 
Design.
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Unit 10
Exercise 11

279
Create and Manage Dashboards

Business Example

As the system administrator, you understand how the Dashboards servers manage the 
visualization of some BI 4 platform Dashboard.

Caution:
You use the new Training course BOE320 content in the Initialize Course 
folder to do this exercise.

Create a Query based on a BI 4 Universe on Dashboards

1. From the Cloud Training Environment, go to Start  →  Programs  →  SAP Business Intelligence 
 →  SAP BusinessObject Dashboards 4 , and run the Dashboards 4 application.

2. Begin to create a new query on the Warehouse.unx universe with the Add Query button.

3. Enter your BI 4 Administrator credentials.

4. In the Wizard, select the appropriate options for your querry.

5. In the Add Query window, drag and drop the following objects into the Result Objects panel:

● Country

● Quantity

● Net Sales

● Margin

6. In the Add Query window, drag and drop the Year object into the Filters panel.

7. In the Filters panel, perform the following steps:

8. Keep the default prompt value, and then click the Run button.

9. Click the Next button, and then click the OK button to create the query.

Hint:
You can see your query in the Query Browser panel on the left side of the screen.
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Design the Dashboards

1. Add a bar chart to your Dashboards.

2. Begin to configure the properties of your bar chart component by entering the following title: 
Incoming Orders Per Country .

3. In the Data by Series area, perform the following steps:

● Enter Quantity for the Name value.

● Select Quantity from the Query Data option for Values(X).

4. Add a second series in the Data by Series area and provide the following information for the 
series:

● Enter Net Sales for the Name value.

● Select the Net Sales from the Data Query option for Values(X).

5. Add a third series in the Data By Series area. Provide the following information for the series.

● Enter Margin for the Name value.

● Select Margin from the Query Data option for Values(X).

● Choose Country as the Category Label (Y) from the Query Data option.

Your bar chart is now properly configured.

6. From the Components Panel on the left side of the Dashboard window, drag the Query 
Prompt Selector component to the position above the Bar Chart Component to add a Query 
Prompt Selector in your Dashboards.

7. Configure the properties of the Query Prompt Selector component to refresh.

● Select your query prompt displayed in the Source Prompt dropdown list.

● Select the Refresh Queries checkbox in front of Query 1.

Your query prompt selector is now configured.

Test and Publish your Dashboards to the Platform

1. Locally test your Dashboards.

2. Publish your Dashboards as Incoming Orders Dashboards onto the BI 4 platform in your 
Personal folder.

Publish and Test Dashboards Servers (Cache and Processing)

1. In the Cloud Training Environment, open and publish World Sales by Region.XLF from 
another local Dashboard to your BI 4 Personal folder.

Note:
This sample Dashboard is a standalone Dashboard. It does not use BI 4 Queries.
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2. In the BI launch pad, open the World Sales by Region standalone Dashboards. What 
happened?
Your standalone Dashboards is correctly displayed with data.

3. In the BI launch pad, open Incoming Orders Dashboards using the Incoming Orders 
Dashboards BI 4 Query. What happened?
Your Query Dashboards is correctly displayed with data.

4. In the CMC, stop the Dashboards Cache server. Try to view the two previous Dashboards 
again. What happened?
Your standalone Dashboards can continue to display data because it does not use the 
Dashboards Cache server for visualization. Your Query Dashboards cannot display data 
because the Cache server has stopped. Data that comes from a BI 4 Query is stored and 
managed by the Dashboards Cache server.

5. In the CMC, stop the Dashboards Processing server. Try to view the two previous Dashboard 
again. What happened?
Your standalone Dashboards can continue to display data. It does not use the Dashboards 
Processing server for visualization. Your Query Dashboards cannot display data because the 
Cache server is still stopped. Data that comes from a BI 4 Query is generated by the 
Dashboards Processing server.

Lesson: Managing Dashboard Design Servers
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282
Create and Manage Dashboards

Business Example

As the system administrator, you understand how the Dashboards servers manage the 
visualization of some BI 4 platform Dashboard.

Caution:
You use the new Training course BOE320 content in the Initialize Course 
folder to do this exercise.

Create a Query based on a BI 4 Universe on Dashboards

1. From the Cloud Training Environment, go to Start  →  Programs  →  SAP Business Intelligence 
 →  SAP BusinessObject Dashboards 4 , and run the Dashboards 4 application.

2. Begin to create a new query on the Warehouse.unx universe with the Add Query button.
a) Select the View-Query Browser menu option.

b) On the left side of the Query Browser window, click the Add Query button to create the 
query.

3. Enter your BI 4 Administrator credentials.

4. In the Wizard, select the appropriate options for your querry.
a) Select the Universe option and then click the Next button.

b) Select the Warehouse.unx option from the list and then click the Next button.

5. In the Add Query window, drag and drop the following objects into the Result Objects panel:

● Country

● Quantity

● Net Sales

● Margin

6. In the Add Query window, drag and drop the Year object into the Filters panel.

7. In the Filters panel, perform the following steps:
a) In the Filters panel, select the List of Values from the list box.

b) Select 2006 and click > to move the value to the Selected member window.
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c) Click the OK button and then click the Next button.

8. Keep the default prompt value, and then click the Run button.

9. Click the Next button, and then click the OK button to create the query.

Hint:
You can see your query in the Query Browser panel on the left side of the screen.

Design the Dashboards

1. Add a bar chart to your Dashboards.
a) In the Components Panel on the left side of the window, drag and resize the Bar Chart 

component on your canvas in Dashboard.

2. Begin to configure the properties of your bar chart component by entering the following title: 
Incoming Orders Per Country .

3. In the Data by Series area, perform the following steps:

● Enter Quantity for the Name value.

● Select Quantity from the Query Data option for Values(X).

4. Add a second series in the Data by Series area and provide the following information for the 
series:

● Enter Net Sales for the Name value.

● Select the Net Sales from the Data Query option for Values(X).

a) Click the + sign to add a second series in the Data By Series area. Provide the listed 
information for the series.

5. Add a third series in the Data By Series area. Provide the following information for the series.

● Enter Margin for the Name value.

● Select Margin from the Query Data option for Values(X).

● Choose Country as the Category Label (Y) from the Query Data option.

a) Click the + sign to add a third series in the Data By Series area. Then provide the listed 
information for the series.

Your bar chart is now properly configured.

6. From the Components Panel on the left side of the Dashboard window, drag the Query 
Prompt Selector component to the position above the Bar Chart Component to add a Query 
Prompt Selector in your Dashboards.
a) In the Components Panel on the left side of the window, drag the Query Prompt Selector 

component to the position above the Bar Chart component, on the top of your canvas in 
Dashboard.

Lesson: Managing Dashboard Design Servers
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7. Configure the properties of the Query Prompt Selector component to refresh.

● Select your query prompt displayed in the Source Prompt dropdown list.

● Select the Refresh Queries checkbox in front of Query 1.

Your query prompt selector is now configured.

Test and Publish your Dashboards to the Platform

1. Locally test your Dashboards.
a) Click the Preview button.

b) Enter all of your credentials.

c) Choose any year option in the Prompt Values field.

d) Click the Apply button.

2. Publish your Dashboards as Incoming Orders Dashboards onto the BI 4 platform in your 
Personal folder.

a) Select the File > Save to Platform menu options from the Dashboard application.

b) Select your Personal folder.

c) Enter the following to name your Dashboards: Incoming Orders Dashboards .

d) Click the Save button.
Your Dashboards is now published on the BI 4 platform.

Publish and Test Dashboards Servers (Cache and Processing)

1. In the Cloud Training Environment, open and publish World Sales by Region.XLF from 
another local Dashboard to your BI 4 Personal folder.

Note:
This sample Dashboard is a standalone Dashboard. It does not use BI 4 Queries.

2. In the BI launch pad, open the World Sales by Region standalone Dashboards. What 
happened?
Your standalone Dashboards is correctly displayed with data.

3. In the BI launch pad, open Incoming Orders Dashboards using the Incoming Orders 
Dashboards BI 4 Query. What happened?
Your Query Dashboards is correctly displayed with data.

4. In the CMC, stop the Dashboards Cache server. Try to view the two previous Dashboards 
again. What happened?
Your standalone Dashboards can continue to display data because it does not use the 
Dashboards Cache server for visualization. Your Query Dashboards cannot display data 
because the Cache server has stopped. Data that comes from a BI 4 Query is stored and 
managed by the Dashboards Cache server.
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5. In the CMC, stop the Dashboards Processing server. Try to view the two previous Dashboard 
again. What happened?
Your standalone Dashboards can continue to display data. It does not use the Dashboards 
Processing server for visualization. Your Query Dashboards cannot display data because the 
Cache server is still stopped. Data that comes from a BI 4 Query is generated by the 
Dashboards Processing server.

Lesson: Managing Dashboard Design Servers
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LESSON SUMMARY
You should now be able to:

● Manage Dashboards Design servers

Unit 10: Dashboard Servers
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Unit 10

287
Learning Assessment

1. Which servers are Dashboards Design servers?

Choose the correct answers.

X A Dashboards Processing Server

X B Dashboards Adaptive Server

X C Dashboards Enterprise Server

X D Dashboards Cache Server

2. Dashboards Design is a tool for data storage and the creation of on demand reports.

Determine whether this statement is true or false.

X True

X False

3. Arrange the following steps for saving a Dashboard to the Business Intelligence Platform in 
the correct order.

Arrange these steps into the correct sequence.

0 The CMS communicates with the Input File Repository server to store the new Dashboards 
runtime SWF file and the new Dashboards definition XLF file.

0 SAP BusinessObjects Dashboards Design sends a CORBA message to the Central 
Management Server (CMS) to save the new Dashboards to the SAP BusinessObjects 
Business Intelligence platform.

0 The CMS creates all required metadata about the new Dashboards and stores it as an 
InfoObject in the CMS system database.

0 The CMS returns information about save success to SAP BusinessObjects Dashboards 
Design.
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288
Learning Assessment - Answers

1. Which servers are Dashboards Design servers?

Choose the correct answers.

X A Dashboards Processing Server

X B Dashboards Adaptive Server

X C Dashboards Enterprise Server

X D Dashboards Cache Server

2. Dashboards Design is a tool for data storage and the creation of on demand reports.

Determine whether this statement is true or false.

X True

X False

3. Arrange the following steps for saving a Dashboard to the Business Intelligence Platform in 
the correct order.

Arrange these steps into the correct sequence.

3 The CMS communicates with the Input File Repository server to store the new Dashboards 
runtime SWF file and the new Dashboards definition XLF file.

1 SAP BusinessObjects Dashboards Design sends a CORBA message to the Central 
Management Server (CMS) to save the new Dashboards to the SAP BusinessObjects 
Business Intelligence platform.

2 The CMS creates all required metadata about the new Dashboards and stores it as an 
InfoObject in the CMS system database.

4 The CMS returns information about save success to SAP BusinessObjects Dashboards 
Design.
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UNIT OBJECTIVES

● Configure Explorer servers

● Manage information spaces
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290
Configuring Explorer Servers

LESSON OVERVIEW
SAP BusinessObjects Explorer is an application that can be launched from the BI launch pad. 
Explorer installs four servers that are added to the Central Configuration Manager (CCM) and the 
Central Management Console (CMC). These servers manage information exploration, indexing, 
and search querries for the platform. Explorer servers are easily configured by accessing the 
server properties through the CMC.

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● Configure Explorer servers

SAP BusinessObjects Explorer
You launch SAP BusinessObjects Explorer from within the BI launch pad. You can launch the 
Explorer as an application, or you can open and explore an Information Space directly from the BI 
Launchpad document list on the Documents tab.

When you install SAP BusinessObjects Explorer, the following servers are added to the Central 
Configuration Manager (CCM) and Central Management Console (CMC):

● Explorer Master Server

● Explorer Indexing Server

● Explorer Search Server

● Explorer Exploration Server

Table 43: Explorer Servers

Server kind Description

Explorer Master Server Manages all of the Explorer servers.

Explorer Indexing Server Provides and manages the indexing of information space 
data and metadata.

Explorer Search Server Processes search queries and returns the results.

Explorer Exploration Server Provides and manages the information space exploration 
and analysis capabilities including search on data, filter-
ing, and aggregation.
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SAP BusinessObjects Explorer User Verification
The following steps explain the interaction of platform components when you log on to SAP 
BusinessObjects Explorer.

1. The SAP BusinessObjects Explorer web client sends the user credentials through the web 
server to the Web Application server, where the SAP BusinessObjects Explorer web 
application is running.

2. The Web Application server determines that the request is a logon request and sends the user 
credentials to the Central Management Server (CMS) for authentication.

3. The Central Management Server (CMS) validates the user credentials against the appropriate 
database. In this case, Enterprise authentication is used, so user credentials are 
authenticated against the CMS system database.

4. Upon successful validation, the Central Management Server (CMS) creates a session for the 
user in memory. The CMS returns a session token to the Web Application server to confirm 
that the validation was successful.

5. The Web Application server sends a request to the Explorer Master server to open an Explorer 
session. The Explorer Master server returns confirmation that it has opened an Explorer 
session.

6. The Web Application server sends the session token through the Web server to the Web 
client. For the rest of this session, the Web Application server uses the session token to 
validate the user.

Figure 44: Log on to Explorer

Lesson: Configuring Explorer Servers
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Facilitator Producer

Say:

"We'll be starting a group chat activity. I will 
be pasting a series of questions into the Chat 
Pod and ask that you enter your response af-
ter each question is posted."

"I will select some responses to discuss as a 
group."

Do:

Display the first question on the slide provid-
ed in the Instructor Presentation deck. Dis-
play questions one at a time.

Ask them to answer their questions based on 
their independent study and then to review 
their classmates answers.

Select the response from one participant and 
copy/paste it to the whiteboard.

Do:

Assist by pasting the pre-written questions in-
to the Chat Pod.

If desired, archive the Chat Pod and white-
board overlay for later reference/distribution.

INTERACTIVE ELEMENT: Chat

1. When logging in to the SAP BusinessObjects Explorer, what is the role of the Central 
Management Server (CMS) after validation?

.

.

.

.

.

.

.

.

.
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How to Modify Explorer Properties
You can define which features your users have access to for SAP BusinessObjects Explorer by 
settings its security rights from the Applications area of the CMC.

1. Go to the Applications area of the CMC.

2. Click Explorer from the list of Applications.

3. Click Manage  → Properties .

4. Define the SAP BusinessObjects Explorer settings that you want.

5. Click the Save & Close button.

Hint:
Explorer server properties may also be configured by navigating to 
Servers>ServiceCategories>Explorer Services . Right-click Explorer Services and 
select the Properties option from the menu. The Properties window opens for 
configuration.

Server Administration in CMS
You manage Explorer server administration tasks such as auditing, monitoring, and the 
integration into Solution Manager Diagnostics in the same way as any other server in the CMS. 
The key metrics for Explorer servers include:

● Number of users currently logged-in

● Number of indexations in progress response time

● Number of replications in progress

● Exploration response time

● Search response time

● Information space opening

Note:
SAP BusinessObjects Explorer allows you to access the following data sources:

● Universes in the format .UNX (relational sources only)

● Excel files (average aggregation method added)
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LESSON SUMMARY
You should now be able to:

● Configure Explorer servers
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Lesson 2

293
Managing Information Spaces

LESSON OVERVIEW
The Explorer application Home tab displays a list of information spaces. Information spaces can 
be created or indexed from an Excel file or a universe. These spaces are indexed and stored on 
the Explorer Indexing server and the Explorer Exploration server. Information spaces can be 
viewed with a request sent from the Explorer web client.

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● Manage information spaces

Information Spaces Displayed in Explorer
The following steps explain the interaction of platform components when the list of information 
spaces is displayed on the Home tab in SAP BusinessObjects Explorer.

1. The SAP BusinessObjects Explorer web client sends a request (for the list of information 
spaces) through the web server to the web application server, where the SAP 
BusinessObjects Explorer web application is running.

2. The web application server requests the list of information spaces from the Explorer Search 
Server.

3. The Explorer Search Server provides the index reference of the index in use to the Explorer 
Master Server. The Explorer Master Server uses a reference counter to manage resources.

4. The Explorer Search Server sends a request to the Central Management Server (CMS) to 
obtain the list of information spaces available to the user. The CMS checks the CMS system 
database to identify the information spaces available to the user, and the CMS returns the list 
of information spaces to the Explorer Search Server.

5. The Explorer Search Server sends the list of information spaces to the web application server.

6. The web application server sends the list of information spaces through the web server to the 
SAP BusinessObjects Explorer web client, where the list of information spaces is displayed on 
the Home tab.
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Figure 45: Display the List of Information Spaces on the Home Tab in SAP BusinessObjects Explorer

Information Space Viewing
The following steps explain the interaction of platform components when you view an information 
space based on a universe or an Excel file in SAP BusinessObjects Explorer.

1. The SAP BusinessObjects Explorer web client sends a request (to open the selected 
information space) through the Web server to the Web Application server, where the SAP 
BusinessObjects Explorer web application is running.

2. The Web Application server sends the request (to open the information space) to the Explorer 
Exploration server.

3. The Explorer Exploration server notifies the Explorer Master server that the information space 
index is in use. The Explorer Master server sets a timeout and increments the reference 
counter that it uses for resource management.

4. The Explorer Exploration server creates an Explorer context (containing the name, ID, and 
other properties) for the selected information space. The Explorer Exploration server opens 
the information space and returns information, such as last refresh date, to the Web 
Application server. Note: The Explorer Exploration server uses the personalized information 
space (if one is bound to the selected information space) to apply restrictions on the selected 
information space at consume time.

5. The Web Application server returns information about the selected information space, such 
as last refresh date, through the Web server to the Web client.

6. The Web client sends a request through the Web server to the Web Application server to 
obtain measures, facets, and other metadata for the selected information space.
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7. The Web Application server sends a request to the Explorer Exploration server to obtain 
measures, facets, and other metadata for the selected information space.

8. The Explorer Exploration server reads the structure in Explorer storage that stores the index 
metadata.

9. The Explorer Exploration server returns the index metadata for the selected information 
space to the Web Application server.

10. The Web Application server returns the index metadata for the selected information space 
through the Web server to the Web client.

11. The Web client sends a request through the Web server to the Web Application server to 
obtain facet values (index data) for the selected information space to display in the facets 
panel on the Explore tab.

12. The Web Application server sends a request to the Explorer Exploration server to obtain facet 
values (data) for the selected information space.

13. The Explorer Exploration server uses the Lucene connectivity plugin to read the structure in 
Explorer storage that stores the index data (facet values) for information spaces based on 
Excel or universe (UNX) data sources.

14. The Explorer Exploration server returns the index data (facet values) for the selected 
information space to the Web Application server.

15. The Web Application server returns the index data (facet values) for the selected information 
space through the Web server to the SAP BusinessObjects Explorer web client, where the 
facet values are displayed in the facet panel on the Explore tab.

16. The Web client sends a request through the Web server to the Web Application server to 
determine the best chart to display in the visualization panel on the Explore tab.

17. The Web Application server sends a request to the Explorer Exploration server to determine 
the best chart to display in the visualization panel.

18. The Explorer Exploration server notifies the Explorer Master server that the index is in use. 
The Explorer Master server resets the timeout.

19. The Explorer Exploration server returns a list of available charts, and the best chart selected, 
to the Web Application server.

20. The Web Application server returns the list of available charts, and the best chart selected, 
through the Web server to the Web client.

21. The Web client sends a request through the web server to the Web application server to 
generate the chart to display in the visualization panel on the Explore tab.

22. The Web Application server sends a request to the Explorer Exploration server to generate the 
chart to display in the visualization panel.

23. The Explorer Exploration server notifies the Explorer Master server that the index is in use. 
The Explorer Master server resets the timeout.

24. The Explorer Exploration server generates the chart and returns it to the Web Application 
server.

Lesson: Managing Information Spaces

© Copyright . All rights reserved. 313



25. The Web Application server returns the chart through the Web server to the SAP 
BusinessObjects Explorer web client, where the chart is rendered in the visualization panel on 
the Explore tab.

Figure 46: View an Information Space Based on a Universe or Excel File in SAP BusinessObjects Explorer

Information Space Creation
You can create an information space based on an Excel file or a universe.

Information Space Creation Based on an Excel File

The following steps explain the interaction of platform components when you create an 
information space based on an Excel file in SAP BusinessObjects Explorer.

1. The SAP BusinessObjects Explorer web client sends a request (for data objects in the 
selected data source) through the Web server to the Web application server, where the SAP 
BusinessObjects Explorer web application is running.

2. The Web Application server sends a request (for data objects in the selected data source) to 
the Explorer Master server.

3. The Explorer Master server uses the Excel connectivity plugin to communicate with the 
Central Management Server (CMS). The CMS checks the CMS system database to locate the 
Excel file stored by the Input File Repository Server. The Excel connectivity plugin reads the 
Excel file to obtain the data objects in the Excel file.

4. The Explorer Master server sends the data objects (from the selected data source) to the Web 
Application server.
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5. The Web Application server sends the data objects (from the selected data source) through 
the Web server to the SAP BusinessObjects Explorer web client.

6. The user designs the information space based on the data objects shown in the SAP 
BusinessObjects Explorer web client.

7. The SAP BusinessObjects Explorer web client sends the request (to create the new 
information space in the SAP BusinessObjects Business Intelligence platform) through the 
Web server to the Web Application server, where the SAP BusinessObjects Explorer Web 
Application is running.

8. The Web Application server sends the request (to create the new information space) to the 
Explorer Master server.

9. The Explorer Master server sends the request (to create the new information space) to the 
Central Management Server (CMS). The CMS sends the new information space definition to 
be stored by the Input File Repository Server, and the CMS creates a new InfoObject in the 
CMS system database to represent the new information space. The CMS returns 
confirmation that the new information space was created, back through the Explorer Master 
server to the Web Application server, to the Web server, and finally to the SAP 
BusinessObjects Explorer web client.

Figure 47: Create a New Information Space Based on an Excel File in SAP BusinessObjects Explorer

Information Space Creation Based on a Universe
The following steps explain the interaction of platform components when you create an 
information space based on a universe (UNX) in SAP BusinessObjects Explorer.
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1. The SAP BusinessObjects Explorer web client sends a request (for data objects in the 
selected data source) through the Web server to the Web Application server, where the SAP 
BusinessObjects Explorer web application is running.

2. The Web Application server sends a request (for data objects in the selected data source) to 
the Explorer Master server.

3. The Explorer Master server uses the DSL connectivity plugin to communicate with the Central 
Management Server (CMS). The CMS checks the CMS system database to locate the 
universe (UNX) file stored by the Input File Repository Server. The DSL connectivity plugin 
reads the universe (UNX) file to obtain the data objects in the universe.

4. The Explorer Master server sends the data objects (from the selected data source) to the Web 
Application server.

5. The Web Application server sends the data objects (from the selected data source) through 
the Web server to the SAP BusinessObjects Explorer web client.

6. The user designs the information space based on the data objects shown in the SAP 
BusinessObjects Explorer web client.

7. The SAP BusinessObjects Explorer web client sends the request (to create the new 
information space in the SAP BusinessObjects Business Intelligence platform) through the 
Web server to the Web Application server, where the SAP BusinessObjects Explorer web 
application is running.

8. The Web Application server sends the request (to create the new information space) to the 
Explorer Master server.

9. The Explorer Master server sends the request (to create the new information space) to the 
Central Management Server (CMS). The CMS sends the new information space definition to 
be stored by the Input File Repository Server, and the CMS creates a new InfoObject in the 
CMS system database to represent the new information space. The CMS returns 
confirmation that the new information space was created, back through the Explorer Master 
server to the Web Application server, to the Web server, and finally to the SAP 
BusinessObjects Explorer web client.
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Figure 48: Create a New Information Space Based on a Universe in SAP BusinessObjects Explorer

Information Space Indexing
You can index an information space based on an Excel file or a universe in SAP BusinessObjects 
Explorer.

Information Space Indexing Based on an Excel File

The following steps explain the interaction of platform components when you index an 
information space based on an Excel file in SAP BusinessObjects Explorer.

1. The SAP BusinessObjects Explorer web client sends a request (to index a new information 
space) through the Web server to the Web Application server, where the SAP 
BusinessObjects Explorer web application is running.

2. The Web Application server sends the request (to index a new information space) to the 
Explorer Master Server.

3. The Explorer Master Server sends a request to the Central Management Server (CMS) to 
obtain the ID of the information space to be indexed. The CMS checks the CMS system 
database and returns the information space ID to the Explorer Master server.

4. The Explorer Master server sends the information space ID to the Explorer Indexing server.

5. The Explorer Indexing server uses the Excel connectivity plugin to communicate with the 
Central Management Server (CMS). The CMS checks the CMS system database to locate the 
information space definition and the Excel file stored by the Input File Repository Server. The 
Excel connectivity plugin reads the Excel file to obtain the required data from the Excel file.

Lesson: Managing Information Spaces
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6. The Explorer Indexing server indexes the Excel data and stores the information space index in 
Explorer storage. Explorer storage includes two distinct structures. One structure stores 
index metadata, and the other structure stores index data from the Excel file.

7. The Explorer Indexing server returns the index status to the Explorer Master server.

8. The Explorer Master server returns the index status to the Web Application server.

9. The Web Application server returns the index status through the Web server to the SAP 
BusinessObjects Explorer web client.

Information Space Indexing Based on a Universe
The following steps explain the interaction of platform components when you index an 
information space based on a universe in SAP BusinessObjects Explorer.

1. The SAP BusinessObjects Explorer web client sends a request (to index a new information 
space) through the Web server to the Web Application server, where the SAP 
BusinessObjects Explorer Web Application is running.

2. The Web Application server sends the request (to index a new information space) to the 
Explorer Master server.

3. The Explorer Master server sends a request to the Central Management Server (CMS) to 
obtain the ID of the information space to be indexed. The CMS checks the CMS system 
database and returns the information space ID to the Explorer Master server.

4. The Explorer Master server sends the information space ID to the Explorer Indexing server.

5. The Explorer Indexing server uses the DSL connectivity plugin to communicate with the 
Central Management Server (CMS). The CMS checks the CMS system database to locate the 
information space definition and the universe (UNX) file stored by the Input File Repository 
Server.

6. The Explorer Indexing server uses the DSL connectivity plugin to communicate with the 
Connection server to obtain data as required by the information space definition. The 
Connection server connects to the data source on which the universe (UNX) is based (a 
relational database in this example) and returns data to the DSL connectivity plugin.

7. The Explorer Indexing server indexes the data and stores the information space index in 
Explorer storage. Explorer storage includes two distinct structures. One structure stores 
index metadata, and the other structure stores the actual index data from the universe (UNX) 
data source.

8. The Explorer Indexing server returns the index status to the Explorer Master server.

9. The Explorer Master server returns the index status to the Web Application server.

10. The Web Application server returns the index status through the Web server to the SAP 
BusinessObjects Explorer web client.
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301
Manage a Geographic Information Space

Business Example

As the system administrator, you must understand how the Explorer servers are working 
together in a BI4 platform.

Create an Information Space with Geographic Dimension on a BI 4 Universe

1. From the BI launch pad, run the Explorer web application to create a new Information Space.

2. On the Home page of the Explorer app, click the Manage Space s menu.

3. Select the Warehouse.unx BI 4 universe. Click the New button to create a new Information 
Space that is based on the Warehouse universe.

4. Configure and validate the new Information Space.

5. Click the OK button to create your new Information Space.
Your new Information Space is created and displayed in the Manage Spaces tab.

Index an Information Space

1. In the Explorer application, select the Index value in the dropdown list of your new Information 
Space.

Note:
Indexing of the Information Space has started. After a couple of minutes, data will 
be ready to view in the Information Space.

2. When the Status is "Succeeded," close the Manage Space s tab to return to the Explorer 
Home page. Click the Refresh List button to update the Home page.
Your new Information Space is ready to display data.

View Information Space Data

1. Click the Information Space link to open it.

2. Filter the data to see the net sales of the "Top 3 Country" by Quarter for 2006. Which country 
is did the best in 2006?

3. Filter the Geographic data to see the net sales of the "Top 3 Products" in Canada for 2006. 
Which product has the best net sales in Canada for 2006?

4. Filter the data to see the net sales of the "Top 3 Products" in Canada for each quarter in 2006. 
Which quarter has the biggest net sales for this product in Canada in 2006?
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5. Filter the data to see the net sales of the "Top 3 Products" worldwide for each quarter of 
2006. Which quarter and product has the biggest net sales worldwide in 2006?

6. Filter the data to see the net sales of the "Top 3 Products" worldwide in 2006. Which product 
has the biggest net sales figure worldwide in 2006?

Manage the Explorer Servers

1. Find the Information Space indexing files.

2. Stop the Explorer Search server. Can you still explore data in the current Information Space? 
Can you still search information data in the current Information Space?

3. Stop the Explorer Indexing server. Can you still explore data in the current Information space? 
Can you still index your Information Space in the Manage Spaces section of Explorer?

4. Stop the Explorer Exploration server. Can you still explore data in the current information 
space?

5. Close the Explorer application, and then stop the Explorer Master server. Can you still access 
and run the Explorer web application from the BI launch pad?

6. Restart all of the stopped Explorer servers in the CMC.
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303
Manage a Geographic Information Space

Business Example

As the system administrator, you must understand how the Explorer servers are working 
together in a BI4 platform.

Create an Information Space with Geographic Dimension on a BI 4 Universe

1. From the BI launch pad, run the Explorer web application to create a new Information Space.

2. On the Home page of the Explorer app, click the Manage Space s menu.

3. Select the Warehouse.unx BI 4 universe. Click the New button to create a new Information 
Space that is based on the Warehouse universe.

4. Configure and validate the new Information Space.
a) On the Properties tab, configure the following data:

● Enter Customer Sales Data in the Name field.

● Enter Customer Sales Data showing data from the Warehouse universe in 
the Description field.

● Select the Availability checkbox.

b) On the Objects tab, set the following measures:

● Net Sales (Increasing)

● Quantity (Increasing)

● Discount (Increasing)

● Gross Sales (Increasing)

● Occurrences

c) On the Objects tab, set the following facets:

● Country (Dimension: Geography, Sort Largest to Smallest)

● Region (Dimension: Standard, Sort Largest to Smallest)

● City (Dimension: Geography, Sort Largest to Smallest)

● Customer (Dimension: Standard, Sort Largest to Smallest)
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● Date (Dimension: Standard, Sort Largest to Smallest)

● Quarter (Dimension: Standard, Sort Largest to Smallest)

● Year (Dimension: Standard, Sort Largest to Smallest)

● Day of Week (Dimension: Day, Sort Largest to Smallest)

● Month Name (Dimension: Month, Sort Largest to Smallest)

● Product (Dimension: Standard, Sort Largest to Smallest)

● Line (Dimension: Standard, Sort Largest to Smallest)

● Category (Dimension: Standard, Sort Largest to Smallest)

Caution:
Ensure that you enter the facets in the order shown here; otherwise, you 
might encounter an indexing failure.

5. Click the OK button to create your new Information Space.
Your new Information Space is created and displayed in the Manage Spaces tab.

Index an Information Space

1. In the Explorer application, select the Index value in the dropdown list of your new Information 
Space.

Note:
Indexing of the Information Space has started. After a couple of minutes, data will 
be ready to view in the Information Space.

2. When the Status is "Succeeded," close the Manage Space s tab to return to the Explorer 
Home page. Click the Refresh List button to update the Home page.
Your new Information Space is ready to display data.

View Information Space Data

1. Click the Information Space link to open it.

2. Filter the data to see the net sales of the "Top 3 Country" by Quarter for 2006. Which country 
is did the best in 2006?
a) Filter the "Year" dimension data by the 2006 value.

b) Filter the data with the Net Sales measure.

c) Select the Quarter option.

d) Sort the data by Country, only Top 3 .
Canada is the best country in net sales for each quarter in 2006.
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3. Filter the Geographic data to see the net sales of the "Top 3 Products" in Canada for 2006. 
Which product has the best net sales in Canada for 2006?
a) Select the Country option (instead of Quarter ).

b) Sort by None .

c) Select the colored geographic view at the bottom of the left-side window.

d) Double-click on Canada .

e) Select Product, only Top 3 .

f) Do not sort.
Black Diamond 8800 is the best selling product in Canada in 2006.

4. Filter the data to see the net sales of the "Top 3 Products" in Canada for each quarter in 2006. 
Which quarter has the biggest net sales for this product in Canada in 2006?
a) Sort the data by Quarter (Ascending) .

The third quarter of 2006 generated the best Net Sales for the Black Diamond 8800 
product in Canada.

5. Filter the data to see the net sales of the "Top 3 Products" worldwide for each quarter of 
2006. Which quarter and product has the biggest net sales worldwide in 2006?
a) Remove the Canada filter.

The Descent Competition Bicycle product sold in the third quarter had the best net sales 
worldwide in 2006.

6. Filter the data to see the net sales of the "Top 3 Products" worldwide in 2006. Which product 
has the biggest net sales figure worldwide in 2006?
a) Do not sort the data.

The Descent Competition Bicycle product had the most net sales worldwide in 2006.

Manage the Explorer Servers

1. Find the Information Space indexing files.
a) In the CMC, go to the Servers View .

b) Select the Properties of either the ExplorerExplorationServer, the ExplorerIndexingServer, 
or the ExplorerSearchServer.
The Explorer server indexing files are located in D:\Program Files (x86)\SAP 
BusinessObjects\SAP BusinessObjects Enterprise XI 4.0\Data\Polestar
\index .

2. Stop the Explorer Search server. Can you still explore data in the current Information Space? 
Can you still search information data in the current Information Space?
You can still explore data in the current Information Space. You cannot search any 
Information Space in the Home tab of the Explorer server.

3. Stop the Explorer Indexing server. Can you still explore data in the current Information space? 
Can you still index your Information Space in the Manage Spaces section of Explorer?
You can still explore data in the current Information Space. You cannot index your 
Information Space.
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4. Stop the Explorer Exploration server. Can you still explore data in the current information 
space?
You cannot explore data in the current Information Space.

5. Close the Explorer application, and then stop the Explorer Master server. Can you still access 
and run the Explorer web application from the BI launch pad?
You cannot run the Explorer application when the Explorer Master server is stopped.

6. Restart all of the stopped Explorer servers in the CMC.
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LESSON SUMMARY
You should now be able to:

● Manage information spaces

Lesson: Managing Information Spaces
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309
Learning Assessment

1. Name the four servers that are added to the Central Configuration Manager (CCM) and 
Central Management Console (CMC) when you install Explorer.

2. Select the correct menu path to access Explorer properties.

Choose the correct answer.

X A Go to CMS → Servers → Explorer → Manage → Properties .

X B Go to CMC → Servers → Explorer → Properties .

X C Go to CMS → Servers → Explorer → Applications → Manage → Properties .

X D Go to CMC → Applications → Explorer → Manage → Properties.

3. What are the two basis upon which you can create an information space.

Choose the correct answers.

X A Excel File

X B Universe

X C Database

X D Explorer Dashboard
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Learning Assessment - Answers

1. Name the four servers that are added to the Central Configuration Manager (CCM) and 
Central Management Console (CMC) when you install Explorer.

The four servers that are added to the CCM and the CMC when Exlplorer is installed are: 
Explorer Master Server, Explorer Indexing Server, Explorer Search Server, and Explorer 
Exploration Server. 

2. Select the correct menu path to access Explorer properties.

Choose the correct answer.

X A Go to CMS → Servers → Explorer → Manage → Properties .

X B Go to CMC → Servers → Explorer → Properties .

X C Go to CMS → Servers → Explorer → Applications → Manage → Properties .

X D Go to CMC → Applications → Explorer → Manage → Properties.

3. What are the two basis upon which you can create an information space.

Choose the correct answers.

X A Excel File

X B Universe

X C Database

X D Explorer Dashboard
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312
Configuring Event Servers

LESSON OVERVIEW
An Event server hosts the Event service that monitors for file events on a File Repository Server 
(FRS). Event server properties determine how often the cleanup utility is run, and how often the 
server polls for a file that triggers an event. If the default property values are not appropriate, 
administrators can easily modify them. The Metrics screen displays the Event server metrics, 
namely a list of monitored files and the total number of monitored files.

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● Configure Event servers

Event Server Responsibilities

Events
Events are objects that represent occurrences in the system. Depending on the event type, 
events can be used for various purposes, including the following:

● Events act as scheduling dependencies which trigger specific actions once a scheduled 
job runs.

● Events trigger alert notifications.

● Events allow system administrators to monitor the health of the system.

File events
When you define a file-based event, you specify a filename that the Event server should 
monitor for a particular file. When the file appears, the Event server triggers the event. For 
instance, you might want to make some reports dependent upon the regular file output of 
other programs or scripts. File events are stored in the System Events folder.

Schedule events
When you define a schedule-based event, you select an object whose existing recurrence 
schedule will serve as the trigger for your event. In this way, schedule-based events allow you 
to set up contingencies or conditions between scheduled objects. For instance, you might 
want certain large reports to run sequentially, or you might want a particular sales summary 
report to run only when a detailed sales report runs successfully. Schedule events are stored 
in the System Events folder.

Custom events
When you create a custom event, you create a shortcut for triggering an event manually. 
Custom events are stored in the Custom Events folder.
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The following table describes the server that handles the Event service.

Table 44: Event Server

Server kind Service Service Cate-
gory

Description

Event Server Event Service Core Services Monitors for file events on a File Repository 
Server (FRS). Monitors the system for 
events, which can act as a trigger for run-
ning a report. When you set up an event 
trigger, the Event server monitors the con-
dition and notifies the CMS that an event 
has occurred. The CMS can then start any 
jobs that are set to run upon the event.

Event Server Properties
The following table describes the server properties of Event servers.

Table 45: Server Properties

Property Description Default Value

Cleanup Interval (minutes) Specifies how often, in mi-
nutes, the cleanup utility runs.

The default value is 20 mi-
nutes.

Event Poll Interval (seconds) Specifies how often, in sec-
onds, the server polls for a file 
that triggers an event.

The default value is 10 sec-
onds. The range of allowed val-
ues is 1 to 1200 seconds.

Event Server Metrics
The following table describes the server metrics that appear on the Metrics screen for Event 
servers.

Table 46: Server Metrics

Property Description

List of Monitored Files A table that lists the files the are being monitored by the Event 
server. The Filename column displays the name and path of the 
file. The Last Notified Time column displays the latest time-
stamp of when the server did a poll and found that the file ex-
ists.

Monitored Files The total number of files that are being monitored by the Event 
server.
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LESSON SUMMARY
You should now be able to:

● Configure Event servers
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315
Managing Event Servers

LESSON OVERVIEW
The Event server monitors the system for events. When an event has occurred, the Event server 
notifies the Central Management Server (CMS) to start the job that is set to run upon the event. 
The Event server manages these file-based events in the storage tier. Administrators can manage 
the frequency that the Event server polls for a particular file in the Event Service Properties. 
Events can be easily created, scheduled, and managed from the Central Management Console 
(CMC).

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● Manage Event servers

Event Server Management
The Event server monitors the system for events, which can act as a trigger for running a 
schedule for a report. When you set up an event trigger, the Event Server monitors the condition 
and notifies the CMS that an event has occurred. The CMS can then start any jobs that are set to 
run upon the event. The Event server manages file-based events that occur in the storage tier.

The Event server properties contain a property that dictates how often the Event server polls for a 
particular file that is located in an unmanaged disk. the default is 10 seconds, and this property 
can be modified to any desired timeframe. This polling activity is minimal, and it does not disrupt 
system performance.

Figure 49: Event Service Poll Properties
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Note:
The Event server polls for a file that has been placed in an unmanaged disk. It does not 
poll to check if the file simply exists in the unmanaged disk. The file itself does not 
need to have content. To manage a recurring schedule (such as, daily), delete the file 
from the unmanaged disk space for each schedule run. This causes the Event server 
to poll successfully and find the file name that is being monitored the next time the 
report schedule is triggered. You can use the Adaptive Job server's Program Job 
Scheduling service to process a batch file that deletes the file being monitored by the 
Event server every time a report schedule is triggered by the file event.

How to Schedule Reports with Events
Create a file event and schedule a report to run when the event occurs.

1. Click Events in the Central Management Console (CMC).

2. Navigate to the System Events folder.

3. Go to the Manage menu and select New  → New Event .

4. In the Type list, select File .

5. Enter a name for the event: MyFile and complete the Description field.

6. In the Server list, select the Event Server that will monitor the specified file.

7. Enter a file name and the location where the file event is to occur, for example D:
\Myfile.txt .

8. Click the OK button.

9. You have created a file-based event. Now you must schedule a report to run when this file 
event occurs. Go to the Folders area of the CMC, and select Report Samples  → Featured 
Samples  → Drilldown report.

10. From the Action menu, click Schedule . On the Recurrence tab, select to run object Now .

11. On the Events tab, select your file event from the list of available events, and move it to the 
Events to wait for window.

12. Click the Schedule button to schedule the report.

13. Click the Refresh button to update the schedule information.
Notice that the report status is pending. Click the Status button to view instance properties. 
The report is waiting for the file event to occur.

14. To trigger the file event, open Windows Explorer. Browse to view D:\ .

15. Open Notepad. Create a new file and save it as Myfile.txt .
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16. Go back to the Folders area of the CMC and click Report Samples  → Featured Samples 
 → Drilldown report and access the History by clicking on Action Menu.
Notice that the report ran successfully.

Lesson: Managing Event Servers
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317
Schedule a Report with Events

Business Example

As the system administrator, you must start the scheduling of Web Intelligence documents only 
when your data warehouse will be correctly updated.

Caution:
You must use the new Training Course BOE320 content in the Initialize 
Course folder to do this exercise.

Prerequisites for Managing a File-Based Event

1. Connect to the Operating System (OS) of your BI 4.x platform with the following Remote 
Desktop Connection credentials.

SAP BusinessObjects Busi-
ness Intelligence Platform 4.1 
SP2 System

Windows User Account Password

WDFLBMT5072 boadmin BOTraining

WDFLBMT5073 boadmin BOTraining

2. Once connected to the OS, create a new folder with Windows Explorer on the D:\ drive. Name 
the folder Event (D:\Event).

Note:
This folder will contain the file that will trigger the report scheduling.

3. Minimize the Remote Desktop Connection window and return to your Training Cloud 
Environment.

4. In the Training Cloud Environment window, publish the CREATE.BA T and the DELETE.BAT 
batch files from the uncompressed training course environment to your BI 4.x Personal 
folder.

5. Configure the Program Logon properties for both of the newly published program files.

6. Set the program objects right to allow users to run scripts/binaries on the platform.

7. Test the batch files.
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Create a File-Based Event

1. In the CMC Home page, click Events

2. In the Event folder, right-click System Events folder and create a new event based on the 
presence of the D:\Event\GO.TXT file.

Create Two Schedule Events

1. In the CMC Home page, click Events folder.

2. In the Events folder, right-click the System Events folder and create a new event based on 
the success of scheduling a BI 4.x report.

3. In the Event folder, right-click the System Events folder and create a new event based on 
the failure of scheduling a BI 4.x report.

Manage Subscribers to Event Alerts

1. In the CMC Home page, click Events .

2. Configure the Event GO file-based event to send an alert message to the Administrator user 
account on the BI 4.x Launchpad when the event is triggered.

3. Repeat step 2 for the Event Schedule KO and the Schedule Event OK events.

Note:
These events will send alert messages to the Administrator user account on the BI 
launch pad Home page when they are successfully triggered by the platform.

Schedule Objects in BI 4.x

1. In the CMC Home page, click Folders .

2. Schedule the Charting Samples BI 4.x Web Intelligence document with the following trigger 
condition:

● Events to wait for: Event GO

● Events to trigger on completion:

- Event Schedule KO

- Event Schedule OK

3. Return to the CMC Home page and click the Personal Folders icon.

4. Schedule the DELETE program object with the following trigger condition:

● Events to wait for: Event Schedule OK

Trigger the File-Based Event to Start the Daisy Chain Job.

1. In the CMC Home page, click the Personal Folders icon.

2. Run now the CREATE program object to start the first job.
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3. Monitor the D:\Event folder on the server side. Has the GO.TXT file been created?

4. Monitor the History of the Web Intelligence document. Was an instance created?

5. Monitor the D:\Event folder on the server side. Has the GO.TXT file been created?

Note:
After the second job has successfully run. the environment is ready for another 
run.

6. Connect to the BI launch pad with the Administrator user account. Did you receive Event 
Alerts?

Lesson: Managing Event Servers
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320
Schedule a Report with Events

Business Example

As the system administrator, you must start the scheduling of Web Intelligence documents only 
when your data warehouse will be correctly updated.

Caution:
You must use the new Training Course BOE320 content in the Initialize 
Course folder to do this exercise.

Prerequisites for Managing a File-Based Event

1. Connect to the Operating System (OS) of your BI 4.x platform with the following Remote 
Desktop Connection credentials.

SAP BusinessObjects Busi-
ness Intelligence Platform 4.1 
SP2 System

Windows User Account Password

WDFLBMT5072 boadmin BOTraining

WDFLBMT5073 boadmin BOTraining

2. Once connected to the OS, create a new folder with Windows Explorer on the D:\ drive. Name 
the folder Event (D:\Event).

Note:
This folder will contain the file that will trigger the report scheduling.

3. Minimize the Remote Desktop Connection window and return to your Training Cloud 
Environment.

4. In the Training Cloud Environment window, publish the CREATE.BA T and the DELETE.BAT 
batch files from the uncompressed training course environment to your BI 4.x Personal 
folder.
a) Go to the CMC and select the Personal Folders menu.

b) Select the Administrator folder.
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c) Right-click the selected Administrator folder and select the Add > Program File menu 
options.

d) Browse to the uncompressed training course environment and select the CREATE.BAT 
file.

e) Click the OK button to publish this file to your Personal folder.

f) Repeat steps C through E to publish the DELETE.BAT file.
You can now see two new programs published in the Administrator > Personal 
folder.

5. Configure the Program Logon properties for both of the newly published program files.
a) Select the CREATE.BAT program file that is published in the Administrator > 

Personal folder.

b) Right-click the file, then click Default Settings on the context menu.

c) Select the Program Logon option and enter the following credentials.

User Name Password

boadmin BOTraining

d) Click the Save and Close button.

e) Select the DELETE.BAT program file that is published n the Administrator > 
Personal folder. Repeat steps B through D to configure the Program Logon properties 
for this file.
You have configured the Windows users accounts that will be used by the platform to run 
these batch files.

6. Set the program objects right to allow users to run scripts/binaries on the platform.
a) Go to CMC Home page and select Applications from the menu.

b) Select the Central Management Console entry, right-click it, and select the Program 
Objects Rights option from the context menu.

c) In the Program Rights window, select the Run scripts/binaries checkbox.

d) Click the Save and Close button.
The Administrator has granted program files to be run on the BI 4.x platform.

7. Test the batch files.
a) In the CMC Home page, select Personal folders from the menu, and then select the 

content of the Administrator folder.

b) Right-click the CREATE.BAT program object and select the Run Now option from the 
context menu. After a couple of seconds the batch file will end with success. (This can be 
checked in the history of the program object.)
You will see a new file (D:\Event|GO.TXT ) has been created on the server side.
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c) Right-click the DELETE.BAT program object and select the Run Now option from the 
context menu. After a couple of seconds the back file will end with success. (This can be 
checked in the history of the program object.)
You will see a new file (D:\Event\GO.TXT) has been successfully deleted from the server 
side.

Create a File-Based Event

1. In the CMC Home page, click Events

2. In the Event folder, right-click System Events folder and create a new event based on the 
presence of the D:\Event\GO.TXT file.

a) Right-click on the System Events folder and then select New > New Event from the 
context menu.

b) In the New Event window, enter the following parameter.

Type File

Event Name Event GO

File Name D:\Event|GO.TXT

Alerting Enabled Checked

Alerting Message This is an information message to warn 
that a File-Based even has been triggered 
with success on the BI 4.x platform.

c) Click the OK button to save this new file-based event.

Note:
This event will send an alert message when it is triggered by the BI 4.x 
platform.

Create Two Schedule Events

1. In the CMC Home page, click Events folder.

2. In the Events folder, right-click the System Events folder and create a new event based on 
the success of scheduling a BI 4.x report.
a) Right-click the System Events folder and then select the New > New Event context menu 

options.

b) In the New Event window, enter the following parameter.

Type Schedule

Event Name Event Schedule OK

Result Success
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Type Schedule

Alerting Enabled Checked

c) Click the OK button to save this new success-based event.
This event will send an alert message when it is successfully triggered by the BI 4.x 
platform.

3. In the Event folder, right-click the System Events folder and create a new event based on 
the failure of scheduling a BI 4.x report.
a) Right-click the System Events folder and then select the New > New Event context menu 

options.

b) In the New Event window, enter the following parameter.

Type Schedule

Event Name Event Schedule KO

Result Failure

Alerting Enabled Checked

c) Click the OK button to save this new failure-based event.
This event will send an alert message when it has been triggered by the BI 4.x platform.

Manage Subscribers to Event Alerts

1. In the CMC Home page, click Events .

2. Configure the Event GO file-based event to send an alert message to the Administrator user 
account on the BI 4.x Launchpad when the event is triggered.
a) In the System Events folder, right-click the Events GO object and then select the 

Subscribe option from the context menu.

b) Select the My Alerts checkbox and the click the Save button.

c) Select the Manage Subscribers > Subscriber List options to check that the Administrator 
account has been added to the Subscriber List.

d) Click the Save and Close button.

3. Repeat step 2 for the Event Schedule KO and the Schedule Event OK events.

Note:
These events will send alert messages to the Administrator user account on the BI 
launch pad Home page when they are successfully triggered by the platform.

Schedule Objects in BI 4.x

1. In the CMC Home page, click Folders .
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2. Schedule the Charting Samples BI 4.x Web Intelligence document with the following trigger 
condition:

● Events to wait for: Event GO

● Events to trigger on completion:

- Event Schedule KO

- Event Schedule OK

a) Right-click the Charting Samples Web Intelligence document and then add the three 
events described in the bullets above.

b) Select the Schedule > Events property and then add the three events that are described in 
the bullet list above.

c) Click the Schedule button to run the job.

d) Check the status of the job, then close the History window.

Note:
The first job will have a status of "Pending". It will wait for the D:\Event
\GO.TXT file for scheduling the Web Intelligence document.

3. Return to the CMC Home page and click the Personal Folders icon.

4. Schedule the DELETE program object with the following trigger condition:

● Events to wait for: Event Schedule OK

a) Right click the DELETE program object. Select the Schedule option from the context menu.

b) Select Schedule > Events and then add the even listed in Step 4.

c) Click the Schedule button to run the job.

d) Check the status of the job; then close the History window.

Note:
This second job will have a status of "Pending". It will wait for the successful 
end of the first job to start.

Trigger the File-Based Event to Start the Daisy Chain Job.

1. In the CMC Home page, click the Personal Folders icon.

2. Run now the CREATE program object to start the first job.

a) Right-click the CREATE program object. Select the Run Now context menu option.

3. Monitor the D:\Event folder on the server side. Has the GO.TXT file been created?
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This action will create the D:\Event\GO.TXT file on the server side for a few seconds. 
It will also automatically launch the first job.

4. Monitor the History of the Web Intelligence document. Was an instance created?
The GO.TXT file launches the first job, which successfully creates an instance for the 
Web Intelligence document.

5. Monitor the D:\Event folder on the server side. Has the GO.TXT file been created?
After a couple of seconds the D:\Event\GO.TXT is deleted on the server side. The 
second job has been successfully run, based on the "Success" status of the first job.

Note:
After the second job has successfully run. the environment is ready for another 
run.

6. Connect to the BI launch pad with the Administrator user account. Did you receive Event 
Alerts?
Yes, the Administrator user account has received two alert messages. One alert 
message is called "Event GO," and the other is called "Event Schedule OK." Notice that 
the name of the alert message is the name of the event.
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LESSON SUMMARY
You should now be able to:

● Manage Event servers
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327
Learning Assessment

1. What are the three types of events?

2. Select the correct event server description.

Choose the correct answer.

X A Event servers store event alerts.

X B Event servers trigger events on the Input File Repository server.

X C Event Servers control the Events database.

X D Event servers monitor for file events on a File Repository Server (FRS).

3. What is the default setting for how often the Event server polls for a particular file that is 
located in an unmanaged disk.

Choose the correct answer.

X A 60 seconds

X B 5 seconds

X C 10 seconds

X D 30 seconds
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328
Learning Assessment - Answers

1. What are the three types of events?

There are File events, Schedule events, and custom events.

2. Select the correct event server description.

Choose the correct answer.

X A Event servers store event alerts.

X B Event servers trigger events on the Input File Repository server.

X C Event Servers control the Events database.

X D Event servers monitor for file events on a File Repository Server (FRS).

3. What is the default setting for how often the Event server polls for a particular file that is 
located in an unmanaged disk.

Choose the correct answer.

X A 60 seconds

X B 5 seconds

X C 10 seconds

X D 30 seconds

348 © Copyright . All rights reserved.



UNIT 13 SAP BusinessObjects Business 
Intelligence Platform 4.1 
Monitoring

Lesson 1

Monitoring the SAP BusinessObjects Business Intelligence Platform 4.1 350

Lesson 2

Using the SAP BusinessObjects Business Intelligence Platform 4.1 Monitoring Dashboard 356
Exercise 14: Create and Monitor a Metric 369
Exercise 15: Create and Monitor Alerts 383
Exercise 16: Test Servers with Probes 395
Exercise 17: Restart Servers with Probes 399

UNIT OBJECTIVES

● Monitor the BusinessObjects Business Intelligence platform 4.1
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Unit 13
Lesson 1

330
Monitoring the SAP BusinessObjects Business 
Intelligence Platform 4.1

LESSON OVERVIEW
The platform Monitoring web application is integrated with the Central Management Console 
(CMC), and monitors the system environment. This application collects and visualizes a set of 
counters that are related to the operating system and application servers of the platform. 
Monitoring collects and graphically reports system and application counters so that 
administrators can accurately evaluate platform performance. Monitoring also stores the 
collected metrics in a dedicated database, and when a malfunction is found, alerts the designated 
recipients of the error.

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● Monitor the BusinessObjects Business Intelligence platform 4.1

Monitoring Application Role
The SAP BusinessObjects BI 4 platform allows an administrator to have a standard application 
and an integrated solution for monitoring its system environment (development, quality, and 
production). This solution is available from the BI 4.0 version, and it comes in the form of a web 
application (Monitoring option) that is integrated with the Central Management Console (CMC).

Figure 50: Central Management Console

The Monitoring application allows you to collect and return a set of counters as graphs. These 
graphs are related to the operating system and the application servers of the platform. The 
Monitoring application performs many roles, including the following:

● Monitoring the performance of the application servers of the platform

● Monitoring the overall health of the platform
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● Aiding the diagnostics and performance tests on the platform

● Alerting in the event of a problem on one or more application servers

Functions of the Monitoring Application

The application performs the following functions:

● The application collects, in real time, and graphically reports system and application counters. 
This metric collection allows an administrator to accurately and objectively evaluate the 
performance of the BI 4 platform.

● The application stores the collected metrics in a centralized, dedicated database. This 
database is Open Source (JAVA Derby), and installed automatically with the platform. It 
collects and logs monitoring metrics to allow the administrator to establish a regular 
diagnostic on the health of the platform.

● Upon detection of a malfunction on an application server, the monitoring application sends 
message alerts automatically to designated recipient addresses that may be internal or 
external to the platform.

● The application is able to test periodically the health and performance of a set of Business 
Intelligence services on the platform.

Monitoring Application Properties
The BI 4 Monitoring application has a default configuration that is editable from the Applications 
section of the Central Management Console (CMC).

Note:
All changes to the Monitoring application properties (except for the activation of the 
service) are reflected in the operation of the system after a manual restart of the BI 4 
Application server (the default Adaptive Processing server). The Adaptive Processing 
server hosts the service that runs the Monitoring application on the platform.

Figure 51: Monitoring Application Properties Option
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Monitoring Application Enablement Property

The Monitoring application works through the BI 4 Monitoring service. It is hosted by the Adaptive 
Processing server, and is installed by default on the BI 4 platform. The platform administrator 
may enable or disable the Monitoring service by performing the following steps:

1. Go to the Central Management Console.

2. Right click the Monitoring Application option and select the resulting Properties menu option. 
The Monitoring Application Properties screen appears.

3. Select the Enable Monitoring Application checkbox to enable the service. Deselect the 
checkbox to disable the service.

Figure 52: Enable Monitoring Application Checkbox

Note:
Any failure of the default Adaptive Processing Server implies the immediate cessation 
of the hosted monitoring service. Therefore, the functions of the monitoring service 
(collecting and reporting) have also stopped. Only the probes will remain operational, 
but it is not possible to consult the monitoring database to see the history.

Caution:
It is not advisable to disable the monitoring service on a production environment.

Note:
For safety, we recommend that administrators create a new Adaptive Processing 
server that is dedicated to the Monitoring service. This way the service is isolated 
from the other application servers that are running on the platform, and it ensures 
high quality and availability of the Monitoring service on the platform.

The JAVA Web Service for Monitoring

Monitoring the platform data can also be accessed from external applications like CORBA or 
JAVA, rather than through the CMC. The external client application accesses Monitoring through 
a URL connection that is defined in the CMC. This URL is the address of the Web Service JAVA 
JMX that is hosted by the BI 4 platform.
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Figure 53: Monitoring Default JMX Agent URL

Note:
The JMX agent end point URL is platform specific and not editable.

Monitoring Application Properties

The Monitoring Application database has many parameters that are configurable from the CMC. 
The Monitoring Application Properties screen allows administrators to configure the database 
settings, such as storage configuration, backups, exportation, and database cleanup.

Monitoring data is stored in the embedded database (Derby JAVA) by default. This setting can be 
changed in the Monitoring Application Properties screen. Select the Use Audit Database radio 
button to store Monitoring data on the Auditing (relational) database.

Figure 54: Monitoring Application Properties

Note:
Monitoring data is stored on the server in the form of flat files. These files are located 
in the following local directory: C:\ProgramFiles (x 86)\SAPBusinessObjects
\SAP BusinessObjects Enterprise XI 4.0\Data\TrendingDB .

Lesson: Monitoring the SAP BusinessObjects Business Intelligence Platform 4.1
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Backup and Cleaning the Monitoring Data

The backup and automatic cleaning of the Monitoring data is configurable on the Monitoring 
Application Properties screen of the CMC.

Caution:
The location and frequency (schedule) of the database backup is set by the 
administrator because Monitoring data is not saved automatically.

When a backup of the Monitoring data is launched, the BI 4 platform copies the content to the C:
\Program Files (x86)\SAP BusinessObjects Enterprise XI4.x\TrendingDB\Derby 
directory. To restore the database from the backup, simply copy the contents of the backup 
directory and place it in the directory that is configured in the CMC.

Set a limit to how much data is stored in the database before it is cleaned in the Delete older data 
when the database size grows more than (MB ) field. Enter an amount of data, in megabytes, that 
will trigger the deletion of the oldest data.

Note:
There is no parameter that sets a maximum size limit for the database. It is important 
that the administrator regularly monitors the database size.

Other Monitoring Parameters

Other settings found on the Monitoring Application Properties screen include the Metric Refresh 
Interval, Monitoring UI auto refresh interval, and the Alert Reminder Frequency.

Figure 55: Other Property Settings

Table 47: Other Monitoring Parameters

Parameter Default Setting

Metric Refresh Interval (seconds) 60

Monitoring UI auto refresh interval (seconds) 15

Alert Reminder Frequency (days) 1
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Caution:
Decreasing the default settings of the Other Settings can cause a more rapid growth 
of the database and downgrade the system performance.

LESSON SUMMARY
You should now be able to:

● Monitor the BusinessObjects Business Intelligence platform 4.1

Lesson: Monitoring the SAP BusinessObjects Business Intelligence Platform 4.1
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Lesson 2

336
Using the SAP BusinessObjects Business 
Intelligence Platform 4.1 Monitoring Dashboard

LESSON OVERVIEW
The Monitoring application is accessed on the Central Management Console (CMC). The 
application dashboard offers five tabs that help administrators manage and monitor the different 
aspects of the platform. The dashboard allows administrators to create and monitor a metric, to 
create and monitor an alert, and test or restart the server with probes.

LESSON OBJECTIVES
After completing this lesson, you will be able to:

● Monitor a metric

● Monitor servers with alerts

● Monitor servers with probes

Monitoring Dashboard Overview
The Monitoring dashboard is a JAVA Web application in the CMC that allows you to view and 
analyze monitoring data from the past or in real time. This dashboard contains five main features 
that are presented in unique tabs on the Central Management Console: Dashboard tab (main 
page), Metrics tab, Watchlist tab, Probes tab, and Alerts tab.
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Figure 56: Monitoring Dashboard Graphical View

Note:
The Monitoring dashboard is a web application that was developed in Flash format. 
Therefore, to view this application, it is necessary to install the latest version of Flash 
Player on the client side.

Dashboard Tab

The Monitoring application dashboard tab is comprised of several parts that provide general 
information on the platform monitoring. The main sections of the Dashboard tab are:

● Overall Health

● Recent Alerts

● KPI Status

● Deployment Level Metrics

● Graphical View

● Tabular View

Overall Health

The first part of the Dashboard tab that you are likely to notice is the Overall Health indicator. This 
icon indicates the state of the BI 4 platform.

Lesson: Using the SAP BusinessObjects Business Intelligence Platform 4.1 Monitoring Dashboard
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Figure 57: Overall Health Status

Note:
In the case of a multi-node BI 4 clustering, this flag only gives the general state of the 
first application node that is installed on the platform. To view the status of the other 
nodes, go to the Tabular View of BI Landscape area, or to the Metric area of each node.

Recent Alerts

This second section of the Dashboard tab displays a summary of the most recent monitoring 
alerts that are received from the platform.

Figure 58: Recent Monitoring Alerts

Alert Details

Each alert in the list reflects the name the watch that generated it. Click on the alert to view the 
following data:

● Watch Name

● Alert Status (Caution or Danger)

● Time of Alert

● Caution Rule

● Danger Rule

● Cause

● Action

Unit 13: SAP BusinessObjects Business Intelligence Platform 4.1 Monitoring
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Figure 59: Alert Details

Hint:
These alerts are also available for analysis on the Alerts tab.

KPI Status

This third section of the Dashboard tab shows some key indicators of performance of the 
platform. It monitors platform watches by default, and the administrator can reconfigure these 
KPIs by selecting the corresponding watch.

Figure 60: KPI Status

Note:
The administrator can select up to four monitoring watches to customize the KPI 
Status area.

Lesson: Using the SAP BusinessObjects Business Intelligence Platform 4.1 Monitoring Dashboard
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Deployment Level Metrics

This fourth section of the Dashboard tab displays the following metrics in real time:

● Running Jobs

● Users

● Pending Jobs

Figure 61: Development Level Metrics

KPI Details Users

Click on one of these metrics to view details of the selected metric.

Figure 62: KPI Details Users

Note:
It is not possible to configure the KPI Details Users screen.

Graphical View

This fifth and final section of the Dashboard tab shows the overall status of each plaform server. 
Several types of views are available, including the following:

● Enterprise Nodes view

● Server Groups view

● Service Categories view

Each of these views can be presented in either a graphical style or in a tabular style.

Unit 13: SAP BusinessObjects Business Intelligence Platform 4.1 Monitoring
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Figure 63: Graphical View of BI Landscape

Tabular View of BI Landscape

Figure 64: Tabular View of BI Landscape

Watch Details

By default, each platform server is monitored by a watch. Double-click a server to view the 
following performance details:

Lesson: Using the SAP BusinessObjects Business Intelligence Platform 4.1 Monitoring Dashboard
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● The current health state of the server is evaluated through af calculations rule on one or more 
metrics (OK, Warning, Danger)

● Performance (live or history) based on metrics are the two most commonly accessed 
performance details

Figure 65: Watch Details

Hint:
You can also view data collected in the past by looking at the history.

Monitoring Dashboard Metrics
Business Intelligence platform relies on a set of indicators called metrics. These metrics can be 
viewed on the Metrics tab of the Monitoring application on the CMC. Administrators may create 
new metrics or select from many choices of metrics from the following five categories:

● System Metric

● Application Server Metric

● Probe Metric

● Topology Metric

● Derived Metric

Unit 13: SAP BusinessObjects Business Intelligence Platform 4.1 Monitoring
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Facilitator Producer

Say:

"We've just been talking about topology met-
rics. Let me pop up a poll question for you."

Do:

Using your Instructor Handbook, enter the 
pre-written poll questions into the Adobe 
Connect environment prior to class.

Display the poll question for the class and in-
vite participation.

When the voting is completed, display the re-
sults for the class and comment on them.

When done, minimize the Poll Pod so that the 
results can be popped up again later in the 
class (if desired).

Do:

Assist the instructor by monitoring questions 
in the Chat Pod.

INTERACTIVE ELEMENT: POLL

Question Answers

A status "1" indicates which value? a. This value indicates "OK".

b. This value indicates "Danger".

c. This value indicates "Caution".

System Metrics

System metrics are indictors of the performance of the operating system (RAM, CPU, disk space, 
number of used file) that hosts the platform. Every platform server has a set of predefined 
system metrics.

These metrics are immediately available from the Servers option on the Metrics tab. You can 
evaluate the metrics in the form of a chart that is updated automatically every 15 seconds.

Lesson: Using the SAP BusinessObjects Business Intelligence Platform 4.1 Monitoring Dashboard
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Figure 66: System Metrics

Caution:
A system metric cannot be edited or deleted.

Note:
If a metric is within a monitoring watch, you can view a history of the metric because 
its data was collected and stored in the monitoring database.

Application Server Metrics

Application server metrics are an indicator of the performance of the Application server. These 
metrics monitor things like:

● Frequency of auditing

● Number of user connections

● Number of opened WEBI documents

Each platform server has its own set of predefined application metrics.

Application server metrics are immediately available from the Servers option on the Metrics tab. 
You can monitor and graphically view the values of each of these metrics. (Graphics are updated, 
by default, every 15 seconds.)

Unit 13: SAP BusinessObjects Business Intelligence Platform 4.1 Monitoring
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Figure 67: Application Server Metrics

Caution:
A system metric cannot be edited or deleted.

Note:
If a metric is within a monitoring watch, you can view a history of the metric because 
its data was collected and stored in the monitoring database.

Probes Metrics

Probes metrics are performance indicators that are returned when available by the monitoring 
application test BI 4 probe. There are only two specific indicators for probes:

● Roundtrip time Metrics : This is the value that is returned by the metric which indicates the 
execution time of the test of the probe (in milliseconds). The larger the value, the larger the 
load is and the worse the performance on the platform.

● Result Metrics : This is the value that indicates the result of the execution of a probe. The value 
will be either Pass (Success) or Fail (Failure).

This metric is immediately available from the Servers option in the Metrics tab. You can monitor 
and graphically view values for each of these metrics. The graphics are updated every 15 seconds 
by default.

Lesson: Using the SAP BusinessObjects Business Intelligence Platform 4.1 Monitoring Dashboard
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Figure 68: Probes Metrics

Caution:
A system metric cannot be edited or deleted.

Note:
If a metric is within a monitoring watch, you can view a history of the metric because 
its data was collected and stored in the monitoring database.

Topology Metrics

The Topology metrics are not performance indicators. Instead, these metrics indicate the state of 
the general health of the service categories in the platform. These metrics also indicate the 
general health of the platform nodes, in the case of clustering nodes in BI 4. There is one specific 
indicator for Topology Metrics: Health State metrics. The value returned by this metric gives one 
of the following statuses:

● Unknown Value -- This value means that the server has stopped. It is black in color.

● 0 -- This value means "Danger" and has a red color.

● 1 -- This value means "Caution" and has an amber color.

● 2 -- This value means "OK" and has a green color.

The Topology metrics are immediately available from the Servers option in the Metrics tab. You 
can monitor and graphically view the values for this metric on the Metrics tab. Graphics are 
updated every 15 seconds by default

Unit 13: SAP BusinessObjects Business Intelligence Platform 4.1 Monitoring
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Figure 69: Topology Metrics

Caution:
A system metric cannot be edited or deleted.

Note:
If a metric is within a monitoring watch, you can view a history of the metric because 
its data was collected and stored in the monitoring database.

Derived Metrics

Derived Metrics is an indicator of user performance that can be customized by the administrator. 
To create a new Derived Metric, click the Create a Metric button on the Monitoring tab. Write a 
formula for calculating the value of the new metric for each rule. It is possible to validate the 
syntax of the formula.

New metrics can be saved by the administrator as either a Derived metric, a Probe metric, an 
Application server metric, or as a System metric.

This metric is immediately available in the Metrics tab. You can monitor and graphically view 
values for each of these metrics. Graphics are updated every 15 seconds by default.

Lesson: Using the SAP BusinessObjects Business Intelligence Platform 4.1 Monitoring Dashboard
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Figure 70: Derived Metrics

Edit Derived Metrics

Note:
It is possible to modify or delete any derived metric.

Figure 71: Edit Derived Metrics

Unit 13: SAP BusinessObjects Business Intelligence Platform 4.1 Monitoring
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Unit 13
Exercise 14

349
Create and Monitor a Metric

Business Example

As the system administrator, you must monitor the percentage of connected users on your 
production BI 4 platform in real time.

Properties of the Monitoring Application on the BI 4 Platform

1. Open the Central Management Console (CMC) application and select the Application menu.

2. Display the Monitoring Application properties.

● Is the Monitoring application service enabled?

● What is the maximum size of the Monitoring database?

● Where is the Monitoring database stored on the platform?

3. Run a database backup in the D:\ directory. What can you see on the server side?

4. How long does it take to back up the Monitoring database on the server?

5. What is the size of the backup folder?

6. How do you restore a Monitoring database backup, if necessary?

7. What is the platform server that is running and hosting the Monitoring service?

Create a New Metric and Monitor the Percentage of Connected Users on the Platform

1. In the Central Management Console (CMC), run the Monitoring Dashboard. Click the Metrics 
tab.

2. Create a new metric called My Rate of BI4 User Connections to monitor the percentage of 
established BI 4 platform user connections.

3. Monitor the current value displayed by your new metric. What does this value stand for?

4. Open a new BI launch pad session (in a new Internet Explorer window) with your 
Administrator user account. What is the new value of the metric in the graphic?

5. Log off from the new BI launch pad session you had open. What is the new value of the metric 
in the graphic?

6. Go to the history of this metric. What do you see and why?
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Unit 13
Solution 14

350
Create and Monitor a Metric

Business Example

As the system administrator, you must monitor the percentage of connected users on your 
production BI 4 platform in real time.

Properties of the Monitoring Application on the BI 4 Platform

1. Open the Central Management Console (CMC) application and select the Application menu.

2. Display the Monitoring Application properties.

● Is the Monitoring application service enabled?

Yes, the Enable Monitoring Application option is selected.

● What is the maximum size of the Monitoring database?

The maximum size of the Monitoring database is 1024 Mb. When the limit is 
reached, the oldest data will be automatically deleted.

● Where is the Monitoring database stored on the platform?

The Monitoring database is stored in the following folder: D:\Program Files 
(x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 4.x\Data
\TrendingDB. 

3. Run a database backup in the D:\ directory. What can you see on the server side?

a) Enter D:\ in the Trending database backup directory field.

b) Click the Save button.

c) Click the Now button. Do not close the Monitoring Application Properties window.

The Monitoring database backup is stored in a new folder (D:\Derby ) that is located 
at the Operating System (OS) level on the platform.

4. How long does it take to back up the Monitoring database on the server?
The Monitoring database backup to the D:\ drive only takes a couple of minutes.

5. What is the size of the backup folder?
The size of the backup folder is ~224 Mb.

6. How do you restore a Monitoring database backup, if necessary?
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Copy the contents of the backup folder, D:\Derby, and paste it to D:\Program Files 
(x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 4.0\Data
\TrendingDB\Derby .

7. What is the platform server that is running and hosting the Monitoring service?
The Adaptive Processing server hosts the Monitoring service by default. It can be 
moved to a single, dedicated Adaptive Processing server to secure this service on the 
platform.

Create a New Metric and Monitor the Percentage of Connected Users on the Platform

1. In the Central Management Console (CMC), run the Monitoring Dashboard. Click the Metrics 
tab.

2. Create a new metric called My Rate of BI4 User Connections to monitor the percentage of 
established BI 4 platform user connections.
a) Click the Create a Metric button.

b) Enter the following for the metric name: My Rate of BI 4 User Connections .

c) Expand the Central Management Server list and select the correct metrics to build the 
following metric formula:

(wdflbmt5072.CentralManagementServer$'Number of Sessions Established by 
All Users' / (wdflbmt5072.CentralManagementServer$'Existing Concurrent 
User Accounts' + wdflbmt5072.CentralManagementServer$'Existing Named User 
Accounts')) * 100

d) Click the Evaluate button to evaluate the syntax.

e) Click the Save button to create your new metric.

3. Monitor the current value displayed by your new metric. What does this value stand for?
a) Select the Metrics > Metrics.DerivedMetrics > My Rate of BI 4 User Connections options.

b) Click the ">" button.

Hint:
The graphic shows the current percentage of connected users on the BI 4 
platform, and it is updated periodically.

4. Open a new BI launch pad session (in a new Internet Explorer window) with your 
Administrator user account. What is the new value of the metric in the graphic?A new user 
connection was made, so the metric increased in the graphic.

5. Log off from the new BI launch pad session you had open. What is the new value of the metric 
in the graphic?A user connection has closed, so the metric increased in the graphic.

6. Go to the history of this metric. What do you see and why?The history for this metric is 
empty because a metric only displays current values in the system, and it does not 
keep a history of them in the Monitoring database. To see a history of the metrics, 
create a Watch that is based on this metric.

Lesson: Using the SAP BusinessObjects Business Intelligence Platform 4.1 Monitoring Dashboard
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Watch and Alerts
The Monitoring Watch application is a new tool for the BI 4 platform.

Monitoring Watch Features

● Automatically archives the monitoring data that is collected in the platform monitoring 
database

● Can be activated or deactivated to help control the volume of data that is stored in the 
platform monitoring database

● Can automatically send alert messages in the case of caution or danger encountered on the 
platform

Figure 72: CMC Watchlist Tab

Monitoring watches

By default, the platform offers nine predefined and operational watches that monitor the health 
status and performance of the installed default servers on the platform. The nine watches are:

Types of Monitoring Watches

● Analysis Services watch

● Connectivity Services watch

● Consolidated Heath watch

● Core Services watch

● Crystal Reports Services watch

● Dashboards Services watch

Unit 13: SAP BusinessObjects Business Intelligence Platform 4.1 Monitoring
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● Data Federation Services watch

● Application Server watch

● Adaptive Job Server watch

Note:
There is no predefined watch for the Explorer servers.

Functions of the Monitoring Application

The monitoring application performs the following functions:

● Analyzes the data that is collected by the monitoring watches

● Manages the watches

● Creates new watches

Analysis of the Data Collected by Monitoring Watches

The administrator can immediately analyze the data that is collected by a watch by clicking on the 
watch. A detailed panel appears that graphically presents all of the metrics that constitute the 
watch. This allows administrators to gather and monitor a set of metrics within the same 
monitoring tool.

The metrics can be analyzed by a watch in three ways:

● By color code:

- Black indicates that the server has stopped.

- Red indicates that the server status is Danger.

- Amber indicates that the server status is Caution.

- Green indicates that the server status is Ok.

● By Value:

- An unknown value indicates that the server has stopped.

- A value of 0 indicates that the server status is Danger.

- A value of 1 indicates that the server status is Caution.

- A value of 2 indicates that the server status is OK.

● By analysis chart (Metrics can be more finely parsed through the graphical analysis of data.):

- Go To Live is a type of visualization (default) that shows the current value of the metric in 
the system.

- Go To History shows the different values of the metric collected in the past, since the 
creation of the watch. It provides a detailed analysis of the history of this metric.

Lesson: Using the SAP BusinessObjects Business Intelligence Platform 4.1 Monitoring Dashboard
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Figure 73: Watch Metrics Graphic Analysis

Watch Management

The Watchlist tab provides a management toolbar that includes the following options:

● New -- Create a new watch

● Edit -- View watch properties and edit the configuration

● Copy -- Copy a watch

● Enable/Disable -- Enable or disable a watch

● Disable or enable monitoring alerts

● Add the watch as a new KPI in the dashboard

Figure 74: Managing a Watch Toolbar

New Watch Creation

Watches are useful to monitor a set of metrics that are gathered within the Monitoring 
application. An administrator can create a customized watch through the Watchlist tab toolbar. 
Click the New button and a wizard launches that guides you through the following steps:

1. Define the General properties

2. Define the Metrics and Rules

3. Define the Periods and Alerts

On the General Properties screen, enter the following data:

1. Name the watch.

2. Select the type of watch. A two state watch alerts of statuses Ok and Danger. A three state 
watch alerts of the statuses OK, Caution, and Danger.

Unit 13: SAP BusinessObjects Business Intelligence Platform 4.1 Monitoring
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Note:
The state of a monitoring watch can change when a threshold value is reached or 
exceeded.

3. Under Settings , select Write collected data to the Monitoring Database (Trending DB) and Add 
this watch within the KPIs list of watch.

Note:
A new watch is not set as a new KPI and does not keep data in the monitoring DB by 
default. The administrator can change these settings any time.

Figure 75: New Watch - General Properties

Watch Caution Rule Screen

The definition of metrics and rules is made on the Caution Rule screen. This stage of the creation 
of a watch defines the rules for a Danger or Caution status. For each state (Danger and Warning), 
the administrator must choose at least one metric and assign a threshold value and a condition.

Click the plus sign (+) next to a metric type to expand its view and show the individual metrics 
nested within them. Select the metrics you want to add to the watch, and click the right arrow 
button to move these metrics over to the Added Metrics portion of the screen. You can select 
metrics, probes, servers, and topology in this fashion on this screen.

Note:
You can define simple operators to combine the rules (and, or).

Lesson: Using the SAP BusinessObjects Business Intelligence Platform 4.1 Monitoring Dashboard
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Figure 76: Watch Caution Rule Screen

Watch Danger Rule Screen

To view the details of a selected metric, right-click the metric. A popup screen appears with 
details on the metric.

Once all metrics are selected for the Caution rule, click the Next button to move on to the Danger 
Rule screen. The same method of metric selection discussed previously apply to the Danger rule 
as well.

Figure 77: Watch Danger Rules Screen

Unit 13: SAP BusinessObjects Business Intelligence Platform 4.1 Monitoring
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Once all of the Danger Rule metrics have been added to the watch, click the Next button to move 
on to the Throttle and Notifications screen. This last step toward creating a watch defines two 
important elements:

● The alert frequency and duration of monitoring

● Recipients and alerting methods

Administrators can select one of two frequency and duration options:

● A frequency of alerts without any time limit for all rules. This option is the Change watch state 
every time Caution or Danger Rule evaluates to true radio button.

● A frequency and a time limitation for each rule and period. This option is the Change watch 
state according to Throttling criteria below radio button.

Throttle and Notification Watch Screen

● Select the Add Metric Trend History As Attachment checkbox to send the graphic view of the 
state that generated the alert to the selected recipients as an email attachment.

Figure 78: Throttle and Notification Watch Screen

Directory Window

The second part of the Throttle and Notification screen is the Notification settings. This section 
refers to the watch recipients and alerts. Administrators can select from the following options:

● Select the Enable alert notifications checkbox to turn on notifications.

● Select a list of internal or external (email addresses) recipients to receive the alerts. Click the 
Directory button to select the appropriate recipients. The Directory window appears. Select 
the recipients and then click on the Alert Settings dropdown menu to select the alerts the 
recipients receive. The selected recipients will display in the List of users to be notified field on 
the Throttle and Notification screen.

Lesson: Using the SAP BusinessObjects Business Intelligence Platform 4.1 Monitoring Dashboard
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Figure 79: Directory Window

New Watch Displayed in Watchlist Tab

When you are done with the Throttle and Notification screen, click the Save button. The new 
watch is listed in the Watchlist tab. The administrator can look at its historical data or data in real 
time.

Figure 80: New Watch Displayed in Watchlist Tab

New Watch as KPI

When a watch is added as a new KPI, it will appear in the KPI Status portion of the Monitoring 
Dashboard tab.

Unit 13: SAP BusinessObjects Business Intelligence Platform 4.1 Monitoring
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Figure 81: New Watch as KPI

Alerts

Previously, we learned that a monitoring alert is defined by rules (Danger and Caution) within a 
watch. As soon as one of the rules is evaluated to be true by the platform, the Monitoring 
application automatically broadcasts an alert message by mail or in the BI launch pad to the 
recipients defined in the watch.

Figure 82: Unread Alerts

Monitoring Alert Toolbar

The alert message is also automatically maintained in the Monitoring application on the Alerts 
tab. This tab displays the history of all monitoring alerts and the watch the alert is associated 
with. The Alerts tab has a toolbar that provides analysis and management of alerts through the 
following functions:

● Filter text field that allows you to show alerts from a specific service.

● Browse button that allows you to search for specific alerts.

● Clear button that clears filters from the Alerts tab.

● Filter drop-down menu provides a set of common filter options, such as Read or Unread .

Lesson: Using the SAP BusinessObjects Business Intelligence Platform 4.1 Monitoring Dashboard

© Copyright . All rights reserved. 379



● Confirm alert button.

● Delete alert button.

● Enable Auto-Refresh of the Alerts tab button.

Figure 83: Monitoring Alert Toolbar

Analysis of Alert Messages

To view and analyze the details of an alert to determine its cause, click the Alerts tab on the 
Monitoring application. A list of the alerts is displayed that includes the watch, the time, and the 
status of the alert. (An amber icon indicates a status of Caution and a red icon indicates a status 
of Danger.)

Figure 84: Alerts Tab

Alert Details Screen

Click on an alert to view further details of the alert. The Alert Details screen displays details on the 
watch, the status rules, and Cause and Action information when available. Click the Close button 
to return to the Alerts tab of the Monitoring application.
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Figure 85: Alert Details Screen

Alert Management

Alerts can be managed from the Alerts tab of the Monitoring application. Select an alert on this 
tab to activate management options on the Alerts tab toolbar. Management options include:

● Alert Confirmation

● Alert Deletion

● Analysis of Alert Statistics

To confirm an alert, click the Confirm button on the toolbar. The Enter possible cause and action 
popup window appears. Enter the cause of the alert in the Cause text field. Enter the action 
necessary to correct the problem in the Action text field. Click the OK button to complete the alert 
confirmation.

Figure 86: Confirm an Alert

Note:
These alert confirmation comments are saved in the alert. They remain preserved in 
the Alerts history.
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To delete an alert, click the Delete button on the Alerts tab toolbar.

Caution:
Deleted alerts are permanently deleted from the Monitoring database.

Alert Statistics

Alert statistics can be viewed by sorting and filtering alerts with the option on the Alerts tab 
toolbar. The number of Monitoring alerts can be viewed by Watch and by Type of Alert. The Select 
Watches window shows how many Caution and Danger status alerts have been issued for each 
watch. Select a watch to view the details of the alerts.

Figure 87: Select Watches Window
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Unit 13
Exercise 15

363
Create and Monitor Alerts

Business Example

As the system administrator, you must monitor and store the percentage of connected users on 
your production BI 4 platform in the Monitoring database. Additionally, you want to receive alerts 
in your BI launch pad Home page when a special overload of user connections is detected on the 
platform.

Create a Watch
Create a Watch that monitors and alerts on overloading user connections on the BI 4 platform.

1. In the Central Management Console (CMC), open the Monitoring Dashboard and go to the 
Watchlist tab.

2. Create a new Watch that monitors connections and sends alerts when existing platform 
connections are overloaded. Name this new watch: My User Connections Watchlist .

3. Set the general properties for the new Watch according to the following table:.

Watch Name: My User Connections Watchlist

Metric Description: My Rate of BI 4 User Connections

Number of States: Three (Ok, Caution, Danger)

Settings: Write to Trending Database and Add as KPI

4. Set the Caution Rule for the new Watch according to the following table.

Added Metrics My Rate of BI 4 User Connections

Caution Rule: Caution >=50

5. Set the Danger Rule for the new Watch according to the following table.

Added Metrics: My Rate of BI 4 User Connections

Danger Rule: Danger >=75

6. Set the Throttle and Notification for the new Watch according to the following table.

Throttle: All default settings

Notification: Administrator (Alerts only)

© Copyright . All rights reserved. 383



Monitor the Watch

1. Add the new Watch as a KPI Dashboard tab in the Monitoring application. What is its current 
KPI status?

2. Click the new My User Connections Watchlist KPI, and monitor the current value that is 
displayed by your new Watch. What does this value signify?

3. Open a new BI launch pad session (in a new Internet Explorer window) with your 
Administrator user account. What is the new value of the metric in the graphic?

4. Log off from the new BI launch pad session. What is the new value of the metric in the 
graphic?

5. Go to the History page for this Watch. What can you see and why?

Watch Alerts

1. In the CMC, open the Monitoring Dashboard and go to the Alerts tab. What do you see?

2. Study the details on the Caution and Danger alerts that were sent by your Watch. What do you 
notice?

3. Log on to the BI launch pad Home page with your Administrator user account. What do you 
see?
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Unit 13
Solution 15

365
Create and Monitor Alerts

Business Example

As the system administrator, you must monitor and store the percentage of connected users on 
your production BI 4 platform in the Monitoring database. Additionally, you want to receive alerts 
in your BI launch pad Home page when a special overload of user connections is detected on the 
platform.

Create a Watch
Create a Watch that monitors and alerts on overloading user connections on the BI 4 platform.

1. In the Central Management Console (CMC), open the Monitoring Dashboard and go to the 
Watchlist tab.

2. Create a new Watch that monitors connections and sends alerts when existing platform 
connections are overloaded. Name this new watch: My User Connections Watchlist .

a) Click the New button.

3. Set the general properties for the new Watch according to the following table:.

Watch Name: My User Connections Watchlist

Metric Description: My Rate of BI 4 User Connections

Number of States: Three (Ok, Caution, Danger)

Settings: Write to Trending Database and Add as KPI

a) Enter the following in the metric Name field: My Rate of BI 4 User Connections .

b) Select the Three option for the Number of states (OK, Caution, Danger).

c) Select all of the settings checkboxes (Write to Trending Database and Add as KPI ).

d) Click the Next button.

4. Set the Caution Rule for the new Watch according to the following table.

Added Metrics My Rate of BI 4 User Connections

Caution Rule: Caution >=50

a) Select the My Rate of BI 4 User Connections metric to be added to the Added Metrics table.

b) Change the Caution Rule to Caution >=50 .

© Copyright . All rights reserved. 385



c) Click the Next button.

5. Set the Danger Rule for the new Watch according to the following table.

Added Metrics: My Rate of BI 4 User Connections

Danger Rule: Danger >=75

a) Select the My Rate of BI 4 User Connections metric to be added to the Added Metrics table.

b) Configure the Danger Rule to Danger >=75 .

c) Click the Next button.

6. Set the Throttle and Notification for the new Watch according to the following table.

Throttle: All default settings

Notification: Administrator (Alerts only)

a) Keep the default Change watch state every time Caution or Danger Rule evaluates to true 
settings.

b) Keep Enable alert notifications enabled.

c) Click the Directory button.

d) In the new window, select the Administrator account. Then select the Alert Settings option 
from the dropdown list.

e) Select the Get inbox alerts checkbox.

f) Click the OK button to return to the previous screen.

g) Click the Save button to create the new watch.

Monitor the Watch

1. Add the new Watch as a KPI Dashboard tab in the Monitoring application. What is its current 
KPI status?
a) In the Dashboard tab of the Monitoring application, click the Select KPI option in the KPI 

Status area.

b) Select My User Connections Watchlis t in the Watchlist area, and then click outside of the 
window.

Hint:
The KPI Status shows the current status of your Watch. Green signifies the 
status is "OK". Orange signifies that the status is "Caution". Red signifies that 
the status is "Danger".

2. Click the new My User Connections Watchlist KPI, and monitor the current value that is 
displayed by your new Watch. What does this value signify?
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The Watchlist displays a color coded value that corresponds to the caution threshold 
for the metric. For instance, if the color of the My User Connections Watchlist is 
orange, then the current value for the percentage of connected users on the BI 4 
platform is =50%.

3. Open a new BI launch pad session (in a new Internet Explorer window) with your 
Administrator user account. What is the new value of the metric in the graphic?
The Watchlist displays a red value that corresponds to the Danger threshold for the 
percentage (=75%) of connected users on the platform.

4. Log off from the new BI launch pad session. What is the new value of the metric in the 
graphic?The Watchlist displays an orange value that corresponds to the Caution 
threshold (=50%), because a user connection has been closed.

5. Go to the History page for this Watch. What can you see and why?The history for this new 
metric contains data, because the Watch keeps a history of all values for the metrics 
that it collects. It stores these values within the Monitoring database.

Watch Alerts

1. In the CMC, open the Monitoring Dashboard and go to the Alerts tab. What do you see?All of 
the alerts that were sent by the Watch (Danger and Caution alerts) are displayed in the 
list.

2. Study the details on the Caution and Danger alerts that were sent by your Watch. What do you 
notice?
a) Select the Caution alert that was sent by your Watch.

b) Click the Caution Alert hyperlink to open the details of this alert.The details of the alert 
show that the Caution threshold of =50% had been reached, so the Caution Rule is 
true.

c) Click the Close button.

d) Select the Danger alert that was sent by your Watch.

e) Click the Caution Alert hyperlink to open the details of this alert.The details of the alert 
show that the Danger threshold of =75% had been reached, so the Danger Rule is 
true.

3. Log on to the BI launch pad Home page with your Administrator user account. What do you 
see?
a) Log on to the BI launch pad as Administrator.The BI launch pad Home page displays the 

new alerts (Caution and Danger) that are coming from the Watch.

b) Open the alert to see the details.The alert details show that a threshold has been 
reached, so a Rule is true and has sent the alert to your BI launch pad.

Lesson: Using the SAP BusinessObjects Business Intelligence Platform 4.1 Monitoring Dashboard

© Copyright . All rights reserved. 387



Probes
Another type of monitoring of the BI 4 platform is the use of probes. Unlike monitoring watches 
that monitor the status of a server, monitoring probes test the functioning of a set of platform 
servers. Monitoring probes can be viewed on the Probes tab of the Monitoring application.

Figure 88: Probes Tab

Platform Probe Types

The platform may feature three types of probes: Health probe, Diagnostic probe, and Hybrid 
probe. These probes provide health status and functional performance information on the 
platform. They can be scheduled periodically.

Table 48: Platform Probe Types

Probe Description

Health probe This probe generates metrics on the following 
data types: integer, Boolean, and string. An ex-
ample of a health probe is the default CMS 
Logon/Logoff probe. This probe checks that a 
user can log on and log off of the CMS.

Diagnostic probe This probe generates reports that contain cur-
rent system information. An example of a diag-
nostic probe is the default Stop/Start server 
probe. This probe checks all of the servers, re-
cords the state of each, and restarts servers 
and collects information about these servers 
again.

Hybrid probe This type of probe functions as both a health 
probe and a diagnostic probe.

Predefined Probes

The Monitoring application provides nine predefined probes:

● BI launch pad probe

● CMS Cache probe

Unit 13: SAP BusinessObjects Business Intelligence Platform 4.1 Monitoring

388 © Copyright . All rights reserved.



● CMC DB Connection probe

● CMC Logon Logoff probe

● CMS Ping probe

● Crystal Reports Service (Processing server) probe

● Crystal Reports Service (Report Application server) probe

● Interactive Analysis probe

● Start Stop Servers probe

The Probes tab has a probe management toolbar that provides the following functionality:

Table 49: Probe Management Toolbar

Toolbar Option Functionality

Run Now button This button runs the selected probe.

Delete button This button permanently deletes the selected 
probe.

Properties button This button displays the properties of the se-
lected probe.

Schedule button This button facilitates scheduling of the select-
ed probe.

History button This button displays the history of the selected 
probe.

Enable Auto-Refresh button This button enables auto-refresh for the select-
ed probe.

Health and Performance Probes

Each probe fills a well defined test set. For example, the CMS DB Connection test probe roles is to 
test the availability and performance of the CMS database system. Once a probe execution has 
finished, it returns a functional state of health and the performance of the platform in the form of 
the following two metrics:

● Result metric: This metric provides the functional status of the probe:

- A result of Fail indicates that the test of the probe failed.

- A result of Pass indicates that the test of the probe succeeded.

● Execution Time metric: this metric provides the execution time of the probe, which indicates 
the state of the platform. The greater the value of this metric, the slower the platform is 
performing.
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Note:
The result and execution time metrics are also available as graphs. At each 
execution, two new values of metrics are stored in the Monitoring database 
(history).

Figure 89: Probe Metrics Graphically Represented

Each probe keeps test instances in its history. Select the probe and then click the History button 
in the Probes tab toolbar to view the probe history.

Probe History

Each probe keeps test instances in its history. Select the probe and then click the History button 
in the Probes tab toolbar to view the probe history.

Figure 90: Probe History

Probe Properties Configuration

Before scheduling a probe to run, check to make sure that the properties are correctly 
configured. To view the properties of a probe, select the probe and click the Properties button. On 
the Properties window, make sure that the probe Timeout, Document CUID, Refresh, Export to 
Excel, and Export to PDF settings are correct. Make any necessary adjustments and save the 
properties.

Unit 13: SAP BusinessObjects Business Intelligence Platform 4.1 Monitoring

390 © Copyright . All rights reserved.



Note:
Probe configuration options are unique to the probe. Not all probes have the 
properties previously listed. Many probes do not have properties like Export to Exel 
and Export to PDF.

Figure 91: Probe Properties

Probe Execution

Probes may be executed either manually (on demand) or automatically (scheduled). To schedule 
a probe to run, select the probe and click the Schedule button on the Probes tab toolbar.

In the case of a periodically scheduled probe, its behavior is like a robot that tests regularly for the 
health and performance of the vital organs of the platform. Recurrence options for probe 
scheduling can be found on the Recurrence portion of the scheduling screen in the Run object 
dropdown list.

Figure 92: Probes Running Recurrence Options
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Customized Probes

There are two ways to create a customized probe: with JAVA or with scripting. To create a 
customized probe, begin by clicking the Register button on the Probes tab of the Monitoring 
application, and then select either Java-based Probe or Probe . The Register Probe window 
appears.

The Java-based probe registration window provides the following configuration options:

● Probe Name: Enter a descriptive name for the new probe.

● Description: Enter an accurate description of the probe.

● Timeout: Enter the amount of seconds the Probe will timeout.

● Probe Type: Select the correct type for this probe, either Health , Diagnostic , or Hybrid .

● List of Parameters: Use this option to add, edit, or delete parameters for the probe.

Figure 93: Java-based Probe

Scripted Customized Probe Registration

The other custom probe option is to use scripting. The Probe Registration window provides the 
following configuration options:

● Probe Name: Enter a descriptive name for the new probe.

● Probe Input Type: Select either the Command Line radio button or the Script Upload radio 
button.

● Script File: Use the Browse button here to navigate to and upload a script file for the probe.

● Define Virtual Metrics: Check this checkbox if you wish to define the virtual metrics.
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Figure 94: Scripted Customized Probe Registration

Customized Probes - HTTPWatch Example

Figure 95: Java-based Probe - HTTPWatch Example
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Unit 13
Exercise 16

375
Test Servers with Probes

Business Example

As the system administrator, you need to test the performance of your Web Intelligence server on 
your BI 4 platform. To test this, you need to periodically schedule a Probe with a reference Web 
Intelligence document.

Before beginning this exercise, confirm that the timeout setting for Start Stop Servers is set to 
1200 seconds; otherwise participants might encounter a timeout error when they attempt this 
exercise.

Configure the Interactive Analysis Probe
Configure the Interactive Analysis probe to test a reference Web Intelligence document.

1. In the Central Management Console (CMC), open the Monitoring Dashboard and go to the 
Probes tab.

2. Configure the properties of this probe for refreshing and exporting to PDF the Charting 
Samples Web Intelligence document. Use the following table for configuration details.

Timeout (sec): 100

Document CUID: Copy the CUID of the Web Intelligence docu-
ment from the BI launch pad and paste it into 
this field.

Refresh: true

Export to xls: false

Export to pdf: true

Run Immediate Schedule for the Interactive Analysis Probe

1. Run the Interactive Analysis probe that you just created. What are the results and time of this 
execution?

2. Run the Interactive Analysis probe again. What are the results and the time of this new 
execution?

3. Run the Interactive Analysis probe again. What are the results and the Time of this third 
execution?

4. Check the history of the Interactive Analysis probe. What do you notice?
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Unit 13
Solution 16

376
Test Servers with Probes

Business Example

As the system administrator, you need to test the performance of your Web Intelligence server on 
your BI 4 platform. To test this, you need to periodically schedule a Probe with a reference Web 
Intelligence document.

Before beginning this exercise, confirm that the timeout setting for Start Stop Servers is set to 
1200 seconds; otherwise participants might encounter a timeout error when they attempt this 
exercise.

Configure the Interactive Analysis Probe
Configure the Interactive Analysis probe to test a reference Web Intelligence document.

1. In the Central Management Console (CMC), open the Monitoring Dashboard and go to the 
Probes tab.

2. Configure the properties of this probe for refreshing and exporting to PDF the Charting 
Samples Web Intelligence document. Use the following table for configuration details.

Timeout (sec): 100

Document CUID: Copy the CUID of the Web Intelligence docu-
ment from the BI launch pad and paste it into 
this field.

Refresh: true

Export to xls: false

Export to pdf: true

a) Select the Interactive Analysis probe, and click the Properties option.

b) In the Properties window, configure the Input Parameters as shown in the preceding table.

Hint:
Copy the CUID of this Web Intelligence document from its properties in the BI 
launch pad, then paste the CUID into the Document CUID field. Do not copy 
and paste the ID.

c) Click the Save and Close button.
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Run Immediate Schedule for the Interactive Analysis Probe

1. Run the Interactive Analysis probe that you just created. What are the results and time of this 
execution?
a) Select the Interactive Analysis probe, and then click the Run Now button. Wait a couple of 

seconds to generate the status of this execution.

b) Click the Refresh button to update the status.
Once the probe has been successfully executed, it shows the Result Metric as a "Success" 
and the Roundtrip Time Metric with a high value (such as 12 seconds). This high value for 
the Roundtrip Time is normal. The Web Intelligence document and the Universe have to 
initialize the cache server before refreshing the Web Intelligence document with the Web 
Intelligence Processing server.

2. Run the Interactive Analysis probe again. What are the results and the time of this new 
execution?
a) Select the Interactive Analysis probe, and then click the Run Now button. Wait a couple of 

seconds to generate the status of this execution.

b) Click the Refresh button to update the status.
Once the probe has been successfully executed, it shows the Result Metric as "Success" 
and the Roundtrip Time Metric has a lower value. The Roundtrip Time is shorter because 
the platform contents are already in the cache, so refreshing and exporting is faster than 
the previous execution.

3. Run the Interactive Analysis probe again. What are the results and the Time of this third 
execution?
a) Select the Interactive Analysis probe, and then click the Run Now button. Wait a couple of 

seconds to generate the status of this execution.

b) Click the Refresh button to update the status.
Once the probe has been successfully executed, it shows the Result Metric as "Success" 
and the Roundtrip Time Metric with a lower value. The Roundtrip time is shorter because 
the platform contents are already in the cache. Therefore, refreshing and exporting is 
faster than the previous executions.

4. Check the history of the Interactive Analysis probe. What do you notice?
a) Go to the History View for the Roundtrip Time Metric in the Interactive Analysis probe 

View.
You will notice that the Result and the Roundtrip Time Parameters are stored in the 
Monitoring database. You can consult the values at any time in the History View.

b) Click the History button for the Interactive Analysis probe View .
You will see another view of the probe history that includes the probe status and the Run 
Result Metric.
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Unit 13
Exercise 17

379
Restart Servers with Probes

Business Example

As the system administrator, you need to periodically restart some platform server on your 
platform automatically. Additionally, you want to monitor the history of the status and the 
performance metrics after restarting the servers.t

Configure the Start/Stop Probe to Restart Servers
Configure the Start/Stop probe to periodically restart all platform servers except the Adaptive 
servers.

1. In the Central Management Console (CMC), open the Monitoring Dashboard and go to the 
Probes tab.

2. Configure the properties of the Start Stop Servers probe to periodically stop and restart the 
servers of the platform.

Run Immediate Schedule for the Start Stop Servers Probe

1. Run the Start Stop Servers probe. What are the results the time of this execution?

2. Check the History of the Start Stop Servers probe. What do you see?
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Solution 17

380
Restart Servers with Probes

Business Example

As the system administrator, you need to periodically restart some platform server on your 
platform automatically. Additionally, you want to monitor the history of the status and the 
performance metrics after restarting the servers.t

Configure the Start/Stop Probe to Restart Servers
Configure the Start/Stop probe to periodically restart all platform servers except the Adaptive 
servers.

1. In the Central Management Console (CMC), open the Monitoring Dashboard and go to the 
Probes tab.

2. Configure the properties of the Start Stop Servers probe to periodically stop and restart the 
servers of the platform.
a) Select the Start Stop Servers probe, and click the Properties option.

b) In the Properties window, keep all of the default values.

Note:
The whereclause field contains the list of servers to start or not. All platform 
servers will restart, except for the Adaptive Processing server and the Adaptive 
Job server.

c) Click the Save and Close button.

Run Immediate Schedule for the Start Stop Servers Probe

1. Run the Start Stop Servers probe. What are the results the time of this execution?
a) Select the Start Stop Servers probe.

b) Click the Run Now button. Wait a couple of minutes before viewing the status of this 
execution.

c) Click the Refresh button to update the status.
After waiting for the platform servers to restart on the platform, the Success status 
appears. The Roundtrip Time shows the length of time it took the servers to restart.

2. Check the History of the Start Stop Servers probe. What do you see?
a) In the Start Stop Servers Probe View , go to the Roundtrip Time metric History View .
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You see that the Result and Roundtrip Time parameters are stored in the Monitoring 
database. You can consult these values in the History View window.

b) In the Start Stop Servers Probe View window, click the History button. What do you see?
You see another view of the probe history that includes the status and the Run Result 
metric.

Lesson: Using the SAP BusinessObjects Business Intelligence Platform 4.1 Monitoring Dashboard
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LESSON SUMMARY
You should now be able to:

● Monitor a metric

● Monitor servers with alerts

● Monitor servers with probes

Unit 13: SAP BusinessObjects Business Intelligence Platform 4.1 Monitoring

402 © Copyright . All rights reserved.



Unit 13

383
Learning Assessment

1. What part of the platform is the Monitoring application integrated with?

Choose the correct answer.

X A CMS

X B Dashboard Design

X C Explorer

X D CMC

2. Choose the correct pathway to the Monitoring Properties screen.

Choose the correct answer.

X A Go to the CMC →  and right click the  → Monitoring Application →  option. Select the 
 → Properties popup option.

X B Go the CMS → Applications → , and right click the  → Monitoring Application →  option. 
Select the  → Properties popup option.

X C Go to to the CMS → Servers → Application → Monitoring → Properties.

X D Go to the CMC → Servers → Applications → Monitoring → Properties .

3. Which tab of the Monitoring application shows you the frequency of auditing?

Choose the correct answer.

X A Probes tab

X B Watchlist tab

X C Metrics tab

X D Alerts tab
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4. A system metric can be deleted on the Metric tab of the Monitoring application.

Determine whether this statement is true or false.

X True

X False

5. How many predefined and operational watches does the platform offer?

Choose the correct answer.

X A 1

X B 15

X C 7

X D 9

6. When do recipients receive an alert?

Choose the correct answer.

X A An alert is issued when one of the rules is evaluated to be true by the platform.

X B An alert is issued when an administrator sends one out.

X C An alert is issued when one of the servers encounters an error.

X D An alert is issued when a watch finds an inconsistency.
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7. Match the item in the first column to the corresponding item in the second column.

Health Probe

Diagnostic Probe

Hybrid Probe

This probe generates reports 
that contain current system in-
formation. And example of a 
diagnostic probe is the default 
Stop/Start server probe. This 
probe checks all of the servers, 
records the state of each, and 
restarts servers and collects 
information about these serv-
ers again.

This type of probe functions as 
both a health probe and a diag-
nostic probe.

This probe generates metrics 
on the following data types: in-
teger, Boolean, and string. An 
example of a health probe is 
the default CMS Logon/Logoff 
probe. This probe checks that 
a user can log on and log off of 
the CMS.

8. Probes may be executed on demand or scheduled to run automatically.

Determine whether this statement is true or false.

X True

X False

Unit 13: Learning Assessment
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386
Learning Assessment - Answers

1. What part of the platform is the Monitoring application integrated with?

Choose the correct answer.

X A CMS

X B Dashboard Design

X C Explorer

X D CMC

2. Choose the correct pathway to the Monitoring Properties screen.

Choose the correct answer.

X A Go to the CMC →  and right click the  → Monitoring Application →  option. Select the 
 → Properties popup option.

X B Go the CMS → Applications → , and right click the  → Monitoring Application →  option. 
Select the  → Properties popup option.

X C Go to to the CMS → Servers → Application → Monitoring → Properties.

X D Go to the CMC → Servers → Applications → Monitoring → Properties .

3. Which tab of the Monitoring application shows you the frequency of auditing?

Choose the correct answer.

X A Probes tab

X B Watchlist tab

X C Metrics tab

X D Alerts tab
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4. A system metric can be deleted on the Metric tab of the Monitoring application.

Determine whether this statement is true or false.

X True

X False

5. How many predefined and operational watches does the platform offer?

Choose the correct answer.

X A 1

X B 15

X C 7

X D 9

6. When do recipients receive an alert?

Choose the correct answer.

X A An alert is issued when one of the rules is evaluated to be true by the platform.

X B An alert is issued when an administrator sends one out.

X C An alert is issued when one of the servers encounters an error.

X D An alert is issued when a watch finds an inconsistency.
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7. Match the item in the first column to the corresponding item in the second column.

Health Probe

Diagnostic Probe

Hybrid Probe

This probe generates metrics 
on the following data types: in-
teger, Boolean, and string. An 
example of a health probe is 
the default CMS Logon/Logoff 
probe. This probe checks that 
a user can log on and log off of 
the CMS.

This probe generates reports 
that contain current system in-
formation. And example of a 
diagnostic probe is the default 
Stop/Start server probe. This 
probe checks all of the servers, 
records the state of each, and 
restarts servers and collects 
information about these serv-
ers again.

This type of probe functions as 
both a health probe and a diag-
nostic probe.

8. Probes may be executed on demand or scheduled to run automatically.

Determine whether this statement is true or false.

X True

X False
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